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1  About this guide
This guide provides an overview of the OpenScape Contact Center 
Manager application and walks users through the various 
administration tasks that need to be performed on an ongoing basis. 

1.1  Who should use this guide

This guide is intended for contact center administrators, who are 
responsible for configuration maintenance, and for supervisors and 
managers, who use the OpenScape Contact Center productivity tools.

1.2  Formatting conventions

The following formatting conventions are used in this guide:

Bold 
This font identifies OpenScape Contact Center components, window 
and dialog box titles, and item names.

Italic 
This font identifies references to related documentation.

Monospace Font 
This font distinguishes text that you should type, or that the computer 
displays in a message.

NOTE:  Notes emphasize information that is useful but not essential, 
such as tips or alternative methods for performing a task. 

IMPORTANT:  Important notes draw special attention to actions that 
could adversely affect the operation of the application or result in a loss 
of data. 
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1.3  Documentation feedback

To report an issue with this document, call the Customer Support 
Center. 

When you call, be sure to include the following information. This will 
help identify which document you are having issues with.

• Title: Manager Administration Guide

• Order Number: A31003-S22B1-M103-08-76A9
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2  Planning an implementation
Most customers work closely with their service representative through 
the planning and design phase of an OpenScape Contact Center 
implementation. The service representative takes responsibility for 
creating and implementing the initial configuration. The design 
database that is created for you is set up with definitions of the 
essential resources, an initial set of users, workflows that dictate how 
incoming contacts and queued contacts are handled, and mappings to 
the communication platform resources that OpenScape Contact Center 
monitors.

This chapter provides an overview of the key concepts that must be 
considered when planning an OpenScape Contact Center 
implementation, including a summary of the basic configuration tasks 
that must be performed to create a design database, put the design 
database into production, and perform the initial configuration of the 
system. 

After the initial configuration has been put into production, on-going 
tasks include routine maintenance, such as maintaining users, profiles 
and extensions, and day-to-day supervisory tasks such as configuring 
and using the productivity tools.

Policy changes, new business, changes in performance requirements, 
and simple growth can result in the need to modify the contact routing 
aspects of your configuration. This commonly amounts to relatively 
isolated reconfiguration tasks, such as changing a Call Director menu 
setup, adding service for a new dialed number, or revisiting your queue 
setup. The latter part of this guide provides instructions on how to 
perform these types of reconfiguration tasks.

NOTE:  Contact your service representative for assistance with major 
reconfiguration.
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2.1  OpenScape Contact Center processing

This section introduces the highest level elements of the OpenScape 
Contact Center configuration. 

2.1.1  Initial processing

Incoming contacts are directed to OpenScape Contact Center as 
follows:

• Voice – For each dialed number serviced by the contact center, 
incoming contacts are held on the communication platform. The 
platform notifies OpenScape Contact Center of the contact, 
provides relevant contact information, and then waits for 
OpenScape Contact Center to provide directives on how to further 
process the contact. For more information on voice support, see 
Chapter 11, “Working with voice resources”.

• Callback – In addition to basic voice support, OpenScape Contact 
Center supports callbacks. Callback is a feature that lets customers 
and users schedule outgoing calls to customers. OpenScape 
Contact Center then establishes and administers the call. For more 
information on callback support, see Chapter 13, “Working with the 
callback feature”. 

• E-mail – E-mail messages are routed through a corporate e-mail 
server to the OpenScape Contact Center E-mail Server. All e-mail 
messages are stored in a single mailbox on the corporate e-mail 
server. Support for multiple e-mail addresses can be handled by 
providing aliases. For more information on e-mail support, see 
Chapter 14, “Working with the e-mail feature”.

•

2.1.2  Workflow processing

On arrival in OpenScape Contact Center, incoming contacts are 
processed by a routing strategy workflow. The workflow gathers 
contact requirements and determines how each contact is to be routed. 
For more information, see Section 9.2, “About routing strategy 
workflows”, on page 146. 

If you are using the networking feature, a networking workflow 
executes immediately after a routing strategy workflow finishes 
executing. Networking workflows make decisions on whether incoming 
contacts are to be routed to other sites. For more information, see 
Section 16.5, “About networking workflows”, on page 365. 
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2.1.3  Queue processing

While a contact is in queue, OpenScape Contact Center executes a 
number of steps to try to match the contact to a specific user. The way 
in which the queue steps are configured depends on the type of 
routing: group-based or skills-based. For details, see Section 8.1, 
“About group-based routing”, on page 159, or Section 8.2, “About 
skills-based routing”, on page 162.

Although queued contacts are typically handled in the order that they 
are placed in the queue, OpenScape Contact Center has routing 
decision and queue properties, such as priority, that can determine the 
handling order. 

While a contact is waiting in queue, a queue processing workflow is 
applied to the queue simultaneously. The queue or the queue 
processing workflow can handle the contact. For more information, see 
Section 10.1, “About queues”, on page 193 and Section 9.5, “About 
queue processing workflows”, on page 174. 

2.2  Design database configuration overview 

This section provides a high-level overview of the steps required to 
configure a design database. 

NOTE:  Before you begin to configure the design database, you should 
complete the resource worksheets for the communication platform to 
which you are connecting. This ensures that you have all the required 
information for the configuration. 

For detailed instructions on how to complete each task, refer to the 
procedures provided in later chapters or in the Manager Help. 

2.2.1  Basic design database configuration

Start by creating a new, empty design database, and then activate the 
required product features by using the license file.

NOTE:  In a multitenant environment, to prevent conflicts between 
different business units, only a system administrator can activate 
product features and upload a design database. 
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To configure a basic design database:

1. Log on to the Manager application.

2. Create a new design database.

3. Activate the product features using a license file.

NOTE:  By default, the system is configured to use group-based 
routing. If you intend to use skills-based routing, the feature that 
allows you to change to skills-based routing must be enabled. 

2.2.2  Communication platform connectivity 
and voice resources

To route telephone calls and gather statistics, the system monitors a 
set of key resources on the communication platform. Using the 
Manager application, you must configure a matching definition within 
OpenScape Contact Center for each resource on the communication 
platform. 

For a list of communication platform resources, see Section 11.3, 
“Communication platform resources”, on page 213.

To configure communication platform connectivity and voice 
resources:

1. Configure the communication platform settings.

2. Configure the default time-out extension.

3. Configure the resources for the communication platform. The 
resources depend on the type of communication platform to which 
you are connecting.
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2.2.3  Configuring the corporate server 
connections

Depending on the features that are licensed, you must configure the 
connections to the corporate e-mail server for the OpenScape Contact 
Center e-mail feature, and to the corporate Web server for the 
OpenScape Contact Center Web-enabled features.

To configure the corporate e-mail server connections:

1. Configure t he IMAP server settings that the OpenScape Contact 
Center E-mail Server uses to communicate with the corporate 
e-mail server to route incoming e-mail messages.

2. Configure the SMTP server settings that the OpenScape Contact 
Center E-mail Server uses to communicate with the corporate 
e-mail server to route outgoing e-mail messages

To configure the corporate Web server connections:

1. Configure the port number of the unsecured port and TLS-enabled 
port that the Web Interaction Server uses to communicate with the 
corporate Web server. 

2. Configure the port number that the Web Interaction Server uses to 
communicate with the corporate Web server for Web callback 
requests.

3. Configure the port number that the Web Interaction Server uses to 
communicate with the corporate Web server for Web callback 
requests, Web collaboration sessions, and VoiceXML integration.

2.2.4  Configure networking resources

If the networking feature is licensed, you must configure the 
networking resources. When networking is enabled at the site level, the 
site can accept and distribute contacts according to the details of the 
networking configuration at the site. You can disable a site's 
participation in networking to correct errors or otherwise modify the 
configuration.

To configure networking resources:

1. Configure the remote networked sites that the local site 
communicates with for networking purposes. 

2. Configure the network transit numbers.
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2.2.5  Configuring users and user-based 
resources

When you create a new user, you must specify at a minimum, the 
following attributes: the user's first name, last name, ID, user name, 
and either the password for OpenScape Contact Center authentication 
or the domain name for Windows authentication.

To configure users and user-based resources:

1. Configure groups for group-based routing, or skills and virtual 
groups for skills-based routing. 

2. Configure departments.

3. Configure locations. 

4. Configure users. You can configure each user manually, or you can 
create multiple users. 

• To create multiple users based on a user template, configure the 
user templates.

• To create multiple users by importing a user list, create the user 
list.

• If you created multiple users, complete the user definitions. For 
example, after creating multiple users based on a user template, 
you may need to assign users to departments and team lists.

2.2.6  Configuring wallboard and Broadcaster 
resources

To use the wallboard and Broadcaster, you must configure them to 
display messages.

To configure wallboard and Broadcaster resources:

1. Create wallboard definitions (optional).

2. Configure wallboard views.

3. Configure wallboard distributions.

4. Configure Broadcaster views.

5. Configure Broadcaster distributions. 
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2.2.7  Configuring the routing resources

For each media type that is licensed (for example, voice, e-mail), you 
must configure the routing resources. 

To configure routing resources for each media type:

1. Configure queues.

2. Configure components for each workflow type.

3. Make a copy of the sample routing strategy workflow provided and 
modify it, as required.

4. Make a copy of the sample queue processing workflow provided and 
modify it, as required. You can skip this step if you want the 
communication platform to handle all queue processing. 

5. If networking is licensed, make a copy of the sample networking 
workflow provided and modify it, as required. 

2.2.8  Completing the setup

For each media type that is licensed (for example, voice, e-mail), you 
can configure further settings for handling contacts. 

Complete the setup for each media type:

1. Configure the default routing strategy, queue, and error queue 
settings. 

2. Configure the Unavailable reasons, Work reasons, and Wrap-up 
reasons.

3. For e-mail, configure the destinations, categories, templates, 
Discard reasons, and the remaining e-mail options, such as the 
default routing schedule. You can also display confidence levels, if 
required.

4. For callbacks, configure the Delete reasons, Retry reasons, 
Excluded numbers, and the remaining callback options, such as the 
default routing schedule. 

5. For Web collaboration, configure the languages, standard 
messages, URLs, emoticons, monitored sources and destinations, 
and the remaining default options, such as the location for storing 
transcripts. 

6. For networking, configure the acceptance and distribution settings, 
data exchange interval, and default networking workflow. 
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2.2.9  Configuring report definitions

A report definition defines the properties of a report. Some properties 
are common to all report types, while others options are specific to 
certain report types. A particular report definition depends on the 
report type, the resources that need to be reported on, the required 
format of the report, the report schedule, and so on. Many options are 
available.

2.2.10  Configuring Call Director

If Call Director is licensed, you must configure a voice processor to be 
used with the system. A voice processor is used with Call Director to 
play messages and interact with the caller. 

IMPORTANT:  When using the Communication Platform OpenScape 
Business, you cannot deactivate the feature "Call Director" in the 
Features tab of the Options window. This is due to the fact that the 
"Disconnect" node requires Call Director functionality for this switch 
type.

To configure Call Director:

1. Configure the voice processors.

2. Configure the Call Director subscriber numbers or Call Director 
extensions.

NOTE:  When the system is configured for high availability (warm 
standby), redundant voice processors are required. For details, see 
Section 18.1, “Call Director configuration in a high availability (warm 
standby) environment”, on page 388. 

2.2.11  Validating the design database

You can check for and resolve any inconsistencies in the design 
database. For example, the system can find any servers or 
communication platform resources that are not configured, or users 
who are not included in a group. 
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2.3  Performing the initial Manager configuration

After the communication platform is configured and you have installed 
the OpenScape Contact Center server and client software and 
integrated the third-party components, you must configure the 
Manager application for first-time use. 

This section provides an overview of the steps required to perform the 
initial Manager configuration. For detailed instructions, see the 
Manager Help.

NOTE:  In a multitenant environment, to prevent conflicts between 
different business units, only a system administrator can activate 
product features and upload a design database. For details, see the 
Manager Help. 

To perform the initial Manager configuration:

1. Log on to the Manager application and connect to the already 
configured design database.

2. Activate the product features in the production database using the 
same license file that you used to activate features in the design 
database, and then upload the design database.

3. After restarting the OpenScape Contact Center and OpenScape 
Contact Center AutoPA services, log on to the Manager 
application and connect to the production database.

4. If you have not already done so, change the default password for 
the Master Administrator user account to align with the 
organization’s corporate security policy. 

5. Ensure that the Config Sync feature is enabled. 

6. In the Telephony Center, under Communication Platform 
Resources, ensure that the state is Active for the following 
resources. The resource types depend on the type of 
communication platform:

• OpenScape Voice – User subscriber numbers, Music On Hold 
Hunt Groups, and Initial Hunt Groups

• OpenScape 4000 or HiPath 4000 – User extensions and ACD 
groups

• OpenScape Business – User extensions and UCD groups

7. In the Administration Center, under Users, ensure that the state 
is Active for all users (except supervisors or administrators who are 
not handling contacts). 
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8. Ensure that the required .wav files are installed on the main server 
machine, and then assign the .wav files to the appropriate routing 
strategy and queue processing workflows. 

NOTE:  When the system is configured for high availability (warm 
standby), the .wav files are not replicated on the backup server 
machine. You must manually copy the .wav files to the WaveFiles 
folder on the backup server machine and ensure that the .wav files 
on the backup server machine and the primary server machine 
remain synchronized. 

9. Configure wallboards, as required. 
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3  Getting started
This chapter introduces you to the Manager application and describes 
how to log on to the application. 

3.1  About the Manager application

The Manager application provides contact center managers and 
supervisors with a unified, easy-to-use interface for performing all 
contact center management tasks. 

Manager features include:

• An intuitive user interface for system configuration and user 
administration tasks.

• A powerful design tool for creating routing strategy and queue 
processing workflows.

• Real-time statistics and performance data that can be distributed to 
user desktops or wallboards.

• Customizable real-time, cumulative, and historical reports in 
graphical and tabular format.

• Built-in analytic model for predicting trends in operating conditions.

• Configurable alerts, thresholds, and notifications.

• Automatic detection and identification of synchronization errors or 
mismatched resources.

3.2  Logging on to the Manager application

Each Manager user has a unique user name, as well as a password that 
might be required to log on to the Manager application. Your user 
definition determines what permissions you have. If you do not have 
the Manager access permission, you cannot log on to the Manager 
application. 

Your user definition also determines whether you use OpenScape 
Contact Center authentication or Windows authentication when you log 
on. If you use Windows authentication, you will not be able to log on to 
a design database, and you will not see the Logon dialog box when you 
start the Manager application. The Manager application will simply 
verify your Windows user name and then open. 
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On an OpenScape Contact Center client machine, you can run two 
instances of the Manager application at one time. For details, see 
Section 3.2.2, “Running two Manager instances on a client machine”, 
on page 26. 

NOTE:  If you are logging on to the Manager application for the first 
time, you are logging on using the Master Administrator user account. 
For details, see Section 3.2.1, “About the Master Administrator”, on 
page 21. 

To log on to the Manager application:

1. On the Start menu, point to Programs, then OpenScape Contact 
Center Enterprise, and then click Manager. The application 
displays the Logon dialog box.

2. In the Logon profile list, select the logon profile you want to use. 
For information on how to save a logon profile, see Section 3.2.3, 
“Saving a logon profile”, on page 27. 

3. To log on to the default database, proceed directly to step 3. To log 
on to a database other than the default database, click Options, 
and then do one of the following:

• To connect to the production database:

– In the Connect to list, select Production Database.

– In the Administration Server box, type the address of the 
Administration Server on the main server machine in the 
format portnumber@servername. The default is 
6000@servername. 

NOTE:  When the system is configured for high availability 
(warm standby), in most cases, you should connect using the 
server cluster name in the format portnumber@clustername so 
that you access the active server machine. In a few cases, such 
as when you are activating product features using a license file, 
you must log on using the physical machine name in the format 
portnumber@servername.

– In a multitenant environment only, in the Business unit 
box, type the name of the business unit you want to log on 
to. If you want to perform system administrator tasks, you 
must log on to the system-level business unit. In this case, 
type system. In a non-multitenant environment, this value 
is ignored. For details on multitenancy, see Chapter 19, 
“Working with the multitenancy feature”. 
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• To connect to a design database:

– In the Connect to list, select Design Database.

– In the Design database file name box, type the full path 
and file name for the database. You can click  to locate 
and select the database file. If you specify a database name 
that does not exist, the application will create a new blank 
design database. If you attempt to connect to a design 
database that uses an unsupported communication platform 
type, the application will prompt you to upgrade the 
database and select a supported type. 

– In a multitenant environment only, in the Business unit 
box, type the name of the business unit. 

4. In the User name box, type your user name.

5. In the Password box, type your password. 

6. Click OK. 

NOTE:  Occasionally, false alarm notifications may appear in the 
“Notification” window after login due to cached transitional states. 
These can be safely ignored, as the OSCC server status will be updated 
correctly in sequence.  
Only the most recent state should be taken into consideration.

3.2.1  About the Master Administrator

The Master Administrator is a default user account configured in each 
newly created OpenScape Contact Center database. The Master 
Administrator user account has access to all the functions in the 
Manager application. The default user name for the Master 
Administrator is master, and the default password is password. You 
should change the default Master Administrator password the first time 
you log on, and then change it periodically to conform to security 
policies at your site. For details, see Section 15.2.2, “Changing the 
password”, on page 265.

NOTE:  In a multitenant environment, the following restrictions apply: 
1) The Master Administrator user accounts that are created at the 
system level and the business unit level have limited access to the 
Manager functions. For details, see Section 19.3, “Administrator roles 
in a multitenant environment”, on page 394. 2) The password for the 
business unit Master Administrator is defined by the system 
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administrator when the business unit is created. For details, see 
Section 19.5.1, “Configuring a business unit”, on page 396. 3) On a 
central reporting server machine, the system administrator can only 
view business unit resources, so the system administrator cannot 
change the password for the business unit Master Administrator. 

If the Master Administrator remains logged on but inactive for a 
configured period of time, the Master Administrator is logged off 
automatically. For details on how to configure the time-out interval for 
the Master Administrator account, see Section 15.4, “Configuring the 
application options”, on page 273. 

3.2.2  Running two Manager instances on a 
client machine

On an OpenScape Contact Center client machine, you can run two 
instances of the Manager application at one time. This allows you to 
connect to two different server machines (for example, the main server 
machine and the central reporting server machine) at the same time. 

The following restrictions apply: 

• You cannot run two instances of the Manager application using the 
same user name to log on to the same Administration Server (and 
using the same business unit in a multitenant environment). 

• You cannot run two instances of the Manager application against 
the same design database. 

• When you run two instances of the Manager application at one time, 
two Manager licenses are consumed. 

• If you use Windows authentication, the first instance of the Manager 
application will verify your Windows user name and then open, but 
the second instance will display the Logon dialog box.

NOTE:  You cannot run more than one instance of the Manager 
application on an OpenScape Contact Center server machine. 

You can save a logon profile to simplify logging on to more than one 
instance of the Manager application. For details, see Section 3.2.3, 
“Saving a logon profile”, on page 27. 
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3.2.3  Saving a logon profile

To simplify logging on to more than one instance of the Manager 
application, you can save a logon profile during the logon process. 

To save a logon profile:

1. In the Logon dialog box, click Options. 

2. After you have entered the required user name, password, and 
connection settings, click Save Profile.

3. In the Save Logon Profile dialog box, type a name for the logon 
profile you want to save, and then click OK. The logon profile is 
selected when you return to the Logon dialog box and will be 
available the next time you log on.

3.3  About the user interface

The Manager application has five main work centers dedicated to 
helping you perform key contact center management tasks: 
Administration Center, Broadcast Center, Design Center, Report Center, 
and Telephony Center. 

Selected Manager work Access to other work 
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3.3.1  Administration Center

The Administration Center provides a central point of administration for 
all user-related configuration. The Administration Center is the area 
where you define and manage resources, such as users, user 
templates, profiles, data sources, directories, and notifications. 

3.3.2  Broadcast Center

The Broadcast Center provides a fully integrated and powerful 
communication tool for keeping your contact center personnel 
informed at all times. You can send real-time statistics and 
performance data for all media types to wallboards or directly to user 
desktops via the Broadcaster. 

The Broadcast Center is the area where you define and manage 
wallboard and Broadcaster views and definitions. 

3.3.3  Design Center

The Design Center provides a powerful workflow-style tool for defining 
intelligent routing strategy and queue processing workflows to handle 
all multimedia contact center interactions. 

To streamline the creation of workflows, OpenScape Contact Center 
provides a library of configurable and reusable routing strategy and 
queue processing components. A drag-and-drop interface allows you to 
configure workflows that are automatically validated for completeness 
as they are created. 

The Design Center is the area where you define and manage the 
queues and workflows that determine how incoming contacts are 
routed. 

3.3.4  Report Center

The Report Center provides a powerful, yet easily customized reporting 
engine for defining and viewing real-time, cumulative, and historical 
reports for all media types. Versatile reporting allows for better 
operational monitoring, more effective decision making, and the ability 
to proactively recognize and respond to patterns before they become 
issues.

The Report Center is the area where you define and manage the 
reports that provide insight into your contact center operations. 
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3.3.5  Telephony Center

The Telephony Center simplifies the synchronization between 
OpenScape Contact Center and the communication platform. The 
Telephony Center is the area where you configure the OpenScape 
Contact Center communication platform resources and other external 
components that OpenScape Contact Center monitors to route 
contacts and collect statistics for reporting. 
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4  Working with users, templates and profiles
This chapter describes how to configure user definitions, as well as how 
to work with user templates and profiles. 

4.1  Configuring a user

To use the Manager application, a user definition must be configured in 
the Manager application. Factors such as hiring, attrition, and contact 
center expansion require that user definitions be created, deleted, and 
modified on a regular basis. Administrators are normally responsible 
for configuring all users in the contact center. Administrators cannot 
modify their own user definitions. 

NOTE:  To create or change a user, you must have Full or Modify 
access, respectively, for the Users Manager permission. If the 
enhanced security option is enabled, you must also have the required 
security access to change the user. For details on the enhanced security 
option, see Section 15.3.4, “Configuring the enhanced security option”, 
on page 271. 

NOTE:  In a multitenant environment, this procedure describes how to 
configure users at the business unit level. To configure users at the 
system level, see Section 19.5.2, “Configuring a user at the system 
level”, on page 398. 
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For users who have voice capabilities/access, you must ensure that 
there is a matching user definition on the communication platform. You 
can use the Config Sync feature to assist with the management of 
users. For details, see Section 11.4.1, “Config Sync treatment of user 
IDs”, on page 214.

NOTE:  When you are on a central reporting server machine (see 
Chapter 17, “Working with central reporting”), you can configure only 
users who can administer the central reporting server machine and 
perform reporting operations on the replicated data. These users 
cannot be reported on (that is, they will not appear in the list of users 
that are presented when configuring a report). 

NOTE:  If you are integrating with Microsoft CRM, there are some 
special user requirements. For details, see Chapter 16, “Microsoft CRM 
integration”. 

Overview

The following is an overview of the steps required to configure all the 
attributes in a user definition:

1. Configure the general user properties – see Section 4.1.1, 
“Configuring the general user properties”, on page 26.

2. Configure the user permissions – see Section 4.1.2, “Configuring 
the user permissions”, on page 29. 

3. Configure the contact handling settings for the user – see Section 
4.1.3, “Configuring the contact handling settings for a user”, on 
page 31. 

4. Configure the media-specific settings for the user – see Section 
4.1.4, “Configuring the media-specific settings for a user”, on page 
31. 

5. Configure the thresholds for the user – see Section 4.1.5, 
“Configuring the thresholds for a user”, on page 32. 

6. Configure the resources that the user can monitor – see Section 
4.1.6, “Configuring the resources a user can monitor”, on page 34.

7. Configure the Team List for the user – see Section 4.1.7, 
“Configuring the reports for a user”, on page 35. 

8. Configure the reports that display data about the user – see Section 
4.1.7, “Configuring the reports for a user”, on page 35. 
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9. Configure the users who can modify this user, and the resources 
that the user can modify – see Section 4.1.8, “Configuring the 
security settings for a user”, on page 37. 

NOTE:  You can also create new users based on a user template (see 
Section 4.2, “About user templates”). 

4.1.1  Configuring the general user 
properties

You can configure the general user properties, such as the user's name, 
system identification settings, department, and so on. 

When creating a new user, as a minimum, you must specify the user's 
first name, last name, ID, user name, and either the password for 
OpenScape Contact Center authentication or the domain name for 
Windows authentication. 

To configure the general user properties:

1. On the File menu, point to New, then Administration Center, 
then User, and then click User.
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2. On the General tab, under User, do the following:

• In the First name box, type the user's first name. 

• In the Last name box, type the user's last name. 

3. Under System Identification, do the following:

• In the ID box, type a unique, numerical ID used to identify the 
user on the communication platform. If you are using the Config 
Sync feature and the ID you provide is not within a monitored 
domain range, you will be prompted to create a new Config Sync 
domain range. For more information, see Section 11.4, “About 
Config Sync”, on page 213.

• In the User name box, type a unique user name. This name is 
used when logging on to the Manager application and for 
recording statistics. If you want to use the Windows 
authentication method, the user name must match the name 
used for logging on to the Windows domain. 

• In the Authentication list, select one of the following: 

– To have the system validate the user, select Use 
OpenScape Contact Center, type the password in the 
Password box, and then type it again in the Verify 
password box to ensure that you typed it correctly.

NOTE:  If you are configuring an SAP CIC user (see step 6), you 
must use OpenScape Contact Center authentication and the 
password must match the password specified in the SAP system.

– To have Windows validate the user, select Use Windows, 
and then type the NetBIOS name for the Windows domain in 
the Domain box. Ensure that the user name matches the 
name used for logging on to the Windows domain. When you 
select this option, this user will not be able to log on to a 
design database, and will not see the Logon window when 
starting the Manager application. 

4. To set the user attributes based on a user template (see Section 
4.2, “About user templates”, on page 38), under Templates, click 
Change and select the user template you want to apply to the user 
from the list. If you later change an attribute in the user record or 
user template, an indicator shows that the template association is 
not current. For details, see Section 4.2.1, “User template 
associations”, on page 39. 

5. Under Broadcaster, in the Distribution list, select the name of the 
Broadcaster distribution that you want the user to be assigned to.  
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6. Under Application, specify the user's access to the three 
OpenScape Contact Center applications. For each application, click 
the item in the Permissions column and select the access from the 
list. For the Manager and System Monitor applications, the access 
is simply Yes or No. The License Used column shows the type of 
license used based on your selection. You can check the product 
features to see how many licenses are available for the contact 
center. 

7. Under Automatic Post-processing, do the following:

• To have the system automatically place the user in Post-
processing handling state after the user disconnects from a 
contact, select the Enable check box. If you configure this 
option, do not configure the Autowork feature for this user on 
the communication platform.

• If you specify a time in the Maximum time box, the user will 
remain in Post-processing handling state for the duration of time 
specified. 

• To have the user remain in Post-processing handling state until 
a Wrap-up reason has been saved for the contact, select the 
Wrap-up reason required check box. If a Maximum time has 
also been specified, the user will remain in Post-processing 
handling state for the time specified after the user saves a 
Wrap-up reason. 

8. Under Settings, do the following:

• In the Real-Time Server list, select the Real-Time Server to 
which the user can connect. Your contact center may have only 
one main Real-Time Server (in which case there will be only one 
item in the list) or a number of auxiliary Real-Time Servers (see 
Section 5.3.4, “Configuring a Real-Time Server on an auxiliary 
server machine”, on page 74). 

• To include statistics for this user in department-based reports, 
in the Department list, select a department for the user. 

• To enable user reports to be based on the time zone of the user’s 
location, in the Location list, select the location of the user. 

9. If you are finished working with this user definition, click OK.
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4.1.2  Configuring the user permissions

Permissions control the user’s access to the Manager application 
features and the resources that the user can work with. Although you 
can assign each permission individually, you normally specify one or 
more user profiles to save time. For details, see Section 4.3, “About 
user profiles”, on page 46. You can use the default permissions as 
defined in the selected profile or you can modify the permissions, as 
required. 

IMPORTANT:  Use care when assigning permissions. The ability for a 
user to create other users and change their permissions should be 
strictly controlled. 

NOTE:  For some permissions, you must configure other settings in the 
Manager application. For example, if you want a user to have access to 
an external directory in the Mobile Supervisor application, you enable 
the Directory Supervisor permission, and then configure the contact 
lookup settings in the Options dialog box. 
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To configure the user permissions:

1. In the Administration Center, under General, click Users, and 
then, in the right pane, double-click the user you want to configure. 

2. Click the Permissions tab. 

3. In the Profiles table, select the check box for each profile that you 
want to assign to the user. If two or more profiles are selected, the 
user's actual access level is changed to the highest access level of 
the selected profiles.

4. Optionally, in the Permissions table, modify the default 
permissions. For each function you want to change, click the item 
in the Actual column and select the access level from the list. For 
a description of the access levels, see Section 4.3.3, “Access 
levels”, on page 50. 

NOTE:  You can click Reset to reset the effective permissions to 
the default access levels.

5. To show only the permissions in the list for which the default access 
level has been modified, select the Show overrides only check 
box. 

6. If you are finished working with this user definition, click OK.
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4.1.3  Configuring the contact handling 
settings for a user

When the system is configured for group-based routing, you must 
select the groups that a user belongs to. The groups that you select 
determine the types of contacts that the user is eligible to receive. For 
more information, see Section 8.1, “About group-based routing”, on 
page 139.

When the system is configured for skills-based routing, you must select 
the skills that a user possesses. The skills that you select for the user 
determine the types of contacts that the user is eligible to receive. For 
more information on skills-based routing, see Section 8.2, “About 
skills-based routing”, on page 162. 

When the system is configured for multiple contact handling, you must 
select the contact handling rules for the user. The rules that you select 
determine the number and types of contacts that the user can handle 
at one time. For more information on multiple contact handling, see 
Section 8.3, “About multiple contact handling”, on page 167. 

NOTE:  The Contact Handling tab in the User dialog box becomes 
active only when you select the Receive contacts routed by 
OpenScape Contact Center User permission. 

To configure the contact handling settings for a user:

1. In the Administration Center, under General, click Users, and 
then, in the right pane, double-click the user that you want to 
configure. 

2. Click the Contact Handling tab. 

3. If the system is configured for group-based routing, under Include, 
select the check box for each group to which you want to assign this 
user. You can select up to 10 groups. 

4. If the system is configured for skills-based routing, under Include 
Skills, select the check box for each skill that you want to assign to 
this user. You must configure the skills before they can be selected 
on this tab. For details, see Section 8.2.2, “Configuring a skill”, on 
page 163.
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5. If skill levels are displayed, the value from the Prefill level box is 
entered automatically in the Level column. If you want to change 
this value, click the cell in the table and select a new value from the 
list.

NOTE:  To specify the skill level that will be entered automatically 
into the Level column when you select a skill in the list, type or 
select a value in the Prefill level box. For more information, see 
Section 8.4.7, “Displaying skill levels”, on page 180.

6. If skill preferences are displayed, the value from the Prefill 
preference box is entered automatically in the Preference 
column. If you want to change this value, click the cell in the table 
and select a new value from the list.

NOTE:  To specify the skill preference that will be entered 
automatically into the Preference column when you select a skill 
in the list, type or select a value in the Prefill preference box. For 
more information, see Section 8.4.8, “Displaying skill preferences”, 
on page 181

7. To see the virtual groups that the user is eligible to be included in 
based on the selected skills, click Show Eligible Virtual Groups. 

8. If the system is configured for multiple contact handling, under 
Include Rules, select the check box for each contact handling rule 
that you want to apply to this user. You must configure the rules 
before they can be selected on this tab. For details, see Section 
8.3.1, “Configuring a contact handling rule”, on page 169. 

9. If you are finished working with this user definition, click OK.
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4.1.4  Configuring the media-specific settings 
for a user

For each user, you can configure the following settings that are specific 
to the media type: 

• Voice – The backup group to be used if the OpenScape Contact 
Center system goes down.Also, if SAP ICI applications have been 
licensed, the SAP ICI integration settings.

NOTE:  When the system is connected to an OpenScape Voice 
communication platform, a backup group is not required. In this 
case, if only the voice media has been licensed, the Media tab will 
be disabled. 

NOTE:  Multiple contact handling is not supported for SAP ICI 
users. If you configure the SAP ICI integration settings, only the 
system-defined single contact handling rules are available on the 
Contact Handling tab. If you have already selected a user-defined 
contact handling rule, the SAP ICI integration settings will be 
unavailable. For more information, see Section 8.3, “About multiple 
contact handling”, on page 167. 

• E-mail – The queue to which the user’s e-mail messages are sent 
if you want to monitor the user silently. 

• Web collaboration – The greeting and user message prefix that 
override the default settings configured for each Web collaboration 
language, if required. For details on the default Web collaboration 
settings, see Section 15.5.1, “Configuring a Web collaboration 
language”, on page 344. 

To configure the media-specific settings for a user:

1. In the Administration Center, under General, click Users, and 
then, in the right pane, double-click the user you want to configure. 

2. Click the Media tab.

3. Under Voice Settings, select the backup group to be used if the 
OpenScape Contact Center system goes down and the 
communication platform is used to route calls. The backup routing 
configuration depends on the type of communication platform:

• OpenScape 4000 or HiPath 4000 – In the Backup ACD group 
list, select the backup ACD group for the user. 
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• OpenScape Business – In the Backup UCD group list, select 
the backup UCD group for the user. 

4. To enable SAP ICI integration for the user (available only if 
licensed), select the Enable SAP ICI integration check box, and 
then do the following:

• In the SAP ID box, type the user ID required for the SAP ICI 
application. 

• In the Extension box, type the user extension required for the 
SAP ICI application. 

5. If this user has e-mail permission, under E-mail Settings, in the 
Silent monitoring queue list, select the e-mail queue to which the 
user’s e-mail messages are requeued after the user sends them. 
This features allows the e-mail messages to be reviewed by a 
manager or supervisor before they are sent to a customer. This 
feature is optional.

6. If this user has Web collaboration permission, under Web 
Collaboration Settings, you can override the default greeting and 
user message prefix for each configured language, if required:

• To override the Web collaboration settings for a language, click 
Add, and then configure the new Web collaboration settings 
(see Section 4.1.5, “Configuring the Web collaboration settings 
for a user”, on page 41). 

• To update an existing Web collaboration override, select a line 
in the list, click Edit, and then edit the Web collaboration 
settings (see Section 4.1.5, “Configuring the Web collaboration 
settings for a user”, on page 41). 

• To delete an existing Web collaboration override, select a line in 
the list, and then click Delete. 

7. If you are finished working with this user definition, click OK.

4.1.5  Configuring the Web collaboration 
settings for a user 

When you are configuring the media-specific settings for a user (see 
Section 4.1.4, “Configuring the media-specific settings for a user”, on 
page 40), you can override the default greeting and user message 
prefix that are configured for a Web collaboration language, if required. 
You can configure only one override for each Web collaboration 
language. 
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To configure the Web collaboration settings for a user:

1. In the Web Collaboration Settings dialog box, in the Languages 
list, select the language for which you want to override the default 
settings. You must have already created the language you want to 
select. 

2. In the Greeting box, type the greeting that you want to use instead 
of the selected language’s default greeting. 

3. In the User message prefix box, type the user message prefix 
that you want to use instead of the language’s default user message 
prefix. 

4. To insert a tag into either of the boxes, click Insert Tag and select 
one of the following tags from the list:

NOTE:  To ensure that the date format displayed in the Web 
Collaboration - Contact Details window matches the date format 
selected in the Windows Regional and Language options, you must 
select the language to be used for standards and formats, as well 
as for non-Unicode programs. If different languages are selected in 
these two places, the date format might not be displayed as 
expected.

5. To change the font style of the selected text, click .

6. Under Preview, view a preview of the selected text, including the 
actual value of any inserted tags.

7. Click OK. 

4.1.6  Configuring the thresholds for a user

The system can display statistics in the users application based on 
whether a user has exceeded certain personal performance thresholds. 
These statistics can help to show how well the user is handling 

<USERNAME> Displays the name of the contact center user, as defined 
in the Manager application.

<TIME12> Displays the time in 12-hour format, with an AM or PM 
suffix.

<TIME24> Displays the time in 24-hour format.
<DATE> Displays the date in YYYY/MM/DD format.
<NAME> Displays the customer's name. 
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contacts. You can set thresholds for values such as the maximum post-
processing time, maximum handling time (for each media type), and 
utilization.

NOTE:  The Thresholds tab in the User dialog box becomes active only 
when you select the Receive contacts routed by OpenScape 
Contact Center and Personal performance permissions. You must 
enable the Receive contacts routed by OpenScape Contact 
Center permission before you can select the Personal performance 
permission. 

To configure the thresholds for a user:

1. In the Administration Center, under General, click Users, and 
then, in the right pane, double-click the user you want to configure. 

2. Click the Thresholds tab.

3. Under Values, do the following:

• In the Maximum post-processing time box, type the 
maximum amount of time that the user should spend in Post-
processing handling state while completing a contact. 

• In the Average post-processing time box, type the average 
amount of time that the user should spend in Post-processing 
handling state while completing a contact. 
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• In the Utilization box, type the percentage of time the user 
should spend handling a contact. The Utilization calculation is 
based on the total time that the user is logged on to the 
communication platform. You can change the Utilization 
calculation to include Available time in addition to Work time. 
For details, see Section 15.7.3, “Configuring the user 
calculation”, on page 288. 

4. In the grid, specify the following thresholds for each media type:

• In the Maximum handling time box, type or select the 
maximum amount of time that the user should spend handling 
a routed contact.

• In the Average handling time box, type or select the average 
amount of time that the user should spend handling a routed 
contact.

• In the Maximum active time box (available only when the 
system is configured for multiple contact handling), type or 
select the maximum amount of time that a routed contact 
should be active for the user. 

• In the Average active time box (available only when the 
system is configured for multiple contact handling), type or 
select the average amount of time that a routed contact should 
be active for the user. 

• In the Maximum non-primary time box (available only when 
the system is configured for multiple contact handling), type or 
select the maximum amount of time that a routed contact 
should be active but not primary. 

• In the Average non-primary time box (available only when 
the system is configured for multiple contact handling), type or 
select the average amount of time that a routed contact should 
be active but not primary. 

• In the Maximum handling time excluding post-processing 
box, type or select the maximum amount of time that the user 
should spend handling a routed contact, not including the time 
spent post-processing the contact.

• In the Average handling time excluding post-processing 
box, type or select the average amount of time that the user 
should spend handling a routed contact, not including the time 
spent post-processing the contact.

5. If this user has e-mail permission, under E-mail, do the following:

• In the Maximum defer count box, type the maximum number 
of e-mail messages that the user should defer. 
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• In the Maximum external consult count box, type the 
maximum number of e-mail messages that the user should 
forward to external users for consultation. 

6. If you are finished working with this user definition, click OK. 

4.1.7  Configuring the resources a user can 
monitor

You can configure a user to monitor other resources in the OpenScape 
Contact Center database, such as users, groups, queues and 
aggregates. Monitoring permission is usually given only to supervisors, 
managers, and administrators.

When a user has monitoring permission for a resource, the user can:

• View statistics for the resource.

• Create a Broadcaster or wallboard view item about the resource in 
the Broadcast Center.

• Report on the resource in the Report Center.

When the monitored resource is a user, a user can: 

• Edit and run reports owned by the monitored user. 

• Assign the monitored user as the owner of reports. 

• Add the monitored user to a Team List. 

• View and edit Broadcaster and wallboard views owned by the 
monitored user.

NOTE:  You cannot change your own monitored resources. 

To configure the resources a user can monitor:

1. In the Administration Center, under General, click Users, and 
then, in the right pane, double-click the user you want to configure. 

2. Click the Monitor tab.

3. Under Include, in the Show list, select the type of resource to be 
monitored. 

4. Select the resources you want the user to monitor in one of the 
following ways:
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• To have the user monitor all resources in the list, select the 
Monitor All check box. 

NOTE:  You can select the Monitor All check box only if your own 
user definition has the Monitor All capability. 

• To have the user monitor only some of the resources in the list, 
select the check box for each item you want the user to monitor. 

5. Repeat steps 3 and 4 for each type of resource to be monitored. 

6. If you are finished working with this user definition, click OK.

4.1.8  Configuring the reports for a user

You can configure the reports that display data about a user. 

NOTE:  The Reports tab in the User dialog box becomes active only 
when you select the Receive contacts routed by OpenScape 
Contact Center User permission. 

To configure the reports for a user:

1. In the Administration Center, under General, click Users, and 
then, in the right pane, double-click the user you want to configure. 

2. Click the Reports tab. 
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3. Under Reports, in the Select by box, do one of the following:

• Select User, and then select the check box for each report that 
you want to display data about this user. The list contains only 
the reports you own, or reports that are owned by users you can 
monitor.

• Select Department, and then view the reports that display data 
about this user's department.

• Select Group (or Virtual Group), and then view the reports 
that display data about this user's group (or virtual group).

NOTE:  When Department or Group (or Virtual Group) is 
selected in the Select by box, you can only view the reports that 
display information about this user's department or group (or 
virtual group). You cannot add individual users to or remove 
individual users from these reports. Also, the list of reports shown 
on the Reports tab is not dynamically updated if the user's 
department or group (or virtual group) is changed while the User 
dialog box is open.

NOTE:  When you are editing a user definition that is associated 
with a user template, the reports in the list that are associated with 
the user template are read-only. If you want to remove one of those 
reports from the user definition, you must either break the user's 
association with the user template, or remove the report from the 
user template and update all users (in which case, all users 
associated with the user template will be removed from the report).

4. If you are finished working with this user definition, click OK.

4.1.9  Configuring the security settings for a 
user

The enhanced security feature provides an additional level of security 
for the contact center. If the enhanced security option is enabled, you 
can:

• Configure the users who can modify this user.

• Configure the resources in the OpenScape Contact Center database 
that the user can modify. 

Modify permission is usually given only to administrators. 
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For details on the enhanced security option, see Section 15.3.4, 
“Configuring the enhanced security option”, on page 271. 

To configure the security settings for a user:

1. In the Administration Center, under General, click Users, and 
then, in the right pane, double-click the user you want to configure. 

2. Click the Security tab.

3. To configure the users who can modify this user, do the following:

a) Under Configure, select Users who can modify this user. 
This option is disabled if the user you are configuring does not 
have access to the Manager application. 

b) Under Users, select the check box for each user who you want 
to be able to modify this user. The list contains only the users 
who have Full or Modify access for the Users Manager 
permission. 

4. To configure the resources that the user can modify, do the 
following:

a) Under Configure, select Resources this user can modify. 
This option is disabled if the user does not have Full or Modify 
access permission for any of the eligible resources. 

b) Under Include, in the Show list, select the type of resource 
that you want to configure. The list contains only the resource 
types for which both you and the user have Full or Modify access 
permission. 

c) In the resulting list, select the check box for each resource that 
you want this user to be able to modify. 

5. If you are finished working with this user definition, click OK.
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4.2  About user templates

User templates are very useful for the initial configuration of a large 
number of users. Instead of setting the attributes individually for each 
new user, you can assign most of the attributes to many users at one 
time. 

When you configure a user template (see Section 4.2.2, “Configuring a 
user template”, on page 39), you specify all the user attributes except 
the following attributes which must be set individually for each new 
user: 

• First name

• Last name

• ID

• User name

• Password (only if using OpenScape Contact Center authentication)

• SAP ID and SAP extension (only if SAP ICI applications have been 
licensed) 

You can then use a template to create a single user or multiple users. 
For details, see the following topics:

• Section 4.2.3, “Creating a user based on a user template”, on page 
42

• Section 4.2.4, “Creating multiple users based on a user template”, 
on page 43

You specify the default user template in the Options dialog box. For 
details, see Section 15.1, “Configuring the personal options”, on page 
261.

NOTE:  If you intend to maintain the configuration of users within your 
contact center through the use of user templates, we recommend that 
you use only the templates to change the user properties, rather than 
changing the properties within other resources that have an association 
with the user. For example, if you want to change the users that are 
assigned to a particular department, you should change the 
department within the user template, rather than changing the users 
selected on the Users tab within the department, or changing the 
department selected within each user record. This will ensure that the 
association with the user template is maintained. For more 
information, see Section 4.2.1, “User template associations”, on page 
39. 
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4.2.1  User template associations

Each user template contains a list of users that are associated with that 
user template. The association between a user and a user template 
remains until an attribute (other than a user-specific attribute) is 
changed in the user record or user template record, at which time the 
association is broken. The association between a user and a user 
template is also broken if the user or user template is deleted. 

If you break a user template association, the user record shows the last 
template applied to the user, with a clear indication that the association 
is historical rather than active. 

When you update a user template, you can choose to update the user 
template only or to update all users associated with the user template. 
For details, see Section 4.2.2.3, “Updating a user template”, on page 
41. 

If a user report is part of a user template and you use the User Report 
dialog box to perform any of the following tasks, it will not change the 
user's template association: 

• Add the user to a new report.

• Add the user to an existing report.

• Remove the user from an existing report. 

In each of these scenarios, the user's template association will be 
maintained and neither the template nor any other users associated 
with the template will be affected.

NOTE:  If a user report is part of a user template and you change the 
Report by and Select by options in the report to anything other than 
User, the report is removed from the user template and the user 
definitions that are associated with that template, but the user 
template associations are maintained. 

4.2.2  Configuring a user template

You can configure user templates in several ways. For details, see the 
following topics:

• Section 4.2.2.1, “Creating a user template”

• Section 4.2.2.2, “Creating a user template based on an existing 
user”
 A31003-S22B1-M103-08-76A9, 04/2025
44 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



users_profiles.fm

Working with users, templates and profiles
About user templates
• Section 4.2.2.3, “Updating a user template”

NOTE:  To create or change a user template, you must have Full or 
Modify access, respectively, for the User templates Manager 
permission. If the enhanced security option is enabled, you must also 
have the required security access to change the user template. For 
details on the enhanced security option, see Section 15.3.4, 
“Configuring the enhanced security option”, on page 271. 

4.2.2.1  Creating a user template

You can create a new user template as described in this topic. 

To create a user template:

1. On the File menu, point to New, then Administration Center, and 
then click User Template. 

2. On the General tab, under User Template, do the following:

• In the Name box, type a unique name for the user template. 

• In the Description box, type a description for the user 
template.

3. Under Template, click Edit.

4. Modify the settings (other than the user-specific attributes) in the 
same way that you configure the settings for a user. When you are 
finished, click OK to return to the user template dialog box. 

5. Click the Users tab. 

6. Under Users, select the check box for each user who you want to 
associate with this template. To select multiple users, hold down 
CTRL or SHIFT and click to select the users, and then press the 
SPACE bar. When you press the SPACE bar, all cleared check boxes 
will be selected and all selected check boxes will be cleared. 

7. Click the Security tab. This tab is available only if the enhanced 
security option is enabled. For details, see Section 15.3.4, 
“Configuring the enhanced security option”, on page 271. 

8. Under Users, select the check box for each user who you want to 
be able to modify this user template. The list contains only the users 
who have Full or Modify access to the User templates Manager 
permission. 

9. Click OK. 
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4.2.2.2  Creating a user template based on an 
existing user

You can create a user template based on an existing user definition. 

To create a user template based on an existing user:

1. In the Administration Center, under General, click Users.

2. In the right pane, select the user on which you want to base the new 
user template.

3. On the Actions menu, select Create Template from User.

4. On the General tab, under User Template, do the following:

• In the Name box, type a unique name for the user template. 

• In the Description box, type a description for the user 
template.

5. Under Template, click Edit.

6. Modify the settings (other than the user-specific attributes) in the 
same way that you configure the settings for a user. For details, see 
Section 4.1, “Configuring a user”, on page 25. 

4.2.2.3  Updating a user template

When you update a user template, you can choose to update the user 
template only or to update all users associated with the user template. 

To update a user template: 

1. In the Administration Center, under General, click User 
Templates.

2. In the right pane, double-click the user template that you want to 
change.

3. Under Template, click Edit.

4. Modify the settings (other than the user-specific attributes) in the 
same way that you configure the settings for a user. See Section 
4.1, “Configuring a user”, on page 25. 

5. Click the Users tab. 

6. Under Users, select the check box for each user who you want to 
associate with this template. To select multiple users, hold down 
CTRL or SHIFT and click to select the users, and then press the 
SPACE bar. When you press the SPACE bar, all cleared check boxes 
will be selected and all selected check boxes will be cleared.
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7. Click OK.

8. In the User Template Updates dialog box, do one of the 
following:

• To update the user template with your changes, select Update 
template only. If you choose this option, the association 
between the template and any users created based on the 
template will be broken and will be indicated as historical rather 
than active in the User dialog box. 

• To update all currently associated users with your changes, 
select Update all users. In this case, the association between 
the template and all users created based on the template will be 
maintained. 

9. Click OK. 

4.2.3  Creating a user based on a user 
template

Instead of setting the attributes individually for each new user, you can 
create a new user based on the default user template. For more 
information, see Section 4.2, “About user templates”, on page 38. You 
specify the default user template in the Options dialog box (see Section 
15.1, “Configuring the personal options”, on page 261). 

Only the following user-specific attributes must be set individually for 
each new user: the first name, last name, ID, user name, password, 
and, if SAP ICI applications have been licensed, SAP ID and SAP 
extension.

To create a user based on a user template:

1. On the File menu, point to New, then Administration Center, and 
then click User, and then click User from Default Template. A 
User dialog box that contains the attributes of the selected user 
template is displayed. 

2. On the General tab, under User, do the following:

• In the First name box, type the user's first name.

• In the Last name box, type the user's last name.
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3. Under System Identification, do the following:

• In the ID box, type a unique, numerical ID used to identify the 
user on the communication platform. 

• In the User name box, type a unique user name. This name is 
used when logging on to the Manager application and for 
recording statistics.

• In the Authentication list, do the following:

– To have the system validate the user, click Use OpenScape 
Contact Center, type the password in the Password box, 
and then type it again in the Verify password box to ensure 
that you typed it correctly. 

NOTE:  If you are configuring an SAP CIC user, you must use 
OpenScape Contact Center authentication and the password 
must match the password specified in the SAP system. 

– To have Windows validate the user, click Use Windows, and 
then type the NetBIOS name of the Windows domain in the 
Domain box. Ensure that the user name is the same in both 
Windows and OpenScape Contact Center. When you select 
this option, this user will not see the Logon window when 
starting the Manager application.

4. If SAP ICI applications have been licensed, click the Media tab and 
do the following:

• Select the Enable SAP ICI integration check box. 

• In the SAP ID box, type the user ID required for SAP ICI 
applications. 

• In the Extension box, type the user extension required for SAP 
ICI applications.

5. Click OK. 
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4.2.4  Creating multiple users based on a user 
template

When you are connected to a design database, you can create multiple 
users based on a user template simultaneously. For more information, 
see Section 4.2, “About user templates”, on page 38. 

NOTE:  You cannot create multiple users when you are connected to a 
production database. 

For each user you create, you must provide the user-specific attributes 
(that is, first name, last name, ID, user name, password, and, if SAP 
ICI applications have been licensed, SAP ID and SAP extension). The 
remaining attributes are set based on a specified user template. 

You also have the option of creating multiple users by importing a text 
file that lists the user-specific attributes. For details, see Section 4.2.5, 
“Creating multiple users by importing a text file”, on page 44. 

To create multiple users:

1. On the File menu, point to New, then Administration Center, 
then User, and then click Add Multiple Users.

2. In the Add Multiple Users window, complete the following 
attributes for each user you want to create:

• First Name – Type the user's first name. 

• Last Name – Type the user's last name. 

• ID – Type a unique, numerical ID used to identify the user on 
the communication platform.

• User Name – Type a unique user name. This name is used 
when logging on to the Manager application and for recording 
statistics.

• Password – Type the password required for OpenScape 
Contact Center authentication. If the user template specifies to 
use Windows authentication, this box can be left blank. If this 
box is left blank and the user template specifies to use 
OpenScape Contact Center authentication, the user will not be 
created.

• Confirm Password – Type the password again to confirm that 
you typed it correctly. 
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• SAP ID – Type the user ID required for SAP ICI applications. 
This ID is required only if SAP ICI applications have been 
licensed. If there is no SAP ICI license, this box must remain 
blank.

• SAP Extension – Type the user extension required for SAP ICI 
applications. This extension is required only if SAP ICI 
applications have been licensed. If there is no SAP ICI license, 
this box must remain blank. 

• User Template – Click the cell in the table and select the name 
of the user template from the list. If you leave this box blank, 
the default user template will be used; however, if a default user 
template has not been specified in the Options dialog box (see 
Section 15.1, “Configuring the personal options”, on page 261), 
the user will not be created. 

3. Click Create Users. The application creates the users based on the 
information you provided. The User list indicates the status of the 
user creation process:

•  – Indicates that the user was created successfully.

•  – Indicates that the user was not created.

4.2.5  Creating multiple users by importing a 
text file

When you are connected to a design database, you can create multiple 
users by importing a text file that lists the user-specific attributes. For 
specifications of the text file, see Section 4.2.5.1, “User list 
requirements”, on page 45. 

NOTE:  You cannot create multiple users when you are connected to a 
production database. 

To create multiple users by importing a text file:

1. On the Tools menu, click Import Users. 

2. In the Open File dialog box, select the text file that contains the 
list of users you want to import, and then click Open. 

3. In the Add Multiple Users window, verify that the attributes in the 
list were imported correctly. 

4. Optionally, in the User Template column, click the cell and select 
the required user template from the list. 
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5. Click Create Users. The application creates the users based on the 
template specified in the text file or, if a template is not specified, 
based on the default user template. The User list indicates the 
status of the user creation process:

•  – Indicates that the user was created successfully.

•  – Indicates that the user was not created.

4.2.5.1  User list requirements

The user list is a text file that contains a list of users that you want to 
create. The text file must meet the following requirements:

• It must contain one user record per line.

• Each line must contain six fields separated by a | character (five | 
characters), unless SAP ICI applications are licensed, in which case, 
each line must contain eight fields separated by a | character 
(seven | characters). 

• For example, if SAP ICI applications are not licensed and you 
specify a user template, the line would contain:

First Name|Last Name|ID|User Name|Password|User Template

• If SAP ICI applications are licensed and you do not specify a user 
template, each line would contain:

First Name|Last Name|ID|User Name|Password|SAP ID|SAP 
Extension|

where the last | character is required to indicate that a user 
template is not specified. 

• The text is case-sensitive and will appear exactly as you type it. 

• Comment lines that begin with // will be ignored.

The following table summarizes the fields for each record. 

Field name Mandator
y

Field description

First name Y User's first name. Maximum 30 characters.

Last name Y User's last name. Maximum 35 characters

ID Y Numerical ID used to identify the user on the 
communication platform. For the OpenScape 
Business, maximum three digits. For the other 
communication platforms, maximum six digits.

Table 1 Fields required for each user record
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4.3  About user profiles

A user profile is a set of default access permissions that can be used 
when configuring a particular type of user. For example, a user based 
on an Administrator profile can be given access to all Manager features 
and controls, but a user based on a Supervisor profile may be allowed 
to configure only users. You can create a user profile or use one of the 
default user profiles provided with the application. 

4.3.1  Default user profiles

The Manager application is packaged with a set of default user profiles, 
which provide a wide range of roles and responsibilities. You can use 
these profiles as provided, or modify them to account for more specific 
permission requirements at your site. 

User name Y Name used when logging on to the Manager 
application and for recording statistics. 
Maximum 35 characters.

Password N If the user template specifies Windows 
authentication, this field can be left blank. If the 
template specifies OpenScape Contact Center 
authentication and this field is left blank, the 
user will not be created. Maximum 16 
characters.

SAP ID N Required only if SAP ICI applications are 
licensed.

SAP extension N Required only if SAP ICI applications are 
licensed.

User template N If this field is left blank, the default user 
template will be used; however, if a default user 
template has not been specified in the Manager 
application, the user will not be created. 
Maximum 32 characters.

Field name Mandator
y

Field description

Table 1 Fields required for each user record
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4.3.1.1  Manager user profiles

The system provides the following default user profiles for the Manager 
application:

• Administrator – The Administrator profile is intended for users 
who have limited administrative responsibilities. This profile 
provides access to all configuration items except those directly 
involved with contact routing and interaction with external 
resources, such as the communication platform. (Access to these 
items is provided in the Master Administrator profile.)

NOTE:  In a multitenant environment, access for the Administrator 
profile within a business unit is further restricted to the items that 
can be configured only at the business unit level. For details, see 
Chapter 19, “Working with the multitenancy feature”. 

• Manager – The Manager profile is intended for users who are 
responsible for the overall contact center business targets, and are 
accountable for hiring and contact center performance. This profile 
provides access to reports that help the manager assess and 
measure performance.

• Master Administrator – The Master Administrator profile is 
intended for users who are responsible for configuring all the 
resources in OpenScape Contact Center. This profile provides full 
access to the system, including the ability to change all contact 
center settings.

NOTE:  In a multitenant environment, the Master Administrator 
profile at the system level has restricted access to system-level 
tasks, such as uploading a design database and configuring 
communication platform resources. Similarly, the Master 
Administrator profile within a business unit has restricted access to 
tasks such as configuring the business unit resources. For details, 
see Chapter 19, “Working with the multitenancy feature”. 

• Supervisor – The Supervisor profile is intended for users who are 
responsible for the day-to-day supervision of contact center staff. 
Responsibilities include monitoring performance and ensuring 
customer satisfaction. This profile provides access to real-time 
communications and reporting.

• Telecommunications Specialist – The Telecommunications 
Specialist profile is intended for users, such as IT experts and 
administrators, who are responsible for providing support for the 
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contact center and configuring the computer and voice aspects of 
OpenScape Contact Center. This profile provides access to system 
and voice settings. 

NOTE:  In a multitenant environment, access for the 
Telecommunications Specialist profile within a business unit is 
further restricted to the items that can be configured only at the 
business unit level. For details, see Chapter 19, “Working with the 
multitenancy feature”. 

4.3.2  Configuring a user profile

You can create a new user profile or modify the existing profiles. For 
more information, see Section 4.3, “About user profiles”, on page 46. 

IMPORTANT:  Use care when assigning permissions. The ability for a 
user to create other users and change their permissions should be 
strictly controlled. 

NOTE:  To create or change a user profile, you must Full or Modify 
access, respectively, for the Profiles Manager permission. If the 
enhanced security option is enabled, you must also have the required 
security access to change the profile. For details on the enhanced 
security option, see Section 15.3.4, “Configuring the enhanced security 
option”, on page 271. 
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To configure a user profile:

1. On the File menu, point to New, then Administration Center, and 
then click Profile. 

NOTE:  To create a new profile based on a copy of a profile, in the 
Administration Center, under General, click Profiles, then, in 
the right pane, right-click the profile and select Create Copy. 

2. On the General tab, under Profile, do the following:

• In the Name box, type a unique name for the profile. 

• In the Description box, type a description for the profile. The 
description should explain what type of user should use this 
profile. 

3. Under Access, by default, all the permissions are set to No or No 
access. For each permission you want to change, click the item in 
the Level column and select the new access level from the list. For 
details on the access levels, see Section 4.3.3, “Access levels”, on 
page 50. 

4. To reset all access levels to No or No Access, click Clear Access. 

5. Click the Security tab. This tab is available only if the enhanced 
security option is enabled. For details, see Section 15.3.4, 
“Configuring the enhanced security option”, on page 271. 
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6. Under Users, select the check box for each user who you want to 
be able to modify this profile. The list contains only the users who 
have Full or Modify access to the Profiles Manager permission. 

7. Click OK.

4.3.3  Access levels

In OpenScape Contact Center, each user or user profile has a set of 
permissions, and for each permission, an access level that indicates the 
functions the user can perform with that permission. 

IMPORTANT:  Use care when assigning permissions. The ability for a 
user to create other users and change their permissions should be 
strictly controlled. 

Some permissions are used for reading, modifying, and creating 
records in the database. The access levels for these permissions are:

• No Access – The user cannot view or modify the item. 

• Read Only – The user can view, but not change, the item.

• Modify – The user can view and change the item.

• Full – The user can create, view, change, and delete the item.

Some features can only be turned on or off. The access levels for these 
permissions are:

• No – The user cannot access the feature.

• Yes – The user can access the feature.

If two or more profiles are selected for a user, the user's actual access 
level is the highest access level of the selected profiles. For example, if 
the access level in one of the profiles is Full, the user’s actual access 
level will be Full. 

When configuring a profile only, the Restricted access level is also 
available. Selecting Restricted for a permission in a profile means that 
when that profile is selected for a user, the user’s actual access level 
will be No or No Access (as appropriate), even if you select another 
profile that has a higher access level.
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5  Configuring other administration resources
Your service representative normally takes responsibility for creating 
and implementing the initial OpenScape Contact Center configuration. 
This includes the configuration of Administration Center resources, 
such as locations, servers, data sources, and directories. These items 
normally do not need to be reconfigured. However, you do need to 
configure departments and reasons, as described in this chapter, 
before putting your OpenScape Contact Center configuration into 
production.

NOTE:  The re are also some global options that normally need to be 
configured before putting your OpenScape Contact Center 
configuration into production. For more information, see Chapter 15, 
“Configuring other global options”. 

5.1  Configuring a department

A department is a collection of OpenScape Contact Center users that 
are grouped for reporting purposes. A department may be composed 
of several groups, or individual users from several groups. 

NOTE:  To create or change a department, you must have Full or 
Modify access, respectively, for the Departments Manager 
permission. If the enhanced security option is enabled, you must also 
have the required security access to change the department. For 
details on the enhanced security option, see Section 15.3.4, 
“Configuring the enhanced security option”, on page 271. 

To configure a department:

1. On the File menu, point to New, then Administration Center, and 
then click Department.

2. On the General tab, under Department, do the following:

• In the Name box, type a unique name for the department. 

• In the Description box, type a description for the department. 
The description of the department should clearly indicate the 
common element for the users in the department. 

3. Click the Users tab.
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4. Under Users, select the check box for each user who you want to 
include in the department.

5. Click the Reports tab.

6. Under Include, select the check box for each report that you want 
to display data about this department. The list contains only the 
reports you own, or reports that are owned by users you can 
monitor. 

7. Click the Security tab. This tab is available only if the enhanced 
security option is enabled. For details, see Section 15.3.4, 
“Configuring the enhanced security option”, on page 271. 

8. Under Users, select the check box for each user who you want to 
be able to modify this department. The list contains only the users 
who have Full or Modify access to the Departments Manager 
permission. 

9. Click OK.

5.2  Configuring a location

You can configure a location for each geographical area that you want 
to associate with OpenScape Contact Center users or wallboards. 
Locations enable user reports to be generated based on the time zone 
of a user’s location, and wallboards to display local time in the time 
zone of the wallboard’s location. 

NOTE:  To create or change a location, you must have Full or Modify 
access, respectively, for the Locations Manager permission. If the 
enhanced security option is enabled, you must also have the required 
security access to change the location. For details on the enhanced 
security option, see Section 15.3.4, “Configuring the enhanced security 
option”, on page 271. 

To configure a location:

1. On the File menu, point to New, then Administration Center, and 
then click Location.

2. On the General tab, under Location, do the following:

• In the Name box, type a unique name for the location. 

• In the Description box, type a description for the location. 

• In the Time zone list, select the time zone of the location. 
 A31003-S22B1-M103-08-76A9, 04/2025
52 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



other_admin.fm

Configuring other administration resources
Configuring a location
3. Under Contact, do the following:

• In the Name box, type the name of the person responsible for 
the location. This person is usually the administrator who 
configures the OpenScape Contact Center database and 
provides technical support. 

• In the Telephone number box, type the telephone number 
where the contact person can be reached. 

4. Click the Users tab.

5. Under Users, select the check box for each user who you want to 
associate with this location. 

NOTE:  If you want to remove a user from a location, you must 
change the user’s location in the user definition. For details, see 
Section 4.1.1, “Configuring the general user properties”, on page 
26. 

6. Click the Wallboards tab.

7. Under Wallboards, select the check box for each wallboard that 
you want to associate with this location. 

8. Click the Security tab. This tab is available only if the enhanced 
security option is enabled. For details, see Section 15.3.4, 
“Configuring the enhanced security option”, on page 271. 

9. Under Users, select the check box for each user who you want to 
be able to modify this location. The list contains only the users who 
have Full or Modify access to the Locations Manager permission. 

10.Click OK. 
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5.2.1  Configuring an Unavailable reason

An Unavailable reason is an explanation for a user entering Unavailable 
routing state. When the user is logged on to the communication 
platform, but is not available to handle incoming contacts, the user 
should select Unavailable routing state. Unavailable reasons are usually 
configured to handle common reasons for absences such as lunch 
breaks, and so on. The system will not route contacts to a user who is 
in Unavailable routing state.

NOTE:  To create or change an Unavailable reason, you must have Full 
or Modify access, respectively, for the Unavailable reasons Manager 
permission. 

NOTE:  If you are using the OpenScape Contact Center Ring No 
Answer feature, the OpenScape Contact Center system places a user 
in Unavailable routing state if the user does not answer a routed 
contact. A default Unavailable reason is assigned to the change in 
routing state. 

To configure an Unavailable reason:

1. On the File menu, point to New, then Administration Center, and 
then click Unavailable Reason.

2. In the Name box, type a unique name for the Unavailable reason. 

3. In the Description box, type a description for the Unavailable 
reason.

4. Click OK.
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5.2.2  Configuring a Work reason

A Work reason is an explanation for a user entering Work routing state. 
When the user is logged on to the communication platform, but is 
performing work tasks not associated with contacts, such as attending 
meetings or training sessions, the user should select Work routing 
state. The system will not route contacts to a user who is in Work 
routing state. 

NOTE:  To create or change a Work reason, you must have Full or 
Modify access, respectively, for the Work reasons Manager 
permission. 

To configure a Work reason:

1. On the File menu, point to New, then Administration Center, and 
then click Work Reason.

2. In the Name box, type a unique name for the Work reason. 

3. In the Description box, type a description for the Work reason.

4. Click OK.

5.2.3  Configuring a Post-processing reason

A Post-processing reason is an explanation for a user entering Post-
processing handling state. A user is in Post-processing handling state 
when performing tasks after a contact has been disconnected, such as 
making notes or sending follow-up information. 

Although users can explicitly enter Post-processing handling state, a 
user definition can also be set up to automatically place users in Post-
processing handling state after they disconnect from a contact. For 
details, see Section 4.1.1, “Configuring the general user properties”, on 
page 26. 

NOTE:  To create or change a Post-processing reason, you must have 
Full or Modify access, respectively, for the Post-processing reasons 
Manager permission. 
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To configure a Post-processing reason:

1. On the File menu, point to New, then Administration Center, and 
then click Post-processing Reason.

2. In the Name box, type a unique name for the Post-processing 
reason. 

3. In the Description box, type a description for the Post-processing 
reason.

4. Click OK.

5.2.4  Configuring a Wrap-up reason

A Wrap-up reason is an explanation of what a user did to complete a 
contact. For example, an indication that a sale was made, that a 
problem was solved, or that a customer record was updated. Historical 
reports monitor the Wrap-up reasons selected. 

If the Wrap-up reason required option is selected for a user (see 
Section 4.1.1, “Configuring the general user properties”, on page 26), 
the user must select at least one Wrap-up reason for each contact. 

NOTE:  To create or change a Wrap-up reason, you must have Full or 
Modify access, respectively, for the Wrap-up reasons Manager 
permission. 

To configure a Wrap-up reason:

1. On the File menu, point to New, then Administration Center, and 
then click Wrap-up reason.

2. On the General tab, under Details, do the following:

• In the Name box, type a unique name for the Wrap-up reason. 

• In the Description box, type a description for the Wrap-up 
reason.

3. Click the Queue tab.

4. Under Queue, select the check box for each queue that you want 
to associate with this Wrap-up reason.

5. Click OK.
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5.3  About the servers

The OpenScape Contact Center system uses the following servers:

• Administration Server 

• Callback Server (only if the callback feature is activated)

• Call Director Server (only if the Call Director feature is activated)

• Config Sync Server 

• Data Management Server

• E-mail Server (only if the e-mail feature is activated or the e-mail 
reports option is enabled)

• OpenMedia Server

• Presence Server

• Real-Time Server

NOTE:  You can configure an additional instance of the Real-Time 
Server on an auxiliary server machine. For details, see Section 
5.3.4, “Configuring a Real-Time Server on an auxiliary server 
machine”, on page 74. 

• Reporting Server 

• Routing Server 

• SAP CIC Server (only if the SAP CIC integration is activated)

• SAP ICI Server (only if the SAP ICI integration is activated)

NOTE:  You can configure the SAP servers to run on either the main 
server machine or an auxiliary server machine. For details, see 
Section 5.3.1, “Configuring the server properties”, on page 70. 

• Statistics Server 

• T-Server 

• Watchdog Server 
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• Web Interaction Server 

NOTE:  Some features that have been activated using a license file 
must be enabled before they can be used. For details, see "Enabling 
activated features". 

You can configure the server properties, and create notifications used 
to advise the administrator if there is a problem with any of the servers. 

NOTE:  When you upload a design database, the system overwrites 
the host name of all servers that share the same host as the 
Administration Server with the host name of the server machine on 
which the production database resides. This ensures that the host 
name of the server is always configured correctly. 

5.3.1  Configuring the server properties

For all the OpenScape Contact Center servers, except the Watchdog 
Server, you can change the name, host name, and port number of the 
server resource. To configure the properties of a Watchdog Server, see 
Section 5.3.2, “Configuring a Watchdog Server”, on page 59. 

NOTE:  To create or change a server resource, you must have Full or 
Modify access, respectively, for the Servers Manager permission. 

NOTE:  When you are connected to the production database, if you 
change the server properties, you will be required to restart the 
OpenScape Contact Center service on the main server machine. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the server properties. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the properties of a server:

1. In the Administration Center, under Resources, click Servers.

2. In the right pane, double-click the server you want to change.

3. In the Name box, type the new name of the server. 
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4. In the Host name box, type the host name of the server machine 
where the server resides. You can type a maximum of 15 characters 
on a main server machine or central reporting server machine, or a 
maximum of 128 characters on an auxiliary server machine. 

NOTE:  If you are configuring an SAP server, and the SAP server is 
running on an auxiliary server machine, you must type the host 
name of the auxiliary server machine. 

5. In the Port number box, type the port number of the server on the 
server machine. 

NOTE:  If a firewall is enabled on the server machine and you 
change the port number of a server after the initial system 
configuration, you must reconfigure the firewall settings. 

6. Click OK.

5.3.2  Configuring a Watchdog Server

The application automatically creates a Watchdog Server on every 
machine where an OpenScape Contact Center server is installed. The 
Watchdog Server starts and monitors all other OpenScape Contact 
Center servers and issues notifications. 

You can change the name and port number of a Watchdog Server, but 
you cannot change the host name. The application automatically 
changes the host name of the Watchdog Server if you change the host 
name of the server machine where the Watchdog Server resides.

You can also configure the modem that the Watchdog Server uses to 
connect an auxiliary server machine to the main server machine. 

NOTE:  To change a Watchdog Server, you must have Modify access 
for the Servers Manager permission.

NOTE:  When you are connected to the production database, if you 
change the server properties, you will be required to restart the 
OpenScape Contact Center service on the main server machine.
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NOTE:  In a multitenant environment, only a system administrator can 
configure a Watchdog Server. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure a Watchdog Server:

1. In the Administration Center, under Resources, click Servers.

2. In the right pane, double-click the Watchdog Server you want to 
change.

3. In the Name box, type the new name of the server.

4. In the Port number box, type the identifier used to distinguish the 
connections for the host.

5. Click the Modem tab.

6. To use a modem to connect an auxiliary server machine to the main 
server machine, select the Use Modem check box, and then do the 
following:

• In the Communication port box, select the communication 
port of the server.

• In the Initialization string box, type the string used to 
initialize the modem. 

• In the Hang-up string box, type the string used to hang up the 
modem. 

7. Click OK.

5.3.3  Configuring the OpenMedia Server

The OpenMedia Server is the same server used by the Mobile 
Supervisor feature. 

Before configuring the OpenMedia Server

Install the OpenScape Contact Center Application Server. For detailed 
information, see OpenScape Contact Center Enterprise V10, 
Installation Guide, chapter Installing the OpenScape Contact 
Center Application Server.
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Configuring the OpenMedia Server

1. Enable the OpenMedia feature. In the Administration Center, 
under Tools, click Options. Then in the System Settings field, 
click System and the Features tab. Check the OpenMedia 
checkbox and click OK.

2. After enabling the feature, a new tab OpenMedia will appear. 
Follow the path Tools->Options->System Settings->System 
and click the OpenMedia tab.

3. This tab enables the creation of new Connectors. In the Add 
Connector area, give a Connector name, the Business Unit takes 
the value Default and click Add. A new Connector is added in the 
System Settings. You can add up to ten Connectors.

NOTE:  When the OSCC is a Multitenancy system, you must choose 
the Business Unit from the Business Unit - dropdown list.

4. To delete a Connector, select the Connector you want to delete from 
the table that contains all the Connectors and click Delete.

Configuring a Connector

1. Before configuring a Connector, the Options form must be closed.

2. Follow the path Tools->Options and click on the Connector you 
want to configure.

3. In the General tab, select a Picture for the Connector.

4. In the Connector tab, give the Server Settings. Give the 
credentials for the Social Media server, that is the Logon name and 
the Password. The Token is a password generator on the OSCC 
server, which controls which Connector is connected to the Contact 
Center. Click Generate to create a password.

5. In the Settings tab, set the Maximum number of Deferred 
Messages, the Automatic defer time and the Maximum defer 
time in days: hours: minutes. Also you can set the Session 
Timeout in hours: minutes: seconds.

NOTE:  In case of a Multitenancy environment, the connectors only 
appear when the Manager user is logged in to the respective 
Business Unit.
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5.3.4  Configuring a Real-Time Server on an 
auxiliary server machine

The contact center can use an auxiliary server machine to 
accommodate additional users. In this case, you must configure a new 
Manager resource for the Real-Time Server that is installed on the 
auxiliary server machine. The OpenScape Contact Center software 
must be installed on the auxiliary server machine before you can 
configure the new Real-Time Server resource in the Manager 
application. 

After the Real-Time Server has been configured, you can change the 
properties of the Real-Time Server in the same way as the other 
OpenScape Contact Center servers. For details, see Section 5.3.1, 
“Configuring the server properties”, on page 70. 

NOTE:  To create or change a Real-Time Server, you must have Full or 
Modify access, respectively, for the Servers Manager permission. 

NOTE:  When you are connected to the production database, if you 
configure a new Real-Time Server, you will be required to restart the 
OpenScape Contact Center service on the main server machine. 

5.3.5  Configuring a notification

To ensure that administrators are kept informed of the system status, 
you can configure automatic notifications. You can configure the 
system to send an e-mail message or a page to an individual if there is 
a problem with the database usage or one of the OpenScape Contact 
Center servers. 

NOTE:  To create or change a notification, you must have Full or 
Modify access, respectively, for the Notifications Manager permission. 

NOTE:  In a multitenant environment, only a system administrator can 
configure a notification. For details, see Section 19.3, “Administrator 
roles in a multitenant environment”, on page 394. 
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For e-mail notifications, the sender address is 
“OpenScape_Contact_Center”. If the SMTP server is configured to 
authenticate the sender as part of its security measures, you must 
ensure that the server machine is allowed to send e-mail messages 
using “OpenScape_Contact_Center” as the “from address”. 

To configure a notification:

1. On the File menu, point to New, then Administration Center, and 
then click Notification.

2. On the General tab, under Notification, do the following:

a) In the Condition list, select one of the following conditions:

– Database Usage – Indicates that there is not enough disk 
space available to store the data that will be generated over 
the next two weeks, based on the configured retention 
periods. For details on the data retention periods, see 
Section 15.6, “Configuring the data management options”, 
on page 276. 

– Server Down – Indicates that the server is not operational. 

– Server Response Time – Indicates that the server 
response time is longer than expected. 

– Server Up – Indicates that the server is operational again. 

b) In the Component list, select the server that you want to 
monitor.

3. Under Type, in the Notification method list, select the type of 
notification you want to use: E-mail or Pager. 

4. If you selected E-mail in step 3, under Details, configure the 
e-mail message as follows:

a) In the E-mail address box, type the e-mail address to which 
the notification should be sent. 

b) In the Message box, type the message you want to send to the 
specified e-mail address. 

c) In the SMTP server box, type the host name of the machine 
where the SMTP server resides. 
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5. If you selected Pager in step 3, under Details, configure the pager 
as follows:

a) In the Pager number box, type the number of the pager to be 
called. 

b) In the Numeric code box, type the code for the selected 
condition. For example, if the digits 111 are dialed, then a 
numeric code appears on the pager. 

c) In the Number of attempts box, select the number of times 
you want the pager to be contacted.

d) In the Retry interval box, select the length of time that you 
want to wait between attempts to contact the pager.

e) In the Message delay box, select the length of time that 
elapses between the time when the pager number is dialed and 
the digits for the numeric code are sent. 

6. To test the configured notification, click Test.

7. Click OK.

Setting up notifications on a system without email license:

1. Login on Manager system:

Go to: Tools > Options > System Settings > Reporting

2. Enable the Email report feature:

Locate the option to enable email reporting.

Email-Reports > Enable

Enabling this feature will start the Email Server.

3. Navigate back to the system settings for email configuration:

Tools > Options > System Settings > System

4. Enable the Corporate SMTP Server authentication by adding an 
email address and password as described on Chapter 15, 
“Configuring the e-mail server settings” 
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5.4  Configuring a data source

You can access information in an external ODBC-compliant database, 
and then use that information in a Database Function component to 
help make decisions about contact routing. You must ensure that the 
external database provides mappings to ODBC-compliant data types. 

To access an external ODBC-compliant database, you must do the 
following on the OpenScape Contact Center server machine:

• In Windows, configure an ODBC data source that connects to the 
external database. Since the OpenScape Contact Center system is 
a 32-bit system, only 32-bit ODBC data sources are supported. 

• In the Manager application, configure a data source definition for 
each ODBC data source that you want to access. 

NOTE:  To create or change a data source definition, you must have 
Full or Modify access, respectively, for the Data sources Manager 
permission. 

NOTE:  When the system is configured for high availability (warm 
standby), the data source definition in OpenScape Contact Center is 
replicated, so you must ensure that the ODBC data source is configured 
in Windows with the same information on both the primary and backup 
server machines.

NOTE:  A slow connection to a data source will affect contact center 
performance. Ensure that any data sources you connect to will not 
adversely affect the productivity of your contact center. 

To configure a data source:

1. On the File menu, point to New, then Administration Center, and 
then click Data Source.

2. Under Details, do the following:

• In the Data source name box, type the name of the data 
source. To locate the required data source name, click Find. 

• In the Maximum connections box, specify the maximum 
number of connections available to this data source. 
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3. Under Access, do the following:

• In the User ID box, type the User ID of the user who can 
connect to this data source. 

• In the Password box, type the password for the User ID. 

4. To test the connection to the data source, click Test.

5. Click OK.

5.5  Configuring a directory

You can configure a directory resource in the Manager application to 
provide access to an external LDAP directory. The LDAP directory can 
then be used to search for information, such as a name, telephone 
number, or e-mail address. In the Manager application, the external 
directory is used to select recipients when sending reports by e-mail. 
You can configure up to two directories for use in the Manager 
application. 

NOTE:  The connection between the client applications and the LDAP 
Server can be encrypted by using LDAPS (LDAP over TLS).

NOTE:  To create or change a directory, you must have Full or Modify 
access, respectively, for the Directories Manager permission.

To configure a directory:

1. On the File menu, point to New, then Administration Center, and 
then click Directory.

2. On the General tab, under Directory, do the following:

• In the Name box, type the name of the directory. 

• In the Description box, type a description for the directory.
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3. Under Connection, do the following:

• In the Host name box, type the host name of the directory 
server. 

• In the Port number box, type the TCP/IP port number of the 
directory server. The default value is 389.

NOTE:  To enable LDAPS, set the Port Number to 636. For the 
Agent Portal Web check the flag in Settings > Directories > 
Setup Connection > TLS.

• To test the logon to the directory server, click Test. You must 
enter the account name and password to access the directory 
server. 

NOTE:  This tests the connection from this server machine, not 
from the client machine. 

4. Click the Query tab.

5. Under Fields, do one of the following:

• To configure a new directory field to be queried, click Add, and 
then configure the field. 

• To modify an existing directory field to be queried, select the 
directory field in the list, click Edit, and then configure the field. 

• To delete an existing directory field, select the directory field in 
the list and click Delete. 

NOTE:  The top to bottom order of the fields in the list reflects the 
order in which the fields are displayed in the Manager application. 
To change the order of the fields, click anywhere in a row to select 
the row, and then click the up or down arrow key to the right of the 
list to move the row up or down, respectively. 

6. Under Query String, specify the components of the query string 
used to locate entries in the directory:

• In the Base distinguished name box, type the base 
distinguished name to be used as the starting point for the 
query. The base distinguished name contains one or more 
Attribute Name and Attribute Value strings separated by the “=” 
character, for example, ou=sales, o=mycompany.com. 
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• In the Scope list, select the scope of the query from the list: 
Base, One Level, or Subtree. 

• In the Object class box, type the list of object classes to be 
used to filter the query. The object classes in the list must be 
separated by commas. 

• In the Object categories box, type the list of object categories 
to be used to further filter the query. The object categories in 
the list must be separated by commas.

7. Click the Results tab. 

8. Under Fields, do one of the following: 

• To configure a new directory field to be displayed in the search 
results, click Add, and then configure the field. 

• To modify a directory field to be displayed in the search results, 
select the directory field in the list and click Edit, and then 
configure the field. 

• To delete an existing directory field, select the directory field in 
the list and click Delete. 

9. Click OK. 
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6  Using the Broadcaster and wallboards
Managers and supervisors can broadcast information to contact center 
users in the following way:

• To wallboards in the contact center (see Section 6.1, “About 
wallboards”, on page 67)

You can display the following types of content: 

• Text – Text can be used alone or in combination with date/time 
variables and statistics to provide a label for the variable or statistic. 
For example, if you include a date variable in a view, you could 
include the text Today’s date is.

• Date/Time variables – Date and time variables display the 
current date or time, updated in real time. 

• Performance statistics – Real-time statistics on various contact 
center resources are received from the OpenScape Contact Center 
servers and are updated in real time.

Each collection of content is referred to as a view. You broadcast these 
views to defined groups of users or wallboards, called distributions. The 
view/distribution mechanism lets you define content aimed at specific 
users, and broadcast either directly to those users or to particular 
wallboards. In a simple setup, you may have distributions based on 
your queue setup or users grouped according to their supervisor. 

Each Broadcaster or wallboard can display only one view.

6.1  About wallboards

A wallboard is a display medium located in your contact center where 
several users can view information. 

Wallboards have the following features:

• Multiple lines – Select the line on which the variable appears. You 
can synchronize lines, so that the statistic name appears above its 
value.

Text Date/Time Performance 
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• Text color – Select the color used to display the text (if supported 
by the wallboard model). For tri-color boards, the colors displayed 
are red, yellow and green.

• Scroll direction – Select the horizontal scroll direction. You can 
choose from Scroll left, Scroll left and hold, Scroll right and hold, 
Stationary and hold, or Flash and hold. 

The system supports several Spectrum wallboard models using the EZ 
Key II protocol. For a list of supported wallboard models, and 
instructions on installing and configuring a wallboard, see the System 
Management Guide. If you have an unsupported wallboard model, you 
can create a custom wallboard type (see Section 6.1.1, “Creating a 
wallboard type”, on page 68). 

Read your wallboard documentation to determine the exact features 
supported by your particular wallboard. Ensure that you have 
downloaded the latest firmware for your wallboard.

6.1.1  Creating a wallboard type

The system provides default wallboard types for several Spectrum 
wallboard models. If you have an unsupported wallboard model, you 
can create a custom wallboard type that you can select when creating 
a wallboard definition or configuring a wallboard view. 

NOTE:  To create or change a custom wallboard type, you must have 
Full or Modify access, respectively, for the Wallboard types Manager 
permission.

To create a wallboard type:

1. On the File menu, point to New, then Broadcast Center, then 
Wallboard, and then click Type.

2. Under Type, do the following:

• In the Name box, type the name used to identify the wallboard 
type. 

• In the Description box, type a description for the custom 
wallboard, including the length and model of the wallboard.

3. Under Specifications, do the following:

• In the Lines list, select the number of lines that can be 
displayed on the wallboard.
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• In the Characters list, type or select the number of characters 
that can be displayed on each line of the wallboard.

• If the wallboard type supports three colors, select the TriColor 
check box.

4. Click OK. 

6.1.2  Creating a wallboard definition

A wallboard definition contains the name and description of the 
wallboard, the hardware settings for the wallboard, and the wallboard 
distribution. The definition normally describes the physical location of 
the wallboard in the contact center, for example, third floor, south 
wall. 

While supervisors and managers are typically involved in configuring 
wallboard views and distributions, wallboard definitions are typically 
configured by the service technician. For detailed instructions, see the 
System Management Guide.

NOTE:  To create or change a wallboard definition, you must have Full 
or Modify access, respectively, for the Wallboard definitions Manager 
permission.

Before you begin, check the list of Wallboard types in the Broadcast 
Center to ensure that the type of wallboard you want to use is already 
configured. If the type of wallboard you have is not in the list, create a 
custom wallboard type (see Section 6.1.1, “Creating a wallboard type”, 
on page 68). 
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To create a wallboard definition:

1. On the File menu, point to New, then Broadcast Center, then 
Wallboard, and then click Definition.

2. Under Wallboard, do the following:

• In the Name box, type a unique name for the wallboard. 

• In the Description box, type a description for the wallboard. 
Use the description to specify the physical location of the 
wallboard. 

3. Under Type, in the Name list, select the wallboard type. After you 
select the wallboard type, the properties of the wallboard are shown 
in the Description box.

4. Click the Settings tab.

5. Under Connection, do the following:

• In the Host name box, type the host name or IP address of the 
wallboard. 

• In the Port number box, type the port number of the 
wallboard. The port number indicates the connection to the 
wallboard on the OpenScape Contact Center server machine.

• If you are connected to a production database, you can click 
Test to verify the configuration. If the test fails, check the host 
name or IP address and the port number of the wallboard.

• In the Location list, select the location of the wallboard. The 
default is the location where the Manager application is installed.

6. Click the Content tab. 
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7. In the Distribution list, select a distribution. If there are no 
distributions listed, you can add this wallboard to a distribution 
when you create a wallboard distribution (see Section 6.1.4, 
“Configuring a wallboard distribution”, on page 78). 

8. Click OK. 

6.1.3  Configuring a wallboard view

You can create different views that can be displayed on a wallboard. 
For more information, see Section 6.1, “About wallboards”, on page 67. 

NOTE:  To create or change a wallboard view, you must have Full or 
Modify access, respectively, for the Wallboard views Manager 
permission.

Overview

The following is an overview of the steps required to configure all the 
attributes in a wallboard view:

1. Configure the general information – see Section 6.1.3.1, 
“Configuring the general information for a wallboard view”, on page 
71. 

2. Configure the content – see Section 6.1.3.2, “Configuring the 
content of a wallboard view”, on page 73.

3. Configure a threshold for a wall board item – see Section 6.1.3.4, 
“Configuring a threshold for a wallboard view item”, on page 76.

4. Configure the distribution for a wallboard view – see Section 
6.1.3.5, “Configuring the distribution for a wallboard view”, on page 
77.

6.1.3.1  Configuring the general information for a 
wallboard view

You can configure the name, description, owner and wallboard type for 
each wallboard view. 
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To configure the general information for a wallboard view:

1. On the File menu, point to New, then Broadcast Center, then 
Wallboard, and then click View.

2. Under View, do the following:

• In the Name box, type a unique name for the view. 

• In the Description box, type a description of the view. Use the 
description to specify the information displayed in the wallboard 
view. 

• In the Owner list, click a user name. The owner is the only user, 
other than the Master Administrator, who can modify the 
properties of this view. You can select your own name or any 
other user who you can monitor. The owner can see only the 
users, groups, or queues in the view which the owner can 
monitor. 

3. Under Wallboard, in the Type list, select the wallboard type for 
which you are configuring the view. After you select the wallboard 
type, the properties of the wallboard are shown in the Description 
box. 
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4. If you are finished working with this view definition, click OK.

6.1.3.2  Configuring the content of a wallboard view

You can configure a wallboard view to display text or statistics. 
Changes that you make to a wallboard view occur immediately and 
affect the users who are viewing the wallboard. 

To configure the content of a wallboard view:

1. In the Broadcast Center, under Wallboard, click Views.

2. In the right pane, double-click the wallboard view for which you 
want to configure the content.

3. Click the Content tab.
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4. Under Settings, in the Line list, select the line in the wallboard 
view for which you want to configure the content. Your choices are: 
Top Line and Bottom Line. 

NOTE:  The system supports the use of wallboards that have up to 
four lines, but the EZ Key II Protocol can only address the lines as 
Top Line and Bottom Line. So in the case of a three-line or four-line 
wallboard, the wallboard uses all its lines minus one to display the 
content defined in the Top Line. The Bottom Line begins 
immediately following the last line of the Top Line. For example, if 
the content configured in the Top Line takes up only two lines of a 
four-line wallboard, the content configured in the Bottom Line will 
start on the third line of the wallboard.

5. In the Mode list, select the scroll direction and action you want to 
use: 

• Scroll left – Continuously moves text to the left.

• Scroll left and hold – Holds text on the screen for a specified 
amount of time before scrolling left.

• Scroll right and hold – Holds text on the screen for a specified 
amount of time before scrolling right.

• Stationary and hold – Holds text stationary for the specified 
amount of time. For large quantities of text, groups of 
characters are displayed for the specified amount of hold time.

• Flash and hold – Continuously flashes text.

6. If you selected a mode that contains a hold action, under Hold 
Time, move the slider to specify the length of time an item pauses 
at the center of the wallboard.

7. Under Data, do one of the following:

• To add a new wallboard item, click Add.

• To edit an existing wallboard item, select the item in the list and 
click Edit. 

8. Configure a wallboard view item (see Section 6.1.3.3, “Configuring 
a wallboard view item”, on page 75). 

9. Repeat steps 7 and 8 for each item you want to configure.

10.The Preview area shows the contents of the wallboard view. The 
selected scrolling action is shown, but not the selected hold action. 

11.If you are finished working with this view definition, click OK.
 A31003-S22B1-M103-08-76A9, 04/2025
74 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



views_dists.fm

Using the Broadcaster and wallboards
About wallboards
6.1.3.3  Configuring a wallboard view item

You can configure a wallboard view item to display text, date and time 
variables, and performance statistics. 

To configure a wallboard view item:

1. Open the Wallboard View Item dialog box. 

2. Under Item, in the Type list, select one of the types provided. You 
can choose Text Only or one of several different variable types. 

3. In the Text box, type the text to display on the wallboard.

4. If you selected a variable type, use the Statistic box to select the 
statistic you want to display on the wallboard view. You can 
configure the threshold for each threshold-eligible statistic that you 
select.

5. If you selected a Group, Queue or Aggregate variable type, use the 
For box to select the queue, group, or aggregate for which to 
display the statistic. You can select only the queues, groups, or 
aggregates that you and the owner of the view can monitor. 

6. In the Spaces after box, type or select the number of spaces that 
you want to insert after the item in the wallboard view. 

7. Under Attributes, select a Text color to apply to the item.

8. Click OK.
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6.1.3.4  Configuring a threshold for a wallboard view 
item

You can configure a threshold for each statistic shown on the wallboard 
view. When a threshold is exceeded, you can display the statistic name 
in a different color (for tri-color wallboard types), or display text on the 
other line of the wallboard. 

Before you can configure a threshold for a statistic, the wallboard view 
must be configured to display the statistic (see Section 6.1.3.3, 
“Configuring a wallboard view item”, on page 75).

To configure a threshold for a wallboard view item:

1. In the Broadcast Center, under Wallboard, click Views.

2. In the right pane, double-click the wallboard view you want to 
configure.

3. Click the Thresholds tab.

4. Under Items, select the statistic for which you want to configure a 
threshold. The Items list contains only the statistics specified on the 
Contents tab for which you can set a threshold.

5. Click Edit. The Statistic and For boxes show the statistic you 
selected. You cannot edit them here.

6. Under Settings, select the Active check box. This enables you to 
configure the threshold. After the threshold has been configured, 
you can use the Active check box to activate or de-activate the 
threshold in the wallboard view. 
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7. In the Threshold box, specify the limit to which you want to 
compare the statistic. The statistic determines if this value is a 
maximum or minimum. 

8. In the Action list, select the action that alerts users to the 
exceeded threshold:

• Change color – In the To list, select the color to display.

• Show text – In the Text box, type the text to display. 

9. In the Apply to list, select whether to apply the threshold condition 
to the Statistic only or the Entire item (including text labels). 

10.Click OK. The information you entered is displayed on the 
Thresholds tab. If the threshold is inactive, None appears under 
Threshold for the Statistic in the Items list. 

11.If you are finished working with this view definition, click OK.

6.1.3.5  Configuring the distribution for a wallboard 
view

You can assign a wallboard view to specific wallboard distributions. 

NOTE:  You must create the wallboard distributions before you can 
select them in a view (see Section 6.1.4, “Configuring a wallboard 
distribution”, on page 78).

To configure the distribution for a wallboard view:

1. In the Broadcast Center, under Wallboard, click Views.

2. In the right pane, double-click the wallboard view for which you 
want to specify the distribution. 

3. Click the Distribution tab.

4. Under Send to, select the check box for each wallboard distribution 
where you want to send the view. 

5. If you are finished working with this view definition, click OK.
A31003-S22B1-M103-08-76A9, 04/2025
OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide 77
         



Using the Broadcaster and wallboards

views_dists.fm

About wallboards
6.1.4  Configuring a wallboard distribution

A wallboard distribution is a group of wallboards to which you can 
assign a single wallboard view (see Section 6.1.3, “Configuring a 
wallboard view”, on page 71). After you create a wallboard distribution 
and assign a view to it, the view can be displayed on the selected 
wallboards. 

Each wallboard can be a member of only one distribution at a time 
because only one view can be displayed on each wallboard. 

NOTE:  To create or change a wallboard distribution, you must have 
Full or Modify access, respectively, for the Wallboard distributions 
Manager permission.

To configure a wallboard distribution:

1. On the File menu, point to New, then Broadcast Center, then 
Wallboard, and then click Distribution.

2. Under Distribution, do the following:

• In the Name box, type a unique name for the distribution. 

• In the Description box, type a description of the distribution.

3. Under Current, in the View list, select the wallboard view that you 
want to be displayed on all the wallboards in the distribution.

4. Click the Wallboards tab. 

5. Under Include, select the check box for each wallboard where you 
want to display the current wallboard view.

6. Click OK.
 A31003-S22B1-M103-08-76A9, 04/2025
78 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



reporting.fm

Reporting
7  Reporting
You can use the Manager reporting feature to view performance data 
which can help you resolve issues, evaluate the efficiency of your 
contact center, and optimize your OpenScape Contact Center 
configuration. Reporting provides real-time statistics, accumulated 
statistics for the current day, and historical statistics on various contact 
center resources. Options range from online views showing the current 
status of particular resources to traditional statistical summaries.

There are four main types of reports: 

• Real-time – see Section 7.1, “About real-time reports”, on page 
80. 

• Historical – see Section 7.2, “About historical reports”, on page 
83. 

• Cumulative – see Section 7.3, “About cumulative reports”, on 
page 85. 

• Activity – see Section 7.4, “About activity reports”, on page 86. 

Real-time view showing the 
current status of a queue

Statistical summary with totals, 
rollups, and an interval 
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The Manager application provides a set of predefined report definitions 
that can be used as is, or as the basis for creating new reports. For 
detailed information on the report types, the predefined reports, and 
the content that can appear in reports, see the Reporting Reference 
Guide. 

By default, reporting is available at the single site level. If you are using 
the networking and central reporting features, you can report at the 
network level. This lets you include site level statistics in certain reports 
and makes different types of reports available. For information on 
central reporting, see Chapter 17, “Working with central reporting”. 

NOTE:  You can report on resources for which you have been assigned 
monitoring permission only. For more information, see Section 7.5, 
“Monitoring permissions and reporting”, on page 87. 

NOTE:  You cannot run reports while the system performs data 
maintenance. For more information, see Section 7.13.3, “Configuring 
the queue real-time report options”, on page 136. 

7.1  About real-time reports

Real-time reports are reports that are viewed online to monitor the 
current status of the following resources:

• Users

• Groups (or virtual groups) 

• Contacts

• Callbacks

• Queues and aggregates

• Sites 

The data displayed in a real-time report is updated in real time. You can 
use the reports to help you make minute-to-minute decisions, for 
example, you can monitor activities in a group of users to evaluate if 
their workload indicates a need for more users. For a description of the 
statistics available, refer to the Reporting Reference Guide. 
 A31003-S22B1-M103-08-76A9, 04/2025
80 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



reporting.fm

Reporting
About real-time reports
Real-time reports have an alarm mechanism to alert you to key column 
values in the report. For columns that have numeric or elapsed time 
values, you can set a threshold condition. For example, on a Contacts 
- Queued column you could set a threshold condition to trigger an 
alarm when the number of contacts in queue is greater than five. 

NOTE:  User real-time reports are available only if your site is 
operating with a reporting level of Full (see Section 7.6, “Reporting 
level”, on page 88). 

NOTE:  You can configure the application to include ringing and 
unanswered contacts in queue real-time reports. For details, see 
Section 7.13.3, “Configuring the queue real-time report options”, on 
page 136.

For example, a key piece of information in a contact center is the 
number of contacts currently waiting in queue. If you wanted to 
monitor contacts waiting at the queue level, you could use a queue 
real-time report.

This report shows current contact waiting totals for a set of queues. 
Details for each queue include:

• The number of contacts waiting in that queue.

• The current service level based on the last 24 contacts and an 
estimated service level.

• The estimated time that a contact received will wait before being 
answered.

The highlighting on the Contacts - Queued column is an alarm 
mechanism that provides a visible or audible alarm to problem 
situations. Each real-time report subtype provides a set of columns for 
which you can set alarms. When setting up a report, you can define up 
to three different thresholds on a particular column. A different alarm 
can be displayed or sounded whenever each threshold value is 
exceeded. In a real life situation, the alarm on the Contacts - Queued 
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column might mean nothing more than an unusually busy day. You 
might use this information to take immediate action, for example, to 
have more users become available.

Alternatively, you may want to use the group real-time report as the 
first step in tracking down a problem. If you wanted more detail on 
what was going on with a problem queue, you could generate a user 
real-time report on users associated with that queue:

This report includes a bar chart, which consists of a bar graph 
representation of one statistic at the top of the report. When you create 
a real-time report, you have the option of including tabular 
information, chart information, or both.

In general, information in real-time reports can be helpful in identifying 
the following requirements and problems:

• Additional staffing

• User training

• Queuing bottlenecks

• Configuration changes such as reallocation of users among groups
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7.2  About historical reports

Historical reports provide statistical summaries on the performance of 
specific resources over a specified time period. Historical reports are 
commonly used to evaluate or assess contact center performance, 
configuration efficiency, and the productivity of individual queues and 
users. Statistics are available at user, department, and site levels. For 
a description of the statistics available, refer to the Reporting 
Reference Guide. 

The resources that can be monitored in historical reports are:

• Users

• Groups (or virtual groups) 

• Contacts

• Callbacks

• Queues

• Destinations

• Workflows

• Call Director components

• Wrap-up reasons

• Routing state reasons 

• Post-processing reasons
A31003-S22B1-M103-08-76A9, 04/2025
OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide 83
         



Reporting

reporting.fm

About historical reports
While common ranges for historical reports are daily, weekly, and 
monthly, you can also specify custom ranges. Within the range of a 
report, you can further break down the statistics for display by 
specified intervals. The report shown below is a daily report broken 
down into hourly intervals. 

Historical reports provide three scheduling options: run the report 
immediately, run the report once only at a specified date and time, or 
run the report on a regular basis. If you choose to run a report on a 
regular basis, you can also specify the frequency. 

NOTE:  The maximum number of database records that can be used to 
generate a historical report is 60,000 (10,000 if the report includes 
contact record details). If the number of database records used to 
generate a report exceeds these limits, the report will fail. The failed 
report will appear in the Failed folder with a message indicating that 
the number of records used to generate the report exceeded the 
maximum. To generate the report successfully, you must select fewer 
resources to report on, reduce the range of the report to cover a 
shorter time period, or select a longer interval. 
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7.3  About cumulative reports

Cumulative reports combine the “current status” benefits of real-time 
reports with the detailed statistics and rollup availability of historical 
reports. 

The key differences between cumulative reports and historical reports 
are:

• Cumulative reports are online reports and cannot be scheduled. 

• Cumulative reports show statistics for the current 24-hour period 
up until the last hourly or 15-minute interval defined for the report. 

• When the next hourly or 15-minute interval passes, statistics for 
that interval for all included resources are added to the report in 
real time. In addition to the statistics for the new interval, totals at 
the department and site level are also updated. 

• The charted statistic in a cumulative report can include a trend line 
that lets you compare current day intervals with the same intervals 
from the previous day or the same day last week. 

For a description of the statistics available, refer to the Reporting 
Reference Guide. 

The resources that can be monitored in cumulative reports are:

• Users

• Groups (or virtual groups) 

• Callbacks

• Queues

• Destinations

• Workflows

• Call Director components

• Wrap-up reasons

• Routing state reasons 

• Post-processing reasons

Cumulative reports have an alarm mechanism to alert you to key 
column values in the report. For columns that have numeric or elapsed 
time values, you can set a threshold condition. For example, on a 
Contacts - Queued column you could set a threshold condition to 
trigger an alarm when the number of contacts in queue is greater than 
five. 
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The cumulative reports mechanism is designed to provide flexible, 
multipurpose reporting that complements historical and real-time 
reports. On a daily basis, you might use a report such as the one shown 
below to monitor contact center performance since start of shift or to 
keep running totals. For example, you might want to track actual 
performance statistics against projected or forecasted values. On a less 
frequent basis, you can create complex, one time only reports with a 
minimum of effort.

In addition to keeping running totals, a key benefit of a cumulative 
report is the use of the trend information to help with forecasting. The 
trend line is based on information collected for the previous day or the 
same day last week, and is present whenever you open the report. 
Tracking the current day’s statistics against the selected trend, might 
alert you to upcoming problems. You may have to change staffing 
levels to accommodate anticipated volume fluctuations predicted by 
the trend line.

As an online report, the user interface provides viewing options such as 
showing or hiding levels of detail, and the ability to change views. 
Lastly, you can print or export the online report.

7.4  About activity reports

There are three types of activity reports that you can generate: 

• User Activity Report – see Section 7.10, “Generating a User 
Activity Report”, on page 126.

• Source Activity Report – see Section 7.11, “Generating a Source 
Activity Report”, on page 127.

• Scheduled Callback List – see Section 13.4, “Generating a 
Scheduled Callback List”, on page 240. 
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User and Source Activity Reports provide historical, step-by-step, state 
and activity data during a specified time interval for a specified date 
range. Note that the statistics are available only after the activity is 
complete, for example, after the current state has changed. In 
addition, the system requires a 15-minute delay so the statistics can 
be written to the OpenScape Contact Center database. For a 
description of the statistics available, refer to the Reporting Reference 
Guide. 

A Scheduled Callback List provides a list of the callbacks scheduled for 
the contact center. 

The following is an example of a User Activity Report for multiple users.

7.5  Monitoring permissions and reporting

If you are a supervisor or manager, you may have been assigned a 
number of users, groups, and queues that you have permission to 
monitor. As a result, you can report only on those resources that you 
have permission to monitor. For information on the resources that you 
can monitor, contact your administrator.

The reporting level also affects what you can monitor. 
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7.6  Reporting level

The reporting level is a licensed feature that restricts the amount of 
information that can be displayed for performance statistics in certain 
types of reports. 

A site can have one of three reporting levels:

• Full – User historical and user cumulative reports can include 
detailed and summary statistics for each user. Events in source 
activity reports can identify specific users. User activity reports can 
be generated. 

• Department – User historical and user cumulative reports can 
display statistics at the department level or site level only. Detailed 
and summary statistics for users are not available. Events in source 
activity reports pertaining to individual users identify only the user's 
department, not the individual user. User activity reports cannot be 
generated. 

• Site – User historical and user cumulative reports can display 
statistics at the site level only. Detailed and summary statistics at 
the user and department level are not available. Events in source 
activity reports pertaining to individual users identify only the user's 
site and not the individual user. User activity reports cannot be 
generated.

For more information on the reporting level at your site, contact your 
service representative. 

7.7  Configuring a report

When configuring real-time, cumulative, and historical reports, you 
create a report definition that defines the properties of the report. 
Some properties are common to all report types, for example, all 
reports have a layout property that dictates the columns displayed in 
the report and their order. Some properties are specific to certain 
report types. For example, real-time reports let you set alarms to draw 
your attention to certain values, and historical reports can be 
scheduled to run on a regular basis. 

NOTE:  To create or change a report definition, you must have Full or 
Modify access, respectively, for the associated Manager permission. 
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Before modifying an existing report, consider its ownership. If you have 
permission to monitor other users and have assigned users ownership 
of a report you want to modify, you may want to consult those users 
before you modify the report definition.

NOTE:  Since activity reports are intended to be used as simple, case-
by-case queries, there is no saved report definition for an activity 
report. 

Overview

The following is an overview of the steps required to configure all the 
properties in a report definition: 

1. Configure the general report properties – see Section 7.7.1, 
“Configuring the general report properties”, on page 89. 

2. Select the resources that you want to report on – see Section 7.7.2, 
“Selecting the content for a report”, on page 94. 

3. Specify the columns you want to appear in the report – see Section 
7.7.3, “Specifying the columns in a report”, on page 101. 

4. For real-time and cumulative reports, set the thresholds and alarms 
for particular columns – see Section 7.7.4, “Setting thresholds and 
alarms in a report”, on page 102. 

5. Optionally, specify a bar chart for the report – see Section 7.7.5, 
“Specifying a bar chart in a report”, on page 105. 

6. For historical reports, specify when to run the report and submit the 
report to the Scheduler – see Section 7.7.6, “Scheduling a historical 
report”, on page 106. 

7. Specify the output options for the report – see Section 7.7.7, 
“Specifying the output options for a report”, on page 109. 

7.7.1  Configuring the general report 
properties

When configuring a report, the first step is to configure the general 
report properties. The options you can select depend on the type of 
report you want to configure. 
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To configure the general report properties:

1. On the File menu, point to New, then Report Center, and then 
click the type of report you want to create. 

NOTE:  To make a copy of a predefined report, in the Report 
Center, under Definitions, click the type of report you want to 
copy, then, in the right pane, right-click the report definition you 
want to copy and click Create Copy. 

2. Under Report, do the following:

• In the Name box, type a unique name for the report. 

• In the Description box, type a description for the report. The 
description should include information about what the report 
contains, and what resources the report is monitoring. 

3. In the Owner list, select the user who will be able to use this report 
when logged on to the Manager application. By default, your user 
name is selected. The list will contain all users that you have 
permission to monitor. You can assign a user who does not have 
permission to create reports as the owner of the report. 

4. Under Attributes, do the following:

• In the Type list, select the type of report you want to create: 
Real-time, Cumulative, or Historical. For some resources, 
only certain report types are available. 

• In the Include area, select the Table check box to include 
tabular information in the report, and/or select the Chart check 
box to include a bar chart in the report. A report is displayed in 
table format by default where the rows list the resources and the 
columns contain the statistics for those resources. If you clear 
the Table check box, the Chart check box is selected by default, 
but you can chart a single statistic only.

• For a cumulative report, specify the range. For details, see 
Section 7.7.1.1, “Specifying the range for a cumulative report”, 
on page 91. 

• For a historical report, specify the range. For details, see Section 
7.7.1.2, “Specifying the range for a historical report”, on page 
91. 

5. If you are finished working with this report definition, click OK.
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7.7.1.1  Specifying the range for a cumulative report 

When configuring a cumulative report, you must specify the range of 
the report. 

To specify the range for a cumulative report:

1. In the Report Center, under Definitions, select the report type, 
then, in the right pane, double-click the report definition that you 
want to configure. 

2. Under Attributes, in the Range list, select the range to be covered 
by the report in the current 24-hour period: 

• To show statistics accumulated since the start of the current 
shift, select Since shift start.

• To show the most recent statistics, accumulated over a specified 
number of hours, select Most recent, and then in the Time 
box, type or select the amount of time (in hours and minutes) 
to be covered by the report. 

• To show statistics accumulated since some specified time of the 
day, select Since, and then in the Time box, type or select the 
starting time for the report. 

• In the Interval list, select the update interval for the report: 15 
Minute or Hourly. 

3. If you are finished working with this report definition, click OK.

7.7.1.2  Specifying the range for a historical report 

When configuring a historical report, you must specify the range of the 
report. 

NOTE:  The Start date, End date, Start time, and End time are 
determined based on the time and time zone settings configured on the 
server machine. 
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To specify the range for a historical report:

1. In the Report Center, under Definitions, select the report type, 
then, in the right pane, double-click the report definition that you 
want to configure. 

2. Under Attributes, to specify a range that crosses over the midnight 
boundary, select the Report over midnight check box. This 
ensures that the data in the generated report includes intervals that 
cross over the midnight boundary. 

3. In the Range list, select the range of the report. Your choices are:

• Yesterday – Run a report on yesterday's statistics. The report 
can be broken down into 15-minute, hourly, or daily intervals. 

• This Week – Run a report on the accumulated statistics to date 
for this week. The Start date is based on the specified first day 
of the week setting. The report can be broken down into 15-
minute, hourly, or daily intervals. 

• Last Week – Run a report on last week's statistics. The Start 
date is based on the specified first day of the week setting. The 
report can be broken down into 15-minute, hourly, daily, or 
weekly intervals. 

• This Month – Run a report on the accumulated statistics to date 
for this month. The Start date is the first day of the month. The 
report can be broken down into 15-minute, hourly, daily, or 
weekly intervals. 

• Last Month – Run a report on last month's statistics. The Start 
date is the first day of the month. The report can be broken 
down into 15-minute, hourly, daily, weekly, or monthly intervals.

• Custom – Run a report on a custom range in which you specify 
the start and end dates. Reports covering a custom range can 
be broken down into 15-minute, hourly, daily, weekly, or 
monthly intervals, depending on the start date and end date 
that you specify. 

NOTE:  If you selected the Report over midnight check box in 
step 2, the ranges appear as <Range>, Including Previous Day. 
In each case, the Start date provided by the system will be one day 
before the start of the selected range. For example, if you select 
This Month, Including Previous Day, the Start date will be the 
last day of the previous month. Also, when the Report over 
midnight check box is selected, the report can only be broken 
down into 15-minute and hourly intervals.
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4. If you selected Custom, in the Start date and End date boxes, 
type the start and end dates of the range. When the Report over 
midnight check box is selected, the start date cannot be the same 
as the end date. 

5. In the Interval list, select the interval for which you want subtotals 
displayed within the range of the report. Refer to the descriptions in 
step 3, above. 

NOTE:  If you select <None> for the interval, the report will be 
generated using the 15-minute statistics. This can cause the report 
to fail if the number of database records used to generate the report 
exceeds the maximum.

6. In the Start time and End time boxes, specify only that part of the 
day that you want the report to cover. This is useful if your contact 
center is active only during part of the day or if you want to target 
particular shifts. The values are entered using a 24-hour clock. 
When the Report over midnight check box is selected, the Start 
time must be equal to or later than the End time. Some examples 
are as follows:

• 09:00 to 17:00 – The report will cover between 9:00 A.M. and 
5:00 P.M. on the same day. 

• 08:00 to 08:00 – The report will cover the 24-hour period. 

• 23:00 to 07:00 – The report will cover between 11:00 P.M. on 
one day to 07:00 A.M. on the next day. This configuration is only 
possible when the the Report over midnight check box is 
selected. 

NOTE:  To specify 23:59 as the End time, select the End of day 
check box. When the Report over midnight check box is selected, 
the End of day check box is unavailable. 

7. If multiple locations are configured, in the Use time zone of list, 
select the time zone option that you want to use to generate the 
contents of the report. Your choices are:

• If you are on a main server machine and you are configuring a 
user, routing state reason, Wrap-up reason, or Post-processing 
reason report, your choices are Local site or User location. If 
you are configuring any other type of report on a main server 
machine, the Use time zone of list is not available. 
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• If you are on a central reporting server machine, for all historical 
report types, your choices are Remote site or Central 
reporting site. 

• If you are on a central reporting server machine, and you are 
configuring a user, routing state reason, Wrap-up reason, or 
Post-processing reason report, your choices are Remote site, 
User location, or Central reporting site. 

NOTE:  On a central reporting server machine, if you select 
Remote site or User location and you select a Weekly interval, 
the Start date and End date will be based on the first day of the 
week configured at each remote site.

NOTE:  If you select User location, you cannot report by queue or 
by aggregate in a Wrap-up reason historical report, as described in 
step 5 of Section 7.7.2.3, “Selecting the resources for a historical 
report”, on page 98. 

8. If you are finished working with this report definition, click OK. 

7.7.2  Selecting the content for a report

A report definition must specify the resources that you want to report 
on. The resources that you can select depend on the type of report you 
are configuring and can include users, groups, queues, destinations, 
and so on. For details, see the following topics:

• Section 7.7.2.1, “Selecting the resources for a real-time report”, on 
page 94

• Section 7.7.2.2, “Selecting the resources for a cumulative report”

• Section 7.7.2.3, “Selecting the resources for a historical report”, on 
page 98

Each report can contain up to 100 resources; however, selecting a large 
number of resources will decrease system performance. 

NOTE:  You can report only on the resources for which you have been 
assigned monitoring permission (see Section 7.5, “Monitoring 
permissions and reporting”, on page 87). 
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7.7.2.1  Selecting the resources for a real-time report

You can select different resources depending on the type of real-time 
report you are configuring. 

To select the resources for a real-time report:

1. In the Report Center, under Definitions, select the report type, 
then, in the right pane, double-click the report definition that you 
want to configure. 

2. Click the Content tab. The Content tab will display a list of 
resources, depending on the type of report you are defining. The 
Content tab will list only the resources that you have permission to 
monitor.

3. For a queue real-time report, use the Report by box to specify the 
level at which the resources can be selected: 

• Queues – The report will contain the queues you select in the 
list. 

• Aggregates – The report will contain the aggregates you select 
in the list. 

4. For a user real-time report, use the Select By box to specify the 
level at which the resources can be selected: 

• User – The report will contain the users selected in the list. 

• Group or Virtual Group – The report will contain all users who 
are members of the groups (or virtual groups) you select and 
that you have permission to monitor. 

• Department – The report will contain all users who are 
members of the departments you select and that you have 
permission to monitor. 

5. In the list of resources, select the check box for each resource that 
you want to include in the report. 

NOTE:  When you are editing a user report where both the Report 
by and Select by options are User, the users in the list who are 
associated with a user template are read-only. If you want to 
remove one of those users from the report, you must either break 
the user's association with the user template, or remove the report 
from the user template and update all users (in which case, all users 
associated with the user template will be removed from the report).
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6. For a user real-time report, under Exclude Users, select the 
Exclude logged off users check box to exclude any users that are 
logged off the system from the report. 

7. For a contact real-time report, under Contact Options, select the 
Include processing before queued contact check box if you 
want the contacts that have just arrived in the contact center and 
are still being processed to be included in the report. If this option 
is not selected, the contacts will not appear in the report until they 
have been enqueued. 

8. If you are finished working with this report definition, click OK.

7.7.2.2  Selecting the resources for a cumulative 
report

You can select different resources depending on the type of cumulative 
report you are configuring. 

To select the resources for a cumulative report:

1. In the Report Center, under Definitions, select the report type, 
then, in the right pane, double-click the report definition that you 
want to configure. 

2. Click the Content tab. The Content tab will display a list of 
resources depending on the type of report you are defining. The list 
will contain only the resources that you have permission to monitor.

3. For a queue or callback cumulative report, use the Report by list 
to select the level at which the statistics are reported:

• Queue – The report will display statistics at the queue level. 

• Aggregate – The report will display statistics at the aggregate 
level.

4. For a callback cumulative report, use the Select by list to select the 
level at which the resources can be selected:

• Queue/Aggregate – The report will contain the queues or 
aggregates (depending on your selection in step 3, above) you 
select. 

• Origin – The report will contain the queues or aggregates 
(depending on your selection in step 3, above) that contain 
callbacks that were created in the ways you select. 
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5. For a user or routing state reason cumulative report, use the 
Report by box to select the level of detail in the report: 

• User – The report will display full user identification information 
and statistics.

• Department – The report will display statistics only at the 
department level. User identification and detailed user statistics 
are suppressed. 

• Site – The report will display statistics only at the site level. User 
and department identification and detailed department and user 
statistics are suppressed. 

6. For a Wrap-up reason cumulative report, use the Report by box to 
select the level of detail in the report:

• User – The report will display full user identification information 
and statistics.

• Department – The report will display statistics only at the 
department level. User identification and detailed user statistics 
are suppressed. 

• Site – The report will display statistics only at the site level. User 
and department identification and detailed department and user 
statistics are suppressed. 

• Queue – The report will display statistics only at the queue 
level. User and department identification and detailed 
department and user statistics are suppressed. 

• Aggregate – The report will display statistics only at the site 
level. User and department identification and detailed 
department and user statistics are suppressed.

NOTE:  The Report by options described in steps 5 and 6, above, 
are available only within the constraints of the reporting level for 
your site (see Section 7.6, “Reporting level”, on page 88). For 
example, if your site uses the Department reporting level, you 
cannot generate reports at the User level. The Report by options 
are also affected by your monitoring permissions. For example, if 
you have permission to monitor only two users, you can generate 
user reports with statistics on those two users only. 
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7. If you selected User in step 5 or step 6, use the Select by list to 
choose the level at which the users can be selected: 

• User – The report will display statistics for the users you select 
in the list. 

• Group (group-based routing) – The report will display statistics 
for all users who are members of the groups you select and that 
you have permission to monitor.

• Virtual Group (skills-based routing) – The report will display 
statistics for all users who are eligible to handle contacts based 
on the skill expression in the virtual groups you select, and that 
you have permission to monitor. 

• Department – The report will display statistics for all users who 
are members of the departments you select and that you have 
permission to monitor. 

8. In the list of resources, select the check box for each resource that 
you want to include in the report. 

NOTE:  When you are editing a user report where both the Report 
by and Select by options are User, the users in the list who are 
associated with a user template are read-only. If you want to 
remove one of those users from the report, you must either break 
the user's association with the user template, or remove the report 
from the user template and update all users (in which case, all users 
associated with the user template will be removed from the report).

9. If you are finished working with this report definition, click OK.

7.7.2.3  Selecting the resources for a historical 
report

You can select different resources depending on the type of historical 
report you are configuring. 

To select the resources for a historical report:

1. In the Report Center, under Definitions, select the report type, 
then, in the right pane, double-click the report definition that you 
want to configure. 

2. Click the Content tab. The resources that can be reported on (for 
example, users, queues, or destinations) are displayed. The 
Content tab will display only the resources that you have 
permission to monitor.
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3. For a queue historical report, use the Report by list to select the 
level at which the queues can be selected:

• Queue – The report will display statistics for the queues you 
select in the list. 

• Queue by User – The report will display statistics for the 
queues you select in the list, with details for the users within 
each queue. 

• Aggregate – The report will display statistics for the aggregates 
you select in the list. 

4. For a user or routing state reason historical report, use the Report 
by box to select the level of detail in the report: 

• User – The report will display full user identification information 
and statistics.

• User by Queue (not available for a routing state reason report) 
– The report will display full user identification information and 
statistics, with details for each queue from which the contact 
was assigned. 

• Department – The report will display statistics only at the 
department and site level. User identification and detailed user 
statistics are suppressed. 

• Site – The report will display statistics only at the site level. User 
and department identification and detailed department and user 
statistics are suppressed. 

5. For a Wrap-up reason historical report, use the Report by box to 
select the level of detail in the report:

• User – The report will display full user identification information 
and statistics.

• Department – The report will display statistics only at the 
department level. User identification and detailed user statistics 
are suppressed. 

• Site – The report will display statistics only at the site level. User 
and department identification and detailed department and user 
statistics are suppressed. 
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• Queue – The report display statistics only at the queue level. 
User and department identification and detailed department and 
user statistics are suppressed.

• Aggregate – The report will display statistics only at the 
aggregate level. User and department identification and detailed 
user and department statistics are suppressed. 

NOTE:  The Report by options described in step 4 or step 5, 
above, are available only within the constraints of the reporting 
level for your site (see Section 7.6, “Reporting level”, on page 88). 
For example, if your site uses the Department reporting level, you 
cannot generate reports at the user level. The Report by options 
are also affected by your monitoring permissions. For example, if 
you have permission to monitor only two users, you can generate 
user reports with statistics on those two users only. 

6. For a callback historical report, use the Report by box to select the 
level at which the callbacks statistics are reported: 

• Queue – The report will display callback statistics for the queues 
you select in the list. 

• Aggregate – The report will display callback statistics for the 
aggregates you select in the list. 

• Disposition – The report will display statistics for all callbacks 
that have the dispositions you select in the list. 

7. If you selected User or User by Queue in step 4 or step 5, use the 
Select By list to choose the level at which the users can be 
selected: 

• User – The report will display statistics for the users you select 
in the list. 

• Group (group-based routing) – The report will display statistics 
for all users who are members of the groups you select and that 
you have permission to monitor.

• Virtual Group (skills-based routing) – The report will display 
statistics for all users who are eligible to handle contacts based 
on the skill expression in the virtual groups you select, and that 
you have permission to monitor. 

• Department – The report will display statistics for all users who 
are members of the departments you select and that you have 
permission to monitor. 
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8. If you selected Queue in step 6, use the Select By list to choose 
the level at which the queues can be selected: 

• Queue – The report will display statistics for the queues you 
select in the list. 

• Origin – The report will display statistics for all callbacks that 
originated in the ways you select in the list. 

9. If you selected Aggregate in step 6, use the Select By list to 
choose the level at which the aggregates can be selected: 

• Aggregate – The report will display statistics for the aggregates 
you select in the list. 

• Origin – The report will display statistics for all callbacks that 
originated in the ways you select in the list. 

10.In the resulting list of resources, select the check box for each 
resource that you want to include in the report. 

NOTE:  When you are editing a user report where both the Report 
by and Select by options are User, the users in the list who are 
associated with a user template are read-only. If you want to 
remove one of those users from the report, you must either break 
the user's association with the user template, or remove the report 
from the user template and update all users (in which case, all users 
associated with the user template will be removed from the report).

11.For a contact historical report, or if you selected Queue by User in 
step 3 or User by Queue in step 4, select the Include contact 
record detail in this report check box to have the report include 
state and activity data. This check box is available only if the 
selected interval is daily, weekly, or monthly (see Section 7.7.1.2, 
“Specifying the range for a historical report”, on page 91). 

NOTE:  If you select this check box, and the number of database 
records used to generate the report exceeds 10,000, the report will 
fail. The failed report will appear in the Failed folder with a 
message indicating that the number of records used to generate the 
report exceeded the maximum. To generate the report successfully, 
you must either select fewer resources to report on or reduce the 
range of the report to cover a shorter time period. 

12.If you are finished working with this report definition, click OK.
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7.7.3  Specifying the columns in a report

You can choose the statistics you want to appear as columns in your 
reports, as well as the order in which they appear. The statistics that 
are available for selection depend on the resources on which you are 
reporting (see Section 7.7.2, “Selecting the content for a report”, on 
page 94). 

To specify the columns in a report:

1. In the Report Center, under Definitions, select the report type, 
then, in the right pane, double-click the report definition that you 
want to configure. 

2. Click the Columns tab. The tab lists all the statistics you can display 
in the report.

3. Under Columns, do the following:

a) In the Report on list, select the media you want to report on. 

b) Select the check box for each column that you want to appear 
in the report. For descriptions of the columns you can select, see 
the Reporting Reference Guide. 

NOTE:  The column that identifies the resource being reported 
on is selected by default and cannot be cleared. In the case of 
user reports, either the Name or User ID check box must be 
selected. The application will not allow you to clear both check 
boxes.

c) The top to bottom order of the statistics in the list reflects the 
left to right order in which the columns appear in the report. To 
change the order of the columns, click anywhere in the row (not 
in the check box) to select the row, and then click the up or down 
arrow key to the right of the list to move the row up or down, 
respectively. 

d) When the system is configured for multiple contact handling, 
you can configure a user real-time report to contain information 
about the primary active contact only in the columns related to 
handling states. To do this, select the Show primary contact 
details only check box. When the box is cleared, the report will 
contain information about both primary and non-primary active 
contacts.
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4. Under Sort, do the following:

• In the Sort By list, select the column on which to sort the data 
in the report.

• In the Sort Order list, select the sort order (Ascending or 
Descending) for the report. 

5. If you are finished working with this report definition, click OK.

7.7.4  Setting thresholds and alarms in a 
report

Real-time and cumulative reports have an alarm mechanism that can 
alert you to key values in a report. You can set a threshold on a 
particular statistic in a report and, when the threshold is exceeded, a 
visible or audible alarm draws your attention to that statistic value. 
Alarm actions include logging a message to the System Messages 
window, color highlighting in the appropriate column of the report 
table, and playing a .wav file. 

NOTE:  The color highlighting alarm action cannot be displayed in a bar 
chart.

You can set thresholds only on threshold-eligible statistics. To 
determine if you can set a threshold on a statistic, see the description 
of the statistic in the Reporting Reference Guide. 

NOTE:  To set thresholds in a report, you must have the Set view and 
report thresholds Manager permission. 
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You can set up to three different conditions for a statistic for low, 
medium, and high thresholds. For example, you could set the following 
conditions on a Contacts - Queued statistic: 

• Highlight the value in blue when the number of contacts waiting is 
greater than 5.

• Highlight the value in yellow when the number of contacts waiting 
is greater than 10.

• Highlight the value in red when the number of contacts waiting is 
greater than 15.

NOTE:  Before setting thresholds and alarms, you must first specify 
the columns to be displayed in the report (see Section 7.7.3, 
“Specifying the columns in a report”, on page 101). 

To set a threshold and alarm in a report: 

1. In the Report Center, under Definitions, select the report type, 
then, in the right pane, double-click the report definition that you 
want to configure. 

2. Click the Thresholds tab. 

3. Under Defined Thresholds, the application lists all existing 
threshold definitions for this report. 

• To create a new threshold, click Add. 

• To edit an existing threshold, select the threshold in the list and 
click Edit.

4. In the Variable Threshold dialog box, in the Statistics list, select 
the name of the statistic for which you want to set a threshold. The 
list contains only threshold-eligible statistics. 

5. If you selected a state statistic, in the State list, select the state 
with which you want to associate the threshold.

6. In the Contact Type list, select the contact type with which you 
want to associate the threshold. 

7. Select the Active check box to activate the threshold on this 
statistic. 

8. Depending on the type of resource you are reporting on (see 
Section 7.7.2, “Selecting the content for a report”, on page 94), 
select the check box for each resource for which the threshold will 
be displayed. For example, if you are configuring a user real-time 
report, under Users, select the check box for each user for which 
you want the threshold to be displayed.
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9. Click the Thresholds tab.

10.Under Activity, in the Range list, select the threshold range for 
which you want to set the alarms: Low, Medium, or High. 

11.If you selected the Medium or High threshold range, select the 
Active check box to activate the alarm on the range. You cannot 
clear the Active check box on the Low range – it is selected by 
default. 

12.In the Threshold box, type or select the threshold value. 

13.In the Action area, select the check box for each alarm you want 
to set for the threshold range:

• If you want to log a system message each time the threshold is 
exceeded, select the Log Alarm to System Messages 
window check box.

• If you want to highlight the text in a different color each time 
the threshold is exceeded, select the Change color check box 
and select a color from the list. 

• If you want to play a sound file each time the threshold is 
exceeded, select the Play a sound file check box, type the 
name of the .wav file stored on the main server machine. If you 
are on the main server machine, you can browse to select the 
.wav file. 

NOTE:  If you are connected to a production database, you can 
click  to play the .wav file. You cannot play .wav files when 
you are connected to a design database.

14.Repeat steps 10 to 13 for each threshold range you want to 
configure.

15.Under Summary, view the threshold ranges and alarms you have 
set. 

16.Click OK to close the Variable Threshold dialog box. The threshold 
is displayed in the Defined Thresholds list. 

17.If you are finished working with this report definition, click OK.
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7.7.5  Specifying a bar chart in a report

All types of reports can contain a bar chart for a single statistic. Only 
some of the statistics in a report can be charted. To determine if a 
statistic can be charted, see the description of the statistic in the 
Reporting Reference Guide.

NOTE:  The color highlighting alarm action for a statistic cannot be 
displayed in a bar chart. For details, see Section 7.7.4, “Setting 
thresholds and alarms in a report”, on page 102. 

NOTE:  Before setting the charting options, you must first specify the 
columns to be displayed in the report (see Section 7.7.3, “Specifying 
the columns in a report”, on page 101). 

NOTE:  On a central reporting server machine, when you run a report 
based on the time zone of a remote site and you select a weekly 
interval, if the first day of the week setting configured on the central 
reporting server machine is different from the setting configured on 
one of the remote sites, charts cannot be rendered.

To specify a bar chart in a report:

1. In the Report Center, under Definitions, select the report type, 
then, in the right pane, double-click the report definition that you 
want to configure. 

2. Ensure that charting is enabled: on the General tab, under 
Attributes, select the Chart check box. 

3. Click the Chart tab. 

4. Under Settings, in the Statistic list, select the name of the 
statistic that you want to chart. The list contains only the columns 
that can be charted. 

5. In the Bar Color list, select the color of the bars in the chart. You 
can select only one color for all the bars. 

6. In the Style area, select the style of the bars: 2D or 3D. 

7. For cumulative reports only, you can display a trend line on the 
chart. Select the Show trend check box and then specify the 
properties of the trend line, as follows:
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• In the Trend box, choose Yesterday to display a trend line 
based on yesterday's statistics or choose Same Day Last Week 
to display a trend line based on statistics from seven days ago. 

• In the Line style list, select Straight or Smooth.

• In the Line color list, select the color of the trend line.

• Select the Data points check box if you want the trend line to 
show key data points.

8. Under Preview, view the choices you have made for your bar chart. 

9. If you are finished working with this report definition, click OK.

7.7.6  Scheduling a historical report

You must submit the reports that you want to execute to the Scheduler. 
The Scheduler is the component responsible for scheduling reports, 
queuing reports to execute, and maintaining the completed reports. 

NOTE:  To schedule a historical report, you must have the Schedule 
and view historical reports Manager permission. 

If a scheduled report executes while you are not logged on to the 
Manager application, the next time you log on you will be prompted to 
transfer the completed report to the local machine. At that time, the 
report will be output as specified in the report definition. The system 
keeps completed reports for up to seven days. 

NOTE:  If you encounter issues when trying to view or print a historical 
report, export a historical report to a file, or send a historical report by 
e-mail, it may be due to a network issue. For assistance, contact your 
network administrator. 
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You can schedule a historical report to: 

• Run immediately – see Section 7.7.6.1, “Scheduling a report to run 
immediately”, on page 107

• Run at a specific date and time – see Section 7.7.6.2, “Scheduling 
a report to run once at a specific date and time”, on page 107

• Run on a regular basis – see Section 7.7.6.3, “Scheduling a report 
to run on a regular basis”, on page 108

NOTE:  If you modify a scheduled historical report, in addition to 
saving the report definition, you must also resubmit the report to the 
Scheduler. 

7.7.6.1  Scheduling a report to run immediately

When you configure a historical report, you can schedule the report to 
run immediately. 

To run a report immediately:

1. In the Report Center, under Definitions, select the report type, 
then, in the right pane, double-click the report definition that you 
want to configure. 

2. Click the Schedule tab.

3. In the Run the report list, select Now. 

4. Click Submit to Scheduler. The report will run with the destination 
and format specified on the Output tab. 

7.7.6.2  Scheduling a report to run once at a specific 
date and time

When you configure a historical report, you can schedule the report to 
run at a specific date and time.

To schedule a report to run once: 

1. In the Report Center, under Definitions, select the report type, 
then, in the right pane, double-click the report definition that you 
want to configure. 

2. Click the Schedule tab.
 A31003-S22B1-M103-08-76A9, 04/2025
108 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



reporting.fm

Reporting
Configuring a report
3. In the Run the report list, select One Time. The tab is updated to 
allow you to specify when your report is to run.

4. In the Date list, select the date when the report is to run.

5. In the Time list, specify the time when you want the report to run. 
The format is based on a 24-hour clock, for example, 4:00 P.M. is 
entered as 16:00.

6. Click Submit to Scheduler. The report will run with the destination 
and format specified on the Output tab. 

7.7.6.3  Scheduling a report to run on a regular basis

When you configure a historical report, you can schedule the report to 
run on a regular basis. 

To schedule a report to run on a regular basis: 

1. In the Report Center, under Definitions, select the report type, 
then, in the right pane, double-click the report definition that you 
want to configure. 

2. Click the Schedule tab.

3. In the Run the report list, select More Than once. The tab is 
updated to allow you to specify when your report is to run.

4. Use one of the following methods to schedule how often the report 
is to run:

• Click Daily and then select the check box beside each day of the 
week when you want the report to run. In the Time box, type 
or select the time of day when the report is to run. 

• Click Weekly and then, from the Day list, select the day of the 
week when you want the report to run. In the Time box, type 
or select the time of day when the report is to run.

• Click Monthly and then, from the Day list, select one of the 
following: Last Day to generate the report on the last day of the 
month, or Specific Day and then choose a date in the month 
from the box that appears. In the Time box, type or select the 
time of day when the report is to run.

NOTE:  The format of the Time box is based on a 24-hour clock, 
for example, 4:00 P.M. is entered as 16:00.

5. Use one of the following methods to specify the duration of this 
report schedule:
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• To run the report indefinitely, click the Forever.

• To apply the schedule for a fixed length of time, click Custom 
and then use the Start and End lists to specify the start and end 
dates.

6. Click Submit to Scheduler. The report will run with the destination 
and format specified on the Output tab. 

7.7.7  Specifying the output options for a 
report

Real-time and cumulative reports are normally designated for online 
viewing, whereas historical reports can be viewed online, printed, 
exported to a file, or sent as an attachment in an e-mail message. For 
more information, see the following topics:

• Section 7.7.7.1, “Specifying the output options for a real-time or 
cumulative report”, on page 109 

• Section 7.7.7.2, “Specifying the output options for a historical 
report”, on page 110

7.7.7.1  Specifying the output options for a real-time 
or cumulative report

Real-time and cumulative reports can be designated for online viewing 
only because they contain information that is updated in real time. 
However, if you need a hard or soft copy of a real-time or cumulative 
report, you can print a copy or save it to a file while viewing it online. 
In these cases, you use the Output tab to specify the printer that is 
used when you print the report from the screen. You can also specify 
the format and file name to be used when you save a copy of the report 
to the hard drive. 

The default output settings for reports are specified in the user 
reporting options. For details, see Section 7.12.1, “Configuring the 
general user reporting options”, on page 129). However, you can 
override the default settings when you configure the output options for 
the report. 
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To specify the output options for a real-time or cumulative 
report: 

1. In the Report Center, under Definitions, select the report type, 
then, in the right pane, double-click the report definition that you 
want to configure. 

2. Click the Output tab. 

3. Under Default Output Settings, the View report option is 
selected by default and cannot be changed.

4. Under Output Mode Settings, in the Output mode list, select the 
output mode for which you want to change the default settings. 

5. If you selected Print report in step 4, do the following:

• In the Printer name list, select the printer where you want the 
report to be printed. 

• To specify the formatting options, such as page orientation, 
headers, and footers, click Advanced.  

6. If you selected Export report in step 4, do the following:

• In the Format list, select the file format of the report. Your 
choices are Modern Microsoft Excel Workbook (.xlsx), Web Page 
(.htm), CSV (Comma Delimited) (.csv), or Portable Document 
Format (.pdf), Old Microsoft Excel Workbook (.xls). 

• In the File Name box, specify the location and name of the file 
to which you want to export the report. You must include the full 
path to the exported file, for example, C:\filename. 

• To specify the formatting options, such as page orientation, 
headers, and footers, click Advanced.  

7. If you are finished working with this report definition, click OK.
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7.7.7.2  Specifying the output options for a historical 
report

When you configure a historical report, you can designate the report to 
be viewed online, printed, exported to a file, or sent to one or more 
recipients by e-mail. Regardless of the output mode, completed 
historical reports are sent to a specified report folder. 

NOTE:  The option to send a historical report by e-mail is available only 
if the e-mail reports option is enabled, and you have the E-mail 
historical reports Manager permission. For details on how to enable 
the e-mail reports option, see Section 7.13.5, “Configuring the e-mail 
reports option”, on page 138. 

The default output settings for reports are specified in the user 
reporting options. For details, see Section 7.12.1, “Configuring the 
general user reporting options”, on page 129. However, you can 
override the default settings when you configure the output options for 
the report. 

To specify the output options for a historical report: 

1. In the Report Center, under Definitions, select the report type, 
then, in the right pane, double-click the report definition that you 
want to configure. 

2. Click the Output tab. 

3. Under Default Output Settings, in the Output folder list, select 
the report folder where you want to send the completed report. You 
can choose the default Report Inbox or a custom report folder. 

4. In the Output mode list, select the default output mode for the 
report: 

• View report – The report is available for online viewing only. 

• Print report – The report is sent to a printer.

• Export report – The report is exported to a file. 

• E-mail report – The report is attached to an e-mail message 
and sent to one or more recipients. 

5. Under Output Mode Settings, in the Output mode list, select the 
output mode for which you want to change the default settings. 
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6. If you selected Print report in step 5, do the following:

• In the Printer name list, select the printer where you want the 
report to be printed. 

• To specify the formatting options, such as page orientation, 
headers, and footers, click Advanced.  

7. If you selected Export report in step 5, do the following:

• In the Format list, select the file format of the report. Your 
choices are Modern Microsoft Excel Workbook (.xlsx), Web Page 
(.htm), CSV (Comma Delimited) (.csv), or Portable Document 
Format (.pdf), Old Microsoft Excel Workbook (.xls). 

• In the File Name box, specify the location and name of the file 
to which you want to export the report. You must include the full 
path to the exported file, for example, C:\filename. 

• To specify the formatting options, such as page orientation, 
headers, and footers, click Advanced.  

8. If you selected E-mail report in step 5, do the following:

• In the From box, the application displays the outgoing e-mail 
address specified in the default output settings. You cannot edit 
the e-mail address. 

• Specify the e-mail recipients. 

– To select a recipient from an LDAP directory, click To, Cc, or 
Bcc, and select the recipient in the Select Recipients dialog 
box. To use this feature, a directory must already be 
configured. For details, see Section 5.5, “Configuring a 
directory”. 

– In the To, Cc, or Bcc boxes, type the e-mail address of the 
recipient. To type an e-mail address, you must have the 
Type e-mail address into Recipient field when 
e-mailing reports Manager permission. 

– To specify more than one recipient in each of the To, Cc, or 
Bcc boxes, separate each recipient with a semi-colon.

• In the Subject box, type the subject of the e-mail message. By 
default, the subject is the name of the report. 
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• In the Message box, type the body of the e-mail message in 
plain text only. By default, the message contains the signature 
specified in the default output settings. 

• In the Format list, select the format of the report that is 
attached to the e-mail message. Your choices are Modern 
Microsoft Excel Workbook (.xlsx), Web Page (.htm), CSV 
(Comma Delimited) (.csv), or Portable Document Format (.pdf), 
Old Microsoft Excel Workbook (.xls). 

• In the File name box, specify the name of the attached file. The 
default file name is the name of the report with an extension 
that corresponds to the selected file format. 

• To specify the formatting options of the report, such as page 
orientation, headers, and footers, click Advanced.  

9. If you are finished working with this report definition, click OK.

7.8  An exercise in creating a simple real-time report

In Section 7.1, “About real-time reports”, on page 80, you saw a simple 
queue real-time report that displayed and categorized the current 
contacts waiting for a set of queues. 

The following topics walk you through the process of creating and 
activating this report. This exercise is intended for practise purposes 
only. 

Before you begin:

• Ensure that the system is running and your contact center is active. 
This is required to generate reports with live data. 

• If you are a supervisor, you will be reporting on and monitoring 
resources such as queues and individual users. You will need 
permission to monitor these resources. To ensure that you have 
been granted these permissions, contact your administrator. 
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7.8.1  Creating a new report definition

The first step in creating a report is to specify a definition for the report, 
including the report type and the administrative details. 

To create a new report definition:

1. In the Report Center, under Definitions, click Queues. 

2. On the File menu, point to New, then Report Center, and then 
click Queue Report. 

3. In the Type list, select Real-time. The tabs on the Queue Report 
dialog box reflect the various properties of a real-time report.

4. In the Name box, type My Queue Real-Time Report.

5. The owner can be you or any of the users you have permission to 
monitor. The report will be available to the owner whenever the 
owner logs on to the Manager application. For now, you can keep 
ownership of the report. Since this is the default option, no action 
is necessary. 
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7.8.2  Specifying the layout of the report

The most important part of the report is the set of columns displayed. 
This is the set of identifiers and statistics in the report and their 
sequence. 

To specify the layout for the report:

1. Click the Columns tab.

2. Select the Name, Contacts-Queued, Service Level-Current, 
Service Level-Estimated, Wait Time- Estimated Answer check 
boxes. Each of the statistics associated with the check boxes 
corresponds to a column that can appear in the report. The top to 
bottom sequence of columns options corresponds to the left to right 
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sequence of the columns in the report. Since the columns you want 
displayed are already in the sequence you want them displayed, 
specifying the layout is easy.

NOTE:  The Name check box is automatically selected and cannot 
be cleared. Each report, regardless of the resource being reported 
on, must include an identifier for the key resource.

7.8.3  Choosing the queues to report on

The queues that you can monitor and report on depend on your role. 
For example, if you are a contact center supervisor, the OpenScape 
Contact Center administrator will have given you permission to monitor 
one or more queues. 

To choose the queues you want to report on:

1. Click the Content tab. 

2. Click Select All.

7.8.4  Setting a threshold and an alarm

The report you are creating will show an alarm on the In Queue 
column. In a real-life situation in which you were using several real-
time reports to monitor several sets of resources, this is the visible 
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alarm that draws your attention to the report and to the specific column 
values. For more information, see Section 7.7.4, “Setting thresholds 
and alarms in a report”, on page 102. 

To set the alarm in your report:

1. Click the Thresholds tab.

2. Click Add.

3. In the Variable Threshold dialog box, you can choose the column 
where you want to set the alarm. In the Statistic list, select 
Contacts - In Queue. This is the column where you want to set an 
alarm.

NOTE:  The only items available in the Statistic list, are the items 
that you selected on the Columns tab that support a threshold 
value. For example, the Name column does not appear in the list, 
as thresholds cannot be set on the queue name. 

4. You can also specify that the alarm should only be displayed for 
certain queues. The names that you see in the Queues area are the 
queues at your site that you have permission to report on. Click 
Select All. This indicates that the alarm will apply to all the queues 
that you selected on the Contents tab.
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5. Click the Thresholds tab. This is where you provide the details of 
your alarm. You can configure up to three levels of alarm. For now, 
a single alarm level will be sufficient. You will have to disable the 
other two alarms. 

6. In the Range list, select High.

7. Clear the Active check box to disable the alarm at the High level. 
The settings for the Medium alarm are shown.

8. Clear the Active check box to disable the alarm at the Medium 
level. The settings for the Low alarm are shown. 

9. In the Threshold box, type or select 1 as the threshold value for 
your alarm. Your alarm will be displayed whenever the Contacts - 
Queued column value is greater than one. 

10.Click the Change color check box and then select red as the color 
to display when the Contacts - Queued column value is greater than 
one. 

11.Click OK to close the Variable Threshold dialog box. 

12.Your report definition is now complete. Click OK to close the report 
definition. 
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7.8.5  Activating and viewing the report

To view your report, you must first activate it. You activate the report 
by adding it to a view located in the Report Views folder.

To activate the report: 

1. In the Report Center, under Output, click the Report Views 
folder. The list is updated to show the contents of the Report Views 
folder.

NOTE:  Unless you are the OpenScape Contact Center 
administrator, your Real-Time folder is probably empty. 

2. On the toolbar, click  (New). A Report View dialog box appears.

3. In the Name box, type My Real-Time Reports.

4. In the Default Layout list, select 1-Single.

5. Click Add. A Select Report dialog box appears.

6. In the Report Type list, select Queues.

7. In the Displayed Reports list, click My Queue Real-Time Report 
to select it, and the click Add.

8. Click Close to close the Select Report dialog box.
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9. Click OK to close the Report View dialog box.

10.Double-click the My Real-Time Reports report view. The Real-
time Viewer opens. 

You have now successfully finished working through your first report. 

7.9  An exercise in adapting a predefined historical report

Making a copy of an existing predefined report and then modifying it is 
often more efficient than creating a new report. The following sections 
walk you through the process of adapting the Queue Summary 
Report (a predefined queue historical report) to address a slightly 
different reporting requirement.

Consider a real-world situation involving your queue configuration. A 
Borrowing queue might have a Mortgages group as its primary group 
and a Savings group as its overflow group. If you monitored the 
Borrowing queue with a real-time report on a daily basis, you might 
notice a daily trend towards more contacts waiting in queue. This could 
mean several things. There might simply be increased traffic from 
customers interested in mortgages as a result of a recent sales or 
advertising campaign. You might be inadequately staffed with regards 
to users who are experts in handling mortgage-related contacts. Or you 
might have to change the step time in your queue configuration, or 
adjust the associated workflow. 

A queue historical report contains statistics that could help you 
investigate further. The following is an example of a queue historical 
report with the basic information you need to get started.

Week-by-week reports for a period of three or four months might help 
you diagnose any trends. Based on the information contained in those 
reports, you might use other reports to examine the trends more 
closely. Historical reports on users might be the next step.

The predefined Queue Summary Report is a close approximation to 
the report shown above. In this exercise, you will modify the Queue 
Summary Report for use in inspecting the problems discussed above.
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7.9.1  Creating a copy of the predefined 
report

The first step is to create a copy of the Queue Summary Report. 

To create a copy:

1. In the Report Center, under Definitions, click Queues. 

2. In the list, click Queue Summary Report to select that report.

3. On the Edit menu, click Create Copy. 

4. In the Queue Summary Report dialog box, in the Name box, 
change the name to Queue Summary Report Sample. 
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7.9.2  Specifying the range for the report

Range and scheduling are closely related properties of a historical 
report. While the range dictates the length of time covered in the 
report, scheduling specifies when the report will be run. For example, 
if you are interested in daily reports (range), you might want to have 
the report for each day run at 10:00 A.M. the following day (schedule). 
You will set your new historical report to have a range of one day and 
have it run immediately. 

To specify the range for this report:

1. Click the Range list to display the range options. Leave the 
Yesterday option selected. 

2. For each queue in the report, statistics will be shown broken down 
by the interval you choose over the range of your report. If you 
were interested in fine detail, you could produce a report with 15-
minute intervals. In the interest of producing a simple report 
definition, an hourly interval will do. In the Interval list click 
Hourly. 

3. Your report should show only those times when the contact center 
is open. If you want, use the Start Time and End Time boxes to 
choose a different daily period to be covered in the report. 

7.9.3  Scheduling the report

You schedule daily reports to run at a specified time on the day 
following the day that the report is to cover. For example, if you are 
concerned about minimizing the load on the system, you might run the 
report for the previous day at a time when the contact center is not 
open, such as 4:00 A.M. 

For this exercise, you can leave the default Now option selected on the 
Schedule tab. For a description of the other options, see Section 7.7.6, 
“Scheduling a historical report”, on page 106. 

7.9.4  Specifying the layout of the report

The next task is to specify the columns that will be displayed in your 
report, and their sequence. Each type of historical report presents a 
large variety of statistics that you can use as columns in your report. 
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To bring this report in line with the report shown on page 119, you will 
have to remove some statistics from the current definition, add others, 
and change the ordering. 

To specify the layout of your report:

1. Click the Columns tab.

2. Clear the check boxes for the following unnecessary statistics:

3. Select the check boxes for the following statistics you want to 
include:

4. Select the Service level statistic. Do not clear the check box.

5. Click the up arrow at the right of the dialog box until the Service 
level statistic is immediately below the Name statistic.

Column Category

Redirected Out of Scope

Abandoned Abandoned Contacts

All Average Wait Time

Column Category
Primary Answered Contacts
Overflow Answered Contacts
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6. Repeat steps 4 and 5 to move the Abandon Rate statistic to 
immediately below the new location of the Service Level statistic. 
Your Columns tab should now appear as follows:
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7.9.5  Specifying the output options for the 
report

Typically, historical reports are printed. You can, however, specify other 
destinations for a historical report. For details, see Section 7.7.7.2, 
“Specifying the output options for a historical report”, on page 110. 

The default output mode of View report on the Output tab will work 
well for this exercise. 
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7.9.6  Choosing the queues to report on

The queues that you can monitor and report on depend on your role. 
For example, if you are a contact center supervisor, the OpenScape 
Contact Center administrator will have given you permission to monitor 
one or more queues. 

To choose the queues you want to report on:

1. Click the Content tab. It includes entries for all the queues that you 
have permission to monitor. 

2. Click Select All. 

7.9.7  Running the report

Your report definition is now complete. The remaining task is to run the 
report. Historical reports are managed by the Scheduler. For more 
information, see Section 7.7.6, “Scheduling a historical report”, on 
page 106. 

To run the report:

1. Click OK. A dialog box appears, prompting whether you want to 
submit the report now. 

2. Click OK to submit the report now. Your report may take several 
minutes to run. When finished, the report will be included in the 
Report Inbox folder, under Output. You can display the contents 
of that folder and double-click the report to display it.

You have now successfully finished working through your second 
report. 
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7.10  Generating a User Activity Report

When you generate a User Activity Report, the application displays 
historical, minute-by-minute, state and activity data for a user or group 
of users during a specified time interval for a specified date range. You 
can choose to report on an individual user or multiple users who were 
active during the time interval. If multiple locations are configured, you 
can choose to run the report based on the time zone of the local site or 
user location. 

NOTE:  To generate a User Activity Report, you must have the 
associated Manager permission. 

NOTE:  User Activity Reports are available only if your site has a 
reporting level of Full. For more information, see Section 7.6, 
“Reporting level”, on page 88.

Each row in the report provides details on an individual state change. 
The columns in the report are:

• User – The user being reported on.

• Time – The date and time when the activity or state change 
occurred.

• Activity – The activity or state to which the user changed.

• Details – Additional details for the activity or state change. 

To generate a User Activity Report:

1. On the View menu, point to Activity Reports, and then click User.

2. Under Criteria, in the Report on list, select the users to report on. 
Your choices are: Individual user or Active users in time 
interval. 

3. In the Start box, type or select the start date and time of the 
interval that you want the report to cover. The time format is based 
on a 24-hour clock, for example, 4:00 P.M. is entered as 16:00. 

4. In the End box, type or select the end date and time of the interval 
that you want to report on. 

5. If multiple locations are configured, in the Use time zone of list, 
select the time zone option that you want use to generate the 
contents of the report. Your choices are Local site or User 
location. 
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6. If you selected Individual user in step 2, in the Name box, type 
or select the name of the user who you want to report on. 

7. If you selected Active users in time interval in step 2, do the 
following:

a) Click Find Now. The system generates the list of users who 
were active during the specified time interval. 

b) Under Users, select the check box for each user who you want 
to report on, or click Select All. You can select a maximum of 
100 users. 

8. On the Actions menu, click Run Report. 

9. Click the Results tab to view the report results. A complete activity 
report can display a maximum of 40,000 records. An incomplete 
activity report (one that reaches 40,000 records before all the users 
have been processed), can display up to 60,000 records. 

7.11  Generating a Source Activity Report

When you generate a Source Activity Report, the application displays 
historical, minute-by-minute, state and event data for all contacts from 
a source or list of sources during a specified time interval for a specified 
date range. You can specify multiple sources or use wildcards to 
generate a list of sources from which to choose. 

NOTE:  To generate a Source Activity Report, you must have the 
associated Manager permission.

Each row in the report provides details on an individual state change. 
The columns in the report are:

• Source – The source being reported on.

• Time – The date and time when the event or state change 
occurred.

• Event – The event or state to which the contact changed.

• Subject – This typically contains the target of the Event. For 
example, for a transfer, the Subject will be the user to whom the 
contact was transferred.

• Details – Additional details for the event or state change.
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To generate a Source Activity Report:

1. On the View menu, point to Activity Reports, and then click 
Source.

2. Under Criteria, in the Media type list, select the media type that 
you want to report on. Your choices are Voice, E-mail, or Web 
Collaboration. 

3. In the Start box, type or select the start date and time of the 
interval that you want to report on. The time format is based on a 
24-hour clock, for example, 4:00 P.M. is entered as 16:00. 

4. In the End box, type or select the end date and time of the interval 
that you want to report on. 

5. Depending on the media type you selected, in the resulting box 
(Telephone number, E-mail address, or Web collaboration 
source), type or select the source that you want to report on. To 
specify multiple sources, separate each source with a comma. The 
system supports the use of one wildcard per source. You can use a 
wildcard on its own or to substitute one or more characters at the 
end of a source, for example:

• The telephone numbers 123* and * are valid. However, *567, 
*567*, and 56*7 are not valid. 

• The e-mail addresses sales* and * are valid. However, *sales, 
*@*, and sales@*.com are not valid.

• The Web collaboration sources www.mycompany.com* and * 
are valid. However, */sales, *sales*, and 
www.mycompany.com/*/sales are not valid. 

6. If you specified more than one source, do the following:

a) Click Find Now. The system generates a list of sources that 
match the criteria that you specified. 

b) Under Sources, select the check box for each source that you 
want to report on, or click Select All. You can select a maximum 
of 100 sources.

7. On the Actions menu, click Run Report. 

8. Click the Results tab to view the report results. A complete activity 
report can display a maximum of 40,000 records. An incomplete 
activity report (one that reaches 40,000 records before all the 
sources have been processed), can display up to 60,000 records.
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7.12  Configuring the user reporting options

You can configure the default options that affect the reports that are 
generated by users. 

7.12.1  Configuring the general user 
reporting options

You can configure the following general user reporting options: 

• The notification method that is used to indicate when a historical 
report completes.

• T he default output settings used when you configure a new report 
definition, and when you print, export, or send a report by e-mail 
(if enabled). You can override most of the default output settings in 
a specific report definition. 

NOTE:  The Outgoing e-mail address and E-mail signature boxes 
are available only if the e-mail reports option is enabled, and you have 
the E-mail historical reports Manager permission. For details on how 
to enable the e-mail reports option, see Section 7.13.5, “Configuring 
the e-mail reports option”, on page 138. 

To configure the report notification methods: 

1. On the Tools menu, click Options.

2. In the left pane, under User Settings, click Reporting. 

3. Under When a Report Job Completes, do the following:

• To play a sound when the report is complete, click the Play a 
sound check box, and then type the name of the .wav file you 
want to play. You can click  to select the .wav file, and you 
can click  to play the selected .wav file. 

• To display a system message when the report is complete, 
select the Log alarm to System Messages window check 
box.

• To display an icon in the system tray when the report is 
complete, select the Show report icon in the system tray 
check box.

4. Under Default Output Settings, do the following:
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• In the Output folder list, select the report folder where you 
want to send completed reports. You can choose the default 
Report Inbox or a custom report folder. 

• In the Printer name list, select the printer where reports are 
printed.

• In the File format list, select the file format for reports that are 
exported. Your choices are Modern Microsoft Excel Workbook 
(.xlsx), Web Page (.htm), CSV (Comma Delimited) (.csv), or 
Portable Document Format (.pdf), Old Microsoft Excel Workbook 
(.xls). 

• In the Outgoing e-mail address box, type the e-mail address 
that is used as the From address when sending completed 
historical reports by e-mail. This e-mail address is required if 
you intend to use the e-mail reports option. You cannot override 
this e-mail address in a report definition. 

NOTE:  The Outgoing e-mail address for E-mail reporting must 
be configured in the following way: 
- Login into the Manager, in the BU System. 
- Navigate to Design Center > Email > Resources > 
Destinations.  
- Add a new E-mail address and select a Business unit.  
- Login into Manager in the selected BU, then set the Available 
for Outgoing flag for the E-mail address.  
E-mail server configuration (Email Servers, Destinations) must 
be done in Web Manager in the Application server if no E-mail 
license available.

• In the E-mail signature box, type the signature that is used 
when reports are sent by e-mail. The signature is plain text only. 

5. Click OK. 
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7.12.2  Configuring the silent monitoring 
settings

When the system is connected to an OpenScape Voice communication 
platform, you can silently monitor an active call, silently monitor all 
calls, whisper to the agent when silently monitoring all calls, and barge 
in on an active call from a user real-time report. Before you can use 
these features, you must specify your subscriber number. 

NOTE:  To configure the silent monitoring settings, you must have the 
Silently monitor calls from user real-time reports or Barge in on 
calls from user real-time reports Manager permission. 

NOTE:  To use the Whisper Coach feature, you must enable the 
Silently Monitor All Calls option on User Real-time Report.  
To make use of the Whisper Coach option, you must have the Silently 
Monitor calls from user real-time reports and Barge in on calls 
from user real-time reports Manager permission.

When the system is connected to an OpenScape Voice V7 R1 
communication platform or higher, you can also configure up to 10 
telephone devices that can be used to silently monitor or barge in on 
active calls. When you have at least one telephone device configured, 
you can select the preferred device to be used when performing these 
activities. If you intend to use the same telephone device to handle 
routed calls and silently monitor or barge in on active calls, we 
recommend that you use different subscriber numbers.

NOTE:  When the system is connected to an OpenScape Voice V7 
communication platform or higher, users who have been configured to 
handle routed calls and silently monitor or barge in on active calls 
cannot be silently monitored or barged in on by other users while 
silently monitoring a call. 

NOTE:  When the system is connected to an OpenScape Voice V6 
communication platform, users who have been configured to handle 
routed calls and silently monitor or barge in on active calls cannot be 
silently monitored or barged in on by another user.
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To configure the silent monitoring settings:

1. On the Tools menu, click Options. 

2. In the left pane, under User Settings, click Reporting.

3. Click the Silent Monitoring tab. 

4. Under Subscriber Number, in the Number box, type the 
subscriber number that you want to use to silently monitor, Whisper 
Coach or barge in on active calls. 

NOTE:  The subscriber number that you specify must be a user 
subscriber number that has been configured in the Telephony 
Center so that it can be monitored by the OpenScape Contact 
Center system.

5. Under Devices (only available when connected to an OpenScape 
Voice V7 R1 or V8 communication platform), do one of the 
following:

• To configure a new device, click Add. 

• To edit an existing device, select the device in the list, and then 
click Edit. 

6. In the Device dialog box, do the following:

a) In the Name box, type a unique name for the telephone device, 
for example, Home.

b) In the Telephone number box, type the telephone number in 
dialable or canonical format. The telephone number must not be 
any of the existing OpenScape Contact Center (CSTA-
monitored) subscriber numbers and it must not be a number 
that is restricted by the OpenScape Voice communication 
platform (such as a long distance number). 

c) Click OK. 

NOTE:  When you edit an existing device, you can only change the 
name of the device, not the telephone number. If you want to 
change the telephone number, you must delete the device and 
configure a new device.
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7. Under Preferred Device (only available when connected to an 
OpenScape Voice V7 R1 or V8 communication platform), in the 
Device list, select the telephone device that you want to use to 
silently monitor or barge in on active calls. The list contains Desk 
Telephone (the physical telephone device associated with the 
subscriber number) and all the devices configured in the Devices 
list. 

NOTE:  If you use the same subscriber number to handle routed 
calls and silently monitor or barge in on active calls, ensure that the 
same preferred devices are configured in the Manager application. 
Click OK. 

NOTE:  The users, who are silently monitored, are displayed in a 
different color in the user real time reports.

7.12.3  Configuring the directory options

You must configure the options for each external LDAP directory that 
you want to be able to access from within the Manager application. A 
directory is used to select recipients when sending reports by e-mail. 

Before you begin, the e-mail reports option must be enabled and the 
directory for which you want to configure the options must already be 
configured. For details, see Section 7.13.5, “Configuring the e-mail 
reports option”, on page 138 and Section 5.5, “Configuring a 
directory”, respectively. 

7.12.3.1  Configuring the directory connection 
settings 

If an external LDAP directory that you want to access from within the 
Manager application requires user authentication, you must configure 
the connection settings for the directory. 

To configure the directory connection settings: 

1. On the Tools menu, click Options.

2. In the left pane, under User Settings, click Reporting.

3. Click the Directory tab. 
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4. Under Directory, in the Select a directory to configure list, 
select the directory for which you want to configure the connection 
settings. 

5. Under Connection, click Change.

6. In the Set Up Connection dialog box, do the following:

a) In the Account name box, type the user name needed to 
access the directory. 

b) In the Password box, type the password needed to access the 
directory. 

c) In the Confirm password box, retype the password to confirm 
that you entered it correctly. 

d) Click OK. 

7.12.3.2  Configuring the directory query settings

When you search a directory, you might need to perform several 
searches, and refine your search criteria for each new search. You can 
configure the query fields to save the search criteria that you enter, and 
use them as the default criteria for the next search. 

At least one directory query field must be configured before you can 
configure the directory query settings.

To configure the directory query settings:

1. On the Tools menu, click Options.

2. In the left pane, under User Settings, click Reporting.

3. Click the Directory tab. 

4. Under Directory, in the Select a directory to configure list, 
select the directory for which you want to configure the query 
settings. 

5. Under Query Field Settings, click Change. 

6. In the Change Query Settings dialog box, select the check box for 
each field that should save the search criteria you enter, and then 
click OK. 
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7.12.3.3  Configuring the directory results settings

You can configure how the results of a directory search are displayed, 
including the fields that are displayed, and the order in which they are 
displayed. 

At least one directory results field must be configured before you can 
configure the directory results settings. 

To configure the directory results settings:

1. On the Tools menu, click Options.

2. In the left pane, under User Settings, click Reporting.

3. Click the Directory tab. 

4. Under Directory, in the Select a directory to configure list, 
select the directory for which you want to configure the results 
settings. 

5. Under Result Field Settings, click Change. 

6. In the Change Results Settings dialog box, do the following:

a) Select the check box for each field that you want to display. The 
top-to-bottom order of the fields in the list reflects the left-to-
right order of the columns as they appear in the search results. 
You can use the up or down arrows to change the order of the 
fields in the list. 

b) In the Sort by list, select the name of the field to sort on. Only 
selected fields appear as sort options. 

c) In the Sort order list, select a sort order (Ascending or 
Descending).

d) Click OK. 

7.12.4  Configuring the colors in reports

You can create reports to view and compare routing states, contact 
states, contact types, and callback origins (if the callback feature is 
enabled). The application provides a set of default colors in which these 
items are displayed in the reports. You can change the default colors 
for the foreground and background of each of these items. 

To configure the colors in reports:

1. On the Tools menu, click Options.

2. In the left pane, under User Settings, click Reporting.
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3. Click the Colors tab. 

4. For the item whose color you want to change, click the cell in either 
the Foreground or Background column. The  button appears 
in the column. A preview of how the item appears in the report is 
also displayed at the bottom of the dialog box. 

5. Click  to open the Color dialog box.

6. In the Color dialog box, select the color you want to use, and then 
click OK. 

7.13  Configuring the system reporting options

You can configure the default settings that affect reports in the 
Manager application. For details, see the following topics: 

NOTE:  To configure any of the system reporting options, you must 
have Full or Modify access for the associated Manager permission.

NOTE:  In a multitenant environment, only a system administrator can 
configure the system reporting options. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 
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7.13.1  Configuring the global queue report 
intervals

The global queue report intervals are used in cumulative and historical 
queue reports to help you determine exactly when contacts are being 
enqueued since contacts can be in queue for a while. Cumulative and 
historical queue reports include breakdowns by interval of the time that 
customers wait before a contact is answered or abandoned, using the 
statistics “Answered in Interval” and “Abandoned in Interval”. You can 
define up to five time intervals so that you can track the number of 
contacts that are answered by a user or abandoned within the different 
time intervals. 

NOTE:  When you are connected to a central reporting server machine, 
you cannot configure the global queue report intervals. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the global queue report intervals. For details, see Section 
19.3, “Administrator roles in a multitenant environment”, on page 394. 

To configure the global queue report intervals:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Reporting.

3. Under Global Queue Intervals, do the following:

a) In the Media list, select the media type for which you want to 
configure the queue report intervals, for example, Voice.

b) In the To column for Interval 1, double-click the time and type 
the end time. The start of Interval 2 is updated to reflect the 
number you just typed.

c) In the To column for each other interval, double-click the time 
and type the end time. The end time for the last interval is 
always Forever.

4. Repeat step 3 for each media type you want to configure, and then 
click OK. 
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7.13.2  Configuring the first day of the week

Historical report definitions that have a range of This Week or Last 
Week display the Start date based on the configured first day of the 
week. 

During installation, the host computer's Regional Options setting 
determines the default first day of the week. For example, for the 
United States, the default is Sunday, and for Germany, the default is 
Monday. Any time after installation, you can change this setting. The 
change will take effect in the next weekly rollup period. The change will 
not affect existing historical data which remains based on the previous 
setting. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the first day of the week. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the first day of the week for reporting:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Reporting.

3. Under First Day of Week, in the Select day box, select the day of 
the week that you want to use as the Start date for historical reports 
that have a range of This Week or Last Week. 

4. The application displays a warning to indicate that the change will 
not affect existing historical data which remain based on the 
previous setting. 
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7.13.3  Configuring the queue real-time 
report options

You can choose the following options, which affect the queue and 
aggregate statistics that appear in real-time reports and wallboard and 
Broadcaster views:

• Include ringing and unanswered contacts – If you choose this 
option, contacts that are in Ringing, Pending, and Unanswered state 
will be included in the Contacts - Queued and Contacts - Overflowed 
statistics, and the time spent ringing will be included in the Wait 
Time statistic.

• Use weighted averages – By default, the system uses a simple 
average to calculate current and estimated statistical summaries in 
queue real-time reports and real-time aggregate statistics. This 
option allows you to use a weighted average, which takes into 
account the number of contacts in each queue. For example, 
suppose you have the following values: 

In this example, the service level calculated using the simple 
average is  
(90 + 50) / 2 = 70%, and the service level calculated using the 
weighted average is [(10 * 90) + (5 * 50)] / 15 = 77%. 

Weighting is performed using the Contacts - Received (Shift) 
statistic when calculating shift statistics, and the Contacts - Queued 
statistic when calculating current and estimated statistics. 

NOTE:  Even when the Use weighted averages option is enabled, 
if there are no contacts in queue, the system uses the default 
simple average calculation method. 

NOTE:  When you are connected to a central reporting server machine, 
you cannot configure the queue real-time report options.

NOTE:  In a multitenant environment, only a system administrator can 
configure the queue real-time report options. For details, see Section 
19.3, “Administrator roles in a multitenant environment”, on page 394. 

Queue Contacts - Received 
(Shift)

Service Level - Shift

Sales 10 90

Support 5 50
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To configure the queue real-time report options:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Reporting.

3. Under Queue Real-Time Report, do the following, and then click 
OK:

• To include calls that are in Ringing and Unanswered state, as 
described above, select the Include ringing and unanswered 
contacts check box. 

• To use a weighted average to calculate summaries in real-time 
reports and real-time aggregate statistics, as described above, 
select the Use weighted averages check box. 

7.13.4  Configuring the workforce 
management output location

The OpenScape Contact Center system automatically exports 
statistical and administration data in XML format to the 
ShareData\XMLOutput folder on the main server machine. You can use 
this XML data in a third-party workforce management application to 
simplify the user scheduling and workforce forecasting process. For a 
description of the XML data that is exported by the system, see the 
Workforce Management Integration Guide. 

NOTE:  The schema for the XML data is defined in the 
OSCCSchema.xsd file. For more information, contact your service 
representative. 
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You can obtain the XML data in two ways:

1. You can copy the XML data from the ShareData\XMLOutput folder 
on the main server machine to a workforce management machine 
or other location. In this case, you must have read access to the 
ShareData\XMLOutput folder. 

2. You can configure the system to write the XML data to a shared 
network folder (in addition to the ShareData\XMLOutput folder). In 
this case, you must:

• Configure the output location (the location of the shared 
network folder), as described in the following procedure. 

• Ensure that the hppc user account on the main server machine 
has the permission to write the XML data to the configured 
output location. 

NOTE:  When you are connected to a central reporting server machine, 
you cannot configure the workforce management output location. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the workforce management output location. For details, see 
Section 19.3, “Administrator roles in a multitenant environment”, on 
page 394. 

To configure the workforce management output location:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Reporting.

3. Under Workforce Management, in the Output location box, 
type the full path to the folder where you want to write the XML 
data, in UNC format. You cannot use a mapped network drive. For 
example:

\\WorkforceManagementMachine\XMLOutput\

4. Click OK. 
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7.13.5  Configuring the e-mail reports option

The e-mail reports feature allows completed historical reports to be 
distributed as attachments to e-mail messages. You can enable or 
disable the e-mail reports option for the system. 

The reports are distributed using the corporate SMTP server configured 
in the Options dialog box. For details, see Section 15.3.2, “Configuring 
the e-mail server settings”, on page 268. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the e-mail reports option. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

NOTE:  When the system is configured for high availability (warm 
standby), you normally log on to the Manager application using the 
cluster name so that you access the active server machine (see Section 
3.2, “Logging on to the Manager application”, on page 23). In this case, 
the application will send empty reports by e-mail because the fact that 
the report contains no data is pertinent. However, if you log on using 
the physical machine name, empty reports will not be sent by e-mail. 
The system is designed this way to avoid any confusion that could 
result when a report that is sent from the active server machine 
contains data, while the same report sent from the standby server 
machine is empty. 

To configure the e-mail reports option:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Reporting.

3. To enable historical reports to be distributed by e-mail, under 
E-mail Reports, select the Enable check box. 

4. Click OK.
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8  Routing
This chapter provides information on how to configure routing 
components and develop a routing strategy. 

NOTE:  For information about user routing states please check section 
5.2.1 About routing states from OpenScape Contact Center V11 
Agent Portal Web, User Guide.

8.1  About group-based routing

Group-based routing is the process of matching a contact to the best 
group of users eligible to handle the contact.

When OpenScape Contact Center routes a contact to a queue, the 
primary step in the queue attempts to route the contact to any user in 
a primary group of users who are most qualified to handle the contact. 
If the primary group cannot handle the contact within the specified 
time, then the contact is routed to one or more overflow groups. The 
overflow mechanism is additive. At each point where a contact 
overflows to a new group, the new group of users is added to the 
current pool of available users.

Group-based routing is the OpenScape Contact Center default routing 
method. For information related to skills-based routing, see Section 
8.2, “About skills-based routing”, on page 162.

8.1.1  Group setup considerations

A group can be any collection of users who share expertise or 
responsibility in some area and who are similarly qualified to handle 
incoming contacts. A single user can belong to several groups. 

The first consideration in setting up groups is specialization. When you 
choose your groups, be as specific as your callers’ requirements. In the 
simplest of scenarios, a service bureau might specialize in technical 
support for four different software products – Word Processing, 
Spreadsheet, Browser, and Project. In such a simple case, since the 
goal is to match caller requirements to a suitable user, you would set 
up one group for each product you support, and assign the specialists 
in those areas to the respective groups. 
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If your areas of expertise are Stocks, Mutual Funds, and Bonds, and in 
each area, you offer services in two languages, you would consider six 
groups:

• Stocks/English

• Stocks/German

• Mutual Funds/English

• Mutual Funds/German

• Bonds/English

• Bonds/German

Apart from strict specialization, you should consider setting up a group 
for each additional functional area that will routinely be used as the first 
choice in routing a contact. For example, while your core areas of 
specialization might be Stocks, Mutual Funds, and Bonds, you may 
want first-time users directed to an Administration group for some form 
of preliminary processing. The best way to handle this is to set up an 
Administration queue, and use your routing strategy workflow to route 
first-time contacts to the Administration group.

In addition, if you have both specialists in particular areas and users 
with general abilities in one or more of your specialized areas, consider 
grouping the general users in backup groups that are intended as 
overflow options to your specialized groups. These groups could be 
used as overflow groups only, associated with several queues, and 
never be used as the primary group for a particular queue.

Since there is a strong correlation between group and queue setup, you 
should also consider factors that influence queue setup. For details, see 
Section 10.2, “Queue setup considerations”, on page 193. 

8.1.2  Configuring a group

In group-based routing (see Section 8.1, “About group-based routing”, 
on page 139), contacts are routed to a group where a user in the group 
can handle the contact. 
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After you have configured a group, you can assign it as a step in a 
queue definition (see Section 10.3.2, “Configuring the queue steps”, on 
page 204). 

NOTE:  To create or change a group, you must have Full or Modify 
access, respectively, for the Groups Manager permission. If the 
enhanced security option is enabled, you must also have the required 
security access to change the group. For details on the enhanced 
security option, see Section 15.3.4, “Configuring the enhanced security 
option”, on page 271. 

To configure a group:

1. On the File menu, point to New, then Administration Center, and 
then click Group.

2. On the General tab, under Group, do the following:

• In the Name box, type a unique name for the group. 

NOTE:  You cannot change the name of a group after you save 
the group.

• In the Description box, type a description for the group. The 
group description should include the common information that 
determines which users belong in the group. 

3. Click the Users tab.

4. Under Include, select the check box for each user who you want to 
add to the group. The list contains only the users who have the 
Receive contacts routed by OpenScape Contact Center User 
permission. All selected users should be able to handle the contacts 
that are routed to this group. 

NOTE:  You can also select the groups a user belongs to when you 
configure the user's properties. See Section 4.1.3, “Configuring the 
contact handling settings for a user”, on page 31. 

5. Click the Reports tab.
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6. Under Include, select the check box for each report that you want 
to display data about this group. The list contains only the reports 
you own, or reports that are owned by users you can monitor. 

NOTE:  To add many groups to a report, you can open the group 
report definition, click the Content tab, and select all the groups 
that you want to add to the report. 

7. Click the Security tab. This tab is available only if the enhanced 
security option is enabled. For details, see Section 15.3.4, 
“Configuring the enhanced security option”, on page 271. 

8. Under Users, select the check box for each user who you want to 
be able to modify this group. The list contains only the users who 
have Full or Modify access to the Groups Manager permission. 

9. Click OK.

8.2  About skills-based routing

Skills-based routing is the term used to describe the matching of a 
contact with the best user eligible to handle the contact based on the 
user’s skills. 

NOTE:  Group-based routing is the default routing method in 
OpenScape Contact Center. To change to skills-based routing, see 
Section 8.4.3, “Changing to skills-based routing”, on page 173. 

To understand skills-based routing, you must understand the following 
concepts:

• Skills – see Section 8.2.1, “About skills”, on page 163

• Virtual groups – see Section 8.2.3, “About virtual groups”, on page 
164

• Skill levels – see Section 8.4.6, “About skill levels”, on page 179

When OpenScape Contact Center routes a contact to a queue, the first 
step in the queue should attempt to route the contact to a user whose 
skill set best meets the requirements of the contact. For more 
information on queue setup, see Section 10.3, “Configuring a queue”, 
on page 242. 
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8.2.1  About skills

Skills are the specific areas of expertise required to handle contacts at 
your site. Skills should be as specific as your customers’ requirements. 
In a simple case, skills in a contact center for an investment firm might 
be Mutual Funds, Bonds, and Stocks. However, if you offered the same 
skills in two languages, the skills might be Mutual Funds, Bonds, 
Stocks, English, and German. 

Each user is configured with a particular set of skills. Within a user 
definition you can specify skill levels and skill preferences for each skill, 
if those options are activated. 

8.2.2  Configuring a skill

This section describes how to configure the skills that can be selected 
for a user. You select the skills that a user has when you configure the 
user definition. For details, see Section 4.1.3, “Configuring the contact 
handling settings for a user”, on page 38. 

NOTE:  To create or change a skill, you must have Full or Modify 
access, respectively, for the Skills Manager permission. If the 
enhanced security option is enabled, you must also have the required 
security access to change the skill. For details on the enhanced security 
option, see Section 20.3.4, “Configuring the enhanced security option”, 
on page 416. 

To configure a skill:

1. On the File menu, point to New, then Administration Center, and 
then click Skill.

2. On the General tab, under Skill, do the following:

• In the Name box, type a unique name for the skill. 

• In the Description box, type a description for the skill.

3. Click the Users tab.

4. Under Include, select the check box for each user who has the 
required skill. 

5. Click the Virtual Groups tab. The application lists the virtual 
groups in which this skill is included. You cannot modify the list. 
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6. Click the Security tab. This tab is available only if the enhanced 
security option is enabled. For details, see Section 20.3.4, 
“Configuring the enhanced security option”, on page 416. 

7. Under Users, select the check box for each user who you want to 
be able to modify this skill. The list contains only the users who have 
Full or Modify access to the Skills Manager permission. 

8.2.3  About virtual groups

A virtual group is a collection of one or more skills that you can select 
when you define the steps in a queue (see Section 10.3.3, “Configuring 
the queue steps for skills-based routing”, on page 249). In skills-based 
routing, any available user whose skill set meets or exceeds the skills 
defined in the virtual group at a particular step in the queue becomes 
eligible to handle the contact. 

You build an expression to define the skills that are included in a virtual 
group. The rules for building an expression are as follows:

• Each expression must contain at least one skill name. The skill 
name must be in quotation marks. 

• If your contact center has skill levels turned on, the skill name is 
followed by the skill level separated by a comma (with no spaces). 

• The only valid operators are AND, OR and NOT. The NOT operator 
must be followed only by a skill name and no skill level can be 
associated with the skill name. 

• Expressions are evaluated from left to right. For example, the 
expression “Stocks” OR “Bonds” AND “German” is not the same as 
“German” AND “Stocks” OR “Bonds”. The former would qualify 
users whose skill set specifies either the Stocks skill or the Bonds 
skill and the German skill. The latter would qualify users whose skill 
set specifies both the German skill and the Stocks skill, or users 
whose skill set specifies the Bonds skill. Therefore, to avoid 
confusion, use parentheses to explicitly group skills. 

The application provides syntax highlighting to clearly differentiate 
skills from operators. We recommend that you always use the controls 
and operator building blocks provided in the dialog box to avoid syntax 
errors. 

Examples of valid skill expressions with skill levels turned off:

• “Stocks” OR “Bonds”

• “Stocks” AND (“Bonds” OR “Mutual Funds”) AND NOT “German”

Examples of valid skill expressions with skill levels turned on:
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• “ Stocks”,9 OR “Bonds”,9

• “Stocks”,9 AND (“Bonds”,5 OR “Mutual Funds”,5) AND NOT 
“German”

8.2.3.1  Virtual group example

The virtual group feature lets you deconstruct the services offered by 
your contact center in a way that maximizes the chances of handling a 
contact with the best available user. This is useful where contact 
requirements can be broken down into two or more components. 

For example, if your contact center offers support for four products in 
two languages, your individual skills might be Word Processing, 
Spreadsheet, Browser, Project, English, and German. Since these can 
be categorized into two areas, products and language, there are a total 
of eight skill combinations that can be used as the basis for creating 
virtual groups. And since virtual groups can include skill levels, there is 
a large number of virtual groups that can be created using the eight 
skill combinations.

If a dialed number was associated with each of the software skills, and 
a menu prompt let customers choose their preferred language, your 
routing strategy workflow might direct a contact to a queue set up to 
handle German language support for the Word Processing product. The 
first queue step might specify the following virtual group:

“German”,9 AND “Word Processing”,9

This would qualify all users whose skill set specifies skill levels of 9 in 
both Word Processing and German. If one of those users became 
available during the queue’s first step, the contact would be directed to 
that user. Ideally, this is the preferred method of handling this 
particular contact.

If the first step expired without the contact being handled, the next 
step might specify the following virtual group:

“German”,7 AND “Word Processing”,9

Products

Languages Word Processing Spreadsheet Browser Project

German 4 4 4 4

English 4 4 4 4
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This would expand the pool of users eligible to handle the contact to 
include all users whose skill set specifies a German skill level of 7. This 
setup would be appropriate if Word Processing was considered the 
more important skill relative to language. 

Certain considerations in setting up groups for group-based routing 
also apply to virtual groups. For details, see Section 8.1.1, “Group 
setup considerations”, on page 159. 

In addition, since there is a strong correlation between virtual group 
and queue setup, you should consider factors that influence queue 
setup. For details, see Section 10.2, “Queue setup considerations”, on 
page 233. 

8.2.4  Configuring a virtual group

You must configure the virtual groups that can be specified in a queue. 
Before configuring virtual groups, you must create any skills that you 
want to use when building your virtual groups. For details, see Section 
8.2.2, “Configuring a skill”, on page 163. 

NOTE:  To create or change a virtual group, you must have Full or 
Modify access, respectively, for the Virtual groups Manager 
permission. If the enhanced security option is enabled, you must also 
have the required security access to change the virtual group. For 
details on the enhanced security option, see Section 20.3.4, 
“Configuring the enhanced security option”, on page 416. 

To configure a virtual group:

1. On the File menu, point to New, then Administration Center, and 
then click Virtual Group.

2. Under Virtual Group, do the following:

• In the Name box, type a unique name for the virtual group. 

• In the Description box, type a description for the virtual group.

3. Under Expression, build the required skill expression using the 
following guidelines:

• To specify a skill, click Insert Skill and select the skill name 
from the list.

• To specify an operator, click the operator you want to use: AND, 
OR or NOT.

• To group expressions, click one of the parenthesis buttons: (, ). 
 A31003-S22B1-M103-08-76A9, 04/2025
146 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



routing.fm

Routing
About multiple contact handling
• When you are finished building the expression, click Verify. 
OpenScape Contact Center checks the expression to ensure that 
the syntax is valid. 

4. To see the users that are eligible to be included in the virtual group 
based on the build expression you have specified, click Show 
Eligible Users. 

5. Click the Queues tab.

6. Under Queues, select the queues that use this virtual group. 

7. Click the Reports tab.

8. Under Reports, select the check box for each report that you want 
to display data about this virtual group. The list contains only the 
reports you own, or reports that are owned by users you can 
monitor. 

9. Click the Security tab. This tab is available only if the enhanced 
security option is enabled. For details, see Section 20.3.4, 
“Configuring the enhanced security option”, on page 416. 

10.Under Users, select the check box for each user who you want to 
be able to modify this virtual group. The list contains only the users 
who have Full or Modify access to the Virtual groups Manager 
permission. 

11.Click OK.

8.3  About multiple contact handling

Multiple contact handling is a feature that allows OpenScape Contact 
Center users to handle more than one routed contact at the same time. 
When the system is configured for multiple contact handling, you can 
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configure the contact handling rules that are applied to a user. For 
details, see Section 8.3.1, “Configuring a contact handling rule”, on 
page 169. The system also provides default single contact handling 
rules, one for each media type.

NOTE:  By default, the system is configured for users to handle one 
routed contact at a time. To change to multiple contact handling, see 
Section 8.4.9, “Changing to multiple contact handling”, on page 182. 

NOTE:  Multiple contact handling is not supported for Microsoft CRM, 
SAP CIC, and SAP ICI users. When configuring these types of users, 
only the system-defined single contact handling rules are available. For 
details, see Section 4.1.3, “Configuring the contact handling settings 
for a user”, on page 38. 

You can apply more than one contact handling rule to a user. The 
system's routing logic takes the user's contact handling rules into 
account to determine the routing availability. For example, you can 
configure a contact handling rule that allows the user to handle one call 
and up to five e-mail messages at the same time. But if you want the 
user to be able to handle either one call or five e-mail messages at one 
time, you can assign two contact handling rules to the user – the Single 
Voice contact handling rule and a custom contact handling rule 
configured for five e-mail messages. In this case:

• If the user receives a call first, the Single Voice rule is applied and 
the user cannot receive any other contacts until the call is complete. 

• If the user receives an e-mail message first, then the custom rule 
is applied and the user will be able to handle up to four more e-mail 
messages, but no calls. 

The maximum number of active contacts that a user can handle 
concurrently is eight, of which no more than one contact can be a call 
or a callback.

Although users can handle multiple contacts concurrently, a user can 
be focused on only one active contact at a particular time. This is called 
the primary contact. The primary contact is the active contact. By 
default, if the user is handling an active call or callback, it is the primary 
contact, but you can change that configuration. For details, see Section 
8.4.10, “Configuring a call or callback as the primary contact”, on page 
182. 
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8.3.1  Configuring a contact handling rule

When the system is configured for multiple contact handling, you can 
configure the contact handling rules that are applied to a user. 

NOTE:  To create or change a contact handling rule, you must have Full 
or Modify access, respectively, for the Contact handling rules Manager 
permission. If the enhanced security option is enabled, you must also 
have the required security access to change the contact handling rule. For 
details on the enhanced security option, see Section 20.3.4, “Configuring 
the enhanced security option”, on page 416. 

To configure a contact handling rule:

1. On the File menu, point to New, then Administration Center, and 
then click Contact Handling Rule. 

2. On the General tab, under Contact Handling Rule, do the 
following:

• In the Name box, type a unique name for the contact handling 
rule. 

• In the Description box, type a description for the contact 
handling rule.

3. Under Media Distribution, for each media type, type or select the 
number of contacts that the user can handle at one time. You can 
specify a total of eight contacts.

4. Click the Users tab.

5. Under Include, select the check box for each user who you want to 
associate with this contact handling rule. 

6. Click the Security tab. This tab is available only if the enhanced 
security option is enabled. For details, see Section 20.3.4, 
“Configuring the enhanced security option”, on page 416. 

7. Under Users, select the check box for each user who you want to 
be able to modify this contact handling rule. The list contains only 
the users who have Full or Modify access to the Contact handling 
rules Manager permission. 

8. Click OK. 
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8.4  Configuring the routing options

You can configure the default settings that affect how contacts are 
routed within the OpenScape Contact Center system. For details, see 
the following topics:

• Section 8.2.1, “Configuring the manual reserve time”, on page 142

• Section 8.2.2, “Configuring the maximum offer time”, on page 142

• Section 8.4.3, “Changing to skills-based routing”, on page 173

• Section 8.4.5, “Configuring the skill scoring”, on page 176

• Section 8.4.7, “Displaying skill levels”, on page 180

• Section 8.4.8, “Displaying skill preferences”, on page 181

• Section 8.4.9, “Changing to multiple contact handling”, on page 
182

• Section 8.4.10, “Configuring a call or callback as the primary 
contact”, on page 182

NOTE:  To configure any of the routing options, you must have Full or 
Modify access for the associated Manager permission. 

8.4.1  Configuring the manual reserve time

When a contact is reserved for a user in a contact real-time report, the 
manual reserve time is the length of time for which the contact can be 
reserved.If the contact is not assigned to the user within the manual 
reserve time, the contact is returned to the queue. You set the manual 
reserve time globally for each media type. 

NOTE:  The time a contact spends reserved for a user is included in the 
wait time. Reserved contacts that remain unanswered before 
proceeding to the queue steps could adversely affect the service level 
calculation. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the manual reserve time. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 
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To configure the manual reserve time:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Routing.

3. Under Manual Reserve Time, for each media type in the table, 
double-click the cell in the Time column and then type the amount 
of time that a contact can be reserved for a user. 

4. Click OK.

8.4.2  Configuring the maximum offer time

You can configure the maximum offer time for each media type. If a 
contact is not accepted within the specified offer time, it will be 
returned to the queue (if configured) or designated unanswered. 

NOTE:  In a multitenant environment, only a business unit 
administrator can configure the maximum offer time. For details, see 
Section 19.3, “Administrator roles in a multitenant environment”, on 
page 394. 

The maximum offer time depends on the media type:

• Voice – The amount of time that a user is given to answer a call.

• Callback – The amount of time that the application or a user, if the 
user has the Preview callbacks permission, is given to accept a 
callback.

• E-mail – The amount of time that the application is given to accept 
an e-mail message. This includes the time required to download the 
e-mail message from the corporate IMAP server. 
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• Web collaboration – The amount of time the application is given 
to accept a Web collaboration contact. This includes the time 
required to download the Web collaboration contact from the 
corporate web server. 

NOTE:  In a custom application, the user might be given the ability to 
manually accept a callback, e-mail message, or Web collaboration 
contact. In each of these cases, the maximum offer time is the amount 
of time that the user is given to manually accept the contact. 

NOTE:  You can configure the communication platform to use the 
OpenScape Contact Center Ring No Answer feature, which will requeue 
any contact that is not answered within the maximum offer time and 
place the user in Unavailable routing state. To configure the OpenScape 
Contact Center Ring No Answer feature, see Section 11.5.3, 
“Configuring the communication platform settings”, on page 218. 

To configure the maximum offer time:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Routing.

3. Under Maximum Offer Time, for each media type in the table, 
double-click the cell in the Time column and then type a duration 
of time. For some media types this time refers to a user's reaction, 
for others to a reaction of the application.

4. Click OK.
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8.4.3  Changing to skills-based routing

You can convert the OpenScape Contact Center system from group-
based routing to skills-based routing. This conversion affects the way 
the system routes contacts and is irreversible. 

IMPORTANT:  Changing to skills-based routing is a one-way 
operation. The system cannot be converted back to group-based 
routing after it has been changed. 

IMPORTANT:  When you are connected to the production database, 
changing to skills-based routing will require that you restart the 
OpenScape Contact Center service on the main server machine.

NOTE:  In a multitenant environment, only a system administrator can 
change the system to skills-based routing. For details, see Section 
19.3, “Administrator roles in a multitenant environment”, on page 394. 

When the system is in skills-based routing mode, the skill levels and 
skill preferences are initially hidden. You have the option to expose 
either or both of these options, but they cannot be hidden again after 
they have been exposed. To enable these options, see Section 8.4.7, 
“Displaying skill levels”, on page 180 and Section 8.4.8, “Displaying 
skill preferences”, on page 181. 

To change to skills-based routing:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Routing.

3. Click the Advanced tab.

4. Click Change to skills-based routing. 

5. In the warning dialog box, under Do you want to change to 
skills-based routing?, select Yes, and then click OK. 

6. When the system prompts you to confirm that you want to convert 
to skills-based routing, click Yes. The system converts to skills-
based routing. 

7. Click OK. 
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8.4.4  About skill scoring

Skill scoring is a feature that finds the best match between users and 
contacts in the following circumstances:

• Several users are eligible for a single queued contact. 

• A user becomes available and there are several contacts (tied in 
priority) that can be routed to that user.

NOTE:  This feature is available only when skills-based routing is 
enabled (see Section 8.4.3, “Changing to skills-based routing”, on page 
173). 

A detailed description of the skill scoring calculation is beyond the 
scope of this document. However, an understanding of the factors that 
you can influence and their roles in the skill scoring calculation, will help 
you use the skill scoring feature more effectively.

In these tie-breaking situations, the system calculates a skill score that 
represents the strength of the match for each possible user/contact 
pairing. You can select one of five schemes that is used to calculate the 
skill scoring (see Section 8.4.4.1, “Skill scoring schemes”, on page 
175). Each scheme is a combination of the skill score type (Closest 
skilled or Most skilled) and the weighting of various factors, such as the 
additional skills in a user's skill set or the amount of time the contact 
has been in queue. 

The skill scoring has two major components:

• Base component – The base component is a skills-based measure 
of the fit between a user and a contact based on:

– The virtual group skill expression specified in the first step of the 
queue associated with the contact. This expression represents 
the ideal match of a user’s skills to a contact’s requirements.

– The skills (and optionally skill levels and skill preferences) 
included in a user’s skill set. 

The base component includes the four skills-based categories: 
Underqualified skills, Additional skills, User preference, and 
Forbidden skills. 

• Queue time component – The queue time component is based on 
two variables: 

– The queue time variable, which increases the value of the queue 
time component the longer a contact stays in queue.
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– The time to maximum importance variable, which places an 
upper limit on the time it takes a contact to reach maximum 
importance. 

After a contact reaches the time to maximum importance, the value 
of the queue time component no longer increases. 

The skill scoring feature lets you influence the skill score result by 
assigning a weight factor to each of the four base component 
categories and the queue time component. 

8.4.4.1  Skill scoring schemes

You can select one of five schemes that are used for skill scoring. The 
weighting factors for each scheme reflect a contact-matching method 
commonly used in contact centers. For more information on skill 
scoring, see Section 8.4.4, “About skill scoring”, on page 174. 

Scheme Description

First in, first 
out

All weight factors are set to zero. This scheme ensures that 
contacts are assigned to users in the same order as they are 
queued. Note that skill scoring is not the only criterion used 
in user/contact matching. For example, in one-contact/
multiple-user tie-breaking situations, the time that a user 
has been available is a strong factor in assigning the 
contact.

Balanced The Underqualified skills and User preference factors are set 
high while the Additional skills factor is set to zero. This 
scheme reduces the chance of routing a contact to a user 
with Underqualified skills, and increases the chance of 
routing a contact to a user with a high skill preference. 

Time sensitive Only the Queue time factor is considered, while all other 
factors are set to zero. This scheme maximizes the chance 
of routing contacts to users in the same order as they are 
queued. Note, however, that after the queue time for a 
contact exceeds the Time to maximum importance 
value, the queue time factor is maximized and the contact's 
skill score will not increase any further. This is an effective 
scheme if you want to override the system-wide Time to 
maximum importance value on a queue-by-queue basis. 

Table 2 Skill scoring schemes
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8.4.5  Configuring the skill scoring

You configure the skill scoring to help you find the best match between 
users and contacts. For a description of the factors that affect skill 
scoring, see Section 8.4.4, “About skill scoring”, on page 174. 

NOTE:  This feature is available only when skills-based routing is 
enabled (see Section 8.4.3, “Changing to skills-based routing”, on page 
173). 

NOTE:  In a multitenant environment, only a system administrator can 
configure the skill scoring. For details, see Section 19.3, “Administrator 
roles in a multitenant environment”, on page 394.

Closest skilled The Additional skills and Forbidden skills factors are set high 
while the Underqualified skills factor is set low. This scheme 
reduces the chance of routing a contact to a user who has 
Additional skills or Forbidden skills, while increasing the 
chance of routing a contact to a user who has 
Underqualified skills. The queue time factor is set low, 
increasing the chance of routing a contact with a long wait 
time.

Most skilled The User preference factor is set high while the Under 
qualified skill factor is set to zero. This increases the chance 
of routing a contact to a user who has a high skill 
preference. This is the only scheme that uses the Most 
skilled Skill score type.

Scheme Description

Table 2 Skill scoring schemes
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To configure the skill scoring:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Routing.

3. Click the Skill Scoring tab.

4. Under Skill Scoring Criteria, in the Scheme list, select the skill 
scoring scheme you want to use. The application sets the Skill 
score type and corresponding sliders based on your selection. For 
a description of the skill scoring schemes, see Section 8.4.4.1, “Skill 
scoring schemes”, on page 175. 

NOTE:  To customize your selection, you can select a different Skill 
score type and/or adjust the sliders, as described in steps 5 and 
6. If you make adjustments, the Scheme list is updated to reflect 
your changes. For example, if you select a Balanced scheme and 
then adjust the Additional Skills slider, a Custom - Balanced 
scheme is added to the list. 
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5. To select a different routing preference, in the Skill score type list, 
select one of the following:

• Closest skilled – The system attempts to match a contact to a 
user according to the least amount of difference between the 
user's skill set and the virtual group that is specified in the first 
step of the queue. This implies that the contact will be routed to 
a user with just enough of the required skills, saving more 
skilled users for other contacts.

• Most skilled – The system attempts to match a contact to a 
user whose skill set meets and exceeds the virtual group that is 
specified in the first step of the queue. This implies that the 
contact will be routed to the user best qualified to handle the 
contact. 

6. To change the weighting of the skill scoring factors, adjust the 
sliders as follows:

• Underqualified skills – A user has Underqualified skills if their 
skill set has fewer skills or lower skill levels than those specified 
in the virtual group expression. Move the slider to the right to 
reduce the chance of routing a contact to a user who has 
Underqualified skills. Move the slider to the left to increase this 
chance. 

• Additional skills – Additional skills are the skills in a user's skill 
set that are not required by the virtual group. Move the slider to 
the right to reduce the chance of routing a contact to a user who 
has Additional skills. Move the slider to the left to increase this 
chance. 

• User preference – User skill preferences can be optionally 
defined for each skill in a user's skill set. Move the slider to the 
right to increase the chance that a contact will be routed to a 
user whose skill set indicates a preference for skills that are 
specified in the virtual group. Move the slider to the left to 
reduce this chance. 

• Forbidden skills – A skill is forbidden if the skill can be found 
in the user's skill set but is preceded by a NOT logical operator 
in the virtual group expression. Move the slider to the right to 
reduce the chance of routing a contact to a user who has 
Forbidden skills. Move the slider to the left to increase this 
chance. 
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• Queue time – This slider controls the weighting of queue time 
in relation to the other skill scoring factors. Move the slider to 
the right to increase the effect of queue time on the skill score 
calculation. Move the slider to the left to reduce this effect. 

NOTE:  When skill levels or skill preferences are not enabled, 
default values are used for the Underqualified skills and User 
preference base values in the skill scoring calculation.

7. Under Time to maximum importance, for each media type in the 
table, double-click the cell in the Time column and type the amount 
of time the contact must have been in queue, after which the 
Queue time is of maximum importance and no additional weight 
can be given to it. 

8. Click OK.

8.4.6  About skill levels

A skill level is a level of proficiency a user has for a particular skill. 
When skill levels are enabled, each skill in a user definition is given a 
skill level from 1 to 9, where 9 is the highest skill level. To be eligible 
to handle a contact, a user’s skill set must specify a skill level that 
equals or exceeds the skill level specified in the virtual group at that 
step in a queue.

NOTE:  This feature is available only when skills-based routing is 
enabled (see Section 8.4.3, “Changing to skills-based routing”, on page 
173). 

For example, in a contact center with users who are experts in the area 
of investing, you might have four different levels for a skill called 
Investment: 3, 5, 7, 9. While a user with a skill level of 3 might only be 
qualified to process an order for a knowledgeable customer, a user with 
a skill level of 9 might be fully qualified to offer advice to a seasoned 
investor or to get an inexperienced investor started. 

In gathering contact requirements, the routing strategy workflow that 
enqueues the contact could check for the customer requirements in 
this regard. If a contact was enqueued with a requirement for an 
Investment skill level of 7, only users with skill levels of 7 or 9 would 
qualify to handle the contact. 
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The next step in the queue might reduce the contact requirement to 
specify an Investment skill level of 5. This would add that collection of 
users to the pool of users currently eligible to handle the contact.

8.4.7  Displaying skill levels

A skill level is a level of proficiency a user has for a particular skill. 
When skill levels are enabled, each skill in a user definition is given a 
skill level from 1 to 9, where 9 is the highest skill level.

You specify skill levels in a user definition (see Section 4.1.3, 
“Configuring the contact handling settings for a user”, on page 38) and 
when configuring a virtual group expression (see Section 8.2.3, “About 
virtual groups”, on page 164).

IMPORTANT:  Displaying skill levels is a one-way operation. The 
system cannot be converted back after it has been changed. 

NOTE:  This feature is available only when skills-based routing is 
enabled (see Section 8.4.3, “Changing to skills-based routing”, on page 
173). 

NOTE:  In a multitenant environment, only a system administrator can 
display skill levels. For details, see Section 19.3, “Administrator roles 
in a multitenant environment”, on page 394. 

To display skill levels:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Routing.

3. Click the Advanced tab.

4. Under Skill Level, click Display Skill Levels. 

5. In the Display Skill Levels dialog box, under Do you want to 
show skill levels?, select Yes, and then click OK. 

6. When the system prompts you to confirm that you want to show 
skill levels, click Yes. The system turns on skill levels. 

7. Click OK. 
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8.4.8  Displaying skill preferences

A preference is a predilection a user has for a particular skill. When 
preferences are enabled, each skill in a user's skill set is given a 
preference from 1 to 9, where 9 is the most preferred. Skill preferences 
are taken into consideration when calculating the skill scoring (see 
Section 8.4.4, “About skill scoring”, on page 174).

IMPORTANT:  Displaying skill preferences is a one-way operation. 
The system cannot be converted back after it has been changed. 

NOTE:  This feature is available only when skills-based routing is 
enabled (see Section 8.4.3, “Changing to skills-based routing”, on page 
173). 

NOTE:  In a multitenant environment, only a system administrator can 
display skill preferences. For details, see Section 19.3, “Administrator 
roles in a multitenant environment”, on page 394. 

To display skill preferences:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Routing.

3. Click the Advanced tab.

4. Under Preferences, click Display Preferences.

5. In the Display Skill Preferences dialog box, under Do you want 
to show skill preferences?, select Yes, and then click OK. 

6. When the system prompts you to confirm that you want to show 
skill preferences, click Yes. The system turns on skill preferences. 

7. Click OK.
A31003-S22B1-M103-08-76A9, 04/2025
OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide 161
         



Routing

routing.fm

Configuring the routing options
8.4.9  Changing to multiple contact handling

You can convert the OpenScape Contact Center system to multiple 
contact handling, which allows users to handle more than one contact 
at the same time. This conversion affects the way the system routes 
contacts and is irreversible. 

When the system is configured for multiple contact handling, you must 
configure the contact handling rules that can be applied to a user. For 
details, see Section 8.3.1, “Configuring a contact handling rule”, on 
page 169. 

IMPORTANT:  Changing to multiple contact handling is a one-way 
operation. The system cannot be converted back after it has been 
changed. 

NOTE:  In a multitenant environment, only a system administrator can 
change the system to multiple contact handling. For details, see 
Section 19.3, “Administrator roles in a multitenant environment”, on 
page 394. 

To change to multiple contact handling:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Routing.

3. Click the Advanced tab.

4. Click Change to multiple contact handling. 

5. In the warning dialog box, under Do you want to change to 
multiple contact handling?, select Yes, and then click OK. 

6. When the system asks you to confirm that you want to change to 
multiple contact handling, click Yes. The system changes to 
multiple contact handling. 

7. Click OK. 
 A31003-S22B1-M103-08-76A9, 04/2025
162 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



routing.fm

Routing
Configuring the routing options
8.4.10  Configuring a call or callback as the 
primary contact

When the system is configured for multiple contact handling, you have 
the option to specify that, if the user has an active call or callback, it is 
always the primary contact. This option is selected by default. In a 
multitenant environment, only a system administrator can configure a 
call or callback as the primary contact. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure a call or callback as the primary contact:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Routing.

3. Click the Advanced tab.

4. Under Multiple contact handling, to configure a call or callback 
as the primary contact, select the Always make the active call 
or callback the primary contact check box. 
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9  Working with workflows
This chapter provides a detailed introduction to workflows, walks you 
through an exercise in creating a workflow, and provides information 
on related tasks.

The OpenScape Contact Center system uses the following types of 
workflows:

• Routing strategy workflows – see Section 9.2, “About routing 
strategy workflows”, on page 146

• Queue processing workflows – see Section 9.5, “About queue 
processing workflows”, on page 174. 

• Networking workflows – see Section 16.5, “About networking 
workflows”, on page 365. 

9.1  About workflow diagrams

A workflow diagram is a visual script similar to a programming 
flowchart. It defines the sequence of events that is used to route or 
process contacts in queue. Decisions can be based on existing 
OpenScape Contact Center information such as contact data, 
performance statistics, database queries, and schedule information. 
Information can also be retrieved from an external data source. 

NOTE:  A slow connection to a data source will affect contact center 
performance. Ensure that any data sources you connect to will not 
affect the productivity of your contact center. 

A workflow diagram includes components and connection lines 
between the components to indicate the contact workflow. 

• Components are stopping points in the workflow diagram. They can 
be used to make a decision based on data, update performance 
statistics, transfer a contact to another location, simply pause, or 
perform other tasks. 

• Connection lines are used to indicate the contact workflow between 
the components. If a decision is required, one line is created for 
each possible output of the component. 

Workflow diagrams are configured using the Design Editor.
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9.2  About routing strategy workflows

A routing strategy workflow is a sequence of events that determines 
the routing of a contact in the contact center. Workflow processing can 
route a contact based on criteria such as time, the source or destination 
of the contact, information obtained by database lookup, and 
performance statistics. Other media-specific criteria, such as 
information collected from the customer using Call Director or 
keywords in e-mail messages, can also be used.

Ultimately, a routing strategy workflow must result in one of the 
following actions:

• Route the contact to a user.

• Route the contact to a queue.

• Disconnect or discard the contact.

You can also configure a routing strategy workflow to link to another 
routing strategy workflow, if required. 

For each media type available in the contact center, OpenScape Contact 
Center provides a default routing strategy to route contacts to a default 
queue. You can make a copy of the default routing strategy and use it 
as the starting point for creating a new routing strategy workflow, or 
you can create a new one. 

NOTE:  When the system is configured for high availability (warm 
standby), the execution of a routing strategy workflow can be impacted 
by a failover. This is because some decisions that are made in a routing 
strategy workflow are based on statistics that may have different 
values after a failover. For more details on the high availability (warm 
standby) feature, see Chapter 18, “Working with the high availability 
(warm standby) feature”. 
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9.2.1  Basic routing strategy workflow 
example

The following diagram shows an example of a simple voice routing 
strategy workflow. It routes a contact to a queue based on the pilot 
number associated with a dialed number. 

While simple, this example illustrates the most basic rules that you 
must follow when creating a routing strategy workflow. A routing 
strategy workflow:

• Begins processing at a Start component. 

• Has intermediate processing that typically involves gathering 
information and making decisions based on that information. In the 
example, intermediate processing is provided by the Check Dialed 
Number component. Intermediate processing is normally more 
complex than shown here. 

• Is terminated by a valid end component. In this example, the 
Enqueue components are the end components. 

The small square objects are workflow components. You can trace the 
execution of a routing strategy workflow by following the connection 
lines that link the components in the workflow. Where a component 
branches into two or more execution paths, as in the case of the Check 
Dialed Number component, that component’s execution involves a 
decision, and execution continues along only one of the paths 
depending on the results of the decision. The paths away from the 
component are known as outputs.

The icons on the components indicate different component types, 
which perform different actions. For example, while the Enqueue to 
Stocks and Enqueue to Mutual Funds components have different 
names, they are both Enqueue components. An Enqueue component’s 
function is to route a contact to a specified queue.
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The Check Dialed Number component is a Source/Destination 
Decision component. 

A Source/Destination Decision component compares the source or 
destination associated with the incoming contact to a list of one or 
more sources and destinations specified when you create the 
component. In the example, the Check Dialed Number component 
checks the pilot number associated with the incoming call for a match 
with 1234. This destination is associated with the dialed number 212 
BROKERS (212 276-5377) on the communication platform. If there is 
a match, the Enqueue to Stocks component will execute next. If they 
do not match, the Enqueue to Mutual Funds component will execute 
next.

9.3  Routing strategy workflow considerations

OpenScape Contact Center provides information from several sources 
that can be used in a routing strategy workflow. Some of this 
information can be used directly or indirectly in routing an incoming 
contact. 

In planning your routing strategy workflow, you should focus on 
answering two questions:

• What information can a routing strategy workflow use to route 
contacts?
 A31003-S22B1-M103-08-76A9, 04/2025
148 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



flows.fm

Working with workflows
Routing strategy workflow considerations
• How does a routing strategy workflow use that information to route 
contacts?

The following topics answer those questions.

9.3.1  Source/destination information

When configuring a Source/Destination Decision component, you can 
provide a list of sources, destinations, or source/destination 
combinations that the component is to compare with the source/
destination details of an incoming contact. Every source/destination 
pair entered results in an exit point for that Source/Destination 
Decision component. The default (*,*) entry in the list of source/
destination combinations is also an exit point that can be used for the 
case where there is no specific matching entry. 

NOTE:  The format of voice sources and destinations available to 
OpenScape Contact Center depends on your geographic location and 
on communication platform programming. The examples provided in 
this book take the following forms: destinations are pilot numbers 
mapped to the dialed number, and sources are 10-digit North American 
telephone numbers.

NOTE:  Unlike other media, Web collaboration sources and 
destinations are site-defined. For details, see Section 15.3, “Web 
collaboration sources and destinations”, on page 339. 

A destination is typically used directly in routing the contact to a queue. 
For example, if you have two lines, 212 BROKERS and 212 FUNDS4U, 
you could route the contact similarly to the routing strategy workflow 
shown in Section 9.2.1, “Basic routing strategy workflow example”, on 
page 146. Contacts on the destination associated with 212 BROKERS 
(pilot number 1234) are routed to the Stocks queue, while contacts on 
the 212 FUNDS4U destination are enqueued to the Mutual Funds 
queue. 
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Similarly, there are a number of uses for the source associated with a 
contact. For example:

• For calls, you could make a source-based decision based on the 
caller’s geographic location. Since the configuration of a Source/
Destination Decision component lets you use wildcards, you could 
check the area code portion of the source of an incoming contact 
and enqueue the contact based on whether it is local.

• You could configure a Source/Destination Decision component to 
look for matches against the e-mail addresses or telephone 
numbers of your biggest accounts or customers. This would let you 
check the source of an incoming contact against those sources and 
route the contact based on that criterion. In the following example, 
three outputs from the Prime Customer? Source/Destination 
Decision component all link to the same Enqueue component.
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9.3.2  Information collected from a call 

If you are using Call Director, the routing strategy workflow can drive 
Call Director to collect information from the caller. In the simplest 
scenario, you prompt the customer for the purpose of their call, and 
then use the information provided to direct the contact.

NOTE:  In addition to using Call Director, you can also use an IVR to 
collect information from the caller.

For example, you could use a single 212 UINVEST line to service 
customers interested in talking to specialists in the areas of Stocks, 
Mutual Funds, or Bonds. When a contact arrives in OpenScape Contact 
Center, a menu could prompt the caller to choose one of these options. 

In this example, Choose Investment Type is a Menu Prompt 
component. When you configure a Menu Prompt component, you 
specify the valid choices that a customer can make. You can then 
create an exit point on the Menu Prompt component for each of those 
choices. In the Choose Investment Type component, the three valid 
exit points correspond to Stocks, Mutual Funds, and Bonds.

In the above example, the caller’s choices directly choose a queue. The 
information that you collect from the customer does not have to be 
used so directly. For example, you could prompt the user to make one 
of two choices:

• To hear a list of services we offer, press 1

• To talk to an agent, press 2

If the caller presses 1, you play them a simple message and then 
disconnect. If the caller presses 2, you route the contact based on the 
destination. The following diagram illustrates the routing strategy 
A31003-S22B1-M103-08-76A9, 04/2025
OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide 151
         



Working with workflows

flows.fm

Routing strategy workflow considerations
workflow that executes this strategy. The Describe Services 
Message is a Message component. It plays the caller a recorded 
message then passes execution to the next component. 

In addition to menu prompting, if OpenScape Contact Center is working 
with Call Director, you can have a routing strategy workflow perform 
simple digit collection, such as having callers provide a credit card 
number. 

9.3.3  Scheduling information

You can set up OpenScape Contact Center schedules that dictate how 
contacts are treated based on the time of day, day of week, and specific 
dates. You can set up schedules to handle contacts according to:

• Time of day and days of the week when your contact center is open

• Specific dates through the year that the contact center is closed

• Routing requirements changing throughout the day. For example, 
you may have different shifts working at different times with 
different staffing and contact volume requirements
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For example, assume that you have the following voice scenario:

• During normal business hours, Monday through Friday, contacts to 
212 BROKERS are directed to the Stocks queue. The Stocks queue 
is configured to route the contacts to specialists in the area of 
stocks, almost exclusively. You have similar setup for inquiries on 
Mutual Funds and Bonds.

• After-hours traffic is much lighter than through the day, and you 
have a smaller, less specialized staff working in the evening. With 
these factors, you lose the benefits of highly specialized queues. 
Between 5:00 P.M. and 9:00 P.M., contacts to 212 BROKERS could 
be directed to a General After Hours queue. That queue could 
initially try to match the contact to a stocks specialist, subsequently 
relax matching so that the contact is handled by a less-qualified 
user, and be configured to time out to a voice mail extension. 

• The contact center is closed Saturday and Sunday every week. You 
want a specific weekend message played to customers on these 
days.

• The contact center is closed all day, January 1. You want a specific 
holiday message played to customers on this date.

• At all other times when the contact center is closed, you want a 
general message played to customers.

The following diagram shows a routing strategy workflow that performs 
the routing for this scenario.
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Stock Center Schedule is a Schedule component. When configuring 
a Schedule component you create a specific case for each time/day/
date that requires different handling. Any times and dates not covered 
by these cases are treated as a default case. Outputs 1 through 4 
correspond to the daytime, evening, weekend, and January 1 periods 
mentioned above. The default output corresponds to all times not 
defined for Outputs 1 through 4.

You are not restricted to a single schedule. You can reference multiple 
schedules in the same workflow. If your contact center has a wide 
variety of functional areas, you might require a separate schedule for 
each area. You might for example, want to associate a separate 
schedule with each destination supported by your contact center.

For an example of how you set up a Schedule component, see Section 
9.10.3, “Adding a Schedule component”, on page 185.

9.3.4  Statistics

OpenScape Contact Center maintains a continually updated set of 
performance statistics. In general, OpenScape Contact Center keeps 
track of:

• Count statistics such as the number of currently available users in 
a group, number of contacts waiting, and number of users logged 
on.

• Calculated statistics such as the current service level, estimated 
wait time, and abandoned time.

A routing strategy workflow has access to a number of these statistics 
at the queue level. This allows you to base your routing on current 
conditions, such as contact volume and staffing levels. 
 A31003-S22B1-M103-08-76A9, 04/2025
154 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



flows.fm

Working with workflows
Routing strategy workflow considerations
For example, prior to enqueuing, you could check the current number 
of contacts waiting in a voice queue. If there were no contacts waiting, 
or an acceptably small number, you would route the contact to that 
queue. Otherwise, you could play the caller a message and then 
transfer the contact to voice mail.

In this example, Calls in Stocks Queue over 10 and Calls in Funds 
Queue over 10 are Performance Decision components. This 
component type performs a simple comparison on a specific statistic 
using comparison operators such as equals, over (greater than) and 
under (less than). It then passes execution to the next component 
depending on whether the test returned yes (true) or no (false). 

9.3.5  Contact data

Each contact being processed by OpenScape Contact Center has a set 
of information, referred to as contact data, that is available for the life 
of the contact. You can use the contact data to keep track of arbitrary 
information about the contact. You can make use of the contact data 
in a workflow to help you route a contact or for other purposes.

You can think of the contact data as a list of key/value pairs. For 
example, the following table demonstrates contact data consisting of 
four key/value pairs. 

Key Value

Name Bill Lee

Address1 955 Morning Glory Circle

Address2 Buffalo, New York

Source (716) 555-1212

Table 2 Contact data as a list of key/value pairs
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With some of the component types available for use in a routing 
strategy workflow, you can write key/value pairs to the contact data. 
For example, the contact data shown in the table could have been 
created by retrieving a record from a customer database and writing 
the results to the contact data. 

NOTE:  For more information on database lookup in a routing strategy 
workflow, see Section 9.3.6, “Database functions”, on page 158.

You can also make routing decisions based on values in the contact 
data. For example, in a banking situation, when a call arrives in 
OpenScape Contact Center, you could have a customer enter their 
account number. This number might be used to identify the account as 
a savings or checking account. Writing this value to the contact data 
would allow you to later queue the contact using that criterion.
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In this example, Collect Account Number is a Digit Collection 
component and Determine Type of Account is a Contact Data 
Decision component. The configuration for these components are 
shown below. 

The Collect Account Number component prompts the customer for 
an account number and writes the provided digits as the value of a 
contact data key/value pair associated with the key 
CONTACT_DATA_ACCT_NM. In this example, checking account 
numbers are in the range 10001 through 19999 while savings account 
numbers are in the range 20000 through 29999. The Determine Type 
of Account component passes execution to one of the two Enqueue 
components, based on which of these ranges the 
CONTACT_DATA_ACCT_NM value falls within. 

NOTE:  Digit Collection components are available only if OpenScape 
Contact Center is working with Call Director. 

Contact data information does not have to be used strictly in routing a 
contact. You can also record information to be used later, to record a 
caller’s previous choices for example. Contact data is also useful to the 
user who is handling the contact.
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For example, you might want callers to 212 FUNDS4U routed directly 
to the Mutual Funds queue. To do this, when a contact arrives, you 
could use a Menu Prompt component to allow the caller to indicate one 
of three levels of risk tolerance (high, medium, low). You could then 
record the choice in the contact data using a Contact Data Update 
component. In this example, the Risk = Low, Risk = Medium, and 
Risk = High components are Contact Data Update components. 

This information would then be available to the user answering the 
contact. Alternatively, after the contact is enqueued, you might want 
to use this information in a queue processing workflow to choose a 
relevant message to play to the caller while the caller waits.

NOTE:  You can pass contact data as a parameter to a DLL or COM 
module called from a Custom Function component. For details, see 
Section 9.3.7, “Custom functions”, on page 166.

9.3.6  Database functions

If you have access to an ODBC-compliant data source, you can use any 
SQL statement in a routing strategy workflow to query or update the 
data source. While the most common use of this action is to access 
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customer database information, this functionality can be used for other 
purposes, for example, to access product information or other 
information used in routing the contact. 

NOTE:  In case you are querying data with non-west-european 
characters, be sure that your ODBC-compliant data source uses UTF-8 
encoding and not any other code page containing those characters.

For example, your contact center could have two levels of customer 
membership: standard and premium. When a call arrives in OpenScape 
Contact Center, you could prompt the caller for their membership ID. 
You could then query the database to check the caller’s membership 
level, and enqueue premium members to a queue set up specifically for 
premium members. 

In this example, Query Membership ID is a Database Function 
component. A Database Function component lets you issue a query to 
an ODBC data source based on a contact data value. The results can 
be formatted and written to the contact data record for subsequent 
use. 

The configuration of the Collect Account Number, Query 
Membership ID, and Premium Member? components are shown 
below. The Collect Membership ID Digit Collection component 
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prompts the customer for a membership ID and writes the provided 
digits as the value of a contact data key/value pair associated with the 
key CONTACT_DATA_ACCT_NM.

The Query Membership ID Database Function component:

1. Issues a query with a WHERE clause that returns the record 
associated with the CONTACT_DATA_ACCT_NM key’s value. For 
details and examples of query construction, see the Section 
9.3.6.1, “Formatting database functions”, on page 160.

2. Writes the membership_type returned with the record as the value 
of a contact data key/value pair associated with the key 
CONTACT_DATA_MEM_TP. 

9.3.6.1  Formatting database functions

This section provides details and examples on the use of variables and 
parameterization in a Database Function component. 

Variable substitution

You can use the ~ (tilde) character to populate the variables in an SQL 
statement: 

• If the data type is a string, use '~VARIABLE~'. 

• If the data type is numeric, use ~VARIABLE~.

1

2
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You can specify a variable that takes its value from the contact data, 
or you can use the predefined SOURCE, DESTINATION, and 
CONTACTID variables, which take their values from the communication 
platform or enqueue request. 

NOTE:  If you use the SOURCE or DESTINATION variable, the contact 
source (ANI) or contact destination (DNIS) will be used, respectively, 
unless SOURCE or DESTINATION has already been specified as a 
contact data key, in which case, the value from the contact data will be 
used. If you use the CONTACTID variable, the Contact ID will always 
be used, regardless of whether it has been specified as a contact data 
key.

NOTE:  For details on how to work with contact data, see Section 
9.3.5, “Contact data”, on page 155. 

Assume the following key/value pairs exist in the contact data: 

<Caller_Name, Peter> and <Order_Number, 13478>

You can specify a contact data key name as a variable. 

If the SQL statement on the Data tab is:

SELECT First_Name AS Name FROM Customer_table WHERE 
First_Name = '~Caller_Name~'

the actual database query will be:

SELECT First_Name AS Name FROM Customer_table WHERE 
First_Name = 'Peter'

If the SQL statement on the Data tab is:

SELECT Number AS Destination_Number FROM Customer_table 
WHERE Number = ~DESTINATION~

the actual database query will use the destination associated with the 
call:

SELECT Number FROM Customer_table WHERE Number = 1234

Formatting data retrieved using SQL

SQL statements are required when you create a Database Function 
component. Information is retrieved from or inserted into the data 
source using SQL. 

You can use any SQL statement to retrieve data in a Database Function 
component, including stored procedures. If you use a stored 
procedure, you must code the procedure so that the returned data type 
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is supported by ODBC. Also, you must name the values in the returned 
data so that they can be used later by the Database Function 
component. 

For detailed information on how to use SQL, refer to your SQL 
documentation.

IMPORTANT:  You should create an SQL statement only if you are 
experienced in SQL.

After the information is extracted from the database, and then 
formatted, the information can be added to the contact data with a key 
you specify. You can use the contact data in other components of a 
workflow to make decisions.

The following functions can be used to extract information from the 
database value:

• "Value function example"

• "Substring function example"

• "Rightstring function example"

• "Combine function example"

• "Tag function examples"

You can use variable substitution to enhance your database query by 
integrating the database query with contact data information. 

Value function example

Example: Extract an order number for customer # 1234

Sample data:

A database table “Orders” contains a Customer_ID, 
Customer_Name, Order_Date, and Order_Number. For example, 
the data reads: 1234, John Smith, 03222004, D65746.

Sample SQL statement:

SELECT Order_Number AS Current_Order_Number FROM Orders 
WHERE Customer_ID = 1234

Result of SQL database search:

D65746, in the variable Current_Order_Number

Use the Value function with the parameter Current_Order_Number 
to extract the order number without any formatting. In the Contact 
Data dialog box, in the Key box, type the contact data key 
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Order_Number_Key, or any other key name. The contact data will 
contain Order_Number_Key, D65746 after the component is executed 
in a workflow.

Substring function example

Example: Extract the first three characters of the order number which 
indicate the region for the customer.

Sample data:

A database table “Orders” contains a Customer_ID, 
Customer_Name, Order_Date, and Order_Number. For example, 
the data reads: 1234, John Smith, 03222004, D65746.

Sample SQL statement: 

SELECT Order_Number AS Order_Region FROM Orders WHERE 
Customer_ID = 1234 

Result of SQL database search: 

D65746, in the variable Order_Region

Use the Substring function with parameters Order_Region, 1, 3 to 
extract the characters 1 – 3 of the Order_Region. In the Contact Data 
dialog box, in the Key box, type the contact data key Region, or any 
other key name. The contact data will contain Region, D65 after the 
component is executed in a workflow.

Rightstring function example

Example: Check to see if a customer had an invoice in the current year.

Sample data:

A database table “Orders” contains a Customer_ID, 
Customer_Name, Order_Date, and Order_Number. For example, 
the data reads: 1234, John Smith, 03222004, D65746.

Sample SQL statement: 

SELECT Order_Date AS Current_Order_Date FROM Orders WHERE 
Customer_ID = 1234 

Result SQL database search: 

03222004, in the variable Current_Order_Date

Use the Rightstring function with parameters Current_Order_Date, 
4 to extract the last four numbers of the Current_Order_Date. In the 
Contact Data dialog box, in the Key box, type the contact data key 
Year. The contact data will contain Year, 2004 after the component is 
executed in a workflow.
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Combine function example

Example: Highlight the order number for a rush order to a special 
customer.

Sample data:

A database table “Orders” contains a Customer_ID, 
Customer_Name, Order_Date, and Order_Number. For example, 
the data reads: 1234, John Smith, 03222004, D65746.

Sample SQL statement: 

SELECT Order_Number AS Current_Order_Number FROM Orders 
WHERE Customer_ID = 1234 

Result of SQL search in database: 

D65746 in the variable Current Order Number

Use the Combine function with parameters 
Current_Order_Number, “-SO” to extract data from 
Current_Order_Number. In the Contact Data dialog box, in the Key 
box, type the contact data key Order Number. The contact data will 
contain Order Number, D65746-SO after the component is executed in 
a workflow.

NOTE:  In the Combine with space function, the only difference is 
that a space is added between the two parameters. 

Tag function examples

XML text is parsed using the following criteria:

• Every element must have an opening tag and a closing tag.

• Only one top level element is allowed.

• You can search only on child elements, not attributes.

• You can search for elements on different levels.

Example: Select a particular customer (in this case the second) from 
XML text.

Sample Data:

A database table, “Customer” contains Names and Country_Codes. 
For example, the Names data reads: 
<Customer_Record><Customer_Name>Peter Jones</ 
Customer_Name><Customer_Name>John Smith</
Customer_Name></Customer_Record>, and the Country_Codes is 
01.
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Sample SQL statement: 

SELECT Names AS Full_Name FROM Customer WHERE 
Country_Codes = 01.

Result of search: 

<Customer_Record><Customer_Name>Peter Jones</ 
Customer_Name><Customer_Name>John Smith</
Customer_Name></Customer_Record>

Use the Tag function, with the parameters Full_Name, 
“Customer_Name”, 2 to extract the second occurrence of 
Full_Name. In the Contact Data dialog box, in the Key box, type the 
contact data key Name. The contact data will contain Name, John 
Smith, after the component is executed in a workflow.

NOTE:  The Tag parameter must be in quotation marks.

Example: Select elements from different levels within XML text.

Sample Data:

<contact category=”Sales”><fullname>John Smith</
fullname><phonenumbers><home>8015552323</
home><cell>8015553232</cell></phonenumbers><email 
address='jsmith@email.com'/></contact>

Search for full name (element labeled “fullname”)

Result: John Smith

Search for telephone numbers (element labeled “phonenumbers”)

Result: 80155523238015553232

Search for home telephone number (element labeled “phonenumbers” 
and sub-element “home”)

Result: 8015552323

Search for attribute category (element labeled “category”)

Not allowed – you can search only for a child element as in previous 
examples.

Search for contact category (element labeled “contact category”)

Not allowed – contact is a tag name, category is an attribute name. 
They cannot be used together in a search.

Search for contact (element labeled “contact”)
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Result: John Smith80155523238015553232

NOTE:  E-mail address does not go into this search result because it is 
stored in the attribute instead of a child element.

9.3.7  Custom functions

The workflow components provided with OpenScape Contact Center 
provide a wide range of functionality that lets you collect information 
on incoming contacts, make routing decisions, and otherwise automate 
aspects of your contact center. You can also make use of functionality 
that is outside the scope of the topics covered in this chapter. 

You can write a custom function in a DLL or COM module and call the 
function from a routing strategy or queue processing workflow, for all 
supported media. The function is passed contact data associated with 
the contact and the function can:

• Modify the provided contact data values – For example, if you 
prompted the customer for a seven-digit account number, you could 
have the workflow format the number to include spaces or dashes, 
for display purposes. 

• Add new contact data for use in the workflow – This would be useful 
if you wanted to make use of a value not normally available in a 
workflow. This might be derived from information passed as inputs, 
by a calculation for example. Similarly, the information might be 
obtained from a third party source, by a database query for 
example, processed in some way and passed back to the workflow. 
After the custom workflow finishes executing, the new information 
is available as contact data for use in the workflow.

• Perform tasks that are entirely outside the scope of OpenScape 
Contact Center processing – You could, for example, write contact 
details out to a custom contact log. 

NOTE:  For details on how to work with contact data, see Section 
9.3.5, “Contact data”, on page 155.
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After you have written and compiled a custom function, you can call the 
function in a routing strategy or queue processing workflow. In the 
following example, the caller is prompted for a seven-digit account 
number. 

The account number is written to the contact data and it is the 
responsibility of the Extract Membership Level Custom Function 
component to parse out the third, fourth, and fifth digits, 
corresponding to the caller’s membership level, and create a new 
contact data key/value pair with these digits. The contact could then 
be enqueued based on whether the three digits constitute a premium 
or general membership.

9.3.7.1  Programming custom functions

This section provides direction in writing DLLs and COM module 
functions used in conjunction with Custom Function components. 

Contact data as input and output parameters

When a DLL or COM custom function is called, it is passed a configured 
subset of the current contact data as a character string. Similarly, the 
custom function is expected to return a set of updates to the contact 
data as a character string. 

NOTE:  A queue set up to use the supplemental information feature 
can collect contact information and store it as contact data. For more 
information, see Section 10.3.1.1, “About the supplemental 
information feature”, on page 203.
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Datatype and declaration

Parameters storing the contact data input and output parameters must 
be declared as single byte character strings in DLLs and as BSTR (wide) 
character strings in COM modules. The following table shows the 
declarations.

NOTE:  The custom function does not have to be named 
CustomFunction. The function name can be any value legal for a COM 
module or DLL function.

The first parameter stores the contact data key/value pairs to be 
passed into the custom function while the second parameter is used to 
return the contact data modified by the custom function to the 
workflow that called the custom function. The type of character data 
that may be stored and passed in both the input and the output 
parameters is restricted to ISO-8859-1 compatible characters: 

• When the interface type is a DLL component, the characters must 
be ISO-8859-1 single byte characters. 

• When the interface type is a COM component, the parameter 
contents must be encoded as UNICODE code page 28591 (ISO 
8859-1 Latin 1).

Contact data string layout

Contact data is passed to and returned from custom functions in 
character strings. The first two characters in the string store the 
number of key/value pairs and each subsequent block of 160 
characters stores a key/value pair. Up to 99 key/value pairs can be 
passed into and returned from the custom function.

Within each record, the first 32 characters are reserved for the contact 
data key and the remaining 128 characters are reserved for the contact 
data value. Unused bytes within these key and value string fields must 
be padded with NULL values (binary zero). 

Type Declaration

DLL long = CustomFunction(char * pInput, char * pOutput)

COM HRESULT = CustomFunction(BSTR bstrInput, BSTR bstrOutput)

Table 3 Sample COM and DLL function declarations
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For example, the following diagram shows the layout of the character 
string used to pass the contact data key/value pair PIN/1234 into a 
custom function:

The output string passed back to OpenScape Contact Center from the 
custom function is formatted using the same rules. The number of key/
value pairs passed within the input parameter and the output 
parameter may differ. The following diagram shows the layout of a 
character string used to return contact data from a custom function. 
The contact data input above has been updated to include an address, 
Address/2211 High Street, possibly obtained by a database query. 

Constraints

When writing a custom function, observe the following constraints:

• Ensure that the function called from the Custom Function 
component, and any functions it calls in turn, are threadsafe. These 
functions must be reentrant and multiprocessor-safe.

• During execution of the custom function, memory ownership 
remains with the Routing Server. Custom functions should not 
perform memory allocations or reallocations for the input nor the 
output strings nor delete them.

Runtime restrictions

After the input parameters are packaged, the custom function is called. 
During this time, workflow execution for the contact is halted. The COM 
module or DLL function must finish execution within five seconds. 

When a custom function completes successfully, workflow execution 
resumes at the component that follows the Custom Function 
component. To indicate successful execution, a custom function must 
return one of the following return codes:

• For DLLs, 0

• For COM modules, a value that can be validated with the 
SUCCEEDED macro 
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In addition to the return code and time limit restrictions imposed by 
OpenScape Contact Center, runtime errors in the custom function code 
can result in exceptions. If an exception is raised during the execution 
of the custom function, OpenScape Contact Center terminates 
workflow processing.

If the function does not successfully complete within five seconds, 
returns a return code other than those described above, or otherwise 
throws an exception, the next action will depend on the type of 
workflow that called the custom function:

• If a routing strategy workflow called the custom function, the 
contact is enqueued to the error queue specified for that routing 
strategy or to the global error queue specified for the associated 
media if no routing strategy error queue is specified.

• If a queue processing workflow called the custom function, the 
queue processing workflow terminates. For calls, the contact 
returns to default communication platform treatment. For other 
contact types, the workflow simply terminates and the contact 
remains enqueued. For all media, OpenScape Contact Center will 
continue to try to match the contact to a user.

NOTE:  When a custom function fails, an error code and description are 
displayed in the System Monitor application.

Sample DLL source code

The following is an example of the source code for a custom function 
called within a DLL.

CustomFunctionExampleDLL.cpp : Defines the entry point for the DLL 
application.
//

#include <stdlib.h>
#include "stdafx.h"

BOOL APIENTRY DllMain( HANDLE hModule, 
                       DWORD  ul_reason_for_call, 
                       LPVOID lpReserved
 )
{
    return TRUE;
}
extern "C"
{
   __declspec(dllexport) long CustomFunctionExample(const char * dataIn, char 
* dataOut)
   {
      // Determine number of input parameters
      char numParametersAsString[3] = {dataIn[0], dataIn[1], '\0'};
      const unsigned int numParameters = atoi(numParametersAsString);

      const unsigned int HEADER_SIZE = 2;
      const unsigned int KEY_SIZE = 32;
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      const unsigned int VALUE_SIZE = 128;

      // Read each input parameter
      for (unsigned int i = 0; i < numParameters; i++)
      {
         char key[KEY_SIZE] = {0};
         char value[VALUE_SIZE] = {0};

         const unsigned int keyIndex = HEADER_SIZE + i * (KEY_SIZE + 
VALUE_SIZE);
         const unsigned int valueIndex = keyIndex + KEY_SIZE;

         memcpy(key, dataIn + keyIndex, sizeof(key));
         memcpy(value, dataIn + valueIndex, sizeof(value));
      }

      // Return a single output parameter
      dataOut[0] = '0';
      dataOut[1] = '1';

      char outputKey[KEY_SIZE] = {'O', 'U', 'T', '_', 'K', 'E', 'Y', '\0'};
      char outputValue[VALUE_SIZE] = {'O', 'U', 'T', '_', 'V', 'A', 'L', 'U', 
'E','\0'};

      memcpy(dataOut + HEADER_SIZE, outputKey, sizeof(outputKey));
      memcpy(dataOut + HEADER_SIZE + KEY_SIZE, outputValue, 
sizeof(outputValue));

      return 0;
   }
}

9.4  Configuring a routing strategy workflow

A routing strategy workflow is typically used to route a contact to a 
queue, but the contact can also be routed to a user or disconnected or 
discarded. For more information, see Section 9.2, “About routing 
strategy workflows”, on page 146. 

NOTE:  To create or change a routing strategy workflow, you must 
have Full or Modify access, respectively, for the associated Manager 
permission.

If you are configuring a voice routing strategy workflow, you must 
configure the .wav files that you want to use before you begin (see 
Section 12.3.2, “Configuring a .wav file”, on page 224). 

NOTE:  You cannot create a routing strategy workflow diagram that 
connects back to itself. A routing strategy workflow diagram must end 
with a termination component. 
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To configure a routing strategy workflow:

1. On the File menu, point to New, then Design Center, then select 
the media type, and then click Routing Strategy Workflow.

2. On the General tab, under Workflow, do the following:

• In the Name box, type a unique name for the routing strategy 
workflow. The name appears on the tab in the Design Editor 
when you open the workflow diagram. 

• In the Description box, type a description for the routing 
strategy workflow. The description should include the purpose of 
the workflow. 

3. To configure override settings for the workflow, click the Override 
tab, and then do the following:

• For a voice routing strategy workflow, configure the Call Director 
override settings for the workflow, if required. See Section 
9.4.1, “Overriding the default Call Director settings”, on page 
173. 

• Configure the error queue override settings for the workflow, if 
required. See Section 9.4.2, “Overriding the default error queue 
settings”, on page 174. 

4. Click the Reports tab.

5. Under Include, select the reports that you want to display data 
about this routing strategy workflow. The list only contains the 
reports you own, or reports that are owned by users you can 
monitor.

6. Click OK. The application saves the new workflow and gives it a 
status of Incomplete. 

7. In the right pane, double-click the new workflow. A workflow 
diagram appears in the Design Editor with a Start component. 

8. Create the components for the routing strategy workflow diagram, 
as required. 

9. Add components to the workflow diagram. 

10.Connect the components. 

11.On the File menu, click Save.
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9.4.1  Overriding the default Call Director 
settings

You configure the default Call Director settings in the Options dialog 
box (see Section 12.4, “Configuring the Call Director options”, on page 
227). When you configure a routing strategy workflow (see Section 
9.4, “Configuring a routing strategy workflow”, on page 171) or a 
queue processing workflow (see Section 9.7, “Configuring a queue 
processing workflow”, on page 179), you can override the default 
settings. 

Before you begin, the .wav files that you want to use must be 
configured and installed on the main server machine (see Section 
12.3.2, “Configuring a .wav file”, on page 224). 

To override the Call Director settings:

1. In the Voice Routing Strategy dialog box or Voice Queue 
Processing dialog box, click the Override tab. 

2. Under Override Call Director Settings, do any or all of the 
following, if required:

• To override the selected language for spoken messages, select 
the Language check box, then click Standard and select the 
language you want to use from the list. The list contains the 
languages supported by the voice processor. 

NOTE:  The Custom locale ID should be used only by your 
service representative. The use of a language other than one of 
those provided in the Standard list requires additional firmware 
for the voice processor. 

• To override the .wav file that plays when an error occurs, select 
the Error message file name check box, and then select a 
different .wav file from the list. 

NOTE:  If you are connected to a production database, you can 
click  to play the .wav file. You cannot play .wav files when 
you are connected to a design database.

• To override the .wav file that plays if there is no caller response, 
select No response file name check box, and then select the 
.wav file from the list. 
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• To override the .wav file that plays if there is an invalid caller 
response, select the Invalid response file name check box, 
and then select the .wav file from the list. 

• To override the queue that the call is forwarded to when the 
caller presses the Operator key, select the Operator queue 
check box, and then select a different voice queue from the list. 

• To override the .wav file that plays when the caller is transferred 
to the operator, select the Operator transfer file name check 
box, and then select a different .wav file from the list. 

3. If you are finished working with this workflow, click OK.

9.4.2  Overriding the default error queue 
settings

You configure the default error queue settings in the Options dialog box 
for each media type. When you configure a routing strategy workflow 
(see Section 9.4, “Configuring a routing strategy workflow”, on page 
171), you can override the default error queue settings. 

To override the error queue settings:

1. In the Routing Strategy dialog box, click the Override tab. 

2. Under Override Error Queue, do the following: 

• To override the queue where contacts are placed when an error 
is encountered in the routing strategy workflow, select the Error 
queue check box, and then select a different queue from the 
list. 

• To override the default description of the error queue, select the 
Error Description check box, and then type a different error 
queue description in the box. 

3. If you are finished working with this workflow, click OK.

9.5  About queue processing workflows

A queue processing workflow determines what happens to a contact 
while it is waiting in queue. A queue processing workflow dictates:

• For calls, what a caller hears and what actions a caller can take.

• For e-mail messages, what automated actions are applied to the 
e-mail message, for example, auto-acknowledgments and auto-
responses. 
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• For Web collaboration contacts, what standard messages are sent 
to the customer’s session window and what URLs to which their 
browser is directed.

A queue processing workflow works in parallel with the system’s 
attempts to route the contact and will affect the routing only if the 
workflow enqueues the contact to a different queue, transfers, 
discards, or disconnects the contact. When Call Director is enabled, a 
queue processing workflow can also be used to play messages for calls.

In general, in a queue processing workflow, you can perform any of the 
functions that you can use in a routing strategy workflow. 

For each media type available in the contact center, OpenScape Contact 
Center provides a default queue processing workflow. You can make a 
copy of the default workflow and use it as the starting point for creating 
a new queue processing workflow, or you can create a new one. 

NOTE:  When the system is configured for high availability (warm 
standby), the execution of a queue processing workflow can be 
impacted by a failover. This is because some decisions that are made 
in a queue processing workflow are based on statistics that may have 
different values after a failover. For more details on the high availability 
(warm standby) feature, see Chapter 18, “Working with the high 
availability (warm standby) feature”. 

9.6  Queue processing workflow considerations

The following topics introduce the most common uses and aspects of 
queue processing workflows, and explain the differences between 
queue processing workflows and routing strategy workflows.

9.6.1  Looping in a queue processing 
workflow

A workflow can contain loops: one or more components can be 
executed repeatedly. To create a loop, you create a link that runs back 
to a component that has already executed.

NOTE:  Looping in routing strategy workflows is not recommended 
since it can lengthen the time required to enqueue, route, discard, or 
disconnect an incoming contact.
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In a simple voice scenario, a queue processing workflow could start 
with a 30 second wait, then enter a loop: play a message thanking the 
customer for their patience, wait 60 seconds then start the loop again.

In this example, Wait for 60 Seconds and Wait for 30 Seconds are 
Wait Interval components. A Wait Interval component pauses for a 
specified period of time, before the next component in the sequence 
executes. During this time, a voice caller would experience default 
communication platform treatment, typically music-on-hold. Wait 
Interval components can be used only in queue processing workflows. 
They cannot be used in routing strategy workflows. 

You might not want a loop to run indefinitely. If you are using Call 
Director, you could start a voice queue processing workflow with a 90 
second wait interval and then use a Menu Prompt component to offer 
the choice to continue waiting or leave a voice mail message.

You can also perform a test while within the loop to see if a specified 
time has elapsed, or if the loop has executed a specified number of 
times. You can then exit the loop based on the results of the test. The 
following diagram shows a workflow that tests whether a call has been 
enqueued for five minutes and if so, transfers the caller to a voice mail 
pilot number. 
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Queued over 5 minutes? is a Workflow Decision component. Each 
time through the loop, the next component to execute after the 
Workflow Decision component will depend on whether the test yields a 
true or false result.

9.6.2  Exiting a queue processing workflow

A queue processing workflow executes in parallel with the OpenScape 
Contact Center system’s attempts to route the contact to a user. There 
are a number of ways that a queue processing workflow can terminate. 
The workflow will terminate when OpenScape Contact Center 
successfully routes the contact to a user based on the primary and 
overflow groups configured for the queue. The workflow can also 
include component types that terminate the workflow. Like a routing 
strategy workflow, a queue processing workflow can disconnect, 
discard, transfer, or enqueue the contact to a different queue. 

NOTE:  A voice queue processing workflow will terminate if the caller 
abandons the call.

The following diagram shows an example of a voice queue processing 
workflow that lets a caller choose a different queue after a five-minute 
wait in queue.
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You can also terminate execution of a voice queue processing workflow 
by transferring the contact to default communication platform contact 
treatment, typically music-on-hold. For example, if a caller has been 
hearing a recorded message for a specified length of time, you may 
want to have the caller switched to music-on-hold. 

In this example, Music-on-hold is a Default Treatment component. 
After a Default Treatment component executes, the queue will continue 
to attempt to find a user to handle the contact. The caller will 
experience default communication platform treatment until OpenScape 
Contact Center successfully routes the contact to a user or the caller 
abandons the contact. 

IMPORTANT:  Exercise caution when initially enqueuing a contact or 
requeuing a contact to a queue for which a queue processing workflow 
will be executed. Similarly, exercise caution when transferring a 
contact to a number that could result in a routing strategy workflow 
executing. 

Always keep in mind that performance and customer satisfaction can 
be impacted by situations such as: 

• A queue processing workflow requeuing a contact to the queue to 
which it is already assigned, resulting in the same workflow 
executing again.

• A queue processing workflow associated with Queue A requeuing a 
contact to Queue B, whose associated queue processing workflow 
requeues the contact back to Queue A.

• A routing strategy workflow transferring a contact to the main 
OpenScape Contact Center pilot number, resulting in the same 
workflow executing repeatedly.
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9.7  Configuring a queue processing workflow

A queue processing workflow determines what happens to a contact 
while it is waiting in queue. For more information, see Section 9.5, 
“About queue processing workflows”, on page 174. 

NOTE:  To create or change a queue processing workflow, you must 
have Full or Modify access, respectively, for the associated Manager 
permission. 

If you are configuring a voice queue processing workflow, you must 
configure the .wav files that you want to use in the workflow before you 
begin (see Section 12.3.2, “Configuring a .wav file”, on page 224). 

You can create a looping queue processing workflow where a particular 
component is repeated until the contact is handled by a user. Use a 
Workflow Decision component to set a condition for the repeated 
components. For details, see Section 9.6.1, “Looping in a queue 
processing workflow”, on page 175. 

To create a queue processing workflow:

1. On the File menu, point to New, then Design Center, then select 
the media type, and then click Queue Processing Workflow.

2. Under Workflow, do the following:

• In the Name box, type a unique name for the queue processing 
workflow. The name appears on the tab in the Design Editor 
when you open the workflow diagram. 

• In the Description box, type a description for the queue 
processing workflow. The description should include the purpose 
of the workflow. 

3. For a voice queue processing workflow only, click the Override tab 
and configure the Call Director override settings for the workflow, if 
required. See Section 9.4.1, “Overriding the default Call Director 
settings”, on page 173. 

4. Click OK. The application saves the new workflow and gives it a 
status of Incomplete. 

5. In the right pane, double-click the new workflow. A workflow 
diagram appears in the Design Editor with a Start component. 

6. Create the components for the queue processing workflow, as 
required. 

7. Add components to the workflow diagram. 
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8. Connect the components. 

9. On the File menu, click Save.

9.8  Linking workflows

Within a workflow, you can use a Link component to pass execution to 
another workflow. There are two ways that this can be useful:

• You can break your workflows into manageable pieces, creating a 
hierarchy with a main workflow that calls one or more other 
workflows.

• You can eliminate redundant functionality by creating a single 
subflow that is linked to, from a number of locations.

There is no practical limit on the level of linking you can use. A workflow 
called by another workflow can in turn, call a third workflow, and so on. 
However, the set of workflows must terminate with a valid End 
component.

Lastly, you can link only to a workflow of the same type. For example, 
a routing strategy workflow can link only to another routing strategy 
workflow; it cannot link to a queue processing workflow. 
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9.8.1  Simplifying workflows

The following diagram shows a partially complete voice routing 
strategy workflow. This work-in-progress is a candidate for a workflow 
that should be broken into a number of smaller pieces.

The first menu prompt asks the user to choose a general investment 
service. A second menu prompt then asks the user to make a more 
specific choice. If the caller first chooses bonds, the caller is then asked 
to choose from a bond category (municipal, institutional, corporate, or 
government bonds). Similarly, if the caller initially chooses mutual 
funds, the caller might then be asked to choose a specific fund family 
(money market, growth, balanced, or specialty). On completion, this 
workflow would be cluttered, making it difficult to maintain. This and 
other complex workflow situations can be helped through the use of 
linking.
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You could create a separate workflow for each branch that occurs after 
the user chooses their basic investment service. You can then modify 
the workflow shown above to link to the three new workflows.

Link to Bond Selection, Link to Fund Family Selection, and Link 
to Market Selection are Link to Routing Strategy components. Link 
to Routing Strategy components exit the current workflow and pass 
execution to another routing strategy workflow.
 A31003-S22B1-M103-08-76A9, 04/2025
182 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



flows.fm

Working with workflows
Activating a workflow
9.8.2  Eliminating redundant functionality

Linking is also useful if you have identical functionality used in several 
workflows or used in several branches of the same workflow. To take a 
simple example, three of the schedule results in the following workflow 
have identical subsequent processing: play a message and then 
disconnect.

You could create a new workflow that contains the play message and 
disconnect functionality and then modify the original workflow to link 
to the new workflow after the three relevant schedule choices.

9.9  Activating a workflow 

While you can create several workflows for a given media, only one 
workflow per media can be active at an OpenScape Contact Center site. 

The default routing strategy workflow is specified in the Options dialog 
box. For details, see the following topics:

• Section 11.5.1, “Configuring the default voice routing strategy, 
queue, and time-out extension”, on page 216

• Section 14.3.1, “Configuring the default e-mail routing strategy, 
queue, and addresses”, on page 254

• Section 15.6.1, “Configuring the default Web collaboration routing 
strategy, queue, and time-out URL”, on page 353
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The default queue processing workflow is specified in the queue 
definition. For details, see Section 10.3.1, “Configuring the general 
queue information”, on page 201. 

9.10  An exercise in creating a workflow

The following sections make up an exercise you can walk through to get 
familiar with creating workflows. This is intended for practise purposes 
only, and the resulting workflow should not be used. 

You will create the following voice routing strategy workflow:

This workflow executes as follows:

1. If a contact arrives outside normal business hours, it is routed to 
voice mail.

2. If the contact arrives within normal business hours:

• If the contact comes in on the dialed number associated with 
stocks inquiries, it is routed to a Stocks queue to wait for a user 
to handle the contact.

• Otherwise, it is routed to the Mutual Funds queue.

9.10.1  Creating the routing strategy 
workflow

The first step in setting up a working a workflow is to create the 
workflow and define its properties.

To create a routing strategy workflow:
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1. In the Design Center, click the  Voice tab.

2. Under Designs, click Routing Strategy Workflows to display the 
existing voice routing strategy workflows. 

3. On the File menu, point to New, then Design Center, then Voice, 
and then click Routing Strategy Workflow. 

4. In the Name box, type Small Branch Contacts. 

5. In the Description box, type a description for the workflow. 

NOTE:  The Override tab can be used to override certain default 
settings. For the purpose of this exercise, you can ignore the 
overrides.

6. Click OK. The new routing strategy workflow is added to the list.

9.10.2  Accessing the Design Editor

OpenScape Contact Center has an editor dedicated to creating and 
maintaining routing strategy workflows and queue processing 
workflows.

To open the Design Editor:

• Double-click the routing strategy workflow you just created. The 
Design Editor opens your routing strategy workflow. It has a single 
component, Start, which indicates the start of processing for an 
incoming contact. 

9.10.3  Adding a Schedule component

The first step in processing a contact is to verify that the contact arrived 
during working hours. A Schedule component uses the current date 
and time to determine how to handle the contact. While there are a 
variety of options in creating Schedule components, this one will simply 
test whether a contact has arrived between the hours of 9 A.M. and 5 
P.M., Monday through Friday.

To add a Schedule component:

1. In the Design Editor, under Components, expand the Decision 
folder, and then expand the Schedules folder. 

2. On the File menu, point to New Component, then Decision, and 
then click Schedules.
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3. In the Name box, type Office Hours. The component name must 
be unique.

4. In the Description box, type a description for the component.

5. In the calendar grid, double-click the Monday/9:00 cell.

6. In the Configure Output dialog box, do the following:

• In the Start time box, type or select 9:00. 

• In the End time box, type or select 17:00.

• Click OK. 
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7. Right-click the area you just defined, point to Copy, and then click 
Tuesday.

8. Repeat step 7 for Wednesday, Thursday, and Friday.

9. Click OK. The new component is added under Schedules.

10.Drag the new component to a location about one inch to the right 
of the Start component and horizontally aligned with the Start 
component. 

NOTE:  When you add a component to a workflow, the label 
includes a number in brackets. This is the number of connections to 
other components that this component will need. You will connect 
components in a later step.

9.10.4  Adding a Transfer component

For this scenario, when a contact arrives outside normal hours, it 
should be forwarded to a voice mail extension so that the caller can 
leave a message. A Transfer component can perform this action. 

To add a Transfer component:

1. In the Design Editor, right-click below the Office Hours 
component, point to Add New Component, then Routing, and 
then click Transfer. A Voice Transfer dialog box appears.

2. In the Name box, type To Voice Mail.

3. In the Description box, type a description for the component.

4. In the Transfer box, type an arbitrary extension number, such as 
1111. For this exercise, assume that this is a valid voice mail 
extension.

5. Click OK. Your workflow should now look like this:
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9.10.5  Adding a Source/Destination Decision 
component

For this scenario, there are two dialed numbers, one intended for 
queries on stocks and the other intended for queries on mutual funds. 
If a contact arrives during normal business hours, you should direct the 
contact to a Stocks queue or Mutual Funds queue based on the dialed 
number. 

You can check for the dialed number using a Source/Destination 
Decision component. In this case you will be interested in the 
destination only.

To add a Source/Destination Decision component:

1. Right-click to the right of the Office Hours component, point to 
Add New Component, then Decision, and then click Source/
Destination Decisions.

2. In the Name box, type Check Dialed Number.

3. In the Description box, type a description for the component. 
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4. Under Configuration, add the source and destination pairs as 
follows:

a) A default source/destination pair (*/*) is provided in the table.

b) In the Source column, below the default pair, type an asterisk 
(*) to indicate any combination of numbers. See the Manager 
Help for more information about using asterisks in the source 
and destination numbers, and the order of consideration for 
source and destination numbers. 

c) In the Destination column, type 1234. For now you can 
assume that 1234 is associated with the dialed number for 
stocks inquiries. Since there are only two dialed numbers 
associated with this contact center, you need to perform a single 
test only. If the test for 1234 passes, you can enqueue to the 
Stocks queue. If the test fails, you can enqueue the contact to 
the Mutual Funds queue.

5. Click OK.

9.10.6  Connecting the components

While additional components will be added to this workflow, you now 
have enough components to begin linking components. This will dictate 
the order in which the components execute. A component has at least 
one input connection, and has none, one, or more output connections.
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To create a line that connects two components:

1. Select the Start component.

2. To create the first link, click the center of the Start component 
(indicated by a small square) and drag a link to the Office Hours 
component. Note that in the Start component label, the required 
links indicator (1) is no longer showing. Likewise, the required links 
indicator for the Office Hours component has dropped from 3 to 
2, indicating that two links are still required before that component 
is fully configured.

3. Select the Office Hours component. In Abschnitt 9.10.3 auf Seite 
9-185, you created a subset of the calendar for Monday through 
Friday between the hours of 9:00 and 17:00. That subset was 
labeled Output 1. The two remaining links from the Office Hours 
component will be:

• Output1 corresponding to the subset of the calendar you 
created.

• Default corresponding to all other times and days.

4. Click the center square of the Office Hours component, and drag 
a link to the To Voice Mail component.

5. Again, select the Office Hours component. Click the center square 
of the Office Hours component, and drag a link to the Check 
Dialed Number component. This is as far as you can proceed with 
linking components for now. Your workflow should look like this:

The remaining tasks are to create and link the components that 
determine the next action taken based on the results of the test 
performed by the Check Dialed Number component.
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9.10.7  Adding the Enqueue components

An Enqueue component routes a contact to a queue where it will wait 
for an eligible user to become available to handle the contact. The 
queue is configured to maximize the chances of the contact being 
handled by a user highly qualified in the area of expertise for which this 
queue was set up. 

To add the Enqueue components:

1. Right-click above and to the right of the Check Dialed Number 
component, point to Add New Component, then Routing, and 
then click Enqueue.

2. In the Name box, type Enqueue to Stocks.

3. In the Description box, type a description for the component.

4. In the Queue box, select any available queue. If you were creating 
a working workflow, you would have a Stocks queue defined. Since 
this is just a practice session, you can pick any defined queue to 
complete the Enqueue component definition.

5. Click OK.

6. Right-click the new Enqueue to Stocks component and select 
Create Copy. A new Enqueue component definition opens, with the 
same values as the Enqueue to Stocks component.
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7. Change the value in the Name box to Enqueue to Mutual Funds.

8. Click OK.

9. Drag the new Enqueue component so that it is below and to the 
right of the Check Dialed Number component.

10.Using the principles you learned in Abschnitt 9.10.6 auf Seite 
9-189, do the following:

• Create a link from the Check Dialed Number component to the 
Enqueue to Mutual Funds component.

• Create a link from the Check Dialed Number component to the 
Enqueue to Stocks component.

11.On the File menu, click Save to save the workflow. 

12.On the File menu, click Close to close the Design Editor. 

9.11  Other component type functions

In this chapter, you have received an introduction to some of the 
component types you can use in work flows. There are many other 
component types you can use. For details on these component types, 
see the Manager Help. 
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10  Working with queues and aggregates
This chapter provides information on working with queues. It provides 
conceptual information on how queues operate, information on how to 
develop a queue setup strategy, and details on how to work with queue 
definitions.

10.1  About queues

A queue is a logical holding area for contacts waiting to be routed to a 
specific user. While a contact is in queue, OpenScape Contact Center 
executes a number of steps to try to match the contact to a specific 
user.

The way in which the queue steps are configured depends on the type 
of routing: group-based or skills-based. For details, see Section 8.1, 
“About group-based routing”, on page 159, or Section 8.2, “About 
skills-based routing”, on page 162.

NOTE:  For an introduction to queue processing, see Section 2.1.3, 
“Queue processing”, on page 12. 

10.2  Queue setup considerations

An OpenScape Contact Center configuration should show a strong 
correlation between the queues you set up and the groups you have 
designated as the first-line choices in answering contacts, or, if you are 
using skills-based routing, the skill combinations you use to build 
virtual groups. 

Working backwards, there is an implied reliance on the information you 
collect and the decisions you make in your routing strategy workflow. 
Your setup will dictate who will answer the contact, how long the caller 
will wait, and the options a caller has while waiting.
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The remaining topics in this section discuss aspects you should 
consider when setting up queues. 

NOTE:  When planning your queue setup, you should also consider the 
group setup if you are using group-based routing, or the virtual group 
setup if you are using skills-based routing. For details, see Chapter 8, 
“Routing”. 

10.2.1  Initial contact processing 

A routing strategy workflow collects information on a contact and based 
on that information, makes a decision as to how that contact is to be 
routed. Initial processing of contacts arriving in the contact center 
should have a strong influence in your queue setup. During initial setup 
or planned reconfiguration, queue setup and routing strategy workflow 
planning should be considered simultaneously.

For example, consider a voice media in which you may have several 
logical candidates for areas of specialization, but are servicing only a 
single, dialed number. In that case, you could not route calls to a queue 
using a method as simple as use of a Source/Destination Decision 
workflow component in a routing strategy workflow. If, in addition, you 
are not using Call Director or an IVR, it would be difficult to have a 
contact routed to one of several specialized queues without operator 
intervention.

If you have already made decisions that influence initial processing of 
contacts arriving in your contact center, your queue setup should be 
made within the constraints of those decisions.

10.2.2  Scheduling

When planning your queue setup, you need to consider any differences 
in routing required to accommodate the schedules you are working 
with. Section 9.3.3, “Scheduling information”, on page 152, introduces 
OpenScape Contact Center schedules. 

Under some circumstances, schedules will have no effect on your 
queue setup, for example, you may have the same number and types 
of users working for all shifts. For more information on shifts, see 
Section 15.7.5, “Configuring the shifts”, on page 289.

However, you may require different routing during evening coverage. 
For example, with a smaller contact volume after normal business 
hours, you may have a smaller staff working. Instead of three 
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dedicated queues for Stocks, Mutual Funds, and Bonds, a single After 
Hours Investments queue and a staff with more generalized skills may 
provide more efficient contact handling.

10.2.3  Skills versus virtual groups 

Section 9.3, “Routing strategy workflow considerations”, on page 188 
introduced the decisions you can make and the information you can 
collect in gathering contact requirements. For contact requirements 
that consist of individual skills, in general, there will be a one-to-one 
correspondence between skills and queues. However, if your contact 
requirements combine skills, your queue setup will more closely reflect 
the skill combinations you use in building virtual groups.

NOTE:  For background information on skills and virtual groups, see 
Section 8.2, “About skills-based routing”, on page 162.

First, consider a contact center that offers services and advice in the 
areas of Mutual Funds, Stocks, and Bonds. Customers might dial a 
different number for each service, for example, or dial a single number 
and then be prompted to choose a service. In the absence of any 
additional contact requirements, the skills set up for this scenario 
would be:

• Mutual funds

• Stocks

• Bonds

This would also be the obvious choice of queues for this simple setup. 

On the other hand, consider a contact center that offers Mutual Funds, 
Stocks, and Bonds services in both English and German. The most 
efficient virtual group setup would be skill level variations on the 
following skill combinations:

• Mutual funds/English

• Mutual funds/German

• Stocks/English

• Stocks/German

• Bonds/English

• Bonds/German
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A queue setup based on the same combinations ensures that the 
contact will be handled by the most qualified user. The first three queue 
steps for the Mutual Funds/German queue might be:

• “Mutual Funds”,9 AND “German”,6

• “Mutual Funds”,7 AND “German”,7

• “Mutual Funds”,5 AND “German”,5

Subsequent steps might allow a user with the Stock skill and a high skill 
level in German handle the contact.

An incoming contact with requirements for the Mutual Funds service in 
German is more likely to be handled by a user proficient in both Mutual 
Funds and German if directed to the Mutual Funds/German queue.

NOTE:  The skills and virtual groups strategies are not mutually 
exclusive. A single contact center, based on contact requirements, 
could use both strategies effectively.

10.2.4  Staffing, contact volume, and queue 
time 

A key factor in finalizing your queue setup is to verify that the staffing 
capacity meets or exceeds contact volume. In general, when staffing 
capacity meets or exceeds contact volume, caller wait time is minimal. 

For example, consider a situation in which you have the following 
specializations:

• Skates

• Skis

• Hiking boots

• Tennis shoes

• Running shoes

• Walking shoes

A virtual group setup geared to these areas will be efficient given the 
following sample assumptions and statistics:

• Contact volume – Contacts relating to sporting footwear average 
350 per hour.
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• Contact distribution – Incoming contacts are evenly distributed 
across the six areas of expertise.

• Group staffing – Each of the six specializations has 10 ten 
specialists, giving a total of 60 users.

• Contact handling time – It takes a user about seven minutes to 
handle a contact, and an additional three minutes to do wrap-up 
work, giving a total of 10 minutes per contact.

Since a user can handle six contacts per hour, and there are 60 users, 
the expected contact handling capacity for this queue setup is 360 
contacts per hour. Since the staffing level (360 calls per hour) exceeds 
the expected contact volume (350 calls per hour), barring other 
considerations, this configuration might be efficient.

Stated from a slightly different perspective:

• With just under 60 skis-related contacts arriving per hour, on 
average a contact will arrive once per minute.

• An individual user can handle six contacts per hour and can 
therefore be expected to become available every 10 minutes (600 
seconds). With a pool of 10 experts in any one area of 
specialization, a user can be expected to become available once per 
minute.

With one contact arriving per minute and one user becoming available 
per minute, caller wait time is effectively zero. This implies that for any 
queue, the vast majority of contacts will be handled by a user who is a 
specialist in the area associated with the queue. Contacts directed to a 
particular area of specialization are almost always handled by a 
specialist in that area.

There are situations, however, where you may want to go to a less 
specialized or more backup-oriented queue setup.

10.2.4.1  Selecting a more backup-oriented queue 
setup

A backup-oriented queue setup still relies on specialists but also relies 
on users with general skills in more than one area of specialty. 

The following table shows an example of a backup-oriented queue 
setup.

Queue First Step Second Step

Skates Skates Sporting Footwear Backup

Table 4 A backup-oriented queue setup
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You may prefer this type of queue/group setup if any of the following 
conditions apply:

• There is insufficient overlap of knowledge or responsibilities across 
the areas of specialization. Skate specialists, for example, are not 
qualified to handle contacts in other areas.

• There are not enough specialists available to handle the contact 
volume. This may be a temporary situation. For example, if staffing 
in a particular specialty is geared toward contact volume outside 
peak hours, staffing in that specialization would not be able to 
handle peak hour traffic.

• A low contact volume/staffing requirement in combination with 
lengthy contact handling and wrap-up times can increase actual 
queue time for individual contacts. For example, if you have two 
specialists in a particular area, handling and wrap-up time is 30 
minutes per contact, and average contact volume is four contacts 
per hour, then on average that staffing level meets the expected 
contact volume. However, for contacts arriving when the two users 
are handling contacts, queue time can be lengthy.

10.2.4.2  Selecting a less specialized queue setup

The following table shows an example of a less specialized queue setup.
 

Skis Skis Sporting Footwear Backup

Hiking boots Hiking Boots Sporting Footwear Backup

Tennis shoes Tennis shoes Sporting Footwear Backup

Running shoes Running shoes Sporting Footwear Backup

Walking shoes Walking shoes Sporting Footwear Backup

Queue First Step Second Step

Summer Sporting 
Footwear

Summer Sporting 
Footwear

Sporting Footwear 
Backup

Winter Sporting Footwear Winter Sporting 
Footwear 

Sporting Footwear 
Backup

Table 5 A less specialized queue setup

Queue First Step Second Step

Table 4 A backup-oriented queue setup
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There are a number of reasons you may choose a less specialized 
queue setup, for example:

• You cannot easily route to a large set of specializations due to initial 
contact processing constraints. For example, in a voice media 
scenario, if you are supporting fewer dialed numbers than 
specialization area candidates, or if you are not using Call Director 
or an IVR to prompt customers for information used to route the 
contact, you may be obliged to use a less-specialized queue setup. 
For more information, see Section 10.2.1, “Initial contact 
processing”, on page 194.

• Contact volume in particular areas of specialization may not justify 
specific queues and groups set up to handle those areas of 
specialization. For example, low contact traffic in an area of 
specialization might result in an unacceptably high percentage of 
idle time for users in that specialization.

• Contact volume in general may not warrant specialization. For 
example, assuming that wait time is zero when one contact arrives 
per minute and one user becomes available per minute is valid only 
with a statistically significant sample size of users and arriving 
contacts.

NOTE:  These considerations are also influenced by the service level 
intervals you set up for each queue. For more information, see Section 
10.2.5, “Step intervals”, on page 199.

In most cases, administrators will return to their original configuration 
to perform fine tuning. You can use the Manager application’s reporting 
feature to inspect historical performance statistics and to monitor 
resources in real time. For more information, see Section , “Reporting”.

10.2.5  Step intervals

One important aspect to consider when configuring step intervals is the 
maximum amount of time that you want contacts to spend in queue, 
called the service level. You can define a service level for the system in 
general or at the level of individual queues. Certain reports can be used 
to evaluate how well the contact center adheres to this target. If a 
queue is not adhering to the target, you can modify the step intervals 
in that queue. You should also consider balancing the queue time with 
the importance of matching the contact to the appropriate group of 
users. 
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10.2.5.1  Calculating step intervals for group-based 
routing

There is no specific formula for calculating ideal overflow group 
intervals. However, you can compare strategies used in two situations 
to come up with a strategy for your contact center:

• Overflow group intervals for a smaller contact center with less 
specialized groups.

• Overflow group intervals for a larger contact center with more 
specialized groups.

In a smaller contact center, while you may have dedicated experts in 
particular product areas such as skis, skates, and hiking boots, factors 
such as wait time, staffing and contact volume may dictate a less 
specialized queue setup. The following table shows an example.

With a single overflow group for the queue, only one overflow group 
interval has to be provided. In a voice media scenario for example, if 
your target maximum queue time is 60 seconds, you could simply wait 
until the queue time approaches the target maximum queue time 
before allowing a contact to overflow. For example, based on the group 
sizes shown in the table, you could specify an overflow interval of 50 
seconds for the Winter Sporting Footwear queue. For contacts arriving 
in that queue, OpenScape Contact Center would attempt to route that 
contact to one of the nine users in the Winter Sporting Footwear group. 
After 50 seconds the contact would overflow to the Sporting Footwear 
Backup group, adding a pool of 20 eligible users. In most cases, this 
would virtually ensure that a contact is answered within the target 
maximum queue time of 60 seconds.

Queue Primary Overflow Time-out

Summer 
Sporting 
Footwear

Summer Sporting 
Footwear (9 users)

Sporting Footwear 
Backup (20 users)

Voice mail, 
300 seconds

Winter Sporting 
Footwear 

Winter Sporting 
Footwear (9 users)

Sporting Footwear 
Backup (20 users)

Voice mail, 
300 seconds

Table 6 A less specialized queue setup example
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In a contact center with a more specialized queue/group setup, if 
knowledge, specialization, or responsibilities overlap among your 
groups, you have additional options. Consider the following queue/
group setup.

In this case, you may want to rank the suitability of users to handle 
skis-related contacts as follows:

• Skis group – perfect match

• Skates group – good match

• Hiking boots group – acceptable match

As opposed to considering only the target maximum queue time, this 
queue/group setup lets you balance queue time with the suitability of 
the match to answer the contact. For example, while your target 
maximum queue time may be 60 seconds, you may decide that after 
30 seconds, contacts to the Skis queue can overflow to the Skates 
group since a good match to the contact outweighs the probability of 
spending more time in queue. This would double the pool of eligible 
users from 10 to 20 after 30 seconds. Similarly, after 45 seconds you 
may want to overflow to the Hiking boots group, to bring the total 
number of eligible users to 30. Keep in mind that overflowing to a group 
that is another queue’s primary group can impact the service level for 
the second queue. 

10.2.5.2  Calculating step intervals for skills-based 
routing

If you are working with skills-based routing, the considerations in 
calculating queue step intervals can be generalized from those 
mentioned in Section 10.2.5, “Step intervals”, on page 239. 

• If your strategy is to always hold the contact for the ideally qualified 
user, you can hold a contact in the first step until the target 
maximum queue time is about to expire. You can then overflow to 
a virtual group that relaxes the skill level requirement significantly 
in a final step aimed at maximizing the number of eligible users.

Queue Primary 
Group

Overflow Groups Time-out

Skis Skis (10 users) Skates (10 users)
Hiking boots (10 users)

Voice mail, 300 
seconds

Skates Skates Skis, Hiking boots Voice mail, 300 
seconds

Hiking boots Hiking boots Skis, Skates Voice mail, 300 
seconds

Table 7 A more specialized queue setup example
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• If you want to balance wait time against having the contact handled 
by the best qualified user, you can use several queue steps, each 
relaxing the skill level to increase the pool of eligible users. At each 
step, the interval time and relaxed skill levels reflect a new 
calculation of the importance of the two factors

10.3  Configuring a queue

You can configure a queue for each media type available in your contact 
center. There are various items that you should consider when deciding 
how to configure a queue. For details, see the Manager Administration 
Guide. 

NOTE:  To create or change a queue, you must have Full or Modify 
access, respectively, for the associated Manager permission. 

Overview

The following is an overview of the steps required to configure all the 
properties in a queue: 

1. Configure the general queue information – see Section 10.3.1, 
“Configuring the general queue information”, on page 201. 

2. Configure the queue steps – if you are using group-based routing, 
see Section 10.3.2, “Configuring the queue steps”, on page 246; if 
you are using skills-based routing, see Section 10.3.3, “Configuring 
the queue steps for skills-based routing”, on page 249.

3. Configure the queue overrides – if you are using group-based 
routing, see Section 10.3.4, “Configuring the queue overrides”, on 
page 251; if you are using skills-based routing, see Section 10.3.5, 
“Configuring the queue overrides for skills- based routing”, on page 
253. 

4. For a voice queue, configure the networking settings (available only 
if your contact center is licensed for networking) – see Section 
10.3.6, “Configuring the voice queue networking settings”, on page 
255. 

5. Select the queue Wrap-up reasons – see Section 10.3.4, “Selecting 
the queue Wrap-up reasons”, on page 207. 

6. Select the queue aggregates – see Section 10.3.5, “Selecting the 
queue aggregates”, on page 208. 

7. Select the queue reports – see Section 10.3.6, “Selecting the queue 
reports”, on page 208. 
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8. For a Web collaboration queue, select the messages – see Section 
10.3.10, “Selecting the Web collaboration queue messages”, on 
page 258.

9. For a Web collaboration queue, select the URLs – see Section 
10.3.11, “Selecting the Web collaboration queue URLs”, on page 
258. 

10.3.1  Configuring the general queue 
information

You can specify general information about the queue such as the name, 
description, and queue processing workflow to be used. You must 
complete this step when configuring a new queue. 

To configure the general voice queue information:

1. On the File menu, point to New, then Design Center, then select 
the required media type, and then click Queue.

2. On the General tab, under Queue, do the following:

• In the Name box, type a unique name for the queue. 

• In the Description box, type a description for the queue. The 
description should indicate the type of contacts for which this 
queue should be used. 

3. For all queues except callback queues, under Queue Processing, 
in the Workflow list, select a queue processing workflow (see 
Section 9.5, “About queue processing workflows”, on page 174). If 
you do not select a queue processing workflow, only the routing 
strategy workflow will be used to route contacts. You can select the 
default queue processing workflow, or you can create a queue 
processing workflow and assign it to this queue. 

4. Under Supplemental Information, in the Address box, type the 
location of the document that you want to be displayed on the 
user's machine when the contact is directed from the queue to the 
user. You can click  to locate the document. For more 
information, see Section 10.3.1.1, “About the supplemental 
information feature”, on page 203.
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5. For a voice queue, you can have the system create a callback when 
a call is abandoned (available only if the contact center is licensed 
for callbacks). Under Callback Creation, select the Create 
callback on call abandon check box and then select the callback 
queue from the Queue list. 

NOTE:  If the Create callback on call abandon option is enabled 
for a queue and a call in the associated queue is abandoned by a 
caller, the system checks the callback schedule to verify that a 
callback can be handled within the next 24 hours. If a callback is 
created, it remains active for 24 hours after the call was abandoned 
and is then deleted by the system.

6. Under Site-Level Statistics, the Include this queue when 
calculating site-level statistics option (available only if the 
contact center is licensed for networking) is selected by default. If 
you do not want to include the queue in the site-level statistic 
calculations, clear this check box. 

NOTE:  The queue does not need to be networked for it to be 
included in the site-level statistic calculations. 

7. If you are finished working with this queue definition, click OK.
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10.3.1.1  About the supplemental information 
feature

You can configure a queue (see Section 10.3, “Configuring a queue”, 
on page 200) so that when a contact is directed from that queue to a 
user, a document specified by a supplemental information address 
opens on the user’s computer. The address can be any document 
specifier for which the Windows operating system on the client machine 
recognizes as having a default, associated application. 

Examples of how you might use this feature are:

• Opening a spreadsheet of prices or useful support information for 
products associated with the queue. 

• Opening a browser on a telephone directory-based Web site that 
displays the customer name and address, based on the source 
associated with the contact. 

• Displaying the history of a contact by issuing a customer database 
query using information identifying the customer, collected during 
execution of a routing strategy workflow. 

NOTE:  In Agent Portal Web, due to Web browsers security 
restrictions, the supplemental information feature is limited (for 
example, files cannot be opened or executed in the local machine when 
configured in the supplemental information field). 

The supplemental information address can include one or more 
variables that will be substituted with contact data, the contact source, 
or the contact destination, when the contact is enqueued. This allows 
you to configure the address to open documents specifically pertaining 
to the customer or nature of the contact. Valid variables you can 
include in the supplemental information address are listed in the 
following table.

Variable Description

~CDK~ Where CDK is the key component of a contact data key/
value pair created during execution of the routing 
strategy workflow. When the contact is enqueued, the 
variable will be substituted with the value component of 
the key/value pair. 

~SOURCE~ When the contact is enqueued, the variable will be 
substituted with the source associated with the contact.

~DESTINATION
~

Whe n the contact is enqueued, the variable will be 
substituted with the destination associated with the 
contact.

Table 8 Supplemental information address variables
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Any contact data that is to be used as a variable in a supplemental 
information address must be set in the active routing strategy for the 
site. For example, consider a Web-enabled customer database system 
in which users can view key customer record data and contact history, 
given an account number in a browser. On incoming contacts, a voice 
routing strategy workflow could prompt a customer for their account 
number and then store the results as a contact data value associated 
with the contact data key ACCT_NUM.

To make use of that information, the definition of the queue to which 
the contact is directed includes a supplemental information address of 
the relevant URL, including the ACCT_NUM contact data key. 

http://www.cust.com/accountinfo?account=~ACCT_NUM~

If the customer enters 123456 as their account number, the 
supplemental information address resolves to:

http://www.cust.com/accountinfo?account=123456

10.3.2  Configuring the queue steps

NOTE:  This topic describes how to configure the queue steps for 
group-based routing. If your contact center uses skills-based routing, 
see Section 10.3.3, “Configuring the queue steps for skills-based 
routing”, on page 249. 

Queues define the steps that a contact moves through. You can 
configure steps for one primary group and a maximum of 10 overflow 
groups. The primary group is defined as the first group of users to 
which the incoming contact is queued. It should be the group of users 
who are most familiar with the requirements of the contact. An 
overflow group is an additional group to which the contact is also 

~CONTACTID~ When the contact is enqueued, the variable will be 
substituted with the identifier, generated by OpenScape 
Contact Center, that uniquely identifies the contact.

Variable Description

Table 8 Supplemental information address variables
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assigned when the previous step time expires. By adding overflow 
groups to the queue, more users become eligible to handle the contact 
as it waits in queue. 

You can add each group only once to a queue. For more information on 
groups, see Section 8.1, “About group-based routing”, on page 139. 

To configure the queue steps:

1. In the Design Center, click the tab for the media type you want to 
open. 

2. Under Resources, click Queues, then, in the right pane, double-
click the queue you want to configure. 

3. Click the Steps tab.

4. Under Sequence, do the following:

a) In the Primary row under Group, click the cell and select a 
primary group from the list. When you select a primary group, 
a new overflow row is added to the table. 

b) In the Primary row under Step Time, double-click the cell and 
type a time for the contact to wait in queue for a user in the 
primary group to handle the contact. 

c) In the Overflow row under Group, click the cell and select an 
overflow group name from the list. When you select an overflow 
group, a new overflow row is added to the table.

d) In the first Overflow row under Step Time, double-click the 
cell and type a time for the contact to wait in queue while 
assigned to this step. 

e) Repeat steps (c) and (d) for each overflow group you want to 
create. You can configure a maximum of 10 overflow groups. 

NOTE:  For voice and Web collaboration queues, if there are no 
logged-on users in the current step, the step will be skipped and 
queue step execution will proceed to the next step that has logged-
on users. Since the overflow mechanism is additive, the pool of 
users in the current step includes all the users from the overflow 
group specified in the current step, plus all the users from the 
groups specified in the previous steps. For callback and e-mail 
queues, contacts always wait for the specified step time, even when 
no eligible users are logged on. 
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5. Under In last step, select how the queue handles the last step: 

• To allow the contact to time out, select Wait for the specified 
step time. 

• To have the contact continue waiting, select Wait forever (this 
is the default). In this case, you can select the Time out when 
no eligible user is logged on check box to select that 
limitation. 

IMPORTANT:  For voice and Web collaboration queues, if a contact 
arrives at the last step in a queue with no time-out defined and no 
eligible users logged on, the contact will remain at the last step 
indefinitely. For callback and e-mail queues, if you allow the contact 
to time out, the system will delete the contact when it exceeds the 
specified time for the last step.

6. For a voice queue, if you selected Wait for specified step time in 
step 4 above, you must specify the time-out extension: 

• To select the default time-out extension, select Global time-
out extension. For more information, see Section 11.5.1, 
“Configuring the default voice routing strategy, queue, and 
time-out extension”, on page 216. 

• To specify a time-out extension, select Extension and then type 
the extension number.

7. For a Web collaboration queue, if you selected Wait for the 
specified step time in step 4 above, you must specify the time-
out URL:

• To select the default time-out URL, select Global time-out 
URL. For more information, see Section 15.6.1, “Configuring 
the default Web collaboration routing strategy, queue, and time-
out URL”, on page 353.

• To specify a time-out URL, select URL and then type the URL 
you want to use. You can click  to launch a Web browser and 
test the URL or select another URL. 

8. If you are finished working with this queue definition, click OK.
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10.3.3  Configuring the queue steps for skills-
based routing

Queues define the steps that a contact moves through. There should 
be a strong correlation between queues and the skill combinations that 
you use to build virtual groups. The first step in the queue should 
specify the virtual group of users that is best suited to handle the 
contact. In subsequent steps, you can specify virtual groups that have 
a more relaxed set of skills, which will expand the pool of users eligible 
to handle the contact. But this is just one approach. For more 
information, see Section 10.2, “Queue setup considerations”, on page 
233.

You can use each virtual group only once in a queue. For more 
information on virtual groups, see Section 8.2.3, “About virtual 
groups”, on page 164. 

You can configure a maximum of 25 steps for a voice queue. 

To configure the queue steps:

1. In the Design Center, click the tab for the media type you want to 
open. 

2. Under Resources, click Queues, then, in the right pane, double-
click the queue you want to configure. 

3. Click the Steps tab.

4. Under Sequence, do the following:

a) In Step 1 row under Virtual Group, click the cell and select a 
virtual group from the list. When you select a virtual group, a 
new row is added to the table.

b) In Step 1 row under Priority Increment, click the cell and type 
a value between 0 and 100. This value is added to the contact's 
current priority when the contact enters the queue step. 
Negative values are not allowed. If the value is 0, the contact 
priority is not changed when the contact enters the queue step. 
If you enter a value that causes the contact priority to exceed 
100, the system automatically adjusts the contact priority to 
100. 

c) In Step 1 row under Step Time, the default is Forever because 
this is the only step defined so far (and therefore the last step). 
To specify a step time, first under In last step, select Wait for 
the specified step time. Now you can enter a Step Time. 
Double-click the cell and type a time for the contact to wait in 
queue for a user in the virtual group to handle the contact. 
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d) In Step 1 row under Protected Skill, click the cell and select a 
skill from the list. Use this parameter to avoid that a high priority 
skill has no free agents, when the agents are allocated to 
multiple skills and these agents are assigned to contacts, which 
are routed due to other skills.

e) In Step 1 row under Threshold, define the minimum available 
agents for the Protected Skill before assigning an agent to a 
contact, which is routed due to match with other skills.

f) Repeat steps (a) - (e) for each Step you want to configure. You 
can configure a maximum of 25 Steps.

NOTE:  For voice and Web collaboration queues, if there are no 
logged-on users in the current step, the step will be skipped and 
queue step execution will proceed to the next step that has logged-
on users. For callback and e-mail queues, contacts always wait for 
the specified step time, even when no eligible users are logged on. 

5. Under In last step, select how the queue handles the last step:

• If you want the contact to time out, click Wait for the specified 
step time. 

• If you want the contact to continue waiting, click Wait forever 
(this is the default). In this case, you can select the Time out 
when no eligible user is logged on check box to select that 
limitation. 

IMPORTANT:  For voice and Web collaboration queues, if a contact 
arrives at the last step in a queue with no time-out defined and no 
eligible users logged on, the contact will remain at the last step 
indefinitely. For callback and e-mail queues, if you allow the contact 
to time out, the system will delete the contact when it exceeds the 
specified time for the last step. 

6. For a voice queue, and you selected Wait for specified step time 
in step 4 above, you must specify the time-out extension: 

• To select the default time-out extension, select Global time-
out extension. For more information, see Section 11.5.1, 
“Configuring the default voice routing strategy, queue, and 
time-out extension”, on page 270. 

• To specify a time-out extension, select Extension and then type 
the extension number.
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7. For a Web collaboration queue, and you selected Wait for the 
specified step time in step 4 above, you must specify the time-
out URL: 

• To select the default time-out URL, select Global time-out 
URL. For information, see Section 15.6.1, “Configuring the 
default Web collaboration routing strategy, queue, and time-out 
URL”, on page 353.

• To specify a time-out URL, select URL and then type the URL 
you want to use. You can click  to launch a Web browser and 
test the URL or select another URL. 

8. If you are finished working with this queue definition, click OK.

10.3.4  Configuring the queue overrides

NOTE:  This topic describes how to configure queue overrides for 
group-based routing. If your contact center uses skills-based routing, 
see Section 10.3.5, “Configuring the queue overrides for skills- based 
routing”, on page 253. 

You can configure a queue to override certain default settings, if 
required. You can:

• Override the default service level interval. For details on the default 
service level interval, see Section 15.7.1, “Configuring the service 
level interval”, on page 283. 

• For an e-mail queue, override the default e-mail message settings. 
For details on the default e-mail message settings, see Section 
14.3.4, “Configuring the e-mail message settings”, on page 257. 

• For a callback queue, configure the maximum number of times that 
a callback associated with this queue can be retried. Also, if the 
system is connected to an OpenScape Voice, OpenScape 4000, or 
HiPath 4000 communication platform, you can override the default 
caller ID settings. For details on the default caller ID settings, see 
Section 13.3.1, “Configuring the general callback settings”, on page 
303. 

To configure the queue overrides:

1. In the Design Center, click the tab for the media type you want to 
open. 

2. Under Resources, click Queues, then, in the right pane, double-
click the queue you want to configure. 
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3. Click the Override tab.

4. For any type of queue, you can override the default service level 
interval. Under Override System Settings, select the Service 
level interval check box, and then type or select the service level 
interval for this queue. 

5. For an e-mail queue, you can override the default message settings. 
Under Override System Settings, do the following:

• Select the Prolog template check box, and then select the 
Prolog template that you want to use for this queue from the list. 

• Select the Signature template check box, and then select the 
Signature template that you want to use for this queue from the 
list. 

• Select the Original message label check box, and then type 
the text that you want to appear above the original e-mail 
message when the user replies to an e-mail message, for 
example, Original Message:. 

• Select the Conversation ID label check box, and then type the 
text that you want to appear in front of the Conversation ID 
when the user replies to an e-mail message. The Conversation 
ID is an identifier inserted by the OpenScape Contact Center 
E-mail Server to identify the message thread. 

• Select the Reply prefix check box, and then type the text that 
you want to appear at the beginning of the Subject line when the 
user replies to an e-mail, for example, Re:.

6. For a callback queue, if the system is connected to an OpenScape 
Voice, OpenScape 4000, or HiPath 4000 communication platform, 
you can override the default caller ID settings. Under Override 
System Settings, do the following: 

• Select the Caller name check box, and then type the name that 
is presented to the called party when a callback is initiated from 
this queue.

• Select the Caller telephone number check box, and then type 
the telephone number that the called party can use to contact 
the calling party who initiated the callback from this queue.

NOTE:  If you specify the Caller telephone number but leave the 
Caller name blank, no name will be presented even if a default 
Caller name has been specified in the Callback options. 
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7. For a callback queue, under Retry, in the Maximum number of 
retries box, type or select the maximum number of times that the 
system can reschedule a callback associated with this queue. 

8. If you are finished working with this queue definition, click OK.

10.3.5  Configuring the queue overrides for 
skills- based routing

You can configure a queue to override certain default settings, if 
required. You can:

• Override the default service level interval. For details on the default 
service level interval, see Section 20.7.1, “Configuring the service 
level interval”, on page 432. 

• For an e-mail queue, override the default e-mail message settings. 
For details on the default e-mail message settings, see Section 
14.3.4, “Configuring the e-mail message settings”, on page 332. 

• For a callback queue, configure the maximum number of times that 
a callback associated with this queue can be retried. Also, if the 
system is connected to an OpenScape Voice, OpenScape 4000, or 
HiPath 4000 communication platform, you can override the default 
caller ID settings. For details on the default caller ID settings, see 
Section 13.3.1, “Configuring the general callback settings”, on page 
303. 

• For skills-based routing, enable performance routing. When 
performance routing is enabled, the step times defined for the 
queue will be reduced if certain performance thresholds are 
exceeded. The calculation for the reduced step times is the 
threshold value divided by the actual value, multiplied by the step 
time. For example, if the threshold value is 5, the actual value is 6, 
and the step time is 1 hour, the reduced step time would be 50 
minutes. The minimum reduced step time is one tenth of the 
original step time. 

• Override the default setting for the importance of queue time. For 
details on this setting, see Section 8.4.5, “Configuring the skill 
scoring”, on page 176. 

To configure the queue overrides:

1. In the Design Center, click the tab for the media type you want to 
open. 

2. Under Resources, click Queues, then, in the right pane, double-
click the queue you want to configure. 
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3. Click the Override tab.

4. For any type of queue, you can override the default service level 
interval. Under Override System Settings, select the Service 
level interval check box, and then type or select the service level 
interval for this queue. 

5. For an e-mail queue, you can override the default message settings. 
Under Override System Settings, do the following:

• Select the Prolog template check box, and then select the 
Prolog template that you want to use for this queue from the list. 

• Select the Signature template check box, and then select the 
Signature template that you want to use for this queue from the 
list. 

• Select the Original message label check box, and then type 
the text that you want to appear above the original e-mail 
message when the user replies to an e-mail message, for 
example, Original Message:. 

• Select the Conversation ID label check box, and then type the 
text that you want to appear in front of the Conversation ID 
when the user replies to an e-mail message. The Conversation 
ID is an identifier inserted by the OpenScape Contact Center 
E-mail Server to identify the message thread. 

• Select the Reply prefix check box, and then type the text that 
you want to appear at the beginning of the Subject line when the 
user replies to an e-mail, for example, Re:.

6. For a callback queue, if the system is connected to an OpenScape 
Voice, OpenScape 4000, or HiPath 4000 communication platform, 
you can override the default caller ID settings. Under Override 
System Settings, do the following: 

• Select the Caller name check box, and then type the name that 
is presented to the called party when a callback is initiated from 
this queue.

• Select the Caller telephone number check box, and then type 
the telephone number that the called party can use to contact 
the calling party who initiated the callback from this queue.

NOTE:  If you specify the Caller telephone number but leave the 
Caller name blank, no name will be presented even if a default 
Caller name has been specified in the Callback options. 
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7. For a callback queue, under Retry, in the Maximum number of 
retries box, type or select the maximum number of times that the 
system can reschedule a callback associated with this queue. 

8. To turn on performance routing for the queue, under Performance 
Routing, do the following:

a) Select the Enable check box.

b) In the Select statistic list, select the performance statistic the 
calculations for reduced step times are based on. 

c) In the Threshold value box, type or select the threshold for the 
selected performance statistic. 

9. To override the default setting for the Queue time slider, under 
Importance of Queue Time, select the Queue time check box, 
and then set the slider to the importance level you want to use for 
this queue. 

10.If you are finished working with this queue definition, click OK.

10.3.6  Configuring the voice queue 
networking settings

If your contact center is licensed for networking (see Chapter 16, 
“Working with networking”), you can configure the networking settings 
for a voice queue.

You can configure the queue to override the default networking 
acceptance settings, if required. For details on the default acceptance 
settings, see Section 16.8.2, “Configuring the networking acceptance 
settings”, on page 377. 

To configure the voice networking settings:

1. In the Design Center, click the  Voice tab. 

2. Under Resources, click Queues, then, in the right pane, double-
click the queue you want to configure. 

3. Click the Networking tab.

4. To make the queue eligible to accept networked contacts, under 
Acceptance, select the Accept networked contacts check box. 
There must be an identically named queue at one or more of the 
other networked sites for contacts to be routed to this queue. 
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5. To override the default networking acceptance settings, select the 
Override system acceptance settings check box, and then 
configure the performance acceptance criteria. Click Add, or select 
a criterion in the list and click Edit. 

6. To enable the queue to distribute networked contacts, under 
Distribution, select the Distribute networked contacts check 
box and then select the voice networking workflow that you want to 
use to distribute the contacts instead of the default networking 
workflow specified in the Options dialog box (see Section 16.8.1, 
“Configuring the general networking settings”, on page 376). 

7. If you are finished working with this queue definition, click OK.

10.3.7  Selecting the queue Wrap-up reasons

The Manager application allows you to associate Wrap-up reasons with 
a queue. 

To configure the Wrap-up reasons for the queue:

1. In the Design Center, click the tab for the media type that you 
want to open. 

2. Under Resources, click Queues, then, in the right pane, double-
click the queue that you want to configure.

3. Click the Wrap-up reasons tab.

4. Under Wrap-up reasons, select the check box for each Wrap-up 
reason that you want to associate with this queue. For more 
information, see Section 5.2.4, “Configuring a Wrap-up reason”, on 
page 56. 

5. If you are finished working with this queue definition, click OK.

10.3.8  Selecting the queue aggregates

You can select the aggregates to which a queue belongs. For more 
information on aggregates, see Section 10.4, “About aggregates”, on 
page 209. 

NOTE:  You must create an aggregate before you can select it in a 
queue (see Section 10.5, “Configuring an aggregate”, on page 210). 
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To select the queue aggregates:

1. In the Design Center, click the tab for the media type you want to 
open.

2. Under Resources, click Queues, then, in the right pane, double-
click the queue you want to edit. 

3. Click the Aggregates tab.

4. Under Content, select the check box for each aggregate in which 
to include this queue. 

5. If you are finished working with this queue definition, click OK.

10.3.9  Selecting the queue reports

You can select the reports that will display information about the queue 
that you are configuring. 

You can also configure the queue to override the global queue report 
intervals, if required. For details on the global queue report intervals, 
see Section 7.13.1, “Configuring the global queue report intervals”, on 
page 134. 

To select the queue reports:

1. In the Design Center, click the tab for the media type you want to 
open.

2. Under Resources, click Queues, then, in the right pane, double-
click the queue you want to edit. 

3. Click the Reports tab.

4. Under Include this queue in these reports, select the check box 
for each report that you want to display data about this queue. The 
list contains only the reports you own, or reports that are owned by 
users you can monitor.

5. To override the global queue report intervals, under Interval, 
select the Override system settings check box, and then do the 
following:

• In the To column for Interval 1, double-click the time and type 
the end time. The start of Interval 2 is updated to reflect the 
number you just typed.

• In the To column for each other interval, double-click the time 
and type the end time. The end time for the last interval is 
always Forever.
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6. If you are finished working with this queue definition, click OK.

10.3.10  Selecting the Web collaboration 
queue messages

You can associate selected Web collaboration standard messages (see 
Section 15.5.2, “Configuring a Web collaboration standard message”, 
on page 348) with a queue. If you do not associate a standard message 
with a queue, the standard message will be considered generic and will 
be available to all queues. 

To select the Web collaboration queue messages:

1. In the Design Center, click the  Web collaboration tab.

2. Under Resources, click Queues, then, in the right pane, double-
click the queue you want to edit. 

3. Click the Messages tab.

4. Under Include, select the check box for each standard message 
that you want to associate with this queue.

5. If you are finished working with this queue definition, click OK.

10.3.11  Selecting the Web collaboration 
queue URLs

You can associate selected Web collaboration URLs (see Section 
15.5.3, “Configuring a Web collaboration URL”, on page 349) with a 
queue. If you do not associate a URL with a queue, the URL will be 
considered generic and will be available to all queues. 

To select the Web collaboration queue URLs:

1. In the Design Center, click the  Web collaboration tab.

2. Under Resources, click Queues, then, in the right pane, double-
click the queue you want to edit. 

3. Click the URLs tab.

4. Under Include, select the check box for each URL that you want to 
associate with this queue.

5. If you are finished working with this queue definition, click OK.
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10.4  About aggregates

An aggregate is a logical grouping of queues used for reporting 
purposes. Supervisors can view state information on aggregates in 
real-time reports or statistical summaries for aggregates in historical 
reports.

For example, you might be using the following queues:

• Mutual Funds-English

• Mutual Funds-German

• Stocks-English

• Stocks-German

• Bonds-English

• Bonds-German

If you were interested in viewing the performance of all experts in the 
area of Mutual Funds, you could group the Mutual Funds-English and 
Mutual Funds-German into a single Mutual Funds aggregate, and 
generate reports on that aggregate. Likewise, you could group the 
three English skill queues and group the three German queues to 
compare and contrast the handling for contacts with the respective 
language contact requirement.

10.5  Configuring an aggregate

You can use aggregates to monitor similarly routed contacts, even if 
different queues are used.

NOTE:  To create or change an aggregate, you must have Full or 
Modify access, respectively, for the associated Manager permission. 

To configure an aggregate:

1. On the File menu, point to New, then Design Center, then select 
the media type, and then click Aggregate.

2. On the General tab, under Aggregate, do the following:

• In the Name box, type a unique name for the aggregate. 

• In the Description box, type a description for the aggregate.

3. Click the Queues tab.
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4. Under Include, select the check box for each queue that you want 
to include in the aggregate.

5. Click the Reports tab.

6. Under Include this aggregate in these reports, select the check 
box for each report that you want to display data about this 
aggregate. The list contains only the reports you own, or reports 
that are owned by users you can monitor.

7. Click OK. 
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11  Working with voice resources
This chapter provides information on OpenScape Contact Center voice 
support. It introduces the interaction between the OpenScape Contact 
Center system and supported communication platforms, and provides 
instructions on voice-related tasks.

NOTE:  For information on Call Director resources in the Telephony 
Center, see Chapter 12, “Working with Call Director”. For information 
on IVR resources in the Telephony Center, contact your service 
representative.

11.1  Supported communication platforms

OpenScape Contact Center supports the following communication 
platforms: 

• OpenScape Voice V7, V8 and V9

• HiPath 4000 V6 and OpenScape 4000 V7 and V8

• OpenScape Business V2

In working with a communication platform to manage contacts, the 
system’s key responsibilities are calculating and delivering call routing 
directives, collecting statistics, and managing user interaction and 
component interaction with the communication platform. The platform 
is still responsible for initial call processing, fundamental operations 
such as transfers and holds, and other basic voice tasks.

You configure the communication platform settings in the Options 
dialog box. For details, see Section 11.5.3, “Configuring the 
communication platform settings”, on page 218. 
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11.2  Basic interaction with the communication platform

This section provides a basic introduction to the OpenScape Contact 
Center interaction with the communication platform resources.You 
should be familiar with the communication platform resources as they 
pertain to your OpenScape Contact Center configuration before 
working with the Telephony Center. 

NOTE:  This section assumes that you have a basic understanding of 
communication platform components and their functions, and common 
terminology. 

The resources on the communication platform required for OpenScape 
Contact Center operation are set up during installation and 
configuration, prior to Manager application configuration. For 
information on configuring the OpenScape Contact Center equivalents, 
see the Manager Help.

11.2.1  Interaction with OpenScape Voice 
resources

The following diagram provides a simple introduction to OpenScape 
Contact Center interaction with OpenScape Voice communication 
platform resources. It shows the key communication platform 
resources monitored by OpenScape Contact Center, shows the 
OpenScape Contact Center configuration equivalents, and describes 
the interactions using an example of initial call processing.
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The numbered steps are:

1. Each dialed number serviced by the contact center, is associated 
with a dedicated Initial Hunt Group. Incoming calls on those dialed 
numbers are held in that hunt group.

2. Details of the call are passed to OpenScape Contact Center and a 
routing strategy workflow executes to determine the routing of the 
call.

3. If the call results in the call being enqueued to an OpenScape 
Contact Center queue, on the communication platform, the call is 
moved from the Initial Hunt Group to an associated Music On Hold 
Hunt Group. Queue processing treatments such as music-on-hold 
and announcements can be applied in a Music On Hold Hunt Group.

4. Based on its queue/workflow setup, OpenScape Contact Center 
finds the best available user to handle the call. 

5. Based on the subscriber number to which the user is logged on, 
OpenScape Contact Center directs the communication platform to 
route the call to that subscriber number. 

NOTE:  Backup routing is handled by changing the Initial Hunt 
Group from Manual mode to Circular mode when OpenScape 
Contact Center is not operating. 
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11.2.2  Interaction with OpenScape 4000 or 
HiPath 4000 resources

The following diagram provides a simple introduction to OpenScape 
Contact Center interaction with OpenScape 4000 or HiPath 4000 
communication platform resources. It shows the key communication 
platform resources monitored by OpenScape Contact Center, shows the 
OpenScape Contact Center configuration equivalents, and describes 
the interactions using an example of initial call processing.

The numbered steps are:

1. Each dialed number serviced by the contact center is associated 
with a dedicated Route Control Group. Incoming calls on those 
dialed numbers are processed according to routing directives for the 
Route Control Group.

2. Based on preconfigured Shift Set and ART settings, the Route 
Control Group associates the call with a dedicated ACD group. The 
ACD group set up for OpenScape Contact Center processing is 
configured with no users. 

NOTE:  If the Route Control Group detects that OpenScape Contact 
Center is not operational, it routes the call to an ACD group 
dedicated to backup routing.

3. The call is held on the communication platform while the platform 
notifies OpenScape Contact Center of the call.

4. Based on its queue/workflow setup, OpenScape Contact Center 
finds the best available user to handle the call. 
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5. Based on the extension to which the user is logged on, OpenScape 
Contact Center directs the communication platform to route the call 
to that extension.

11.2.3  Interaction with OpenScape Business 
resources

The following diagram provides a simple introduction to OpenScape 
Contact Center interaction with OpenScape Business communication 
platform resources. It shows the key communication platform 
resources monitored by OpenScape Contact Center, shows the 
OpenScape Contact Center configuration equivalents, and describes 
the interactions using an example of initial call processing.

The numbered steps are:

1. A CDL associates dialed numbers serviced by the contact center, 
with a dedicated UCD group.

2. The call is held on the communication platform while the platform 
notifies OpenScape Contact Center of the call.

3. Based on its queue/workflow setup, OpenScape Contact Center 
finds the best available user to handle the call. 

4. Based on the extension to which the user is logged on, OpenScape 
Contact Center directs the communication platform to route the call 
to that extension.
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11.3  Communication platform resources

To route telephone calls and gather statistics, OpenScape Contact 
Center monitors a set of key resources on the communication platform. 
Using the Manager application, you must configure a matching 
definition within OpenScape Contact Center for each resource on the 
communication platform. 

NOTE:  For details on how to configure the matching resource 
definitions, see the Manager Help. 

The following table shows the resources configured in OpenScape 
Contact Center for each communication platform. The communication 
platform resources marked with an “S” in the table can be synchronized 
with the platform to share configuration information. For more 
information, see Section 11.4, “About Config Sync”, on page 267. 

NOTE:  When the system is connected to an OpenScape 4000 or 
HiPath 4000 communication platform, the Config Sync feature is not 
supported. 

Resource OpenScap
e Voice

OpenScape 
4000 or 

HiPath 4000

OpenScape 
Business

User IDs S S

Extensions S S

User Subscriber 
Numbers

S

Route Control Groups S

UCD Groups S

Hunt Groups S

ACD Groups S

ACD Queues

Trunk Groups S

Queue Targets 

Requeue Targets  

Network Transit 
Numbers

  

IVR Transit Numbers  

Table 10 Key communication platform resources
 A31003-S22B1-M103-08-76A9, 04/2025
216 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



telephony.fm

Working with voice resources
About Config Sync
11.4  About Config Sync

The Config Sync (configuration synchronization) feature monitors key 
contact center communication platform resources and synchronizes 
the OpenScape Contact Center definitions with the definitions on the 
communication platform. When a configuration change is detected, 
Config Sync immediately provides the OpenScape Contact Center 
system with the details of the change, thus reducing configuration 
errors, manual entry, and duplicate administration. For a list of 
communication platform resources that can be monitored, see Section 
11.3, “Communication platform resources”, on page 213. 

Config Sync monitors and synchronizes communication platform 
resources only within specified resource domain ranges. This allows 
you to set up the Config Sync feature to focus on dedicated contact 
center resources, such as an agent's extension, and ignore 
nonessential resources, such as the extension at the reception desk. 
For example, in a small contact center, you might set up Config Sync 
to monitor extensions in the range 121 through 140. When a new 
extension in that range is created on the communication platform, an 
equivalent extension definition is created in OpenScape Contact Center. 

Synchronization is driven by the OpenScape Contact Center Config 
Sync Server. When the Config Sync Server starts or when you explicitly 
synchronize resources, the Config Sync Server synchronizes the 
OpenScape Contact Center definitions with those on the 
communication platform. For details on how to enable the Config Sync 
feature, see Section 11.5.4, “Configuring the Config Sync settings”, on 
page 219. 

Config Sync treats changes to user IDs and other resources differently. 
For details, see Section 11.4.1, “Config Sync treatment of user IDs”, on 
page 214, and Section 11.4.2, “Config Sync treatment of other 
resources”, on page 215. 

NOTE:  When the system is connected to an OpenScape 4000 or 
HiPath 4000 communication platform, the Config Sync feature is not 
supported. 
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11.4.1  Config Sync treatment of user IDs

The following table lists the actions taken when the Config Sync Server 
detects changes to user IDs that fall within a defined Config Sync 
domain range. 

Config Sync Server 
detects...

Action taken...

A user was added to the 
communication platform that 
does not exist in OpenScape 
Contact Center

Config Sync creates a new basic definition for 
the user in OpenScape Contact Center (user 
ID, user name, and backup group) and sets 
the resource state to Incomplete. For details 
on completing the definitions, see Section 
11.4.1.1, “Completing a user definition 
created by Config Sync”, on page 215. 

A user was added to 
OpenScape Contact Center 
that does not exist on the 
communication platform

Config Sync sets the OpenScape Contact 
Center definition state to Communication 
Platform Synchronization Error.

A user was deleted from the 
communication platform but 
still exists in OpenScape 
Contact Center 

If the user has permission to handle calls 
only, Config Sync sets the OpenScape Contact 
Center definition state to Inactive. 
If the user has permission to log on to other 
media, then voice is disabled for the user. 

A user was deleted from 
OpenScape Contact Center 
but still exists on the 
communication platform 

Config Sync sets the OpenScape Contact 
Center definition state to OpenScape 
Contact Center Synchronization Error. 

Table 11 Config Sync actions on changes to user IDs
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11.4.1.1  Completing a user definition created by 
Config Sync

When the Config Sync Server detects a new user definition on the 
communication platform, with an ID that falls within one of the defined 
Config Sync domain ranges, it creates a minimal user definition in 
OpenScape Contact Center. The user definition consists of the 
following:

• User ID

• User name

• Backup group

Before a user can become fully functional, you must complete the 
properties in the user definition. One way to check for incomplete user 
definitions is to check the Administration Center for users in 
Incomplete state. This is often an indication that the user definition 
has been recently created.

To complete a user definition created by Config Sync:

1. In the Administration Center, under General, click Users, then, 
in the right pane, double-click the user you want to complete. 

2. Complete the remaining user properties, as required (see Section 
4.1, “Configuring a user”, on page 25). 

11.4.2  Config Sync treatment of other 
resources

The following table lists the actions taken when the Config Sync Server 
detects changes to resources other than user IDs (such as extensions 
and requeue targets) whose identifiers fall within a defined Config Sync 
domain range. 

Config Sync Server detects... Action taken...

A resource was added to the 
communication platform that 
does not exist in OpenScape 
Contact Center

Config Sync creates a new OpenScape 
Contact Center definition for the resource, 
gives it the name of the domain range, and 
sets the resource state to Active.

A resource was added to 
OpenScape Contact Center that 
does not exist on the 
communication platform

Config Sync sets the OpenScape Contact 
Center definition state to Communication 
Platform Synchronization Error.

Table 12 Config Sync actions on changes to other resources
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11.5  Configuring the voice options

Use the voice options to configure the default settings for the voice 
feature. For details, see the following topics:

• Section 11.5.1, “Configuring the default voice routing strategy, 
queue, and time-out extension”, on page 216

• Section 11.5.2, “Configuring the voice error queue settings”, on 
page 217

• Section 11.5.3, “Configuring the communication platform settings”, 
on page 218

• Section 11.5.4, “Configuring the Config Sync settings”, on page 219

• Section 11.5.5, “Configuring the VoiceXML settings”, on page 280

NOTE:  To configure any of the voice options, you must have Full or 
Modify access for the associated Manager permission.

11.5.1  Configuring the default voice routing 
strategy, queue, and time-out extension

You must specify the following defaults for the voice feature: 

• Default routing strategy workflow – The routing strategy 
workflow that is initially used to route all calls in the contact center. 
You can configure the default routing strategy workflow to link to 
other routing strategy workflows, if required.

• Default queue – The queue that you want to use as the default 
option for the no match found (*) entry in a Destination Table 
component.

A resource was deleted from the 
communication platform but still 
exists in OpenScape Contact 
Center

Config Sync deletes the OpenScape 
Contact Center definition of the resource. 

A resource was deleted from 
OpenScape Contact Center but 
still exists on the communication 
platform

Config Sync sets the OpenScape Contact 
Center definition state to OpenScape 
Contact Center Synchronization Error. 

Config Sync Server detects... Action taken...

Table 12 Config Sync actions on changes to other resources
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Time-out extension – The extension to which a call will be routed 
provided that a time-out is specified when you configure a queue. 
In general, the time-out extension should be used to move the call 
outside the OpenScape Contact Center system. The time-out 
extension should not be configured to reference the following, 
depending on the type of communication platform you are using:

• OpenScape Voice – A pilot number for an OpenScape Contact 
Center Music On Hold Hunt Group.

• OpenScape 4000 or HiPath 4000 – A pilot number for an 
OpenScape Contact Center Route Control Group.

• OpenScape Business – A CDL call number for an OpenScape 
Contact Center UCD group.

Before configuring these settings, be sure to create the routing 
strategy workflow (see Section 9.4, “Configuring a routing strategy 
workflow”, on page 171) and the queue (see Section 10.3, “Configuring 
a queue”, on page 200) that you want to use as the default.

NOTE:  In a multitenant environment, only a business unit 
administrator can configure the default voice routing strategy, queue, 
and time-out extension. For details, see Section 19.3, “Administrator 
roles in a multitenant environment”, on page 394. 

To configure the default voice routing strategy and queue:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Voice.

3. On the General tab, under Default, do the following:

• In the Routing strategy list, select the voice routing strategy 
you want to use to initially route all calls. 

• In the Queue list, select the voice queue that you want to use 
as the default option for the no match found (*) entry in a 
Destination Table component. 

• In the Time-out extension box, type the extension that you 
want to use as the default time-out extension. The time-out 
extension is the extension to which a call will be routed provided 
that a time-out is specified when you configure a queue. 

4. Click OK.
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11.5.2  Configuring the voice error queue 
settings

The error queue is the queue to which calls are routed in the case of 
recoverable system errors. Recoverable system errors are errors 
generated by the OpenScape Contact Center servers that cannot be 
handled by the Exit on error option provided in some of the workflow 
components. If the system detects a recoverable system error in a 
routing strategy workflow, the call is routed to the error queue where 
it can then be routed to an appropriate user. 

In the case of a critical error, such as a system outage while the call is 
being handled on a voice processor extension, the system will transfer 
the call to the error transfer number. The error transfer number does 
not serve the same purpose as the time-out extension associated with 
a queue. The error transfer number can be one of the following 
numbers, depending on the type of communication platform to which 
the system is connected:

• OpenScape Voice – The pilot number for an OpenScape Contact 
Center Music On Hold Hunt Group.

• OpenScape 4000 or HiPath 4000 – The pilot number for an 
OpenScape Contact Center Route Control Group. 

• OpenScape Business – The CDL call number for an OpenScape 
Contact Center UCD group.

NOTE:  If a system outage occurs where the system can no longer 
process the call, the communication platform can then invoke backup 
routing. On an OpenScape Voice, OpenScape 4000, or HiPath 4000 
communication platform, when the system transitions out of backup 
routing, all recovered calls are placed in the error queue with a priority 
of 50. 

NOTE:  In a multitenant environment, only a business unit 
administrator can configure the voice error queue settings. For details, 
see Section 19.3, “Administrator roles in a multitenant environment”, 
on page 394. Also, the voice processor or processors are shared 
between business units. So in the case of a critical error, calls will be 
transferred to a single error transfer number, that is, the transfer 
number associated with the error business unit. For details on the error 
business unit, see Section 19.6, “Configuring the error business unit”, 
on page 402.
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To configure the voice error queue:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Voice.

3. On the General tab, under Error, do the following:

• In the Queue list, select the queue to which contacts are 
directed in the case of recoverable errors. 

• In the Description box, type a description for the error queue.

• In the Transfer number list, select the number to which 
contacts are directed in the case of critical errors. 

4. Click OK. 

11.5.3  Configuring the communication 
platform settings

When you installed the OpenScape Contact Center software, you 
selected the communication platform to which the system is 
connected. 

IMPORTANT:  Changing the communication platform type after initial 
system setup can adversely affect the operation of the system. Contact 
your service representative if you plan to change your communication 
platform. You might not have the necessary software on the server 
machine to work with a different communication platform. In most 
cases, you should change the communication platform type only when 
you are connected to a design database for configuration purposes. 
When you are connected to the production database, changing the 
communication platform type will require that you restart the 
OpenScape Contact Center service on the main server machine. 

You can configure the settings for the selected communication 
platform, including:

• The settings used to determine if OpenScape Contact Center is 
functioning properly or needs to use backup routing (required only 
for OpenScape 4000 or HiPath 4000).

• The setting of the OpenScape Contact Center Ring No Answer 
feature.  

• The CSTA server settings for the communication platform interface 
module. 
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11.5.3.1  Configuring an OpenScape Voice 
communication platform

This section describes how to configure an OpenScape Voice 
communication platform.

IMPORTANT:  When you are connected to the production database, if 
you change the CSTA Signaling Manager settings, you will be required 
to restart the T-Server on the OpenScape Contact Center main server 
machine. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the communication platform settings, except for the 
OpenScape Contact Center Ring No Answer feature, which can only be 
configured by a business unit administrator. For details, see Section 
19.3, “Administrator roles in a multitenant environment”, on page 394. 

NOTE:  If the system is configured for high availability (warm 
standby), and you make any changes to the OpenScape Voice 
communication platform settings, the changes are not replicated on 
the backup server machine. Therefore, you must make the same 
changes separately on the backup server machine. In this case, when 
you log on to the Manager application, you must connect to the physical 
backup server machine in the format portnumber@servername. 

To configure an OpenScape Voice communication platform:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Voice.

3. Click the Communication Platform tab.

4. Under Communication Platform Settings, do the following:

• In the Node distribution list, select the subnet deployment.

– Common subnet – Indicates that the nodes reside on a 
common subnet. 

– Separate subnets – Indicates that the nodes reside on 
separate subnets.
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• To enable the OpenScape Contact Center Ring No Answer 
feature, select the Enable Ring No Answer check box. 

NOTE:  When the system is connected to an OpenScape Voice 
V7 R1 or V8 communication platform, you must select the 
Enable Ring No Answer check box for the system to be able 
to recall unanswered calls when users are using a preferred 
device other than the desk telephone.

5. Under CSTA Signaling Manager Settings, do the following: 

• If you selected Common subnet in step 4:

– In the IP Address box, type the IP address of the CSTA 
Signaling Manager service. 

– In the Port number box, type the port number of the CSTA 
Signaling Manager service. 

• If you selected Separate subnets in step 4:

– In the Service name box, type the name of the CSTA 
Signaling Manager service. 

– In the Domain name box, type the fully qualified domain 
name of the CSTA Signaling Manager service. 

NOTE:  When the system is configured for high availability 
(warm standby), the configuration of the Service name and 
Domain name must be the same on the primary and backup 
server machines. 

– In the Port number box, type the port number of the CSTA 
Signaling Manager service. 

6. Click OK. 
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11.5.3.2  Configuring an OpenScape 4000 or HiPath 
4000 communication platform

This section describes how to configure an OpenScape 4000 or HiPath 
4000 communication platform. 

IMPORTANT:  When you are connected to the production database, if 
you change the CSTA server settings, you will be required to restart the 
T-Server on the OpenScape Contact Center main server machine.

NOTE:  In a multitenant environment, only a system administrator can 
configure the communication platform settings, except for the 
OpenScape Contact Center Ring No Answer feature, which can only be 
configured by a business unit administrator. For details, see Section 
19.3, “Administrator roles in a multitenant environment”, on page 394. 

To configure an OpenScape 4000 or HiPath 4000 
communication platform:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Voice.

3. Click the Communication Platform tab.

4. Under Communication Platform Settings, do the following:

• When the system is configured for high availability (warm 
standby) and is connected to an OpenScape 4000 or HiPath 
4000 communication platform, in the Operating mode list, 
select the operating mode. Your choices are: Simplex or 
Duplex. 

• When the system is configured for high availability (warm 
standby), in the Deployment model list, select the deployment 
model. Your choices are: Stand-alone or Access Point 
Emergency. 

• In the Heartbeat application name box, the default name is 
OSCC. You need to change the default name only if you are 
connecting more than one main server machine to a single 
OpenScape 4000 or HiPath 4000 communication platform. In 
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this case, the heartbeat application name is required to uniquely 
identify this server machine. The name you enter here must 
match the application name configured for the server in the 
CSTA settings loaded on the communication platform. 

NOTE:  When the system is configured for high availability 
(warm standby), the heartbeat application name must be the 
same on the primary and backup server machines. 

• In the Fallback number box, type the default ACD number 
where all calls are directed if the communication platform 
detects a problem with the OpenScape Contact Center 
heartbeat. 

• In the Pulse interval box, type the interval, in seconds, 
between heartbeat pulses sent from OpenScape Contact Center 
to the communication platform. The default value is 15 seconds. 

• To enable the OpenScape Contact Center Ring No Answer 
feature, select the Enable Ring No Answer check box. 

5. When the system is connected to an OpenScape 4000 or HiPath 
4000 communication platform, depending on the configuration of 
the high availability (warm standby) feature, do one of the 
following:

• If the system is not configured for high availability (warm 
standby), under CSTA Server Settings:

– In the Host name box, type the host name of the 
communication platform. 

– In the Port number box, type the port number for CSTA on 
the communication platform. 

• If the system is configured for high availability (warm standby) 
and the selected deployment model is Stand-alone, under 
CSTA Server Settings:

– In the Host name box, type the host name of the 
communication platform. 

– In the Port number box, type the port number for CSTA on 
the communication platform. Ensure that you enter a 
different port number on the primary and backup server 
machines.

• If the system is configured for high availability (warm standby) 
and the selected deployment model is Access Point 
Emergency: 
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– Under Main CSTA Settings, in the Host name box, type 
the host name of the communication platform. 

– Under Main CSTA Settings, in the Port number box, type 
the port number for CSTA on the communication platform. 
Ensure that you enter a different port number on the primary 
and backup server machines. 

– Under Access Point Emergency CSTA Settings, in the 
Host name box, type the host name of the Access Point 
Emergency unit. 

– Under Access Point Emergency CSTA Settings, in the 
Port number box, type the port number of the Access Point 
Emergency unit. Ensure that you enter a different port 
number on the primary and backup server machines.

6. Click OK. 

11.5.3.3  Configuring an OpenScape Business 
communication platform

This section describes how to configure an OpenScape Business 
communication platform. 

IMPORTANT:  When you are connected to the production database, if 
you change the CSTA server settings, you will be required to restart the 
T-Server on the OpenScape Contact Center main server machine. 

To configure an OpenScape Business:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Voice.

3. Click the Communication Platform tab.

4. To enable the OpenScape Contact Center Ring No Answer feature, 
select the Enable Ring No Answer check box. 

5. Under CSTA Server Settings, do the following:

• In the Host name box, type the host name of the server 
machine where the CSTA server resides. 

• In the Port number box, type the port number of the CSTA 
server. 

6. Click OK. 
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11.5.4  Configuring the Config Sync settings

You can enable the Config Sync feature (see Section 11.4, “About 
Config Sync”, on page 213) and configure various settings related to 
the feature, such as when synchronization occurs. 

NOTE:  When the system is connected to an OpenScape 4000 or 
HiPath 4000 communication platform, the Config Sync feature is not 
supported. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the Config Sync settings. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the Config Sync settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Voice.

3. Click the Config Sync tab.

4. To enable the synchronization settings, under Config Sync, select 
the Enable check box. 

5. Under Communication Platform Access (not available on 
OpenScape Voice), configure the following items that enable the 
Config Sync Server to access the communication platform and 
potentially make changes to communication platform resources:

a) In the IP address box, type the IP address of the 
communication platform. If the system is connected to an 
OpenScape 4000 or HiPath 4000 communication platform, this 
is the IP address of the communication platform on the 
customer LAN.

b) In the Port number box, type the appropriate port number of 
the communication platform. If the system is connected to an 
OpenScape 4000 or HiPath 4000 communication platform, this 
is the port number on the OpenScape Contact Center system to 
which the communication platform connects.

c) In the Logon name box, type the user name needed to log on 
to the communication platform.
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d) In the Password box, type the password needed to log on to 
the communication platform. 

e) In the Confirm password box, retype the password to confirm 
that you entered it correctly. 

f) In the Lock level box, type or select the access level to the 
communication platform. You can enter a value from 1 to 15.

6. Under Range Allocation, in the Automatic creation size box, 
type the size of the automatically defined resource domain range. 
If you create a resource in OpenScape Contact Center that is 
outside the Config Sync resource domain range, you are prompted 
to add it to the domain range. The value in this box defines the 
increment that is used. You can enter a value from 1 to 1000. The 
default value is 1.

7. Under Synchronization, select the At data maintenance time 
check box to automatically synchronize the communication 
platform and OpenScape Contact Center resources after data 
maintenance is performed, normally about 20 minutes after the 
data maintenance time. 

NOTE:  If you have the required administrator permission, you can 
click Synchronize now to manually synchronize the 
communication platform and OpenScape Contact Center resources, 
but this should be done only during periods of low contact volume.

11.5.5  Configuring the VoiceXML settings

You can enable the VoiceXML feature and configure the port number 
that the Web Interaction Server uses to communicate with the 
corporate Web server for VoiceXML integration. 
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For more information on the VoiceXML feature, see the VoiceXML 
Integration Guide. 

NOTE:  When you are connected to the production database, if you 
change the port number, you will be required to restart the Web 
Interaction Server on the main server machine. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the VoiceXML settings. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the VoiceXML settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Voice.

3. Click the VoiceXML tab.

4. To enable the VoiceXML feature, under VoiceXML, select the 
Enable check box.

5. Under Port Settings, in the Port number list, select the port that 
the Web Interaction Server uses to communicate with the corporate 
Web server to support VoiceXML. You can select an unsecured or a 
secured (TLS-enabled) port. For more information, see Section 
20.3.3, “Configuring the Web server settings”, on page 414. 

6. Click OK. 
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12  Working with Call Director
This chapter introduces Call Director and provides instructions on 
working with configurable Call Director resources in the Manager 
application 

Call Director is a licensed voice feature that allows you to play 
messages and interact with the caller. A message (.wav file) can greet 
the caller, provide a menu prompt, gather numerical data, or play a 
performance level statistic. For example, you can prompt the caller to 
“Press 1 for Service, or press 2 for Sales”. 

Call Director components can help you match callers to the best 
available user in routing strategy and queue processing workflows.You 
must use third-party applications to create .wav files for use with the 
Call Director components. For details, see Section 12.3.2, “Configuring 
a .wav file”, on page 224. 

12.1  Communication platform and voice processor interaction

When the system is licensed for Call Director, a voice processor is used 
to play announcements and interactive recordings, and collect digits 
input by a caller. The system supports the following voice processor: 
OpenScape Contact Media Service - multiple voice processors can be 
configured

When a workflow component invokes a Call Director function, the call 
is routed to an extension dedicated to Call Director services. 

NOTE:  The OpenScape Voice communication platform uses the term 
subscriber number instead of extension. 

NOTE:  When a call is routed to an interactive Call Director extension, 
the caller might hear a short ring before the voice processor answers 
the call. 

In the Telephony Center, each Call Director extension associates a 
voice processor extension (or channel) with a communication platform 
extension dedicated to interactive messages. For announcements 
(OpenScape Business only), the Call Director extension also associates 
the voice processor extension with a communication platform Device 
ID. 
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The number of extensions required is a function of capacity and 
depends on the site. For more information, contact your service 
representative.

Ensure that you complete the voice processor configuration before 
configuring the Call Director extensions. For details, see Section 
12.3.1, “Configuring a voice processor”, on page 224. For information 
on how to configure Call Director extensions, see the Manager Help. 

12.2  Call Director workflow components

The following workflow components directly invoke Call Director 
functionality:

• Menu Prompt components play an audible voice prompt to a caller 
and the routing of the contact or subsequent processing in the 
workflow can be based on the caller's response.

• Message components play an audible message to one specific 
contact.

• Performance Message components play an audible message 
followed by a queue statistic message, followed by a final message.

• Digit Collection components play an audible message, collect 
numeric information, such as an account number, from the caller, 
and store it in the Contact Data. 

• Number Playback components play a number back to a call. The 
number can be configured as part of the component or retrieved 
from Contact Data.
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For configuration details for these components, see the Manager Help.

12.3  Configuring the Call Director resources

Before you can use Call Director components in a workflow, you must: 

• Configure the Call Director extensions or subscriber numbers – see 
the Manager Help. 

• Configure the voice processors – see Section 12.3.1, “Configuring a 
voice processor”, on page 285. 

• Configure the .wav files that you want to use – see Section 12.3.2, 
“Configuring a .wav file”, on page 224. 

NOTE:  Your initial Call Director configuration is typically set up by your 
service representative. For information on the setup tasks, see the 
Communication Platform Integration Guide. 

12.3.1  Configuring a voice processor

If you are using Call Director, you must configure the voice processors 
to be used with the system. The system supports the following voice 
processor:

• OpenScape Contact Media Service - multiple voice processors can 
be configured
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For more information on the OpenScape Contact Media Service, see the 
OpenScape Contact Media Service Installation Guide. 

IMPORTANT:  The system supports the use of only one Contact Media 
Service voice processor. When you are connected to the production 
database, ensure that you complete the voice processor configuration 
before configuring the Call Director extensions or subscriber numbers.

NOTE:  When the system is configured for high availability (warm 
standby), redundant voice processors are required. For more 
information, see Section 18.1, “Call Director configuration in a high 
availability (warm standby) environment”, on page 388. 

NOTE:  In a multitenant environment, only a system administrator can 
configure a voice processor. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure a voice processor:

1. On the File menu, point to New, then Telephony Center, and then 
click Voice Processor.

2. Under Voice Processor, do the following:

• In the Name box, type the name of the voice processor. 

• In the Description box, type a description for the voice 
processor. 

• In the Host name box, type the host name or IP address of the 
host machine where the voice processor is located. 

• In the Port number box, type the port number that the voice 
processor uses for CTI communication. If the system is using 
multiple OpenScape Contact Media Service voice processors, 
you can configure the same port number for each voice 
processor. Default: 6027

• If the system is using multiple distributed voice processors, in 
the Voice processor region list, select the region with which 
you want to associate the voice processor. The voice processor 
region that you want to use must already be configured. For 
details, see Section 12.3.2, “Configuring a voice processor 
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region”, on page 287. The option to use distributed voice 
processors is configured in the Call Director general options. For 
details, see Section 12.4.1, “Configuring the Call Director 
general options”, on page 291. 

• In the Password box, type the password for the user account 
that is used to establish a connection with the voice processor 
for CTI communication. Default: Un1Fy

3. Click OK.

12.3.2  Configuring a voice processor region

When the system is using multiple OpenScape Contact Media Service 
voice processors, you can choose to distribute the voice processors to 
different regions. This allows you to route calls to voice processor 
extensions in different regions. In this case, you must configure the 
regions that you want to use. 

NOTE:  The option to use distributed voice processors is configured in 
the Call Director options. For details, see Section 12.4.1, “Configuring 
the Call Director general options”, on page 291. 

To configure a voice processor region:

1. On the File menu, point to New, then Telephony Center, and then 
click Voice Processor Region.

2. On the General tab, under Voice Processor Region, do the 
following:

• In the Name box, type a name for the voice processor region. 

• In the Description box, type a description for the voice 
processor region. 

3. Click the Voice Processors tab.

4. Under Include, select the check box for each voice processor that 
you want to associate with this voice processor region. 
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12.3.3  Configuring a .wav file

If the Call Director feature is enabled, you must configure a resource 
for each sound (.wav) file that you want to use in Call Director workflow 
components and other settings related to Call Director. 

NOTE:  To create or change a .wav file, you must have Full or Modify 
access, respectively, for the WAV files Manager permission. 

You can upload a .wav file from the main server machine or from a 
client machine. The uploaded .wav files are stored in the WaveFiles 
folder on the main server machine. The file path names are not stored 
in the resource. The system looks in the designated WaveFiles folder 
for the .wav files. 

NOTE:  When the system is configured for high availability (warm 
standby), the .wav files are not replicated on the backup server 
machine. You must manually copy the .wav files to the WaveFiles folder 
on the backup server machine and ensure that the .wav files on the 
primary and backup server machines remain synchronized. For more 
information, see Section 18.1, “Call Director configuration in a high 
availability (warm standby) environment”, on page 388.

The .wav files must meet specific requirements (see Section 12.3.2.1, 
“Call Director .wav file requirements”, on page 226). The .wav files 
must be created using third-party software and hardware. We do not 
provide the software or hardware required to create .wav files. 
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To configure a .wav file:

1. On the File menu, point to New, then Design Center, then Voice, 
and then click WAV File. 

2. On the General tab, under File, do the following:

• In the Name box, type the name of the .wav file. You can 
browse to select and upload the .wav file to the WaveFiles folder. 

NOTE:  When the system is configured for high availability 
(warm standby), to select the .wav file, the Manager application 
must be connected to the physical server machine in the format 
portnumber@servername. 

NOTE:  If you are connected to a production database, you can 
click  to play the .wav file. You cannot play .wav files when 
you are connected to a design database.

NOTE:  If you are connected to a production database, you can 
click  to download the .wav file. You cannot download .wav 
files when you are connected to a design database.

• In the Description box, type a description for the .wav file. Use 
the description to specify what information is presented in the 
.wav file. 

The Installed check box is a read-only item used when you are 
connected to a production database to indicate whether or not 
the .wav file is installed in the WaveFiles folder. If the system 
cannot find the .wav file, the Installed check box is cleared. 
This check box is always cleared when you are connected to a 
design database. You can save the .wav file definition even 
though the system cannot find the .wav file. 

NOTE:  When the system is configured for high availability 
(warm standby), the Installed check box works only when the 
Manager application is connected to the physical server machine 
in the format portnumber@servername. 

3. Click the Security tab. This tab is available only if the enhanced 
security option is enabled. For details, see Section 15.3.4, 
“Configuring the enhanced security option”, on page 271. 
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4. Under Users, select the check box for each user who you want to 
be able to modify this .wav file. The list contains only the users who 
have Full or Modify access to the WAV files Manager permission. 

5. Click OK.

12.3.3.1  Call Director .wav file requirements

When creating a .wav file, you must ensure that it meets the following 
requirements. 

The maximum metallic signal power averaged over any 3-second 
interval in the 200-3995 Hz voice band does not exceed the following 
ANSI/TIA-986-A signal power limitation requirements mandated by the 
FCC:

• The analog CO/DID trunk and OPS line interfaces do not exceed -9 
dBm

• The 2-wire and 4-wire lossless tie trunk type interfaces do not 
exceed -15 dBm

• The digital T1 and ISDN PRI/BRI interfaces do not exceed - 12 dBm

The name of the .wav file contains only alphanumeric and underscore 
characters (A-Z, a-z, 0-9 and “_”), has a .wav extension, and is less 
than or equal to 25 characters, excluding the extension and path 
information. For example, the following are valid .wav file names:

• First_Message.wav

• Next_Msg1.wav

• Next_Msg2.wav

• 1203_Entry.wav

• 1stError_File.wav
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12.4  Configuring the Call Director options

You can configure the various default options for the Call Director 
feature. For details, see the following topics:

• Section 12.4.1, “Configuring the Call Director general options”, on 
page 227

• Section 12.4.2, “Configuring the Call Director destination table”, on 
page 294

• Section 12.4.2, “Configuring the Call Director default navigation”, 
on page 230

• Section 12.4.3, “Configuring the Call Director responses”, on page 
231 

NOTE:  To configure any of the Call Director options, you must have 
Full or Modify access for the associated Manager permission.

NOTE:  You can override some of these default options when you 
configure a workflow. For details, see Section 9.4.1, “Overriding the 
default Call Director settings”, on page 173. 

12.4.1  Configuring the Call Director general 
options

You can configure various general options for Call Director, such as the 
extension allocation and standard language. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the extension allocation and language options, and only a 
business unit administrator can configure the error message file. For 
details, see Section 19.3, “Administrator roles in a multitenant 
environment”, on page 394. 

Before you begin, the .wav files that you want to use must be 
configured and installed on the main server machine (see Section 
12.3.2, “Configuring a .wav file”, on page 224).
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To configure the Call Director general options:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Call Director.

3. Under Extension Allocation, double-click the number in the 
Interactive (%) column and the Routing Strategy row, and then 
type the percentage of all available interactive extensions that you 
want to reserve for playing interactive messages in a routing 
strategy workflow. 

The application automatically updates the Queue Processing row 
so that the Total equals 100. For examples, see Section 12.4.1.1, 
“Extension allocation ratio examples”, on page 293. On an 
OpenScape Business communication platform, you can configure 
the percentage of available announcement extensions in the same 
way. 

4. Under Language, click Standard and select the language you 
want to use for spoken messages from the list. The list contains the 
languages supported by the voice processor. 

In order to use another language than one of the standard 
languages:

1. Click Custom locale ID 

2. Enter an appropriate value, for example 1043 for "Dutch - 
Netherlands".

3. For a custom language you need to record the .wav files by 
yourself or obtain them from a 3rd party. These are system .wav 
files, used in Number Playbacks and Performance Messages, for 
example announcing the wait time in a queue. 

4. Store these .wav files on the OSCC server in the folder 
%HPPCDIR%\SystemVoice\<custom locale id>\Unisex

equivalent to the standard languages, where <custom locale 
id> is the value associated with the custom language.

NOTE:  When using a custom language, all played .wav files are 
taken from the Unisex folder, as opposed to the standard 
languages. For the standard languages the .wav files are taken 
from both the Male and Female folders, depending on 
grammatical context.

5. Under Outage Threshold, in the Extensions out of service box, 
type or select the percentage of Call Director extensions or 
subscriber numbers that must be out of service before the Call 
Director Server becomes nonoperational. The default value is 75%. 
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6. Under Error, in the Message file name list, select the .wav file 
that plays if an error occurs. This error message will be played if the 
connectivity between Call Director and the voice processor is lost. 
This same message will be played if the Call Director Server 
encounters an error in workflow, unless you override this error 
message in a specific workflow diagram (see Section 9.4.1, 
“Overriding the default Call Director settings”, on page 173). 

NOTE:  If you are connected to a production database, you can 
click  to play the .wav file. You cannot play .wav files when you 
are connected to a design database.

7. Click OK.

12.4.1.1  Extension allocation ratio examples

When you configure the Call Director general options, under 
Extension Allocation, you specify the percentage of interactive 
extensions (and announcement extensions on the OpenScape 
Business), that you want to reserve for routing strategy workflows and 
queue processing workflows. For details on how to configure the 
general options, Section 12.4.1, “Configuring the Call Director general 
options”, on page 227. 

If a fraction of an extension remains after the ratio is applied, the 
fraction is assigned to the routing strategy workflows. For example, 
assume you have 10 extensions. Some examples of how the extensions 
would be allocated are shown in the following table.

NOTE:  In the event that a Call Director extension is deleted, the 
system might automatically reallocate extensions to either routing 
strategy workflows or queue processing workflows based on the 
configured extension allocation. 

Extension allocation Actual number of extensions reserved

Routing 
strategy

Queue 
processing

For routing 
strategy 

workflows

For queue 
processing 
workflows

50% 50% 5 5

1% 99% 1 9

55% 45% 6 4

99% 1% 10 0

Table 12 Extension allocation examples
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12.4.2  Configuring the Call Director 
destination table

When the system is using multiple distributed OpenScape Contact 
Media Service voice processors, you must configure the Call Director 
destination table. The destination table is used to route a contact to a 
particular voice processor region based on the dialed destination 
number. 

Before you begin, the voice processor regions that you want to use 
must already be configured. For details, see Section 12.3.2, 
“Configuring a voice processor region”, on page 287. 

NOTE:  The option to use distributed voice processors is configured in 
the Call Director options. For details, see "Configuring the Call Director 
general options". 

NOTE:  In a multitenant environment, only a system administrator can 
configure the Call Director destination table. For details, see Section 
19.3, “Administrator roles in a multitenant environment”, on page 394. 

To configure the Call Director destination table:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Call Director.

3. Click the Destination tab. 

4. Under Destinations, add a destination entry to the table as 
follows:

• In the Destination column, type a valid destination. A single 
asterisk (*) can be used as a wildcard to substitute one or more 
numbers in a destination. The asterisk alone can be used to 
represent all destinations, or you can use an asterisk at the start 
or end of a destination to represent one or more numbers. You 
cannot use more than one asterisk in a single destination, or in 
the middle of a destination. For example, the destination 
numbers *123, 123*, and * are valid. *567* and 56*7 are not 
valid. 

• In the Voice Processor Region column, click the cell, and then 
select the preferred voice processor region from which a voice 
processor extension will be allocated.
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• In the Routing Strategy column, click the cell, and then select 
Yes or No from the list. This option indicates whether the 
system will try to use other voice processor regions if no idle 
routing strategy extensions are found on all the voice processors 
belonging to the preferred voice processor region. 

• In the Queue Processing column, click the cell, and then select 
Yes or No from the list. This option indicates whether the 
system will try to use other voice processor regions if no idle 
queue processing extensions are found on all the voice 
processors belonging to the preferred voice processor region. 

5. Repeat step 4 for every destination that you want to enter. 

6. Click Sort to put the destinations in the order in which they are 
processed by the system.

7. Click OK.

12.4.3  Configuring the Call Director default 
navigation

You can configure the navigation keys that can be used globally for Call 
Director components in workflows. A navigation key is a digit on the 
telephone that a caller can enter to move from one Call Director 
component in a workflow to another. You can choose a subset of these 
keys for each Call Director component that you configure.  

Before you begin, the .wav files that you want to use must be 
configured and installed on the main server machine (see Section 
12.3.2, “Configuring a .wav file”, on page 224).

NOTE:  In a multitenant environment, only a business unit 
administrator can configure the default navigation. For details, see 
Section 19.3, “Administrator roles in a multitenant environment”, on 
page 394. 

To configure the Call Director default navigation:

1. On the Tools menu, click Options. 

2. In the left pane, under System Settings, click Call Director.

3. Click the Interaction tab. 
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4. Under Default Navigation, select the check box for each function 
that you want to make available to a caller. If you want to change 
the key assigned to the function, click the cell in the Key column 
and select the key from the list. You can choose from the following 
functions: 

• Operator – Enables the caller to transfer to the Operator.

• Return to Root Step – Enables the caller to return to the first 
interactive component in the routing strategy workflow or queue 
processing workflow.

• Repeat – Enables the caller to repeat the current component.

• Previous – Enables the caller to return to the previous 
interactive component. If a caller is at the first component, the 
component action is repeated.

• Help – Enables the caller to listen to a .wav file containing help 
for the routing strategy workflow or queue processing workflow. 

IMPORTANT:  If the same key is used for Help and another 
function, the Help will always take precedence over the other 
function. We recommend that you always use the asterisk (*) key 
to provide Help for the Call Director feature. 

5. If you selected the Operator function, do the following:

• In the Operator Queue list, click the queue that the call is 
forwarded to when the caller presses the Operator key. 

• In the Operator transfer file list, click the .wav file that plays 
when the caller is transferred to the operator. 

NOTE:  If you are connected to a production database, you can 
click  to play the .wav file. You cannot play .wav files when you 
are connected to a design database.

6. If you selected the Help function, in the Help file name list, click 
the .wav file that plays when the caller accesses the help. 

7. Click OK.
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12.4.4  Configuring the Call Director 
responses

You can configure the Call Director responses that are used when a 
caller gives no response, or an invalid response, to a Call Director 
component in a routing strategy workflow or queue processing 
workflow. 

Before you begin, the .wav files that you want to use must be 
configured and installed on the main server machine (see Section 
12.3.2, “Configuring a .wav file”, on page 224).

NOTE:  In a multitenant environment, only a system administrator can 
configure the Call Director responses. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the Call Director responses:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Call Director.

3. Click the Interaction tab. 

4. Under Response Attempts, in the Maximum number box, type 
or select the maximum number of times the system will accept no 
response from a caller before transferring the call to the error 
queue. You can specify a number between 1 and 9. 

5. Under No Response, do the following: 

• In the Maximum time box, type or select the maximum 
amount of time, in seconds, that the system will wait for input 
from a caller before determining there is no response. You can 
specify a value between 1 and 60 seconds.

• In the Message file name list, select the .wav file that plays 
when the caller does not respond within the specified amount of 
time. You can override this .wav file in a specific workflow 
diagram (see Section 9.4.1, “Overriding the default Call Director 
settings”, on page 173). 

NOTE:  If you are connected to a production database, you can 
click  to play the .wav file. You cannot play .wav files when 
you are connected to a design database.
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6. Under Invalid Response, in the Message file name list, select 
the .wav file that plays when the caller presses an incorrect 
telephone button. You can override this .wav file in a specific 
workflow diagram (see Section 9.4.1, “Overriding the default Call 
Director settings”, on page 173). 

7. Click OK.
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13  Working with the callback feature
This chapter introduces the callback feature and provides instructions 
on working with configurable callback options in the Manager 
application.

The callback feature is a licensed feature that allows you to provide 
users and customers with the ability to generate callbacks. A callback 
is a request for a return call that is usually based on a customer's 
previous interaction with the contact center. 

A callback can be generated in the following ways:

• A callback request is generated as part of the workflow using a 
Create Callback component. For details on the Create Callback 
component, see the Manager Help. 

• A voice queue can be configured so that a callback is created 
automatically when a customer abandons a call. For details, see 
Section 10.3.1, “Configuring the general queue information”, on 
page 201. This method of callback generation assumes that you 
have ANI numbers coming into the communication platform. 

NOTE:  Support is provided for additional ways of creating 
callbacks programmatically, for example, by having an IVR gather 
contact information to generate a callback. Contact your service 
representative for details.

• A customer generates a callback request from a Web page. For 
details, see Section 13.3.3, “Configuring the Web callback settings”, 
on page 240. 

• OpenScape Contact Center automatically imports a list of callbacks 
to be scheduled. For details, see Section 13.5, “Importing callbacks 
from an outbound list”, on page 310. 

NOTE:  We recommend that you configure callback-specific agents in 
a separate ACD group, UCD group, hunt group, or ACD queue on the 
communication platform (depending on the type of platform) to 
prevent unwanted backup routing. 

To handle callbacks, you must set up callback-specific queues.
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13.1  Callback processing

Regardless of how it is created, each callback gets scheduled for a 
specific time interval on a specific day. At the scheduled time, the 
callback is enqueued to a callback queue. The callback queue to which 
the callback is directed depends on how the callback was created:

• For callbacks created during the processing of a routing strategy or 
queue processing workflow, the queue is specified in the Create 
Callback component. 

• For voice queues configured to create a callback when a customer 
abandons a call, the voice queue also specifies the target callback 
queue. 

• For callbacks created from a Web page, a set of HTML template 
pages are provided that let you specify the target callback queue 
among other things.

NOTE:  For information on configuring a callback queue, see Section 
10.3, “Configuring a queue”, on page 200. 

The queue step execution attempts to find a user who is able to handle 
the callback. When an eligible and available user is found, the callback 
is assigned to that user. A screen pop with details on the callback is 
presented to the user. 

With respect to the callback settings and options configured using the 
Manager application, the key aspects of user options are:

• If the user does not have permission to preview the contact to view 
more details, the basic contact details will be displayed for a 
configurable interval and then the call to the customer will be 
automatically initiated.

• If the user has permission to preview the contact, the user can 
accept or delete the contact. If the user does not accept or delete 
the contact within a configurable interval, the callback will be 
requeued.

– If the user deletes the callback, a site-defined Delete reason 
must be provided. This completes processing of the callback.

– If the user accepts the callback and the call cannot be 
completed, the user can schedule a retry either immediately or 
at a later time. The number of retries that can be attempted is 
configurable, and each time the user requests a retry, a site- 
defined Retry reason must be provided.
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– If the user accepts the callback and the call to the customer is 
established successfully, the user can handle the contact in the 
same way that any other call is handled. When the user 
disconnects, the user must indicate that the callback was 
handled successfully or schedule a retry.

13.2  Configuring the callback resources

You must configure various resources that impact the callback feature.

NOTE:  Your initial callback configuration is typically set up by your 
service representative. For information on the setup tasks, see the 
Communication Platform Integration Guide. 

13.2.1  Configuring a Retry reason

A Retry reason is an explanation that a user can select when a callback 
is unsuccessful and must be retried. Retry reasons are commonly used 
to indicate conditions such as no answer or busy line. 

The Manager application provides a set of predefined Retry reasons. 
You cannot delete or rename these Retry reasons, although you can 
modify their descriptions. 

NOTE:  To create or change a Retry reason, you must have Full or 
Modify access, respectively, for the Retry reasons Manager 
permission. 

To configure a Retry reason:

1. On the File menu, point to New, then Design Center, then 
Callback, and then click Retry Reason. 

2. In the Name box, type a unique name for the Retry reason. 

3. In the Description box, type a description for the Retry reason. 

4. In the Retry Interval box, type the number of hours and minutes 
after which the system will retry the callback.

5. Click OK. 
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13.2.2  Configuring a Delete reason

A Delete reason is an explanation that a user can select when deleting 
a callback. Delete reasons are commonly used to indicate conditions 
such as the user recognizing an invalid telephone number. 

The Manager application provides a set of predefined Delete reasons. 
You cannot delete or rename these Delete reasons, although you can 
modify their descriptions. 

NOTE:  To create or change a Delete reason, you must have Full or 
Modify access, respectively, for the Delete reasons Manager 
permission. 

To configure a Delete reason:

1. On the File menu, point to New, then Design Center, then 
Callback, and then click Delete Reason. 

2. In the Name box, type a unique name for the Delete reason. 

3. In the Description box, type a description for the Delete reason. 

4. Click OK. 

13.2.3  Configuring an excluded number

You can configure a list of telephone numbers that are excluded from 
callbacks. For example, you should exclude emergency numbers, such 
as the numbers for ambulance and police. 

NOTE:  To create or change an excluded number, you must have Full 
or Modify access, respectively, for the Excluded numbers Manager 
permission. 

NOTE:  In a multitenant environment, only a system administrator can 
configure an excluded number. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 
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To configure an excluded number:

1. On the File menu, point to New, then Design Center, then 
Callback, and then click Excluded Number. 

2. In the Name box, type a unique name for the excluded number. 

3. In the Telephone number box, type the telephone number you 
want to exclude from callbacks.

4. Click OK. 

13.3  Configuring the callback options

Use the callback options to configure the default settings for the 
callback feature. For details, see the following topics:

• Section 13.3.1, “Configuring the general callback settings”, on page 
237 

• Section 13.3.2, “Configuring the callback routing schedule”, on 
page 238

• Section 13.3.3, “Configuring the Web callback settings”, on page 
240 

• Section 13.3.4, “Configuring the outbound options”, on page 308 

NOTE:  To configure any of the callback options, you must have Full or 
Modify access for the associated Manager permission. 

13.3.1  Configuring the general callback 
settings

You can configure various general options for callbacks, such as the 
automatic dial delay, and the options that affect the automatic 
generation of a callback when a customer abandons a call. For 
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information on configuring a voice queue to automatically create a 
callback on abandon, see Section 10.3.1, “Configuring the general 
queue information”, on page 201.

NOTE:  In a multitenant environment, only a system administrator can 
configure the general callback settings, except for the Caller ID 
settings, which can only be configured by a business unit administrator. 
For details, see Section 19.3, “Administrator roles in a multitenant 
environment”, on page 394. 

To configure the general callback settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Callback.

3. On the General tab, under Callback Settings, do the following:

• In the Automatic dial delay, type or select the amount of time 
the system waits after offering a callback to a user who does not 
have permission to preview contacts, before automatically 
dialing the callback. This gives the user some time to review the 
callback information. The maximum delay is 60 seconds. 

• In the Maximum time to enter result box, type or select the 
amount of time the user has after disconnecting a callback to 
indicate that the callback was successful or to schedule a retry, 
before the user is placed in Unavailable routing state. 

• To translate the number to be called based on your TAPI 
configuration, select the Format Callback Number check box. 
Some communication platforms can be configured to provide 
dialable calling numbers so that no translation is required. In 
this case, you would clear the check box to use the calling 
number directly, without translation. If you do not have TAPI 
configured, selecting this check box does not have any effect. 

4. Under Caller ID (available only when connected to an OpenScape 
Voice, OpenScape 4000, or HiPath 4000), do the following:

• In the Caller name box, type the name that is presented to the 
called party when a callback is initiated. 
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• In the Caller telephone number box, type the telephone 
number that the called party can use to contact the calling party 
who initiated the callback.

NOTE:  You can specify the Caller telephone number only and 
leave the Caller name blank. However, if you specify the Caller 
name, you must also specify the Caller telephone number. 

NOTE:  If the propagation of the caller name or caller telephone 
number is blocked by the telecommunications provider, the 
information will not be displayed to the customer. 

5. Under Create Callback on Abandon, do the following:

• In the Abandon Threshold box, type or select the minimum 
amount of time that a call must be in queue before being 
abandoned, for a callback to be created. 

• In the Default Priority box, type or select the default priority 
of the callback that is created. You can specify a value between 
1 and 100, where 100 is the highest priority. 

NOTE:  If the Create callback on call abandon option is enabled 
for a queue and a call in the associated queue is abandoned by a 
caller, the system checks the callback schedule to verify that a 
callback can be handled within the next 24 hours. If a callback is 
created, it remains active for 24 hours after the call was abandoned 
and is then deleted by the system.

6. Under Duplicate Entries, select the Prevent duplicate callback 
check box if you want the system to allow only one callback entry 
with the same destination telephone number and queue. 

NOTE:  If the Prevent duplicate callback option is enabled, the 
Callback Server still creates an exit point for the Create Callback 
component when a duplicate callback is encountered.

7. Under Schedule, configure the callback schedule (see Section 
13.3.2, “Configuring the callback routing schedule”, on page 238). 

8. Click OK. 
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13.3.2  Configuring the callback routing 
schedule

The callback routing schedule restricts the hours of operation during 
which a callback can be scheduled within the contact center. You can 
configure the default callback routing schedule, as well as exceptions 
to the default schedule. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the callback routing schedule. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the callback routing schedule:

1. On the Tools menu, click Options. 

2. In the left pane, under System Settings, click Callback.

3. On the General tab, under Schedule, click Edit Schedule.

4. In the Callback Routing Schedule dialog box, double-click the 
day you want to configure, and then edit the active time range for 
the day. 

NOTE:  You can also drag the start or end point of an active range 
to change the range. 

5. Optionally, click the Exceptions tab to create an exception to the 
default schedule. An exception overrides the schedule for the entire 
day.

a) On the calendar, click the day for which you want to schedule an 
exception, for example, a national holiday. The Default row 
shows the default schedule for that day.

b) Select the Override check box. 

c) In the Override row, double-click a cell, and then edit the active 
time range for the override schedule. Click OK. 
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6. Use the Summary tab to view the schedule by status or by day of 
the week. 

• To see the days and times when the schedule is active or 
inactive, expand By Status, and then click Active or Inactive, 
respectively. 

• To see the schedule for that day, expand By Day, and then click 
the day of the week.

7. Click OK. 

13.3.3  Configuring the Web callback settings

Your company can provide a Web interface where customers can 
request information or support. These customer requests can be used 
by OpenScape Contact Center to generate callbacks. 

This section describes how to enable the Web interface and configure 
the port that the Web Interaction Server uses to communicate with the 
corporate Web server. 

IMPORTANT:  When you are connected to the production database, if 
you change the port number, you will be required to restart the Web 
Interaction Server on the main server machine. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the Web callback settings. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the Web callback settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Callback.

3. Click the Web Callback tab.

4. To enable the generation of callbacks via the Web interface, under 
Web Callback, select the Enable check box. 

5. Under Port Settings, in the Port number list, select the port 
number that the Web Interaction Server uses to communicate with 
the corporate Web server for Web callback requests. You can select 
an unsecured or a secured (TLS-enabled) port. For more 
information, see Section 15.3.3, “Configuring the Web server 
settings”, on page 270.
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6. Click OK. 

13.3.4  Configuring the outbound options

If the contact center is licensed for the outbound feature (the callback 
feature must also be licensed), you can configure the system to 
automatically import a text file that contains a list of customer 
callbacks to be scheduled. For details, see Section 13.5, “Importing 
callbacks from an outbound list”, on page 310.

NOTE:  In a multitenant environment, only a system administrator can 
configure the outbound options. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the outbound feature:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Callback.

3. Click the Outbound tab.

4. To enable the outbound feature, under Automatic Import of 
Outbound List, select the Enable check box.

5. In the Outbound path box, type the location of the outbound list 
in one of the following formats: 

• If the outbound list resides on the main server machine, type 
the full path to the folder containing the outbound list. 

• If the outbound list resides on a remote machine, type a fully 
qualified network identifier in the form 
\\machine_name\folder_share_name. In this case, you must 
enable access to the remote machine. For details, see the 
Manager Help.

6. In the File name box, type the name of the outbound list including 
a valid extension, for example, outbound.txt. 

7. To validate the path and file name, click Test. The application will 
display a message indicating one of the following three conditions:

• The outbound list exists in the specified location and is readable.

• The outbound list cannot be found in the specified location.
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• The location specified for the outbound list does not exist or is 
not readable. 

NOTE:  If you do not click Test, the path and file name will be 
validated when you click OK. 

8. Click OK. 

13.4  Generating a Scheduled Callback List

You can generate a list of callbacks that are scheduled to be queued in 
the future and have not yet been queued or routed. The list can be 
generated for specific callback types and queues. 

NOTE:  To generate a Scheduled Callback List, you must have the 
Scheduled callback list Manager permission. 

To generate a Scheduled Callback List:

1. To access the Scheduled Callback List dialog box, do one of the 
following:

• On the Actions menu, click Scheduled Callback List.

• On the View menu, point to Activity Reports, and then click 
Scheduled Callback List.

2. Under Criteria, do the following:

• In the Origin Type box, select where the callbacks you want to 
report on originated from. You can select one of the options in 
the list or All. 

• In the Start area, select the start date and time for the interval 
the report is to cover. The time is specified using a 24-hour 
clock. 

• In the End area, select the end date and time of the interval.

3. Under Queues, select the queues for which you want to see the 
scheduled callbacks. 

4. On the Actions menu, click Find Now.
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13.5  Importing callbacks from an outbound list

Outbound is a licensed feature that is supported only when the 
OpenScape Contact Center system is licensed to handle callbacks.

The outbound feature allows you to configure the system to 
automatically import a text file (called an outbound list) that contains 
a list of customer callbacks to be scheduled. When this feature is 
enabled, the OpenScape Contact Center system scans a folder every 
five minutes, looking for a specified file. When the system finds the file, 
it automatically imports the file, schedules the callbacks, and then 
renames the file based on its time stamp.

While the default scanning frequency is once every five minutes, if the 
file contains more than three hundred callbacks, the next scan will be 
delayed one second for each additional callback record in the outbound 
list. For example, if the most recent outbound list contained 900 
records, OpenScape Contact Center will not scan for an outbound list 
for the next 10 minutes (600 seconds). 

The outbound list is normally generated by an external system, such 
as an SAP, although you can create a custom outbound list, if required. 
The outbound list must meet certain requirements. For details, see 
Section 13.5.2, “Creating an outbound list”, on page 311.

For reporting purposes, callbacks created in this way show Outbound 
as the origin type.

NOTE:  When the system is configured for high availability (warm 
standby), and a failure occurs while the outbound list is being 
imported, the system might be able to restart the import after a 
failover, provided that the backup server machine can access the path 
to the outbound list (see Section 13.3.4, “Configuring the outbound 
options”, on page 308). To ensure that duplicate callbacks are not 
created when this occurs, you should always select the Prevent 
duplicate callback check box (see Section 13.3.1, “Configuring the 
general callback settings”, on page 303).

13.5.1  Outbound list error handling

During import, if OpenScape Contact Center encounters a record that 
is in error, no callback will be created for that record. The record is 
written to a file named outbound.log, where outbound is the name you 
specify as the name of the file containing the outbound list. For details 
on naming the outbound list, see Section 13.3.4, “Configuring the 
outbound options”, on page 308. 
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The error file is located in the same location as the file containing the 
outbound list. A message is logged in the System Monitor application 
indicating that an error was encountered during the import. 

13.5.2  Creating an outbound list

You can create an outbound list manually using a word processor, or 
automatically, for example, by running a script against the results of a 
database query. In any case, the outbound list must meet the 
requirements provided in Section 13.5.2.1, “Outbound list 
requirements”, on page 312.

NOTE:  If you are creating an outbound list using a word processor, we 
recommend that you use Microsoft Word because it will accept and 
save the required ASCII characters properly. For details, see Section 
13.5.2.4, “Special character treatment”, on page 316. 

The source of information that you use to create an outbound list 
depends on your purpose. If you are using the outbound feature to 
retry callbacks that have expired, the information used to create an 
outbound list is contained in the OpenScape Contact Center database. 
You could use one of the following methods to obtain the information 
used to create your outbound lists:

• Generate a Detailed Callback (Historical) Report, save it in text 
format, and then modify the text file.

• Connect to the OpenScape Contact Center database using an SQL 
client, access the reporting data, and generate a custom list of 
callbacks. The database tables can be accessed through standard 
database protocols supported by Informix. The results of the query 
can be formatted as an outbound list. For guidance in this area, 
contact your service representative.

Similarly, if OpenScape Contact Center is working in conjunction with 
an enterprise system such as a CRM product from SAP or Siebel, your 
purpose in generating an outbound list may be independent of 
OpenScape Contact Center operation. For example, you might be 
interested in contacting leads generated for a particular campaign. You 
might therefore be starting your outbound list from a results file 
generated by querying a third party database.
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13.5.2.1  Outbound list requirements

The outbound list is a text file that contains a list of callback records. 
The text file must meet the following requirements:

• It must contain one record per line, to a maximum of 24,000 lines. 
If the Prevent duplicate callback option is enabled, duplicate 
records are not allowed. For details on that option, see Section 
13.3.1, “Configuring the general callback settings”, on page 303.

• The fields in each line must be separated by a | character. Each 
record must be terminated by a line terminator.

• Mandatory fields must not be empty.

• If a nonmandatory field is not included in the record, the | delimiter 
must be present anyway. For example, the Customer name, 
Description, Queue name portion of a record in which no description 
is to be provided, could be Blair Parsons||Technical Support| 

• The schedule date and time must be specified in the local time of 
the OpenScape Contact Center server machine.

• Schedule times cannot overlap each other; however, they must 
overlap part of the callback schedule. 

• Comment lines that begin with // will be ignored.

13.5.2.2  Outbound list callback record format

In general, each callback record in the outbound list does the following:

• Identifies the customer

• Provides details on how the callback is to be enqueued

• Lets you attach contact data to the callback

• Provides one or more schedules that specify when the callback is to 
be attempted
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Each record in the list consists of a set of fields delimited by the | 
character. The following table provides details on the fields that make 
up a callback record.

Field 
name

Man-
datory

Max. # of 
character
s

Description 

Customer 
name

Y 75 The name of the customer to contact.

Description N 100 The callback caption.

Business 
unit name*

Y 32 The name of the business unit. 

*This field is required only in a multitenant 
environment. In a non-multitenant 
environment, this field is not supported 
and must not be present. See the 
examples provided in Section 13.5.2.3, 
“Callback record examples”, on page 315. 

Queue 
name

Y 32 The name of the callback queue to which 
this contact is to be enqueued.

Priority N 3 The initial priority, 1 to 100, of the contact. 
If not specified, the default callback 
priority will be used.

Contact 
data

N 1000 Contact data consisting of one or more 
key/value pairs. The general form is:
 
<SEP1><key><SEP2><value><SEP1> 
<key><SEP2><value><SEP1> ... 
<SEP1><key><SEP2><value><SEP1>

where:
• <SEP1> is ASCII code 16, and is used to 

separate each key/value pair from the 
other key value pairs.

• <SEP2> is ASCII code 15, and is used to 
separate the key component from the 
value component in a key/value pair.

• <key> is the key component of a key/
value pair (max. 32 characters).

• <value> is the value component of a 
key/value pair (max. 128 characters).

For an example, see Section 13.5.2.3, 
“Callback record examples”, on page 315. 
For information on how to encode ASCII 
codes 15 and 16, see Section 13.5.2.4, 
“Special character treatment”, on page 
316. 

Table 13 Format of callback records in an outbound list
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Reserve 
user name

N 67 The name of the user for which to reserve 
the callback in the format Lastname, 
Firstname, for example, Smith, George. 
If the name specified is duplicated or not 
found in OpenScape Contact Center, this 
field will be ignored. 

Reserve 
time

N 8 The time to reserve the contact, in 
DD:HH:MM format. If in error, the default 
reserve time (240 minutes) will be used.

Schedule 1 
start date

Y 10 The start date, in local time, of the interval 
during which this callback will be 
attempted, in YYYY/MM/DD format.

Schedule 1 
start time

Y 5 The start time, in local time, of the interval 
during which this callback will be 
attempted, in HH:MM 24-hour format.

Schedule 1 
end date

Y 10 The end date, in local time, of the interval 
during which this callback will be 
attempted, in YYYY/MM/DD format.

Schedule 1 
end time

Y 5 The e nd time, in local time, of the interval 
during which this callback will be 
attempted, in HH:MM 24-hour format.

Schedule 1 
telephone 
number

Y 32 The telephone number to which this 
callback will be attempted. The format is:

+CC (AC) SN--EXT 

where CC is the country code, AC is the 
area code, SN is the subscriber number, 
and EXT is an extension that must be 
dialed by a user. The +CC and --EXT 
components are optional. For examples of 
valid telephone numbers, see Section 
13.5.2.3, “Callback record examples”, on 
page 315.

Schedule n 
start date

N

One or more additional schedules for the callback can 
be provided. For each additional schedule provided, the 
start date, start time, end date, end time, and 
telephone number components must be provided in the 
same format as specified for the Schedule 1 
components. 

Schedule n 
start time

N

Schedule n 
end date

N

Schedule n 
end time

N

Schedule n 
telephone 
number

N

Field 
name

Man-
datory

Max. # of 
character
s

Description 

Table 13 Format of callback records in an outbound list
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13.5.2.3  Callback record examples

The following callback record examples contain only mandatory fields. 
The optional Description, Priority, Contact Data, Reserve User Name, 
and Reserve Time fields are not included and a single schedule is 
provided.

Example – non-multitenant environment

Blair Parsons||Sporting Goods|||||2008/04/26|18:00|2008/04/
26|20:00|(902) 555-1212

Alastair Macdonald||Hardware|||||2008/04/26|18:00|2008/04/
26|20:00|(902) 555-1313

Example – multitenant environment

Blair Parsons||Business Unit 1|Sporting Goods|||||2008/04/
26|18:00|2008/04/26|20:00|(905) 555-1212

Alastair Macdonald||Business Unit 1|Hardware|||||2008/04/
26|18:00|2008/04/26|20:00|(902) 555-1313

The following is a contact data example of two key/value pairs in an 
outbound list callback record. The <ASCII 15> and <ASCII 16> 
placeholders are used to represent ASCII characters 15 and 16, 
respectively:

|<ASCII 16>ACCT_NUM<ASCII 15>123456<ASCII 16>BALANCE<ASCII 
15>0.00<ASCII 16>|

The following are examples of valid formats for dialable numbers that 
can be included in the Schedule Telephone Number fields:

• + 1 (905) 6957900

• +1 (905)6957900

• + 1 (905) 695 7900

• + 1 (905) 695-7900

• (905)6957900

• (905) 6957900

• (905) 695 7900

• (905) 695-7900

• (89) 12345

• +49(89)12345
A31003-S22B1-M103-08-76A9, 04/2025
OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide 249
         



Working with the callback feature

callbacks.fm

Importing callbacks from an outbound list
13.5.2.4  Special character treatment 

The contact data field in an outbound list callback record uses ASCII 
code 15 and ASCII code 16 characters as delimiters. For details, see 
Section 13.5.2.2, “Outbound list callback record format”, on page 312. 

NOTE:  If you are creating an outbound list using a word processor, we 
recommend that you use Microsoft Word because it will accept and 
save the ASCII characters properly. 

To type the special characters:

1. Ensure that the keyboard’s NUM LOCK feature is enabled.

2. Type ALT-015 or ALT-016, as required, using the keyboard’s 
number pad.

3. When your outbound list is complete, save the document as plain 
text and when you are prompted for text encoding, accept the 
defaults.

13.5.3  Enabling the outbound feature

After you have established a plan for creating outbound lists, you must 
enable the outbound feature and specify the location of the outbound 
list. For details, see Section 13.3.4, “Configuring the outbound 
options”, on page 308. 
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14  Working with the e-mail feature
This chapter introduces the e-mail feature and provides instructions on 
working with configurable e-mail resources in the Manager application. 

The e-mail feature is a licensed feature that allows you to provide 
customers with the ability to request assistance from your contact 
center through e-mail messages. The customer submits a request to a 
particular e-mail address and the e-mail message is routed through 
your corporate e-mail server to the OpenScape Contact Center E-mail 
Server. All e-mail messages are stored in a single mailbox on the 
corporate e-mail server. You need to configure multiple e-mail 
destinations if you want to have multiple e-mail addresses for your 
contact center. 

The OpenScape Contact Center E-mail Server and the corporate e-mail 
server communicate using IMAP4 (Internet Messaging Access 
Protocol). The OpenScape Contact Center applications and the 
corporate e-mail server also use IMAP4 to retrieve and process e-mail 
messages. Message attachments are retrieved using separate IMAP4 
and MIME functions. Reply e-mail messages are sent to customers 
using an SMTP (Simple Message Transfer Protocol) interface. 

NOTE:  No virus protection is provided by the OpenScape Contact 
Center E-mail Server. Protection should be provided by the corporate 
e-mail server and the operating system.

Queues, a routing strategy workflow, and optionally queue processing 
workflows, must be created specifically for e-mail messages. 

14.1  E-mail workflow considerations 

Within OpenScape Contact Center, the routing of incoming e-mail 
messages is initiated with an e-mail routing strategy workflow (see 
Section 9.4, “Configuring a routing strategy workflow”, on page 171). 
While e-mail workflows can make use of common workflow features, 
there are also a number of options available specifically for working 
with e-mail messages: 

• E-mail messages can be categorized by the extraction of relevant 
keywords and phrases in the e-mail message. OpenScape Contact 
Center can then route the e-mail message to the appropriate queue 
based on the e-mail category. For more information, see Section 
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14.1.1, “Working with categories”, on page 244. 

• Other e-mail component types let you automate e-mail actions. 
Responses and acknowledgments can be generated and delivered 
while the e-mail message is being processed by the routing strategy 
workflow or is enqueued. For more information, see Section 14.1.2, 
“Other e-mail workflow components”, on page 246. 

Ultimately, an e-mail routing strategy workflow must direct the e-mail 
message as follows:

• Direct the e-mail message to a queue, to wait to be handled by a 
user. 

• Discard the e-mail message, providing a site-defined discard reason 
(see Section 14.2.2, “Configuring a Discard reason”, on page 248). 

• Auto-respond to the e-mail message. 

After an e-mail message is enqueued, it is the responsibility of the 
queue to find an available user who is eligible to handle the e-mail 
message. 

E-mail messages will be automatically discarded by the OpenScape 
Contact Center E-mail Server under the following circumstances:

• The e-mail message does not contain a From address.

• The From address contains the text “postmaster” or 
"microsoftexchange".

• The To address does not contain an e-mail address that has been 
configured as a destination.

14.1.1  Working with categories

You can route an e-mail message, or base subsequent workflow 
processing, on the presence of keywords in the e-mail message. This 
is accomplished with two types of OpenScape Contact Center 
resources:

• Categories – A category consists of one or more keyword/
component pairs. For details on how to set up categories, see 
Section 14.2.1, “Configuring an e-mail category”, on page 247.

• Category Decision components – A Category Decision 
component tests an e-mail message for a match against one or 
more category criteria and passes execution to the next component 
based on the first criteria match it finds. Each criterion is a logical 
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expression defining a condition based on categories that apply to 
the e-mail message. For details on how to configure Category 
Decision components, see the Manager Help. 

NOTE:  You can use confidence levels to create more precise 
categorization. For details, see Section 14.3.5, “Displaying the e-mail 
confidence levels”, on page 258.

For example, in a contact center that sells footwear, you may have 
queues specializing in winter and summer footwear. You could set up 
categories according to types of footwear you sell:

• Skis

• Skates

• Hiking boots

• Tennis shoes

• Running shoes

• Walking shoes

You could then use a Category Decision component to route e-mail 
messages as follows:

• If the e-mail message contains any of the keywords Skis, Skates, 
or Hiking boots, direct the contact to the Winter Sportswear queue.

• If the e-mail message contains any of the keywords Tennis shoes, 
Running shoes, or Walking shoes, direct the contact to the Summer 
Sportswear queue.

• Contacts for which no specific match was found could be directed to 
an Unassigned queue.
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14.1.2  Other e-mail workflow components

In addition to the Category Decision component, the following e-mail 
components can also be used in e-mail workflows: 

• Auto-acknowledgment – You can use an Auto-acknowledgment 
component to send an automatic reply to a customer's e-mail 
message using the contents of an Auto-acknowledgment template. 

• Auto-response – You can use an Auto-response component to 
send an automatic reply to a customer's e-mail message using the 
contents of a Response template. 

• Auto-suggestion – You can use an Auto-suggestion component to 
create a draft reply to a customer's e-mail message using the 
contents of a Response template. 

NOTE:  The Auto-suggestion feature automatically opens the 
reply screen to the e-mail message with a suggested template. 
Therefore the attachments are not presented in the e-mail 
context.

• Discard – You can use a Discard component to discard an e-mail 
message for a selected reason. 

• Reply Decision – You can use a Reply Decision component to 
determine the routing of an e-mail message based on whether or 
not the e-mail message is a reply to an existing conversation. 

Many of these components are built from site-defined templates. For 
more information, see Section 14.2.3, “About e-mail templates”, on 
page 249. 

For details on how to configure these components, see the Manager 
Help. 

14.2  Configuring the e-mail resources

You must configure various resources that impact the e-mail feature.

NOTE:  Your initial e-mail configuration is typically set up by your 
service representative. For information on the setup tasks, see the 
System Management Guide. 
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14.2.1  Configuring an e-mail category

A category defines the keywords that OpenScape Contact Center 
searches for in an incoming e-mail message to help route the e-mail 
message to the appropriate queue. You can define a category to search 
for the keywords in the subject of the e-mail message, in the body, or 
both. 

For example, you can configure two categories as follows:

• If the keyword “sales” is found in the subject or body, the e-mail 
message is associated with the sales category.

• If the keywords “support”, “service”, or “help” are found in the 
subject or body, the e-mail message is associated with the support 
category. 

NOTE:  To create or change an e-mail category, you must have Full or 
Modify access, respectively, for the Categories Manager permission. 

You can use categories with Category Decision components in a 
workflow, as a step in routing an incoming e-mail message. For a 
detailed introduction to categories and the use of categories in 
workflows, see Section 14.1.1, “Working with categories”, on page 
244. 

To configure a category:

1. On the File menu, point to New, then Design Center, then 
E-mail, and then click Category.

2. On the General tab, under Details, do the following:

• In the Name box, type a unique name for the category. 

• In the Description box, type a description for the category.
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3. Click the Criteria tab. 

4. For each keyword that you want to define, do the following:

• In the Search In column, click the item and select the message 
location from the list. You can choose Subject, Body, or 
Subject or Body. 

• In the Search for the words column, type the keyword that 
you want to search for. 

• Press TAB or ENTER to create another entry.

5. Click OK. 

14.2.2  Configuring a Discard reason

A Discard reason is an explanation that the users and workflows can 
specify when discarding an e-mail message. 

The Manager application provides a set of predefined Discard reasons. 
You cannot delete or rename these Discard reasons, although you can 
modify their descriptions. 

To configure a Discard reason: 

1. On the File menu, point to New, then Design Center, then 
E-mail, and then click Discard Reason.

2. In the Name box, type a unique name for the Discard reason. 

3. In the Description box, type a description for the Discard reason.

4. Click OK. 
 A31003-S22B1-M103-08-76A9, 04/2025
248 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



email.fm

Working with the e-mail feature
Configuring the e-mail resources
14.2.3  About e-mail templates

Workflow processing for e-mail messages can include automatic 
responses, as well as suggested drafts created automatically for 
subsequent processing. These are built, programmatically, using 
templates. Prolog and Signature templates can be assigned at the 
queue level (see Section 10.3.3, “Configuring the queue overrides”, on 
page 206).

You can configure the following five types of e-mail templates:

• Prolog – This type of template is inserted at the beginning of a 
reply e-mail message. For example, “Please do not remove the 
ticket number in the subject line above. The ticket number enables 
us to track responses that you send us in the context of your 
original message.”

• Signature – This type of template is inserted at the end of a reply 
e-mail message. For example:

Sales - My Company 
sales@mycompany.com 
Visit our Web site at www.mycompany.com

• Response – This type of template is selected when you configure 
an Auto-response or an Auto-suggestion component. It can be used 
in the following ways:

– To send an automatic response to an e-mail message when the 
customer asks a simple question that can be answered 
automatically. For example, “Thank you for contacting 
mycompany.com. For information on how to order our products, 
visit www.mycompany.com/products.”.

– To insert suggested text into a reply e-mail message when the 
customer asks a frequently asked question. 

You must associate a Response template with one or more queues. 
When a user responds to an e-mail message routed by one of the 
associated queues, this template will be used to create the draft 
e-mail message. The E-mail Server creates the draft e-mail 
message based on the specified Response template; however, it 
uses the reply prefix, conversation ID label, and original message 
text label configured in the queue. If these items are not configured 
in the queue, the E-mail Server will use the default values 
configured at the system level. 
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• Auto-acknowledgment – This type of template is selected when 
you configure an Auto-acknowledgment component. It is used to 
send an automatic response to an e-mail message to let the 
customer know that their message has been received. For example 
“Thank you for contacting mycompany.com. A qualified agent is 
investigating your inquiry and will contact you shortly.”

• New Message – This type of template is inserted when a user 
creates a new e-mail message. 

14.2.4  Configuring an e-mail template

There are five different types of e-mail templates that you can 
configure (see Section 14.2.3, “About e-mail templates”, on page 249). 
Some templates are used when users reply to e-mail messages, while 
others are used by the system to send automatic responses to e-mail 
messages.

NOTE:  To create or change an e-mail template, you must have Full or 
Modify access, respectively, for the associated Manager permission. 

E-mail templates can be created in both HTML and plain text. HTML 
format allows you to include special formatting, such as bold text, 
bulleted and numbered lists, pictures, and URLs. The system assigns a 
template to an incoming e-mail message based on the format of the 
original message. We therefore recommend that when you create a 
new template, you configure both the HTML and the plain text sections 
of the template. 

E-mail templates have a maximum size of 500 KB.

To configure an e-mail template:

1. On the File menu, point to New, then Design Center, then 
E-mail, and then click one of the template types:

• Prologs

• Signatures

• Responses

• Auto-acknowledgments

• New Messages
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2. Under Details, do the following:

• In the Name box, type a unique name for the template. 

• In the Description box, type a description for the template. 

3. To create HTML content, in the Message–HTML box, do any of the 
following:

• Type the required text. You can change the formatting of the 
text. For details, see the Manager Help. 

• Insert a URL. For details, see the Manager Help.

• Insert a logo or picture. For details, see the Manager Help.

4. To create content in plain text format, in the Message–Text box, 
type a message. 

5. For Response templates only, click the Queues tab, and then select 
the queues for which this Response template can be used. When a 
user responds to an e-mail message routed by one of the selected 
queues, this template can be selected to create the draft response 
text.

6. Click OK. 
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14.2.5  Configuring an e-mail destination

All e-mail messages are stored in a single mailbox on the corporate 
e-mail server. If you want to have more than one destination e-mail 
address for your contact center (such as, sales@company.com and 
support@company.com), you must configure the e-mail destinations 
you want to use.

NOTE:  To create or change an e-mail destination, you must have Full 
or Modify access, respectively, for the associated Manager permission. 

NOTE:  In a multitenant environment, e-mail destinations are initially 
created by the system administrator and then configured by the 
business unit administrator. For details, see Section 19.5.3, 
“Configuring an e-mail destination in a multitenant environment”, on 
page 400. 

NOTE:  You specify the default e-mail addresses in the Options dialog 
box. For details, see Section 14.3.1, “Configuring the default e-mail 
routing strategy, queue, and addresses”, on page 254.

For each destination you create, you can specify whether the 
destination will be available for selection by a user when sending a new 
outgoing e-mail message. When this option is enabled, the destination 
appears in the From list of an outgoing e-mail message You can also 
specify whether the destination is to be monitored so that you can 
gather statistics and report on the destination. 

When you are modifying an existing e-mail destination, you can change 
only the name and description of the destination. You cannot change 
the actual destination. If you need to change the destination, you must 
delete the e-mail destination and create a new one.

To configure an e-mail destination:

1. On the File menu, point to New, then Design Center, then 
E-mail, and then click Destination.

2. On the General tab, under Details, do the following:

• In the Name box, type a unique name for the destination. 

• In the Description box, type a description for the destination.

• In the E-mail address box, type the destination e-mail 
address. 
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• In the From text box, type an alias for the destination e-mail 
address. This alias appears in the From box when a user replies 
to an e-mail message. 

• To gather statistics for this destination for reporting purposes, 
select the Monitored check box. When you select this option, 
the Reports tab becomes active. 

3. If you selected the Monitored check box, click the Reports tab and 
select the check box for each report that you want to display data 
about this destination. The list contains only the reports you own, 
or reports that are owned by users you can monitor. 

4. Click OK. 

14.2.6  Configuring a monitored source for e-
mail

To gather statistics for a particular e-mail source, you must configure 
the source in OpenScape Contact Center so that it can be monitored. 

NOTE:  To create or change a monitored source for e-mail, you must 
have Full or Modify access, respectively, for the associated Manager 
permission. 

NOTE:  When you are modifying an existing monitored source, you can 
change only the name and description of the source. You cannot 
change the actual source. If you need to change the source, you must 
delete the monitored source and create a new one.

To configure a monitored source for e-mail:

1. On the File menu, point to New, then Design Center, then 
E-mail, and then click Monitored Source.

2. On the General tab, under Details, do the following:

• In the Name box, type a unique name for the source. 

• In the Description box, type a description of the source. 

• In the Source box, type the e-mail address you want to monitor.

3. Click the Reports tab.
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4. Under Include this source in these reports, select the check box 
for each report that you want to display data about this source. The 
list contains only the reports you own, or reports that are owned by 
users you can monitor.

5. Click OK. 

14.3  Configuring the e-mail options

Use the e-mail options to configure the default settings for the e-mail 
feature. For details, see the following topics:

• Section 14.3.1, “Configuring the default e-mail routing strategy, 
queue, and addresses”, on page 254

• Section 14.3.2, “Configuring the e-mail error queue settings”, on 
page 255

• Section 14.3.3, “Configuring the e-mail routing schedule”, on page 
256

• Section 14.3.4, “Configuring the e-mail message settings”, on page 
257 

• Section 14.3.5, “Displaying the e-mail confidence levels”, on page 
258

NOTE:  To configure any of the e-mail options, you must have Full or 
Modify access for the associated Manager permission. 

14.3.1  Configuring the default e-mail routing 
strategy, queue, and addresses

You must specify the following defaults for the e-mail feature: 

• Routing strategy workflow – The routing strategy workflow that 
is initially used to route all e-mail messages in the contact center. 
You can configure the default routing strategy workflow to link to 
subsequent routing strategy workflows, if required.

• Queue – The queue that you want to use as the default option for 
the no match found (*) entry in a Destination Table component.

• Incoming e-mail address – The default e-mail destination for all 
incoming e-mail messages. 
 A31003-S22B1-M103-08-76A9, 04/2025
254 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



email.fm

Working with the e-mail feature
Configuring the e-mail options
Before configuring these settings, be sure to create the routing 
strategy workflow (see Section 9.4, “Configuring a routing strategy 
workflow”, on page 171), queue (see Section 10.3, “Configuring a 
queue”, on page 200), and e-mail destinations (see Section 14.2.5, 
“Configuring an e-mail destination”, on page 251) that you want to use 
as the defaults.

NOTE:  In a multitenant environment, only a business unit 
administrator can configure the default e-mail routing strategy, queue, 
and addresses. For details, see Section 19.3, “Administrator roles in a 
multitenant environment”, on page 394. 

To configure the default e-mail routing strategy, queue, and 
addresses:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click E-mail.

3. On the General tab, under Default, do the following:

• In the Routing strategy list, select the e-mail routing strategy 
you want to use to initially route all e-mail messages. 

• In the Queue list, select the e-mail queue that you want to use 
as the default option for the no match found (*) entry in a 
Destination Table component.

• In the Incoming e-mail address list, select the e-mail 
destination that you want to use as the default e-mail address 
for all incoming e-mail messages.

• In the Outgoing e-mail address list, select the e-mail 
destination that you want to use as the default e-mail address 
in the From list when a user creates an outgoing e-mail 
message. Only the e-mail destinations for which you have 
selected the Available for outgoing option are available in the 
list. If you select <None>, the user will be forced to select a 
From address before sending the e-mail message. 

4. Click OK.
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14.3.2  Configuring the e-mail error queue 
settings

The error queue is the queue to which e-mail messages are routed in 
the case of recoverable system errors. Recoverable system errors are 
errors generated by the OpenScape Contact Center servers that cannot 
be handled by the Exit on error option provided in some of the 
workflow components. If the system detects a recoverable system 
error in a routing strategy workflow, the e-mail message is routed to 
the error queue where it can then be routed to an appropriate user. 

NOTE:  In a multitenant environment, only a business unit 
administrator can configure the e-mail error queue settings. For 
details, see Section 19.3, “Administrator roles in a multitenant 
environment”, on page 394. 

To configure the e-mail error queue:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click E-mail.

3. On the General tab, under Error, do the following:

• In the Queue list, select the queue to which contacts are 
directed in the case of recoverable errors.

• In the Description box, type a description for the error queue. 

4. Click OK.

14.3.3  Configuring the e-mail routing 
schedule

The e-mail routing schedule restricts the hours of operation during 
which e-mail messages can be sent and received within the contact 
center. You can configure the default schedule, as well as exceptions to 
the default schedule. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the e-mail routing schedule. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 
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To configure the e-mail routing schedule:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click E-mail.

3. On the General tab, under Schedule, click Edit Schedule.

4. In the E-mail Routing Schedule dialog box, double-click the day 
you want to configure, and then edit the active time range for the 
day.

NOTE:  You can also drag the start or end point of an active range 
to change the range. 

5. Optionally, click the Exceptions tab to create an exception to the 
default schedule. An exception overrides the schedule for the entire 
day.

a) On the calendar, click the day for which you want to schedule an 
exception, for example, a national holiday. The Default row 
shows the default schedule for that day.

b) Select the Override check box. 

c) In the Override row, double-click a cell, edit the active time 
range for the override schedule, and then click OK. 

6. Use the Summary tab to view the schedule by status or by day of 
the week. 

• To see the days and times when the schedule is active or 
inactive, expand By Status, and then click Active or Inactive, 
respectively. 

• To see the schedule for that day, expand By Day, and then click 
the day of the week.

• To see the configured exceptions to the default schedule, click 
the Exceptions folder. 

7. Click OK. 
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14.3.4  Configuring the e-mail message 
settings

You can configure the default prolog, signature, labels and so on, for 
e-mail messages. 

Before you begin, you must create the Prolog and Signature templates 
that you want to use in your e-mail messages (see Section 14.2.4, 
“Configuring an e-mail template”, on page 250). 

NOTE:  In a multitenant environment, only a business unit 
administrator can configure the e-mail message settings, and only a 
system administrator can configure the deferred and consulted e-mail 
messages and attachments. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the e-mail message settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click E-mail.

3. Click the Settings tab.

4. Under E-mail Message Settings, do the following:

• In the Prolog list, select the Prolog template that you want to 
use as the default prolog to an e-mail message. 

• In the Signature list, select the Signature template that you 
want to use as the default e-mail signature. 

• In the Original message label box, type the text that you want 
to appear above the original e-mail message when the user 
replies to an e-mail message, for example, Original Message:. 

• In the Conversation ID label box, type the text that you want 
to appear in front of the Conversation ID when the user replies 
to an e-mail message. The Conversation ID is an identifier 
inserted by the OpenScape Contact Center E-mail Server to 
identify the message thread. 

• In the Reply prefix box, type the text that you want to appear 
at the beginning of the Subject line when the user replies to an 
e-mail message, for example, Re:.
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5. Under Deferred E-mail Messages, do the following: 

• In the Maximum number box, type or select the maximum 
number of e-mail messages that can be deferred by each user. 
This number can be exceeded when e-mail messages are 
automatically deferred by the system. 

• In the Automatic defer time box, type or select the amount of 
time in days, hours and minutes, after which an active e-mail 
message is automatically deferred. When an e-mail message is 
automatically deferred, the user is placed in Unavailable routing 
state and the draft response (if one exists) is automatically 
saved.

• In the Maximum defer time box, type or select the maximum 
amount of time in days, hours and minutes, for which an e-mail 
message can be deferred. After this time has expired, the e-mail 
message is automatically requeued by the OpenScape Contact 
Center E-mail Server. 

6. Under Consulted E-mail Messages, in the Maximum consult 
time box, type or select the maximum amount of time in days, 
hours and minutes, for which an e-mail message can be sent for 
external consultation. After this time has expired, the e-mail 
message is automatically requeued by the OpenScape Contact 
Center E-mail Server. 

NOTE:  When a user externally consults on an e-mail message, the 
reply is reserved for the user who initiated the consultation, and will 
be routed to that user ahead of all other contacts regardless of their 
priority in the queue. 

IMPORTANT:  Since the OpenScape Contact Center E-mail Server 
does not filter the e-mail messages for viruses, the corporate e-mail 
server should provide virus protection. 

7. Click OK. 

14.3.5  Displaying the e-mail confidence 
levels

You can choose to display confidence levels that are associated with 
e-mail categories. Confidence levels are used to express a level of 
certainty. They provide an additional and more precise means of 
categorizing e-mail messages for subsequent routing to the 
A31003-S22B1-M103-08-76A9, 04/2025
OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide 259
         



Working with the e-mail feature

email.fm

Configuring the e-mail options
appropriate queue. When you turn on confidence levels, you can 
specify a confidence level for each e-mail category that you use to 
configure an expression in a Category Decision component. 

IMPORTANT:  Displaying e-mail confidence levels is a one-way 
operation. The system cannot be converted back after it has been 
changed. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the e-mail confidence levels. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

The E-mail Server uses a default interface to categorize incoming 
e-mail messages. When displaying e-mail confidence levels, we 
recommend the use of a custom categorizer. The confidence levels 
returned by the default categorizer are simply occurrence ratios – they 
are not technically confidence levels. An occurrence ratio is calculated 
as the total number of occurrences in the e-mail message of any 
keywords defined for the category, divided by the total number of 
occurrences in the e-mail message of all keywords defined for any 
category. For example, if the sales category is found two times within 
an e-mail message, and three other categories are found within the 
e-mail message, the confidence level will be returned as 2/5 or 40%. 
For this reason, we recommend that you do not display confidence 
levels when using the default categorizer. 

Custom categorizers are in the form of a .dll file. 

NOTE:  For more information in this area, contact your service 
representative.

To display confidence levels:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click E-mail.

3. Click the Advanced tab.

4. Under Confidence Levels, click Display Confidence Levels. 

5. In the Enable Confidence Levels dialog box, under Do you want 
to show confidence levels?, select Yes, and then click OK. 

6. When the system prompts you to confirm that you want to enable 
confidence levels, click Yes. The system turns on confidence levels. 
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7. Under Categorization, select Use custom categorizer, and then 
specify the path and file name of the .dll file you want to use. You 
can click  to locate the file you want to use. 

8. Click OK.

14.4  Conducting an e-mail history search

You can generate a list of e-mail messages that have been handled by 
the contact center over a specified time interval. You can search by 
e-mail message state, as well as by more specific parameters such as 
the Conversation ID, the handling user, the source or destination e-mail 
address, or the subject line. The resulting list allows you to open, view, 
and potentially resend the e-mail messages. 

NOTE:  To conduct an e-mail history search, you must have the 
Perform e-mail history searches Manager permission. 

To conduct an e-mail history search: 

1. On the Actions menu, click E-mail History Search.

2. Under Date and Time, do the following:

• In the Start area, select the start date and time for the interval 
the search is to cover. 

• In the End area, select the end date and time of the interval.

3. Under Status, select the check box for each e-mail message state 
you want to search for. 

4. Optionally, under Advanced Parameters, do the following for 
each parameter you want to use to refine your search:

5. Click a cell in the Parameter column and select one of the options 
from the list.

6. In the Value column, type or select the value that corresponds to 
the Parameter you selected. For example, if you select Subject 
Line, type the text that appears in the subject line of the e-mail 
messages you want to search for. 
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7. On the Actions menu, click Find Now.

NOTE:  Email History Search performs the search on the original 
emails and not on the whole conversation history (for example, 
Externally forwarded e-mails)
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15  Working with the Web collaboration feature
This chapter introduces the Web collaboration feature and provides 
instructions on working with configurable Web collaboration resources 
in the Manager application 

The Web collaboration feature is a licensed feature that allows 
customers to communicate with your contact center by sending text 
messages using a Web browser. The customer submits a request from 
a Web page on the corporate Web site. The request is assigned to a 
queue where it waits for an available user. A user responds by opening 
a Web collaboration session.

For businesses such as service bureaus and other dedicated contact 
centers, Web collaboration provides an alternative to voice and e-mail, 
that provides customers the opportunity to communicate with a 
contact center user in real-time. Other businesses can use Web 
collaboration as a form of support to the primary business. For 
example, a business with an emphasis on online sales could use Web 
collaboration as a live help option to let customers viewing Web pages 
interact with sales or support personnel. 

You can configure OpenScape Contact Center to offer Web 
collaboration sessions in a number of different languages. 

Queues, a routing strategy workflow, and optionally queue processing 
workflows, must be created specifically for Web collaboration. 

15.1  Customer-side and user-side functionality

Customers request Web collaboration sessions using a control on a 
Web page set up specifically for this purpose. For example, the 
customer could click a button labeled Click here to talk to sales. You 
could also have the customer provide additional information, such as 
their account number, prior to requesting a session. 

While the customer is waiting for a user to initiate the Web 
collaboration session, you can set up the Web collaboration feature to 
periodically push messages to the customer, such as “An agent will 
be with you shortly”. You can also push URLs to the customer’s 
browser, to allow them to view content related to the nature of their 
request. 
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After the user initiates the Web collaboration session, the customer can 
interact with the user via an interface similar to popular chat 
applications. 

15.2  Web collaboration component interaction

The following figure shows the component interactions in requesting, 
setting up, and conducting a Web collaboration session between a 
customer and a contact center user.

The Web front-end is a set of one or more HTML pages with links that 
initiate the Web collaboration session. OpenScape Contact Center is 
packaged with a set of sample Web pages and additional HTML samples 
that can be easily modified and incorporated into the customer’s 
existing Web site. Also included is sample Javascript code that 
implements the Web collaboration session window. For details, see the 
System Management Guide. 

A servlet provides the connection between the corporate Web server 
and OpenScape Contact Center, specifically with the Web Interaction 
Server. Transport Layer Security (TLS) security for this connection can 
be enabled or disabled using the Manager application (see Section 
15.6.4, “Configuring the Web server settings for Web collaboration”, on 
page 356). 
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15.3  Web collaboration sources and destinations

Unlike other media, Web collaboration sources and destinations are 
site-defined. They are specified in the Web page links used to initiate a 
Web collaboration request and are used in routing strategy and queue 
processing workflows in enqueuing contacts and for other purposes. 
Most commonly, they are set up as follows:

• Sources – Typically reserved to store customer-provided 
information such as a ticket number provided to the customer in a 
previous transaction or an account number.

• Destinations – Typically set up to identify the type of contact, or 
less directly, to identify the HTML component (Web page or specific 
control) from which a request was initiated. This could be a queue 
name, such as Sales, or identify the URL from which the request 
was issued, such as www.company.com. 

The Web collaboration sources and destinations defined at your site 
should reflect factors such as:

• Relationship between queues and either sources, destinations, or 
source/ destination combinations. For an introduction to criteria to 
use in queue setup, see Section 10.2, “Queue setup 
considerations”, on page 193.

• Importance of sources, destinations, and languages as the basis for 
routing in routing strategy workflows. For more information, see 
Section 15.4, “Web collaboration workflow considerations”, on page 
340.

• Organization of Web pages set up to provide Web collaboration 
access to customers. For more information, see the System 
Management Guide. 

• Sources and destinations you want to report on. For details, see 
Section 15.5.4, “Configuring a monitored source for Web 
collaboration”, on page 350 and Section 15.5.5, “Configuring a 
monitored destination for Web collaboration”, on page 352. 
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15.4  Web collaboration workflow considerations

Incoming Web collaboration requests are initially processed by a 
routing strategy workflow. Web collaboration contacts are typically 
routed to a queue based on source, destination, or language 
preference, but other considerations such as database lookup, can be 
used as well. In addition, the Web collaboration feature offers 
component types that let you automate actions such as sending 
standard messages to the customer’s session window and directing the 
customer’s Web browser to specified URLs.

15.4.1  Web collaboration routing strategy 
workflows

A Web page link used to request a Web collaboration session, specifies 
three parameters available to a routing strategy workflow, that can be 
used in routing the contact:

• A site-defined destination

• A site defined source

• A language specifier

NOTE:  For information on how to set up the Web page links that 
request Web collaboration sessions, see the System Management 
Guide.

In the simplest scenario, the active Web collaboration routing strategy 
workflow could direct the request to a queue based on the contact’s 
destination. Since destinations are site-defined, your site destinations 
can be as direct as the name of the queue to which the associated 
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contacts are to be directed. Less directly, you might use the URL of the 
Web page or another indicator of the purpose of the contact as 
destinations at your site. 

Similarly, sources for Web collaboration are site-defined. Most 
commonly, a source is set up to store customer-provided information. 
For example, you could have the customer provide an account number 
on the originating Web page. The link that passes the request to 
OpenScape Contact Center, passes the account number as a source 
parameter.

However, since there is no constraint on how you define sources, you 
can use the source parameter for other purposes. For example, if you 
do not need to use the source for customer-identifying or customer-
provided information purposes, you could use the source to provide 
information that complements the destination. Before you decide to 
use sources in this way, however, you should consider the OpenScape 
Contact Center ability to report on and monitor sources.

NOTE:  When a Web Collaboration session is initiated, OSCC uses the 
“Source” field to associate the Chat session with a specific customer. If 
the field is left empty, then 360 Customer View is not enabled for this 
specific session.

NOTE:  For information on how to set up the Web page links that 
request Web collaboration sessions, see the System Management 
Guide.
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You can also use the language specifier, accessed from contact data, in 
routing the contact.

NOTE:  For information on accessing contact data in a routing strategy 
workflow, see Section 9.3.5, “Contact data”, on page 155.

OpenScape Contact Center lets you build a complete set of resources 
used to offer Web collaboration sessions in several languages. This 
includes items such as boilerplate messages users can automatically 
send to customers, as well as standard session window content such as 
labels and notifications. To complement this, the value associated with 
the contact data key ___HPPC_ (3 leading underscores followed by 
HPPC and a trailing underscore), passed as a parameter from the Web 
page link, can be used to route the contact according to the language 
resources you have set up. 

In a situation where language is the only consideration in routing a 
contact, you could offer the choice of languages on the Web page 
where Web collaboration sessions are requested.

A routing strategy that could direct the session request to a user who 
speaks the chosen language could be as simple as follows:

NOTE:  For details on how to set up Web collaboration language 
resources, see Section 15.5, “Configuring the Web collaboration 
resources”, on page 344.

While the primary means of directing a Web collaboration request to a 
queue is by making use of the source, destination, or language 
associated with the contact request, you can also make use of the 
principles outlined in Section 9.3, “Routing strategy workflow 
considerations”, on page 148.
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15.4.2  Web collaboration queue processing 
workflows

The basic principles outlined in Section 9.5, “About queue processing 
workflows”, on page 174 apply to Web collaboration queue processing 
workflows. That is, the primary purpose of the workflow is to occupy 
the customer until OpenScape Contact Center finds an available user 
to handle the Web collaboration session. 

Since the key activity targets when occupying a Web collaboration 
customer are the session window and the customer’s browser, there 
are three components available for Web collaboration:

• Auto-push Message – You can use an Auto-push Message 
component to push a message to a customer's browser during a 
Web collaboration session. 

• Auto-push URL – You can use an Auto-push URL component to 
push a Web page to a customer's browser during a Web 
collaboration session. 

• Auto-push Performance Message – You can use an Auto-push 
Performance Message component to push a message containing a 
performance statistic to a customer's browser during a Web 
collaboration session. 

For example, a Web collaboration queue processing workflow could 
start by providing the initial estimated wait time. Subsequently, it could 
then display a standard message, One of our agents will be with 
you shortly, for example, every thirty seconds.

Similarly, a Web collaboration queue processing workflow could start by 
directing the customer’s browser to a page of products related to the 
nature of the contact. This could be accompanied by a standard 
message, delivered to the customer’s session window, for example, An 
agent will be with you shortly... in the meantime, why not 
browse some similar products?

These components use standard messages and URLs. For details, see 
Section 15.5, “Configuring the Web collaboration resources”, on page 
344.

For details on how to configure these components, see the Manager 
Help.
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15.5  Configuring the Web collaboration resources

You must configure various resources that impact the Web 
collaboration feature.

NOTE:  Your initial Web collaboration configuration is typically set up 
by your service representative. For information on the setup tasks, see 
the System Management Guide. 

15.5.1  Configuring a Web collaboration 
language

You must configure a language resource in OpenScape Contact Center 
for each language in which you will be offering Web collaboration 
sessions. You can specify the default Web collaboration language used 
at your site (see Section 15.6.3, “Configuring the default Web 
collaboration language”, on page 355). 

NOTE:  To create or change a language resource, you must have Full 
or Modify access, respectively, for the Languages Manager 
permission. 

NOTE:  The links on a Web page set up to request a Web collaboration 
session can specify the language associated with the session. For 
details on how language specifiers are set up in the URLs, see the 
System Management Guide.

In addition to the content typed by the user and the customer during 
a Web collaboration session, there are several default greetings, 
prefixes, and notifications that can be displayed as part of the session. 
These default messages are configured as part of the language 
resource. 
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You build the default messages using text and a set of tags – variables 
that store items such as user names, times, and URLs. For example, a 
“Join conference” notification could be defined as “<USERNAME> was 
invited to this chat at <TIME12>.” 

To configure a Web collaboration language:

1. On the File menu, point to New, then Design Center, then Web 
Collaboration, and then click Language.

2. On the General tab, under Details, do the following:

• In the Name box, type a unique name for the language. 

• In the Description box, type a description for the language.

Customer 
message 

User message 
prefix
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3. Click the Settings tab.

4. Under Auto-Web Collaboration Defaults, for each text box, type 
the text for the default message that can be displayed in a Web 
collaboration session. For each text box, you can type a maximum 
of 200 characters.

• Greeting – Type the default greeting displayed, for example, 
How can I help you?. 

• Customer message prefix – Type the default customer 
message prefix displayed, for example, <DATE>, <TIME24> 
<NAME>:. 

• User message prefix – Type the default user message prefix 
displayed, for example, <DATE>, <TIME24> <NAME>:. 

• Requeue – Type the default requeue message prefix displayed, 
for example, Waiting for another user to join… 
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• Push URL – Type the default push URL message prefix 
displayed, for example, <USERNAME> pushed <PUSHEDURL> 
to you. 

• Join conference – Type the default message displayed when 
someone joins the Web collaboration session, for example, 
<USERNAME> joined the session at <TIME24>. 

• Exit conference – Type the default message displayed when 
someone exits the Web collaboration session, for example, 
<USERNAME> has left the session. 

• System name – Type the default system prefix displayed 
during a Web collaboration session. 

5. To insert a tag into the text, click Insert Tag and select one of the 
following tags from the list:

NOTE:  To ensure that the date format displayed in the Web 
Collaboration - Contact Details window matches the date format 
selected in the Windows Regional and Language options, you must 
select the language to be used for standards and formats, as well 
as for non-Unicode programs. If different languages are selected in 
these two places, the date format might not be displayed as 
expected.

6. To change the font style of the selected text, click .  

7. Under Preview, view a preview of the selected text, including the 
actual value of any inserted tags.

8. Click OK. 

Tag Description
<USERNAME> Displays the name of the contact center user, as 

defined in the Manager application.
<TIME12> Displays the time in 12-hour format, with an AM or PM 

suffix.
<TIME24> Displays the time in 24-hour format.
<DATE> Displays the date in YYYY/MM/DD format.
<NAME> Displays the customer's name. 
<PUSHEDURL> Displays the URL to be pushed to the customer.
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15.5.2  Configuring a Web collaboration 
standard message

For each language in which you are offering Web collaboration 
sessions, you create an associated set of standard messages, which are 
useful for defining commonly-used content, such as standard 
responses to frequently-asked questions. 

Standard messages can be used in the following ways:

• You can select a standard message when configuring an Auto-push 
Message component.

Each standard message can be associated with one or more queues. If 
you do not associate a standard message with a queue, the standard 
message will be considered generic and will be available to all queues. 
When configuring a queue processing workflow or when handling a 
contact for a given queue, you have access to all standard messages 
associated with that queue, as well as all generic standard messages. 

NOTE:  To create or change a standard message, you must have Full 
or Modify access, respectively, for the Standard messages Manager 
permission. 

NOTE:  You should set up all languages to be used with the Web 
collaboration feature before creating a standard message (see Section 
15.5.1, “Configuring a Web collaboration language”, on page 344). 

To configure a Web collaboration standard message:

1. On the File menu, point to New, then Design Center, then Web 
Collaboration, and then click Standard Message. 

2. On the General tab, under Details, do the following:

• In the Name box, type a unique name for the standard 
message. 

• In the Description box, type a description for the standard 
message.

3. Under Configure, do the following:

• In the Language list, select the configured language for the 
standard message. 
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• In the Message box, type the content of the standard message. 
You can type a maximum of approximately 1900 characters. The 
maximum is actually 2000 characters, but that includes the 
HTML code required for formatting. 

4. To change the font style of the selected text, click . 

You can select several options of font sizes. However, the supported 
sizes are limited, as shown on the table below:

5. Click the Queues tab.

6. Under Include, select the Web collaboration queues that can 
display this standard message. You can also select the message 
when you configure a queue (see Section 10.3, “Configuring a 
queue”). 

15.5.3  Configuring a Web collaboration URL

For each language in which you are offering Web collaboration 
sessions, you create an associated set of URLs for language-specific 
Web pages. URLs can be used in the following ways:

• You can select a URL when configuring an Auto-push URL 
component. 

Each URL can be associated with one or more queues. If you do not 
associate a URL with a queue, the URL will be considered generic and 
will be available to all queues. When configuring a queue processing 

Selected size Supported 
size

8 or lower 7.5

9 - 10 10

11 - 12 12

13 - 15 13.5

16 - 21 18

22 - 30 24

31 or higher 36

Table 15 Font Sizes
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workflow or when handling a contact for a given queue, you have 
access to all URLs associated with that queue, as well as all generic 
URLs. 

NOTE:  To create or change a URL, you must have Full or Modify 
access, respectively, for the URLs Manager permission. 

NOTE:  You should set up all languages to be used with the Web 
collaboration feature before creating a URL (see Section 15.5.1, 
“Configuring a Web collaboration language”, on page 344). 

To configure a Web collaboration URL:

1. On the File menu, point to New, then Design Center, then Web 
Collaboration, and then click URL.

2. On the General tab, under Details, do the following:

• In the Name box, type a unique name for the URL. 

• In the Description box, type a description for the URL.

3. Under Configuration, in the Language list, select the configured 
language for the URL.

4. In the URL box, type a valid URL (for example, http://
www.company.com). 

NOTE:  If you are connected to a production database, you can 
click  to locate the URL on the Web.

5. Click the Queues tab.

6. Under Include, select the Web collaboration queues that can 
display this URL. You can also select the URL when you configure a 
queue (see Section 10.3, “Configuring a queue”). 

7. Click OK. 

15.5.4  Configuring a monitored source for 
Web collaboration

To gather statistics for a particular Web collaboration source, you must 
configure the source in OpenScape Contact Center so that it can be 
monitored. A source for Web collaboration is site-defined and can take 
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any textual value. For more information, see Section 15.3, “Web 
collaboration sources and destinations”, on page 339. 

NOTE:  To create or change a monitored source for Web collaboration, 
you must have Full or Modify access, respectively, for the associated 
Manager permission. 

NOTE:  When you are modifying an existing monitored source, you can 
change only the name and description of the source. You cannot 
change the actual source. If you need to change the source, you must 
delete the monitored source and create a new one.

To configure a monitored source for Web collaboration:

1. On the File menu, point to New, then Design Center, then Web 
Collaboration, and then click Monitored Source. 

2. On the General tab, under Details, do the following:

• In the Name box, type a unique name for the source.

• In the Description box, type a description of the source. 

• In the Source box, type the Web collaboration source that you 
want to monitor. You cannot use non-ASCII characters, non-
printable ASCII characters, and the following special characters: 
accent grave (`), asterisk (*), comma (,), double quotation 
mark (“), exclamation mark (!), percentage sign (%), pipe (|), 
and underscore (_). 

NOTE:  When a Web Collaboration session is initiated, OSCC uses 
the “Source” field to associate the Chat session with a specific 
customer. If the field is left empty, then 360 Customer View is not 
enabled for this specific session.

3. Click the Reports tab.

4. Under Include this source in these reports, select the check box 
for each report that you want to display data about this source. You 
can view only the reports you own, or reports that are owned by 
users you can monitor. 

5. Click OK. 
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15.5.5  Configuring a monitored destination 
for Web collaboration

To gather statistics for a particular Web collaboration destination, you 
must configure the destination in OpenScape Contact Center so that it 
can be monitored. A Web collaboration destination is site-defined and 
can take any textual value. For more information, see Section 15.3, 
“Web collaboration sources and destinations”, on page 339. 

NOTE:  To create or change a monitored destination for Web 
collaboration, you must have Full or Modify access, respectively, for the 
associated Manager permission. 

When you are modifying an existing monitored destination, you can 
change only the name and description of the destination. You cannot 
change the actual destination. If you need to change the destination, 
you must delete the monitored destination and create a new one.

To configure a monitored destination for Web collaboration:

1. On the File menu, point to New, then Design Center, then Web 
Collaboration, and then click Destination.

2. On the General tab, under Details, do the following:

• In the Name box, type a unique name for the destination. 

• In the Description box, type a description for the destination. 

• In the Destination box, type the Web collaboration destination 
you want to monitor. You cannot use non-ASCII characters, non-
printable ASCII characters, and the following special characters: 
accent grave (`), asterisk (*), comma (,), double quotation 
mark (“), exclamation mark (!), percentage sign (%), pipe (|), 
and underscore (_). 

3. Click the Reports tab.

4. Under Include this destination in these reports, select the 
check box for each report that you want to display data about this 
destination. The list contains only the reports you own, or reports 
that are owned by users you can monitor.

5. Click OK. 
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15.6  Configuring the Web collaboration options

Use the Web collaboration options to configure the default settings for 
the Web collaboration feature. For details, see the following topics:

• Section 15.6.1, “Configuring the default Web collaboration routing 
strategy, queue, and time-out URL”, on page 353

• Section 15.6.2, “Configuring the Web collaboration error queue 
settings”, on page 355

• Section 15.6.3, “Configuring the default Web collaboration 
language”, on page 355

• Section 15.6.4, “Configuring the Web server settings for Web 
collaboration”, on page 356

NOTE:  To configure any of the Web collaboration options, you must 
have Full or Modify access for the associated Manager permission.

15.6.1  Configuring the default Web 
collaboration routing strategy, queue, and 
time-out URL

You must specify the following defaults for the Web collaboration 
feature:

• Default routing strategy workflow – The routing strategy 
workflow that is initially used to route all Web collaboration contacts 
in the contact center. You can configure the default routing strategy 
workflow to link to subsequent routing strategy workflows, if 
required.

• Default queue – The queue that you want to use as the default 
option for the no match found (*) entry in a Destination Table 
component.

• Time-out URL – The Web page to which a contact will be routed 
provided that a time-out is specified when you configure a queue. 
This page is typically set up to indicate that the contact center is too 
busy to accept the request now and suggest trying later or 
providing links to more information.

Before configuring these settings, be sure to create the routing 
strategy workflow (see Section 9.4, “Configuring a routing strategy 
workflow”, on page 171) and the queue (see Section 10.3, “Configuring 
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a queue”, on page 200) that you want to use as the default.

NOTE:  In a multitenant environment, only a business unit 
administrator can configure the default Web collaboration routing 
strategy, queue, and time-out URL. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the default Web collaboration settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Web 
Collaboration.

3. On the General tab, under Default, do the following:

• In the Routing strategy list, click the Web collaboration routing 
strategy you want to use to initially route all Web collaboration 
contacts. 

• In the Queue list, click the Web collaboration queue that you 
want to use as the default option for the no match found (*) 
entry in a Destination Table component.

• In the Time-out URL box, select the URL that you want to use 
as the default time-out URL. The time-out URL is the Web page 
to which a contact will be routed provided that a time-out is 
specified when you configure a queue. You can click  to 
launch a Web browser and test the URL.

4. Click OK.
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15.6.2  Configuring the Web collaboration 
error queue settings

The error queue is the queue to which Web collaboration contacts are 
routed in the case of recoverable system errors. Recoverable system 
errors are errors generated by the OpenScape Contact Center servers 
that cannot be handled by the Exit on error option provided in some 
of the workflow components. If the system detects a recoverable 
system error in a routing strategy workflow, the Web collaboration 
contact is routed to the error queue where it can then be routed to an 
appropriate user. 

NOTE:  In a multitenant environment, only a business unit 
administrator can configure the Web collaboration error queue 
settings. For details, see Section 19.3, “Administrator roles in a 
multitenant environment”, on page 394. 

To configure the Web collaboration error queue:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Web 
Collaboration.

3. On the General tab, under Error, do the following:

• In the Queue list, select the queue to which contacts are 
directed in the case of recoverable errors.

• In the Description box, type a description for the error queue. 

4. Click OK.

15.6.3  Configuring the default Web 
collaboration language

You must specify the default language for Web collaboration sessions. 
Links on Web pages set up to initiate Web collaboration sessions 
typically specify a language parameter to indicate the language for the 
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requested session. If the link does not specify a language, OpenScape 
Contact Center uses the default Web collaboration language for the 
site. 

You can choose any one of the configured languages (see Section 
15.5.1, “Configuring a Web collaboration language”, on page 344). 

NOTE:  In a multitenant environment, only a business unit 
administrator can configure the default Web collaboration language. 
For details, see Section 19.3, “Administrator roles in a multitenant 
environment”, on page 394. 

To configure the default Web collaboration language:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Web 
Collaboration.

3. On the General tab, under Language, in the Default language 
list, select the language you want to use as the default. 

4. Click OK.

15.6.4  Configuring the Web server settings 
for Web collaboration

You can configure the port that the Web Interaction Server uses to 
communicate with the corporate Web server for Web collaboration 
sessions. 

IMPORTANT:  When you are connected to the production database, if 
you change the port number, you will be required to restart the Web 
Interaction Server on the main server machine.

NOTE:  In a multitenant environment, only a system administrator can 
configure the Web server settings for Web collaboration. For details, 
see Section 19.3, “Administrator roles in a multitenant environment”, 
on page 394. 
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To configure the Web server settings for Web collaboration:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Web 
Collaboration.

3. Click the Corporate Web Server tab. 

4. Under Port Settings, in the Port number list, select the port 
number that the Web Interaction Server uses to communicate with 
the corporate Web server to support Web collaboration. You can 
select an unsecured or a secured (TLS-enabled) port. For more 
information, see Section 15.3.3, “Configuring the Web server 
settings”, on page 270. 

5. Click OK.
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16  Working with networking
This chapter introduces the optional networking features and provides 
details on the tasks involved in configuring the OpenScape Contact 
Center system to work with this feature. 

Networking is a licensed feature that allows you to distribute calls 
across multiple OpenScape Contact Center sites. Each site that is 
configured to participate in networking shares various performance 
statistics with the other networked sites. A voice networking workflow 
enables a series of decision criteria to be applied so that it can 
determine whether to distribute a contact to a networked site and, if 
so, how to select the site to which the contact is sent. 

NOTE:  In a multitenant environment, networking is not supported. 
For details on the multitenancy feature, see Chapter 19, “Working with 
the multitenancy feature”. 

You can distribute contacts based on:

• Load – Access to local and remote performance statistics let you 
decide when to distribute contacts and which site is best equipped 
to handle overflow contacts. 

• Schedule – Each site defines the times of the day, days of the 
week, and specific calendar dates when it is not accepting 
networked contacts. 

• Site-defined criteria – You can provide your own ranking of sites, 
based on a criterion of your choosing, and distribute contacts on 
this basis. 

OpenScape Contact Center lets you combine these specific criteria to 
build a thorough, flexible networking strategy. In addition, while you 
can configure your networking strategy at the site level, you can also 
override those settings on a queue-by-queue basis. This lets you create 
multiple distribution strategies around queue-related considerations 
such as the purpose of the contact or information collected from the 
customer.

The central reporting feature can be used to produce historical reports 
across multiple networked sites. For details on the central reporting 
feature, see Chapter 17, “Working with central reporting”. 
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Sites that are configured for high availability (warm standby) can also 
participate in networking. Not all networked sites need to be configured 
for high availability (warm standby). The networking feature allows 
both types of sites to participate in networking at the same time. Even 
though high availability (warm standby) is supported only when 
OpenScape Contact Center is connected to an OpenScape Voice, 
OpenScape 4000, or HiPath 4000 communication platform, other 
networked sites that are not configured for high availability (warm 
standby) can be connected to any communication platform type 
supported by OpenScape Contact Center. For details on the high 
availability (warm standby) feature, see Chapter 18, “Working with the 
high availability (warm standby) feature”. 

16.1  Contact processing

Each site allocates a number of dedicated telephone lines that it uses 
to transfer and accept networked voice traffic. The following diagram 
illustrates the basic steps in processing a contact in a networked 
contact center.

The numbered steps are as follows:

1. An incoming call arrives in OpenScape Contact Center.

2. The active routing strategy workflow executes and directs the 
contact to a queue enabled for networking.

3. Local routing of the contact is suspended while a networking 
workflow executes. Using performance statistics for the local site 
and for remote sites, the networking workflow determines whether 
the contact should be routed locally or distributed, and if it is to be 
distributed, to which site the contact is to be routed.
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4. If the contact is to be distributed to a remote site, the local site 
requests the number for a telephone line to be used to transfer the 
contact to the selected remote site. 

5. OpenScape Contact Center at the remote site returns the number 
of an idle telephone line.

6. The local site diverts the call to the remote site and dequeues the 
contact locally.

7. The remote site directs the call to a queue with the same name as 
the queue to which the contact was to be directed at the local site 
while OpenScape Contact Center finds a user available to handle the 
contact.

16.2  Networking at the queue level

Networking is enabled and operates at the queue level. When an 
arriving contact is enqueued to a network-enabled queue, it can be 
distributed and enqueued only to an identically-named queue at 
another site participating in the network. To enable a queue for 
networking, see Section 16.7.4, “Configuring the networking settings 
for a queue”, on page 376. 

NOTE:  Queues must only share a common name. They do not need to 
be configured identically.
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For example, a contact enqueued to Queue A at Site 1 could 
potentially be distributed to either Site 2 or Site 3, since both sites 
have a queue named Queue A. Contacts enqueued to Queue C at Site 
A, on the other hand, could potentially be distributed only to Site 3 
since it is the only other site with a queue named Queue C.

16.3  Acceptance criteria

Each site in the network specifies its own acceptance criteria, that tells 
other sites whether it is currently accepting network traffic. Acceptance 
criteria can consist of either or both of the following components:

• Schedule – The acceptance criteria schedule lets you designate the 
time of the day and days of the week when the site is accepting 
contacts from other networked sites. You can also specify specific 
calendar dates, holidays for example, when the contact center is 
not accepting contacts from other network sites.

• Performance Criteria – A local site can test one or more 
statistics-based conditions that dictate when it is accepting contacts 
from other sites. Each test compares the current value of a specific 
statistic to a configured threshold value using operators such as 
equals, over (greater than) and under (less than). For example, a 
site may only accept network contacts when the current estimated 
wait time at the site is less than one minute. When multiple 
performance criteria are specified, the schedule criteria and all 
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performance criteria must be met in order for the site to accept 
contacts. If no statistics-based tests are specified, only the 
schedule will be used to determine acceptance.

The schedule and performance elements of the acceptance criteria are 
defined at the site level (see Section 16.8.2, “Configuring the 
networking acceptance settings”, on page 377). At the queue level, you 
can override site-level performance criteria or provide additional 
performance criteria (see Section 10.3.6, “Configuring the voice queue 
networking settings”, on page 255). 

Similarly, as part of the process of distributing a contact, the local site 
can select the best-equipped site based on the value of one or more of 
the remote site performance statistics. Each site has access to a set of 
site-level and queue-level performance statistics for every remote site 
participating in the networked contact center.

Each site in a network transmits its acceptance criteria and its package 
of performance statistics to other sites in the network on a configured, 
regular basis, ranging from every five seconds to every five minutes. 
For details on how to configure this interval, see Section 16.8.1, 
“Configuring the general networking settings”, on page 376. 

16.4  Distribution methods

If processing in a networking workflow reaches a Network Selection 
component, then the contact is to be distributed to another site. You 
can use one of two distribution methods:

• Best Site – The contact is routed to the site with the best 
performance on a single, specified statistic. For example, if the 
specified statistic is the estimated wait time, and there are still 
multiple sites in the short list, the contact will be routed to the site 
with the highest service level.

• Preferred Site – The contact is routed to the site remaining in the 
short list that ranks highest in a configured, prioritized list of eligible 
sites. This method lets you rank the sites in your network on an 
arbitrary, site-defined criterion, optionally on a queue-by-queue 
basis, and distribute contacts based on that criterion. Using this 
method you could distribute contacts based on geography or site-
specialization, for example.
A31003-S22B1-M103-08-76A9, 04/2025
OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide 363
         



Working with networking

networking.fm

Distribution methods
Given the Preferred Site ranking, Best Site tested statistic (estimated 
wait time), and a refined short list of eligible sites, the following 
diagram shows the site chosen for each method. Sites 1 and 3 are 
removed from the short list due to acceptance criteria or because 
performance on a particular statistic did not meet a configured level. 

You can specify a single distribution method at the site level, to be used 
as the basis for all contacts that are to be routed to other networked 
sites. In addition, you can override the site setting in the configuration 
for each Network Selection component used in your networking 
workflows. This gives you the flexibility to vary your distribution 
method on a queue-by-queue basis or as dictated by local or remote 
traffic. 

NOTE:  For information on setting up a default, site level distribution 
method, see Section 16.8.3, “Configuring the networking distribution 
settings”, on page 378.

NOTE:  For information on overriding distribution method settings on 
a queue-by- queue level, see Section 10.3.6, “Configuring the voice 
queue networking settings”, on page 255.
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16.5  About networking workflows

If your site is licensed for networking, when a routing strategy 
workflow enqueues a call to a network-enabled queue, local processing 
of the workflow is suspended while a networking workflow executes. 

The networking workflow provides the following basic functionality:

• Makes the decision to resume local routing of the contact or 
distribute it to another site based on a schedule or load at the local 
or remote sites.

• Refines the list of eligible networked sites by eliminating sites that 
fail specific performance tests.

• Distributes the contact to the site that performs best on a given 
performance statistic (Best Site method) or the site that ranks 
highest in a site-defined ordered list of sites (Preferred Site 
method).

OpenScape Contact Center provides a default networking workflow. 
You can make a copy of this workflow and use it as the starting point 
for creating a networking workflow, or you can create a new one. For 
details, see Section 16.6, “Configuring a networking workflow”, on 
page 370. 

NOTE:  When the system is configured for high availability (warm 
standby), the execution of a networking workflow can be impacted by 
a failover. This is because some decisions that are made in a 
networking workflow are based on statistics that may have different 
values after a failover. For more details on the high availability (warm 
standby) feature, see Chapter 18, “Working with the high availability 
(warm standby) feature”. 
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16.5.1  Basic networking workflow example

In a simple scenario, a networking workflow could decide whether to 
handle the contact locally or distribute the contact to a networked site 
using a Schedule component: base the decision on the calendar date, 
day of the week, or time that a contact arrives. 

Consider the following setup:

• The workflow shown above is running at a site called Site 1 in a 
five-site contact center network, where the other four sites are 
located in different time zones.

• The Check Business Hours Schedule component is configured so 
that contacts arriving outside normal, Monday to Friday, 9 a.m. to 
5 p.m. working hours, are routed to another site. 

• If a contact arrives during normal business hours, processing is 
passed to Handle Locally, a Keep Local component, which 
terminates the networking workflow, allowing local routing of the 
contact to resume. 

• Acceptance criteria for all sites is set to disallow acceptance of 
contacts from other sites outside normal business hours at those 
sites. 

• Contacts are to be distributed using the Preferred Site method, with 
the site ordering at Site 1 set as Site 2, Site 3, Site 4, and Site 5. 

Workflow processing for a contact arriving at 7 p.m. when Site 2 and 
Site 3 are closed, might proceed as follows:

• Prior to any components executing, the acceptance criteria for all 
sites is checked. With Site 2 and Site 3 closed, the short list of 
eligible sites is refined to contain only Site 4 and Site 5.

• Since the contact arrives at 7 p.m., the schedule component passes 
control to the Distribute component, which is a Network Selection 
component. 
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• Since the Preferred Site ordering of the short list of sites is Site 4, 
Site 5, the Distribute component routes the contact to Site 4, and 
then terminates the networking workflow. 

16.5.2  Making the decision to process locally 
or distribute

A key decision in a networking workflow is whether to process the 
contact locally or to route it to another site in the networked contact 
center. While a Keep Local component terminates the workflow and 
resumes local routing of the contact, you can base the decision to 
execute that component on a performance statistic at the local site. For 
example, you could use a Local Performance Decision component to 
check the current wait time at the local site and ensure that is 
acceptably low before deciding to process the contact locally. 

You can use multiple Local Performance Decision components if you 
want to test several queue-based or site-based statistics. For example, 
you could make the decision to process the contact locally only if there 
are available users at the local site AND the current estimated wait time 
is less than one minute. 
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16.5.3  Refining the short list of eligible 
networked sites

Network Selection components in a workflow must choose one site 
from a short list of eligible networked sites to which to route a contact. 
At the time that a networking workflow starts to execute, the short list 
consists of all sites configured to participate in networking, except:

• Sites whose acceptance criteria dictate that those sites are not 
accepting networked contacts at the current time.

• Sites that do not have a queue named identically to the queue to 
which the contact is currently enqueued.

While a Network Selection component will ultimately choose the site 
from the short list to which a contact will be routed, you can refine the 
short list prior to execution of a Network Selection component. For 
example, after making the decision whether to keep the contact local 
or distribute, you could first try to eliminate all sites whose 
corresponding queue has an estimated wait time less than one minute. 

In the following diagram, Estimated Wait Time < 60 is a Distribution 
Decision component. This component type lets you test a site-based or 
queue-based statistic at all networked sites. If the test passes, the 
short list is reduced to only those sites that pass the test. You might 
then distribute to the site with the best available estimated wait time. 
If the test fails, then traffic for the associated queue is heavy at all 
sites. In that case, you might distribute to the site that has the most 
available agents, to maximize the chances that the contact is handled 
by an overflow user. 
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In the previous example, a Distribution Decision component was used 
to set up distribution using a Network Selection component. The 
information returned by a Distribution Decision component can also be 
used in other ways. For example, the following diagram shows a 
workflow in which a Distribution Decision is used earlier in the workflow 
to aid in the decision as to whether the contact is to be processed 
locally or distributed.

Lastly, you can also perform multiple Distribution Decision component 
tests in a workflow. The following diagram shows how a four-site (A, B, 
C, and D) short list might be refined by a workflow with two 
Distribution Decision components.

• As the networking workflow begins to execute, site B has been 
removed from the short list because either it does not have a queue 
named identically to that to which the current contact has been 
enqueued or its acceptance criteria indicate that it is not currently 
accepting contacts.

• The first test fails, that is there are no sites that pass the test, so 
the short list continues to include sites A, C, and D. 
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• The second test passes, eliminating site D, and the short list is 
refined to include only sites A and C. 

16.6  Configuring a networking workflow

A networking workflow is a sequence of events that determines the 
distribution of a call through networking to remote sites in the contact 
center. 

NOTE:  To create or change a networking workflow, you must have Full 
or Modify access, respectively, for the Networking workflows 
Manager permission. 
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To configure a networking workflow:

1. On the File menu, point to New, then Design Center, then Voice, 
and then click Networking Workflow.

2. On the General tab, under Workflow, do the following:

• In the Name box, type a unique name for the networking 
workflow. The name appears on the tab in the Design Editor 
when you open the workflow diagram. 

• In the Description box, type a description for the networking 
workflow. The description should include the purpose of the 
workflow. 

3. Click OK. The application saves the new workflow and gives it a 
status of Incomplete. 

4. In the right pane, double-click the new workflow. A workflow 
diagram appears in the Design Editor with a Start component.

5. Create the components for the networking workflow diagram, as 
required. 

6. Add components to the workflow diagram. 

7. Connect the components. 

8. On the File menu, click Save. 

16.7  Configuring the networking resources

You must configure the resources that impact the networking feature.

NOTE:  Your initial networking configuration, such as the allocation of 
telephone lines and the setup of the Wide Area Network (WAN) used 
for site-to-site communication, is typically done by your service 
representative. For information on the setup tasks, see the 
Communication Platform Integration Guide. 

NOTE:  The settings of some of the default options, such as the shifts 
and service level, can impact network functioning. For details, see 
Section 15.7, “Configuring the statistics options”, on page 283. 
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16.7.1  Configuring the telephone lines for 
networking

Each networked site has a number of telephone lines that are used to 
traffic networked contacts. The dialable number associated with each 
line breaks down into two components: 

• Dialing prefix – The initial digits that are common to all telephone 
lines in the networked site, such as country code and area code. 
This is defined when you configure a networked site. For details, see 
Section 16.7.2, “Configuring a networked site”, on page 373. 

• Network transit number – The pilot number or CDL call number 
of the remote site that is used by the local site to move a contact 
to the remote site. For details, see Section 16.7.3, “Configuring a 
network transit number”, on page 374. 

Each site configuration stores all of the network transit numbers for 
that site, as well as the dialing prefix for all other sites in the network. 
When a contact is to be distributed to another site, the OpenScape 
Contact Center system requests a network transit number from the 
target site, and then uses the dialing prefix for that site to resolve the 
network transit number to a dialable number. 

NOTE:  When the system is configured for high availability (warm 
standby) and is connected to an OpenScape 4000 or HiPath 4000 
communication platform with a standby Access Point Emergency unit 
that is located in a different area code than the main communication 
platform, you must ensure that your service provider sets up a unique 
global dialing prefix that can be used with the network transit numbers. 
This will allow incoming calls from the PSTN to be routed to either the 
communication platform or the Access Point Emergency unit, 
regardless of which unit is in control of the call processing. 
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16.7.2  Configuring a networked site

You must configure the remote OpenScape Contact Center sites that 
this site communicates with for networking purposes. 

NOTE:  To create or change a networked site, you must have Full or 
Modify access, respectively, for the Networked sites Manager 
permission. 

To configure a networked site:

1. On the File menu, point to New, then Administration Center, 
then Networking, and then click Site.

2. On the General tab, under Details, do the following:

• In the Name box, type a unique name for the networked site. 
Ensure that the site name is unique so that site level reports 
display only the statistics for one particular site. 

• In the Description box, type a description of the networked 
site. 

• In the Dialing prefix box, type the dialing prefix that is used to 
resolve the network transit number for the networked site into 
a dialable number. For background information on network 
transit numbers, see Section 16.7.1, “Configuring the telephone 
lines for networking”, on page 372. 

3. Under Administration Server, do the following:

• In the Host name box, type the host name of the server 
machine where the networked site resides. 

NOTE:  When the system is configured for high availability 
(warm standby), you must type the name of the server cluster, 
rather than the name of the server machine. 

• In the Port number box, type the port number of the 
Administration Server on the server machine. 

4. Under Contact, do the following:

• In the Name box, type the name of the person responsible for 
the operation of the networked site. This person is usually the 
administrator who configures the OpenScape Contact Center 
database and provides technical support. 
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• In the Telephone number box, type the telephone number 
where the contact person can be reached. 

5. Click the Reports tab.

6. Under Reports, select the check box for each report that you want 
to display data about this networked site. The list contains only the 
reports you own, or reports that are owned by users you can 
monitor. 

7. Click OK. 

16.7.3  Configuring a network transit number

A network transit number is a pilot number that is used to route 
networked calls. You must define the network transit numbers that are 
used by the networked site. For background information, see Section 
16.7.1, “Configuring the telephone lines for networking”, on page 372. 

When configuring a network transit number, you specify one of the 
following numbers depending on the type of communication platform 
to which the system is connected: 

• OpenScape Voice – A pilot number for an OpenScape Contact 
Center Hunt Group. 

• OpenScape 4000 or HiPath 4000 – A pilot number for an OpenScape 
Contact Center Route Control Group. 

• OpenScape Business – A CDL call number for an OpenScape 
Contact Center UCD group.

NOTE:  To create or change a network transit number, you must have 
Full or Modify access, respectively, for the Network transit numbers 
Manager permission. 
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All network transit numbers for the site must have the same number 
of digits and must be externally dialable with the addition of the dialing 
prefix. For example, pilot number 2345 must be externally dialable by 
555-2345. If it is externally dialable by 555-1234 only, it cannot be 
used. 

IMPORTANT:  You must ensure that network transit numbers are 
configured properly. If they are not configured properly, serious call 
processing problems can arise, such as calls being dequeued and not 
handled by the system. 

NOTE:  You must configure a network transit number in both 
OpenScape Contact Center and the communication platform. This 
resource cannot be synchronized using the Config Sync feature. 

When you are modifying an existing network transit number, you can 
change only the name of the network transit number. You cannot 
change the actual number. If you need to change the number, you must 
delete the network transit number and create a new one.

To configure a network transit number:

1. On the File menu, point to New, then Telephony Center, and 
then click Network Transit Number.

2. Under Details, in the Name box, type a name for the range of 
network transit numbers you want to create. 

3. In the From box, type the first pilot number in the range.

4. In the To box, type the last pilot number in the range.

NOTE:  If you want to create a single resource, type only the 
number in the From box. You do not need to type a number in the 
To box. 

5. Click OK. The application creates a network transit number for each 
pilot number you specified. 
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16.7.4  Configuring the networking settings 
for a queue

Networking is implemented at the queue level. The definition for each 
queue participating in the networked contact center must be enabled 
for networking. For details, see Section 10.3, “Configuring a queue”, on 
page 200. 

16.8  Configuring the networking options

If your site is licensed for networking, you can configure the default 
networking options. For details, see the following topics:

• Section 16.8.1, “Configuring the general networking settings”, on 
page 376 

• Section 16.8.2, “Configuring the networking acceptance settings”, 
on page 377

• Section 16.8.3, “Configuring the networking distribution settings”, 
on page 378

NOTE:  To configure any of the networking options, you must have Full 
or Modify access for the associated Manager permission.

16.8.1  Configuring the general networking 
settings

The general networking settings allow you to: 

• Enable and disable networking for the site. When networking is 
enabled at the site level, the site can accept and distribute contacts 
according to the details of the networking configuration at the site. 
You can disable a site's participation in networking to correct errors 
or otherwise modify the configuration. 

NOTE:  In addition to enabling networking at the site level, the 
networking feature must be fully configured. For details, see 
Section 16.7, “Configuring the networking resources”, on page 371.
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• Configure the data exchange interval. Each site in a networked 
contact center makes use of performance statistics from other sites 
in the network in deciding to which site a contact is to be routed. 
(For details, see Section 16.4, “Distribution methods”, on page 
363). In addition, each site must be aware of whether each remote 
site is currently accepting networked contacts at the current time. 
To accommodate this, each site transfers its acceptance criteria and 
a collection of performance statistics to all other participating sites, 
at configured intervals. 

• Specify the default voice networking workflow. For information on 
how to configure a voice networking workflow, see Section 16.6, 
“Configuring a networking workflow”, on page 370. 

To configure the general networking settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Networking.

3. To enable this site to participate in networking, under Networking 
Participation, select the Enable check box. 

4. Under Networking data exchange, in the Data exchange 
interval box, type or select the time interval at which data is 
exchanged with the other networked sites. 

5. Under Default, in the Networking workflow list, select the voice 
networking workflow that you want to use as the default. 

6. Click OK.

16.8.2  Configuring the networking 
acceptance settings

You can configure the hours of operation during which the site will 
accept distributed calls from other networked sites. Optionally, you can 
configure the performance criteria that have to be met for a networked 
voice queue to accept distributed contacts. For more information, see 
Section 16.3, “Acceptance criteria”, on page 362. 

To configure the networking acceptance settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Networking.

3. Click the Acceptance tab.

4. To configure the acceptance schedule, under Schedule, click Edit 
schedule. 
A31003-S22B1-M103-08-76A9, 04/2025
OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide 377
         



Working with networking

networking.fm

Configuring the networking options
5. In the Networking Acceptance Schedule dialog box, double-
click the day you want to configure, and then edit the active time 
range for the day. 

NOTE:  You can also drag the start or end point of an active range 
to change the range. 

6. Optionally, click the Exceptions tab to create an exception to the 
default schedule. An exception overrides the schedule for the entire 
day.

a) On the calendar, click the day for which you want to schedule an 
exception, for example, a national holiday. The Default row 
shows the default schedule for that day.

b) Select the Override check box. 

c) In the Override row, double-click a cell, and then edit the active 
time range for the override schedule. Click OK. 

7. Use the Summary tab to view the schedule by status or by day of 
the week. 

• Expand By Status, and then click Active or Inactive to see the 
days and times when the e-mail schedule is active or inactive, 
respectively. 

• Expand By Day, and then click the day of the week to see the 
schedule for that day.

8. Click OK. 

9. To configure a performance acceptance criterion, under 
Performance Acceptance Criteria, click Add, or select a criterion 
in the list and click Edit. 

10.Click OK. 

16.8.3  Configuring the networking 
distribution settings

You can configure the settings that allow this site to distribute calls to 
other networked sites. You must specify the distribution method and 
the list of sites that will be considered for distribution. 

The distribution methods are described as follows:
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• Best Site – Distributes a contact to the site with the best 
performance on a single, specified statistic. When this method is 
selected, the Included Sites list defines the sites that will be tested 
to determine the best performing site. 

• Preferred Site – Distributes a contact to the site that ranks highest 
in the defined preferred order of sites. When this method is 
selected, the Included Sites list defines the preferred order of the 
sites available for distribution. 

For more information, see Section 16.4, “Distribution methods”, on 
page 363. 

To configure the networking distribution settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Networking.

3. Click the Distribution tab.

4. Under Included Sites, select the sites to which this site can 
distribute calls. Double-click a row in the table to activate the list of 
configured sites, and then select a site from the list. You must have 
already configured the sites before you can select them here. 

5. Under Default Distribution Method, in the Method list, select 
the method by which OpenScape Contact Center selects a site to 
which to distribute a call. You can choose Best Site or Preferred 
Site. 

6. If you chose Best Site in step 5, above, under Default Best Site 
Selection Statistic, specify the default selection statistic as 
follows:

a) In the Evaluate at list, select the level at which to select the 
statistic to be evaluated. You can choose Queue Level or Site 
Level.

b) In the Statistic list, select the statistic you want to use to 
evaluate the site.

c) If you chose Queue Level in step a), in the Queue list, select 
the queue against which to evaluate the selected statistic. 

7. Click OK. 
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17  Working with central reporting
This chapter introduces the optional central reporting feature, and 
provides details on the tasks involved in configuring the OpenScape 
Contact Center system to work with this feature. 

The central reporting feature uses a separate central reporting server 
machine that is running Informix and a subset of the OpenScape 
Contact Center servers. 

A central reporting server machine can be used for the following 
purposes: 

• To produce historical reports across multiple networked sites. For 
details on the networking feature, see Chapter 16, “Working with 
networking”. 

• To offload the historical reporting function from the main server 
machine. This allows the main server machine to process real-time 
contacts and real-time reports more efficiently.

• To provide increased data retention. Since more historical reporting 
data can be stored on a central reporting server machine, you can 
store reporting data for longer periods of time. 

• When the system is configured for high availability (warm standby), 
to consolidate the historical reporting data from the server cluster. 
For details on the high availability (warm standby) feature, see 
Chapter 18, “Working with the high availability (warm standby) 
feature”. 

The central reporting feature provides reporting on all available media 
types. The central reporting server machine stores its own set of report 
definitions, independent of the definitions stored at local sites.

When the central reporting server machine is used for networking, the 
key difference between network reports and reports generated on 
individual sites, is that network reports group entries for individual 
resources by site and provide totals for each site. For example, a user 
historical report will show totals for each user, with the users grouped 
according to the site where they are working, and totals for each site. 
Also, when configuring user, routing state reason, and Wrap-up reason 
reports, the Select by list on the Content tab offers the option to 
select the content of the report by site name. 
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17.1  Central reporting data consolidation

Informix replication is used to consolidate data from the local sites 
(that is, the sites other than the site where the central reporting server 
machine resides) into the OpenScape Contact Center database on the 
central reporting server machine. 

Throughout the day, the raw contact data is rolled up to report-ready 
data for 15-minute and hourly reports. Once a day, at data 
maintenance time, rollup data for daily, weekly, and monthly reports is 
calculated. Also at this time, any configuration changes for local sites, 
such as new user definitions, are imported to the central reporting site. 
For more information on the data maintenance time, see Section 
15.6.1, “Configuring the data maintenance time”, on page 277. 

17.2  Central reporting limited functionality

When you are logged on to a central reporting server machine, the 
Manager application provides the following limited functionality:

• Only the Administration Center and Reporting Center are available. 

• In the Administration Center, only users, user templates, profiles, 
servers, and notifications are displayed. For details on configuring 
users, see Section 17.3, “Configuring a user on a central reporting 
machine”, on page 383. 

• In the Reporting Center, only historical reports are available – real-
time, cumulative, and activity reports are not available. All 
historical reports that are available at the local sites are supported.
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• In the Options dialog box, only options related to the central 
reporting feature and the configuration of the Manager application 
itself are available. For details, see Section 17.4, “Configuring the 
central reporting options”, on page 384. 

• Although it is possible to save the production database as a design 
database for customer support purposes, you cannot save a design 
database over the production database. 

17.3  Configuring a user on a central reporting machine

All administrators and supervisors who will be logging on to the central 
reporting server machine to generate reports or perform site 
maintenance must be configured on the central reporting server 
machine.

The user configuration includes: 

• Permissions to work with specific report types (for example, user 
historical and queue historical) or perform administration tasks. 
Two default profiles specific to central reporting are provided:

– Manager – Provides permissions to work with all report types, 
user definitions, and a selection of related features.

– Manager Administrator – Provides the same permissions as 
the Manager profile and also includes permissions to work with 
the Options dialog box settings specific to central reporting. 

• Monitoring rights to the specific resources to be reported on (for 
example, queues and users). 

• Ownership of report definitions, if the user does not have 
permission to create or modify report definitions. 

Section 4.1, “Configuring a user”, on page 25 provides instructions on 
how to configure users at a local site. The same principles apply on a 
central reporting server machine, however only the General, 
Permissions, and Monitoring tabs are available and only central 
reporting-specific settings are available on these tabs. 
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17.4  Configuring the central reporting options

You must configure the default options that specifically relate to central 
reporting. For details, see the following topics: 

• Section 17.4.1, “Configuring the central reporting server machine 
settings”, on page 384

• Section 17.4.2, “Configuring the server settings for networked 
sites”, on page 385

Other options can be configured on the central reporting server 
machine independently of the same settings on the main server 
machine. For details, see the following topics: 

• Section 7.13.2, “Configuring the first day of the week”, on page 135

• Section 7.13.5, “Configuring the e-mail reports option”, on page 
138

• Section 15.6, “Configuring the data management options”, on page 
276

• Section 15.7.1, “Configuring the service level interval”, on page 283

• Section 15.7.3, “Configuring the user calculation”, on page 288

17.4.1  Configuring the central reporting 
server machine settings

If your contact center is using central reporting, you can configure the 
settings for the central reporting server machine. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the central reporting server machine settings. For details, see 
Section 19.3, “Administrator roles in a multitenant environment”, on 
page 394. 

To configure the central reporting server machine settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Reporting.

3. Click the Central Reporting tab.

4. In the Site name box, type the name of the central reporting site.

5. In the Host name box, type the host name of the central reporting 
server machine. 
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6. In the Port number box, type the port number of the 
Administration Server on the central reporting server machine. 

17.4.2  Configuring the server settings for 
networked sites

When you are connected to a central reporting server machine in a 
networked environment, you can change the name of a networked site 
and the port number of the Administration Server at a networked site.

To configure the server settings for the networked sites:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Reporting.

3. Click the Networked Sites tab. 

4. Under Networked Sites, select a site in the list and click Edit. 

5. In the Networked Sites dialog box, change the following, as 
required:

• In the Site name box, type a name for the site. 

• In the Port number box, type the port number of the 
Administration Server at the site.

6. Click OK. 
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18   Working with the high availability (warm 
standby) feature

This chapter discusses the high availability (warm standby) feature, 
and provides details on the tasks involved in configuring the 
OpenScape Contact Center system to work with this feature. 

High availability (warm standby) is a licensed feature that is supported 
only when the system is connected to an OpenScape Voice, OpenScape 
4000, or HiPath 4000 communication platform.

The high availability (warm standby) feature uses a redundant server 
machine to provide a high level of availability for OpenScape Contact 
Center server processes and required third-party processes in the 
event of a hardware or software component failure. 

When the system is configured for high availability (warm standby), the 
administration and processing data is replicated between the primary 
and backup server machines. To ensure that the system gets updated 
with the replicated data, the OpenScape Contact Center service on the 
server machine that is in standby mode restarts every day, one hour 
before the configured data maintenance time. For information on how 
to configure the data maintenance time, see Section 15.6.1, 
“Configuring the data maintenance time”, on page 277.

If you make any significant administration changes on the server 
machine that is in active mode, we recommend that you restart the 
OpenScape Contact Center service on the server machine that is in 
standby mode. This will ensure that, if the system fails, the backup 
instance of the system will have the latest changes.

An optional central reporting server machine can be used to 
consolidate statistical data from the server cluster and thus provide on-
going historical reporting during and after failover. For details, see 
Chapter 17, “Working with central reporting”. 

In most cases, you should log on to the Manager application using the 
cluster name (see Section 3.2, “Logging on to the Manager 
application”, on page 19) when you are working in a high availability 
(warm standby) environment. You must restart the Manager 
application manually after a failover. 

NOTE:  Certain reporting statistics are affected when a failover to the 
backup server occurs. For details, see the Reporting Reference Guide. 
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18.1  Call Director configuration in a high availability (warm 
standby) environment

When the system is configured for high availability (warm standby), 
redundant voice processors are required for Call Director. Therefore:

• You must configure the backup voice processor separately on the 
backup server machine. If the system is using multiple OpenScape 
Contact Media Service voice processors, you must configure a voice 
processor on the backup server machine for each voice processor 
on the primary server machine, and each pair of voice processors 
must be configured in the same voice processor region (if 
distributed). 

• You must configure a second set of Call Director extensions or 
subscriber numbers on the backup server machine for each backup 
voice processor.

In a high availability (warm standby) environment, you normally log on 
to the Manager application using the cluster name. However, when you 
are configuring items on the backup server machine, you must connect 
to the physical machine in the format portnumber@servername.

In addition, the Call Director .wav files are not replicated on the backup 
server machine. You must manually copy the .wav files to the 
WaveFiles folder on the backup server machine and ensure that the 
.wav files on the primary and backup server machines remain 
synchronized. For details, see Section 12.3.2, “Configuring a .wav file”. 

After configuring these items and copying the .wav files, you must 
restart the OpenScape Contact Center service on the backup server 
machine. 

18.2  Configuring the high availability (warm standby) option

The high availability (warm standby) feature requires special hardware 
and software and must be configured during installation of the 
OpenScape Contact Center system. After installation, the high 
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availability (warm standby) option is enabled by default to ensure that 
the system operates with the high availability (warm standby) feature 
turned on. 

IMPORTANT:  Changing the setting of the high availability (warm 
standby) option after initial system setup can adversely affect the 
operation of OpenScape Contact Center, and will require that you 
restart the OpenScape Contact Center service on the main server 
machine. Contact your service representative before proceeding.

NOTE:  When you are connected to a design database, the high 
availability (warm standby) option will appear only when connected to 
an OpenScape Voice, OpenScape 4000, or HiPath 4000 communication 
platform.

NOTE:  In a multitenant environment, only a system administrator can 
configure the high availability (warm standby) option. For details, see 
Section 19.3, “Administrator roles in a multitenant environment”, on 
page 394. 

To configure the high availability (warm standby) option:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click System.

3. Click the Advanced tab.

4. Under High Availability (Warm Standby), select or clear the 
Enable check box, as required. 

5. Click OK. 
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19  Working with the multitenancy feature
Multitenancy is a licensed feature that is supported only when the 
system is connected to an OpenScape Voice, OpenScape 4000, or 
HiPath 4000 communication platform. This chapter discusses the 
multitenancy feature, and provides details on the tasks involved in 
configuring the OpenScape Contact Center system to work with this 
feature. 

NOTE:  Networking, SAP CIC integration, and SAP ICI integration are 
not supported in a multitenant environment. 

NOTE:  Licensed features are shared between business units in a 
multitenant environment. 

The multitenancy feature enables a single contact center to have 
multiple business units that are clearly separated from each other. For 
example, in a managed services environment, the service provider 
needs to ensure that the different business units on the system cannot 
view each other's resources. Similarly, in a service bureau, supervisors 
and agents servicing different customers should not be able to view 
another customer’s resources. 

NOTE:  If a single contact center site has the multitenancy feature and 
is using a central reporting server machine, all the business units within 
the site can use the central reporting server machine. However, if the 
contact center has multiple sites and one of those sites has the 
multitenancy feature, the central reporting server machine can be used 
by only one site and cannot be shared by multiple sites.

Contacts are associated with a business unit as follows:

• Routed calls are associated with a business unit based on the hunt 
group (OpenScape Voice) or route control group (OpenScape 4000 
or HiPath 4000) where the call was received. Direct calls are 
associated with a business unit based on the subscriber number 
(OpenScape Voice) or user extension (OpenScape 4000 or HiPath 
4000) that is assigned to the business unit.

• Callbacks are associated with a business unit when they are 
created. 
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• E-mail messages are associated with a business unit based on the 
e-mail destination where the message was received. Outgoing e-
mail messages are associated with a business unit based on the 
user who sends the message.

• Web collaboration contacts are associated with a business unit 
based on the business unit name that was specified as part of the 
Web page configuration.

In the event that the OpenScape Contact Center system cannot route 
a contact to a particular business unit in a multitenant environment, 
the system will route the contact to the error business unit that is 
configured at the system level.

19.1  Changing to multitenancy

You can convert the OpenScape Contact Center system from a single 
tenant environment to a multitenant environment. This conversion 
enables the contact center to have multiple business units that are 
separated from each other. 

IMPORTANT:  When the system is configured for high availability 
(warm standby), some additional steps are required when changing to 
multitenancy. For details, see Section 19.2, “Changing to multitenancy 
in a high availability (warm standby) environment”, on page 393. 

IMPORTANT:  Changing to multitenancy is a one-way operation – the 
system cannot be converted back after it has been changed. 

IMPORTANT:  When you are connected to the production database, 
you must ensure that all users are logged off the system before 
changing to multitenancy, and restart the OpenScape Contact Center 
service on the main server machine after changing to multitenancy. 

To change to multitenancy:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click System.

3. Click the Advanced tab.

4. Click Change to Multitenancy. 
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5. In the warning dialog box, under Do you want to change to 
multitenancy?, select Yes, and then click OK. 

6. When the system prompts you to confirm that you want to change 
to multitenancy, click Yes. The system changes to multitenancy. 

7. Click OK. 

19.2  Changing to multitenancy in a high availability (warm 
standby) environment

When the system is configured for high availability (warm standby), 
you must use the following procedure to change to multitenancy. 

NOTE:  This procedure requires you to pause and resume the server 
machine that is in standby mode. For details on pausing and resuming 
nodes (server machines), see the Cluster Administrator Help. 

To change to multitenancy in a high availability (warm standby) 
environment:

1. On the server machine that is in standby mode, do the following:

a) Using the Microsoft cluster application, pause the server 
machine. 

b) Stop the OpenScape Contact Center and OpenScape 
Contact Center AutoPA services. Wait for the services to 
completely shut down before proceeding. 

2. On the server machine that is in active mode, do the following:

a) Change to multitenancy. For details, see Section 19.1, 
“Changing to multitenancy”, on page 392. The new data will be 
replicated to the database on the server machine that is in 
standby mode.

b) When the system prompts you, restart the OpenScape 
Contact Center service. 

3. On the server machine that is in standby mode, do the following:

a) Start the OpenScape Contact Center and OpenScape 
Contact Center AutoPA services. The server machine will 
come up in standby mode with multitenancy enabled. 

b) Using the Microsoft cluster application, resume the server 
machine. 
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19.3  Administrator roles in a multitenant environment

In a multitenant environment, there are two administrator roles:

• System administrator – System administrators are responsible 
for configuring the business units and other system-level resources, 
such as the OpenScape Contact Center servers, communication 
platform resources. 

• Business unit administrator – Business unit administrators are 
responsible for configuring all other items required for their specific 
business unit, such as Broadcaster and wallboard views, routing 
strategy and queue processing workflows, queues, and reports. 

The following table lists the administrator tasks that can be performed 
only by system administrators, and the tasks that can be performed by 
both system administrators and business unit administrators. All other 
Manager tasks can be performed only by business unit administrators. 

System administrators need to provide guidance to business unit 
administrators regarding business unit resources that can impact the 
system. For example, user IDs must be unique across the system. In 
this case, the system administrator should assign a range of user IDs 
to each business unit, and then convey those ranges to the business 
unit administrator to ensure that they do not configure user IDs that 
are in use by another business unit.

System administrator only tasks Both system and business unit 
administrator tasks

• Configuring business units
• Configuring servers
• Configuring communication platform 

resources (such as extensions, 
subscriber numbers, requeue 
targets, Config Sync domain ranges)

• Configuring notifications
• Configuring excluded numbers
• Configuring emoticons
• Uploading a design database
• Activating product features
• Configuring the error log report
• Accessing the System Monitor 

application
• Configuring most of the system-

related options (see the explanation 
in Section 19.3.1, “Configuration of 
system-related options in a 
multitenant environment”, on page 
395)

• Configuring users
• Configuring user templates
• Configuring profiles
• Configuring reasons – system 

administrators can only change 
system-defined reasons (except 
Wrap-up reasons) and business 
unit administrators can only 
configure new reasons

• Configuring e-mail destinations
• Validating the database
• Saving a design database
• Configuring the change log

Table 16 Administrator tasks in a multitenant environment
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19.3.1  Configuration of system-related 
options in a multitenant environment

System administrators are responsible for configuring most items in 
the Options dialog box under System Settings, with the exception of 
the following options, which are configured by business unit 
administrators: 

• Contact Lookup – The settings on the General tab.

• Voice – The settings on the General tab and the OpenScape 
Contact Center Ring No Answer feature. 

• Callback – The caller ID settings (available only when connected to 
an OpenScape Voice, OpenScape 4000, or HiPath 4000 
communication platform).

• E-mail – The settings on the General tab (not including the e-mail 
routing schedule) and the e-mail message settings. 

• Web Collaboration – The settings on the General tab. 

• Routing – The maximum offer time.

• Call Director – The error message file and default navigation. 

• Statistics – The service level interval and corresponding service 
level calculation formula. 

19.4  Updating a design database in a multitenant environment

To prevent conflicts between different business units, only a system 
administrator can upload a design database in a multitenant 
environment. Therefore, a business unit administrator who wants to 
make offline configuration changes in a design database must follow 
the general process provided in this section. 

NOTE:  A business unit administrator can access only the configuration 
information related to their own business unit. However, the design 
database contains the configuration information for all business units. 
Therefore, a system administrator must allow only one business unit at 
a time to make configuration changes to a design database. 
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To update a design database in a multitenant environment:

1. Ask a system administrator for a copy of the design database. 

The system administrator saves a design database, locks the 
production database, and gives you a copy of the design database. 

2. Make the required changes to the design database. 

3. Give the updated design database to the system administrator. The 
system administrator uploads the design database. 

19.5  Configuring the multitenancy resources

You must configure the resources that impact the multitenancy 
feature.

19.5.1  Configuring a business unit

In a multitenant environment, a system administrator must configure 
each business unit within the contact center. 

NOTE:  To create or change a business unit, you must have Full or 
Modify access, respectively, for the Business units Manager 
permission. 

When a system administrator makes configuration changes that impact 
a particular business unit, the system administrator should inform the 
person responsible for the business unit. 

NOTE:  When the system has central reporting, a system 
administrator cannot configure business units on a central reporting 
server machine. The business units are created automatically on a 
central reporting server machine at startup or at data maintenance 
time. 
 A31003-S22B1-M103-08-76A9, 04/2025
396 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



multitenancy.fm

Working with the multitenancy feature
Configuring the multitenancy resources
To configure a business unit:

1. On the File menu, point to New, then Administration Center, and 
then click Business Unit.

2. Under Details, do the following:

a) In the Name box, type a unique name for the business unit. You 
cannot use the name system, which is reserved for the system-
level business unit. 

b) In the Description box, type a description for the business unit. 

c) In the Master password box, type the password for the 
business unit’s Master Administrator user account. For details on 
the Master Administrator user account, see Section 3.2.1, 
“About the Master Administrator”, on page 21. 

d) In the Confirm password box, retype the password to confirm 
that you entered it correctly. 

3. Under Contact, do the following:

• In the Name box, type the name of the person responsible for 
the business unit. This person is usually the business unit 
administrator who configures the OpenScape Contact Center 
database and provides technical support. 

• In the Telephone number box, type the contact telephone 
number for the person responsible for the business unit.

4. Click the Security tab. This tab is available only if the enhanced 
security option is enabled. For details, see Section 15.3.4, 
“Configuring the enhanced security option”, on page 271. 

5. Under Users, select the check box for each user who you want to 
be able to modify this business unit. The list contains only the users 
who have Full or Modify access to the Business units Manager 
permission. 

6. Click OK.
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19.5.2  Configuring a user at the system level

In a multitenant environment, a system administrator can configure 
other system level users and delegate system level administration 
tasks to those users. 

NOTE:  Use SAML2 authentication, to allow users to login 
automatically. For more information, please refer to chapter “Single 
Sign On using SAML2” in the OpenScape Contact Center V11 R1, Web 
Manager, Administrator Documentation.

To configure a user at the system level:

1. On the File menu, point to New, then Administration Center, 
then User, and then click User. 

2. On the General tab, under User, do the following:

• In the First name box, type the user's first name. 

• In the Last name box, type the user's last name. 
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3. Under System Identification, do the following:

• In the User name box, type a unique user name. This name is 
used when logging on to the Manager application and for 
recording statistics. If you want to use the Windows 
authentication method, the user name must match the name 
used for logging on to the Windows domain. 

• In the Authentication list, select one of the following: 

– To have the OpenScape Contact Center system validate the 
user, select Use OpenScape Contact Center, type the 
password in the Password box, and then type it again in the 
Verify password box to ensure that you typed it correctly. 

– To have Windows validate the user, select Use Windows, 
and then type the NetBIOS name for the Windows domain in 
the Domain box. Ensure that the user name matches the 
name used for logging on to the Windows domain. When you 
select this option, this user will not see the Logon window 
when starting the Manager application. 

4. To set the user attributes based on a user template (see Section 
4.2, “About user templates”, on page 38), under Templates, click 
Change and select the user template you want to apply to the user 
from the list. If you later change an attribute in the user record or 
user template, an indicator shows that the template association is 
not current. For details, see Section 4.2.1, “User template 
associations”, on page 39. 

5. Under Application, specify the user's access to the applications. 
For each application, click the item in the Permissions column and 
select either Yes or No from the list.

6. Click the Permissions tab. Only the profiles and permissions 
related to system level tasks are available. For details, see Section 
19.3, “Administrator roles in a multitenant environment”, on page 
394.

7. In the Profiles table, select the check box for each profile that you 
want to assign to the user. If two or more profiles are selected, the 
user's actual access level is changed to the highest access level of 
the selected profiles.

8. Optionally, in the Permissions table, modify the default 
permissions. For each function you want to change, click the item 
in the Actual column and select the access level from the list. For 
a description of the access levels, see Section 4.3.3, “Access 
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levels”, on page 50. 

NOTE:  You can click Reset to reset the effective permissions to 
the default access levels.

9. To show only the permissions in the list for which the default access 
level has been modified, select the Show overrides only check 
box.

10.Click the Security tab. This tab is available only if the enhanced 
security option is enabled. For details, see Section 15.3.4, 
“Configuring the enhanced security option”, on page 271. 

11.To configure the users who can modify this user, do the following:

a) Under Configure, select Users who can modify this user. 
This option is disabled if the user you are configuring does not 
have access to the Manager application. 

b) In the list, select the check box for each user who you want to 
be able to modify this user. The list contains only the users who 
have Full or Modify access for the Users Manager permission. 

12.To configure the resources that the user can modify, do the 
following:

a) Under Configure, select Resources this user can modify. 
This option is disabled if the user does not have Full or Modify 
access permission for any of the eligible resources. 

b) Under Include, in the Show list, select the type of resource 
that you want to configure. The list contains only the resource 
types for which both you and the user have Full or Modify access 
permission. 

c) In the resulting list, select the check box for each resource that 
you want this user to be able to modify. 

13.Click OK.

19.5.3  Configuring an e-mail destination in a 
multitenant environment

All e-mail messages are stored in a single mailbox on the corporate 
e-mail server. If you want to have more than one destination e-mail 
address for your contact center (such as, sales@company.com and 
support@company.com), you must configure the e-mail destinations 
you want to use. 
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In a multitenant environment, you must configure separate e-mail 
destinations for each business unit. E-mail destinations are initially 
created by a system administrator and then later configured by a 
business unit administrator. 

19.5.3.1  Configuring an e-mail destination at the 
system level

In a multitenant environment, a system administrator creates the 
required e-mail destinations and assigns them to a business unit.

NOTE:  Before a system administrator can delete or reassign an e-mail 
destination to another business unit, a business unit administrator 
must ensure that the e-mail destination is not selected as the default 
incoming or outgoing e-mail address for any business unit. 

To configure an e-mail destination at the system level:

1. On the File menu, point to New, then Design Center, then 
E-mail, and then click Destination.

2. On the General tab, under Details, do the following:

• In the Name box, type a unique name for the e-mail 
destination. 

• In the Description box, type a description for the e-mail 
destination.

• In the E-mail address box, type the destination e-mail 
address. 

• In the Business unit list, select the business unit to which you 
want to assign this e-mail destination. 

3. Click OK. 
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19.5.3.2  Configuring an e-mail destination at the 
business unit level

In a multitenant environment, a business unit administrator can 
configure the existing e-mail destinations for their own business unit. 
However, a business unit administrator cannot change a destination 
e-mail address itself, create a new e-mail destination, or delete an 
existing e-mail destination. 

NOTE:  You specify the default e-mail addresses in the Options dialog 
box. For details, see Section 14.3.1, “Configuring the default e-mail 
routing strategy, queue, and addresses”, on page 254. 

To configure an e-mail destination at the business level:

1. On the File menu, point to New, then Design Center, then 
E-mail, and then click Destination.

2. On the General tab, under Details, do the following:

• In the Description box, type a description for the destination.

• In the From text box, type an alias for the destination e-mail 
address. This alias appears in the From box when a user replies 
to an e-mail message. 

• To gather statistics for this destination for reporting purposes, 
select the Monitored check box. When you select this option, 
the Reports tab becomes active. 

3. If you selected the Monitored check box, click the Reports tab and 
select the check box for each report that you want to display data 
about this destination. The list contains only the reports you own, 
or reports that are owned by users you can monitor. 

4. Click OK. 

19.6  Configuring the error business unit

In the event that the OpenScape Contact Center system cannot route 
a contact to a particular business unit in a multitenant environment, 
the system will route the contact to the error business unit. A system 
administrator configures the error business unit for the system. 

To configure the error business unit:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click System.
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3. Click the Advanced tab.

4. Under Multitenancy, in the Error business unit list, select the 
business unit to which contacts are routed in the event of an error. 

5. Click OK. 
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15  Configuring other global options
An OpenScape Contact Center configuration includes a number of 
options (such as application settings, intervals, calculations, and 
scheduled events) that impact routine operation, reporting, and the 
level of service experienced by customers. Initially, most customers 
start by using the default settings for many of these options, but you 
can reconfigure the settings at any time. You configure the settings 
globally, although you can override some settings in queues and 
routing strategy workflows.

IMPORTANT:  Contact your service representative before making 
significant changes to the threshold and interval settings configured in 
your database. 

Some of the global options are described in the relevant chapter (for 
example, routing options are described in Chapter 8, “Routing”), but 
the remaining options are described in this chapter. 

NOTE:  In a multitenant environment, most system-level options can 
be configured only by a system administrator. A small subset of the 
system-level options can be configured by a business unit 
administrator. For details, see Section 19.3, “Administrator roles in a 
multitenant environment”, on page 394. 

15.1  Configuring the personal options

You can configure several personal options, including:

• The appearance and behavior of the Manager application, such as 
the display of the Index bar. 

• The display of system messages in the Messages window and in the 
status bar. The status bar is located at the bottom of the main 
Manager application window. 

• The notification method used to indicate when a threshold in a real-
time or cumulative report is reached. 

• The default user template to be used when creating a new user. For 
more information on user templates, see Section 4.2, “About user 
templates”, on page 38. 
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You can also configure the confirmation options (see Section 15.1.1, 
“Configuring the confirmation options”, on page 263). 

To configure the personal options:

1. On the Tools menu, click Options.

2. In the left pane, under User Settings, click Personal.

3. On the General tab, under Show, select the check boxes for the 
items you want to show:

• Index bar – Displays the Index bar, which allows you to select 
from a subset of items in a list. To display the letters on the 
Index bar that have entries associated with them in bold text, 
select the Display active Index bar letters in bold check box. 

• ToolTips – Displays the function of the toolbar buttons in the 
Manager application window when you hold your mouse pointer 
over the button. 

• Record hints – Displays a description of the selected record. 
Record hints are displayed above the right pane in the main 
Manager application window. 

4. Under Messages, do the following:

• To specify the length of time system messages are displayed in 
the status bar, type or select the number of seconds in the Hide 
status bar messages after box. 

• To have the application display the system messages in a 
separate window when they occur, select the Display System 
Message window when new messages occur check box. If 
you do not select this option, the system messages are 
recorded, but the window does not open.

NOTE:  To view the System Messages window, on the View menu, 
click System Messages.

5. Under When a Threshold is Reached, select the Flash title bar 
or taskbar icon if Real-time Viewer is hidden or minimized 
check box if you want the Real-time Viewer to flash when a 
threshold is reached. If the Real-time Viewer is hidden, the title bar 
will flash, and if the Real-time Viewer is minimized, the taskbar icon 
will flash. 
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6. Under Default User Template, in the Select template list, select 
the user template that you want to use as the default. The default 
template is used when you create multiple users and a user 
template is not specified. For details, see Section 4.2.5, “Creating 
multiple users by importing a text file”, on page 44.

7. Click OK.

15.1.1  Configuring the confirmation options

You can configure the application to prompt you for confirmation when 
you perform various actions such as deleting a record or exiting the 
application. 

To configure the confirmation options:

1. On the Tools menu, click Options.

2. In the left pane, under User Settings, click Personal.

3. Click the Confirmations tab.

4. Under Show Confirmations When, select the check box for each 
action that you want the Manager application to prompt you for: 

• Deleting records – The application will ask if you are sure you 
want to delete the record (that is, a resource or definition in one 
of the application centers). 

• Exiting the Manager application – The application will ask if 
you are sure you want to exit the application. 

• Removing a report from a report view – The application will 
ask if you are sure you want to remove the report from the 
report view. 

• Historical reports were completed – When you log on, the 
application will inform you that historical reports were 
completed while you were logged off. 

• Report changes cause thresholds to be deleted – When you 
change a report (that is, change the report type, the resource 
reported by, the resource selected by, or the type of activity 
reported on), the application will inform you that the currently 
defined thresholds for the report will be deleted as a result of the 
change. 

• Report was successfully submitted – The application will 
inform you that the report was successfully submitted to the 
Scheduler. 
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• Background operations were completed – The application 
will inform you when a background operation (such as deleting 
multiple users) is complete.

5. Click OK.

15.2  Configuring the advanced options

You can configure various advanced user-related options for the 
Manager application. 

15.2.1  Configuring the diagnostic settings

You can configure the Manager application to log messages to a 
diagnostic file, which your administrator or service technician can use 
to track the operations of the applications and resolve problems, such 
as why an application disconnected from an OpenScape Contact Center 
server. You can turn diagnostic logging on and off, and also configure 
the contents of the diagnostic file. You should need to configure the 
contents only if problems occur within your contact center. 

To turn diagnostic logging on:

1. On the Tools menu, click Options. 

2. In the left pane, under User Settings, click Advanced.

3. Under Diagnostics, select the Turn diagnostic logging on check 
box.

4. Click OK.

To configure the diagnostic file contents:

1. On the Tools menu, click Options.

2. In the left pane, under User Settings, click Advanced.

3. Under Diagnostics, click Details. The Diagnostics dialog box is 
displayed. 

NOTE:  The diagnostic files are saved to the folder specified in the 
Location box. 
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4. Under Levels, select the check box for each diagnostic level you 
want to include in the file:

NOTE:  By default, when you start any application, the Event, 
ActiveX Component, and Function Entry/Exit diagnostic levels 
are selected.

• Warning – Saves messages related to errors that do not break 
down the connectivity.

• Information – Saves messages related to normal connectivity 
operations.

• Event – Diagnostic trace of event.

• ActiveX Component – Saves messages related to OCX 
operations. 

• Function Entry/Exit – Diagnostic trace of the code workflow.

5. Click OK. 

15.2.2  Changing the password

An administrator will provide you with a user name and password for 
logging on to the Manager application. For security, you should change 
your password the first time you log on, and then change it periodically 
to conform to security policies at your site. This guideline also applies 
to the default Master Administrator password. For more information on 
the Master Administrator user account, see Section 3.2.1, “About the 
Master Administrator”, on page 21. 

To change the password:

1. On the Tools menu, click Options.

2. In the left pane, under User Settings, click Advanced.

3. Under Password, click Change. 

4. In the Change Password dialog box, do the following:

a) In the Old Password box, type your current password.

b) In the New Password box, type your new password.

c) In the Confirm new password box, retype your new password 
to verify that you entered it correctly. 

d) Click OK. 
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5. Click OK.

15.2.3  Restoring the default settings

You can restore certain user settings, such as custom shortcuts, 
toolbars and colors, to the default settings provided when you first 
installed the application. 

To restore the default settings:

1. On the Tools menu, click Options.

2. Click the Advanced tab.

3. Under Default Settings, click Restore. 

4. Under Features, do the following:

a) Select the check boxes for the features you want to restore to 
the default settings.

b) Clear the check boxes for the features that you do not want to 
restore to the default settings.

c) Click OK.

5. Click OK.

15.3  Configuring the system options

You can configure various system options related to the contact center. 

NOTE:  To configure any of the system options, you must have Full or 
Modify access for the associated Manager permission.

15.3.1  Configuring the general system 
settings

You can configure general system settings, such as the information 
related to the contact center's site and technical support, and the 
location of the ShareData folder. 
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The ShareData folder is a repository for storing and transferring 
various items in the contact center, such as design databases, historical 
reports, .wav files, and XML data. 

IMPORTANT:  We strongly recommend that you do not change the 
default location of the ShareData folder. Locating the ShareData folder 
on a machine other than the main server machine can adversely affect 
system performance. If it is absolutely necessary to change the default 
location, it should be changed only by your service representative. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the general system settings. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the general system settings: 

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click System.

3. Under Profile, in the Site box, type the name of your contact 
center. This name appears on reports about the contact center, and 
when you monitor servers. 

4. Under Contact, do the following:

• In the Name box, type the name of the person responsible for 
the operation of the contact center. This person is usually the 
administrator who configures the OpenScape Contact Center 
database and provides technical support. 

• In the Telephone number box, type the telephone number for 
the person responsible for the operation of the contact center. 

5. Under ShareData, in the Location box, type the path and name of 
the ShareData folder. This folder is usually located on the main 
server machine. 

6. Under 360o Customer View, check the Enable checkbox to 
activate the feature.

7. If the contact center is using an auxiliary server machine, under 
Notifications, in the Select Watchdog Server list, select the 
Watchdog Server that sends notifications for the site. For details on 
configuring an auxiliary server, see Section 5.3.4, “Configuring a 
Real-Time Server on an auxiliary server machine”, on page 74. 

8. Click OK.
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15.3.2  Configuring the e-mail server settings

Incoming e-mail messages are routed through the corporate e-mail 
server to the OpenScape Contact Center E-mail Server. The corporate 
e-mail server and the OpenScape Contact Center E-mail Server 
communicate using the IMAP4 protocol. Message attachments are 
retrieved using separate IMAP4 and MIME functions. 

Outgoing e-mail messages are distributed using an SMTP interface. 
This includes completed historical reports that are distributed as 
attachments to e-mail messages. For more information, see Section 
7.13.5, “Configuring the e-mail reports option”, on page 138.

IMPORTANT:  When you are connected to the production database, if 
you change the e-mail server settings, you will be required to restart 
the OpenScape Contact Center E-mail Server on the main server 
machine. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the e-mail server settings. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the e-mail server settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click System.

3. Click the E-mail Settings tab. 

4. Under Corporate IMAP Server, do the following:

• In the Host name box, type the host name (or FQDN) of the 
machine where the IMAP server resides.

• In the Port number box, type the port number of the IMAP 
server. 

• To secure the connection, select the Use TLS check box. 

• In the User name box, type the user name needed to log on to 
the IMAP server, for example, OSCCEmail. 

• In the Password box, type the password needed to log on to 
the IMAP server. 

• In the Confirm password box, retype the password to confirm 
that you entered it correctly. 
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• In the Maximum IMAP sessions box, type the maximum 
number of allowed IMAP sessions. The value 0 means not 
limited.

NOTE:  Set the parameter Maximum IMAP sessions to 20 if 
the e-mail server is Office365.

5. Under Corporate SMTP Server, do the following:

• In the Host name box, type the host name (or FQDN) of the 
machine where the SMTP server resides.

• In the Port number box, type the port number of the SMTP 
server. 

• To secure the connection, select the Use TLS check box. 

• In the Authentication list, select one of the following: 

– None – Do not use any authentication.

– Use IMAP settings – Use the same user name and 
password specified for the IMAP server. 

– Use settings below – Use the user name and password 
specified in the following boxes. The following three options 
are available only if you select this option. 

• In the User name box, type the name of the user needed to log 
on to the SMTP server. 

• In the Password box, type the password needed to log on to 
the SMTP server. 

• In the Confirm password box, retype the password to confirm 
that you entered it correctly. 

• In the Heartbeat e-mail address box, type a valid e-mail 
address that the SMTP server must be capable of using as the 
From address when creating a new e-mail message (for 
example, the outgoing e-mail address specified in the general 
e-mail options).
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• In the Message rate limit box, type the maximum number of 
outgoing messages that can be processed per minute. You can 
enter a value between 0 and 1000. The default value is 0 and 
indicates that there is no limit.

IMPORTANT:  We strongly recommend that you do not change 
the message rate limit from the default value of 0 unless you are 
using Microsoft Office 365 as the corporate e-mail server.

6. Click OK. 

15.3.3  Configuring the Web server settings

The Web Interaction Server communicates with the corporate Web 
server to provide a direct interface for Web callbacks, VoiceXML 
integration, and Web collaboration sessions.

This section describes how to configure an unsecured port and a 
secured (TLS-enabled) port that the Web Interaction Server can use to 
connect to the corporate Web server. You have the option to configure 
one port or both ports. 

IMPORTANT:  When you are connected to the production database, if 
you change either of the port numbers, you will be required to restart 
the Web Interaction Server on the main server machine. 

NOTE:  Ensure that the port numbers you configure in the Manager 
application match the port numbers configured on the corporate Web 
server. For details, see the System Management Guide. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the Web server settings. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

If you want to secure the connection between the Web Interaction 
Server and the corporate Web server, the system can be configured to 
use TLS certificate-based authentication. 
 A31003-S22B1-M103-08-76A9, 04/2025
270 OpenScape Contact Center Enterprise V11 R1 Manager Administration Guide

        



options.fm

Configuring other global options
Configuring the system options
To complete the TLS configuration, you must also do the following:

• Install a TLS certificate on the main server machine. For details, see 
the Installation Guide.

• Enable TLS security on the corporate Web server. For details, see 
the System Management Guide. 

• Select an TLS-enabled port for the Web connection when you 
configure the following settings: 

– VoiceXML settings – see Section 11.5.5, “Configuring the 
VoiceXML settings”, on page 280.

– Web callback options – see Section 13.3.3, “Configuring the 
Web callback settings”, on page 307.

– Web collaboration options – see Section 15.6.4, “Configuring the 
Web server settings for Web collaboration”, on page 356.

NOTE:  We recommend that you do not select an TLS-enabled port 
until all other Web Interaction Server configurations are complete. 

To configure the Web server settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click System.

3. Click the Web Settings tab.

4. Under Port Settings, do the following:

• In the Port number box, type the number of the unsecured 
port that the Web Interaction Server uses to communicate with 
the corporate Web server. 

• In the Port number (TLS) box, type the number of the TLS-
enabled port that the Web Interaction Server uses to securely 
communicate with the corporate Web server.

5. Click OK. 
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15.3.4  Configuring the enhanced security 
option

The enhanced security feature allows you to restrict access to the 
following resources to authorized personnel only: 

• Business units (in a multitenant environment only)

• Users

• User templates

• Groups (for group-based routing)

• Skills and virtual groups (for skills-based routing)

• Contact handling rules (when multiple contact handling is enabled)

• Departments

• Locations 

• Profiles

• Call Director components (when Call Director is licensed)

• .wav files

When the option is enabled, the dialog boxes related to the applicable 
resources contain an additional Security tab where you can configure 
the security settings for the resource. 

When you first enable the enhanced security option, only the Master 
Administrator user is able to access the applicable resources. For 
details on the Master Administrator user, see Section 3.2.1, “About the 
Master Administrator”, on page 21. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the enhanced security option. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the enhanced security option:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click System.

3. Click the Advanced tab. 

4. Under Enhanced Security, select or clear the Enable check box, 
as required. 

5. Click OK.
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15.3.5  Configuring the network 
communication settings

You can configure the network communication settings for the 
OpenScape Contact Center components to use the Transport Layer 
Security (TLS) 1.2 protocol for encryption.

To configure the network communication settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click System.

3. Click the Advanced tab. 

4. Under Network Communications, do the following:

a) In the Encryption setting box, select one of the following:

• Disabled – Rejects any attempt to use TLS 1.2 encryption. 
The network communication will be unencrypted.

• Allowed – Accepts any attempt to use TLS 1.2 encryption. 
The network communication will be encrypted if requested.

• Required – Only accepts requests to use TLS 1.2 encryption 
for network communication. 

NOTE:  The Required encryption setting is not supported when 
using the OpenScape Contact Center IVR API integration.

b) In the Cipher suite box, select one of the following:

• TLS_RSA_WITH_AES_128_GCM_SHA256

• TLS_RSA_WITH_AES_256_GCM_SHA256

• TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256

• TLS_ECDHE_RSA_WITH_AES_1256_GCM_SHA256

NOTE:  The default encryption setting is Disabled and the 
default cipher suite is 
TLS_RSA_WITH_AES_128_GCM_SHA256.

5. Click OK.
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15.4  Configuring the application options

The application options affect the operation of the Manager application. 
When you configure these options, the settings are implemented for all 
users in the contact center. 

You can configure:

• The interval at which OpenScape Contact Center automatically 
refreshes information in the Manager application. 

• The time-out interval for the Master Administrator account in the 
Manager application.

• The Broadcaster settings. For details, see Section 15.5, 
“Configuring the contact lookup options”, on page 275. 

NOTE:  To configure any of the application options, you must Full or 
Modify access for the associated Manager permission.

NOTE:  In a multitenant environment, only a system administrator can 
configure the application options. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

NOTE:  When you are connected to a central reporting server machine 
(see Chapter 17, “Working with central reporting”), you can only 
configure the time-out interval for the Master Administrator account in 
the Manager application. 

To configure the application options:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Application.

3. Under Contacts Waiting Indicator, do the following for each 
media type:

• In the On box, type the minimum number of contacts required 
to turn the indicator on. 

• In the Slow flash box, type the minimum number of contacts 
required to make the indicator flash slowly. 

• In the Fast flash box, type the minimum number of contacts 
required to make the Indicator flash quickly.
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4. To use a key position on the telephone for the Contacts Waiting 
Indicator, select the Use key position on telephone keypad 
check box, and then in the Position box, type the integer that 
represents the key position you want to use. This option is available 
only if the system is connected to an OpenScape 4000, HiPath 4000 
or OpenScape Business communication platform. The default value 
is 8 when connected to a OpenScape 4000 or HiPath 4000 
communication platform, or 25 when connected to an OpenScape 
Business communication platform. To select a different key 
position, refer to the communication platform documentation. 
Ensure that you do not select a key position that is already assigned 
to a communication platform feature.

5. Under Manager Settings, in the Real-time refresh interval box, 
type or select the number of seconds between data updates in the 
Manager application. Various statistics used in real-time and 
cumulative reports and visible properties in the application are 
refreshed at the specified interval. The default value is 30 seconds.

NOTE:  When setting the Manager real-time refresh interval, you 
should consider the system hardware and the volume of contacts in 
the contact center. For example, you should not use a low refresh 
rate such as 5 seconds if your hardware meets only minimum 
requirements and you have high contact volume. A refresh rate of 
10 seconds or even 15 seconds will improve system performance. 

6. Under Manager Settings, in the Time-out box, type or select the 
number of minutes of inactivity that can elapse before the Master 
Administrator account is automatically logged off. The default value 
is 60 minutes.

7. Click OK.
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15.4.1  About the Contacts Waiting Indicator

The Contacts Waiting Indicator enables the user to gauge the number 
of contacts waiting for the user. It has three states: on, slow flash, and 
fast flash. As the number of contacts waiting for the user increases, the 
indicator moves through the three states. 

You can configure the Contacts Waiting Indicator for each media type. 
For example, if you configure the three states as 1, 5, and 10 contacts:

• The indicator will be bright constantly when the number of contacts 
waiting is between 1 and 4.

• The indicator will flash slowly when the number of contacts waiting 
is between 5 and 9.

• The indicator will flash quickly when the number of contacts waiting 
is higher than 10.

15.5  The Contacts Waiting Indicator shows reserved contacts if the reserved contact is for the 

user.Configuring the contact lookup options

You can configure the Manager application in order for the Agent Portal 
Web applications to search in a specified directory when a contact is 
received and try to match an element from the contact data to a 
selected directory field. The contacts in the directory that contain a 
matching field will be displayed on the Directory tab in the Contact 
Details window. This limits the contact data the user sees when a 
contact is received. Setting the search criteria appropriately can reduce 
the number of records that are searched. The response time will 
improve if the directory search is simple.

Before you begin, you must configure the directory that you want to 
search (see Section 5.5, “Configuring a directory”, on page 63). 

NOTE:  To configure the contact lookup options, you must have Full or 
Modify access for the Directories Manager permission. 

NOTE:  In a multitenant environment, only a business unit 
administrator can configure the contact lookup settings. For details, 
see Section 19.3, “Administrator roles in a multitenant environment”, 
on page 394. 
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To configure the contact lookup options:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Contact Lookup.

3. Under Directory, in the Directory list, select the directory to be 
searched for contact data. Only the directories that have been 
configured in the Manager application are displayed in the list.

4. Under Search, do the following:

a) In the Media box, select the media type for which you want to 
configure the search, for example, Voice. 

b) Select the Enable check box. 

c) In the Directory field name to search box, type the name of 
the directory field on which you want to search. 

d) Select the contact data you want to compare to the specified 
database field name. You can choose one of:

• Source of the contact.

• Destination of the contact.

• Contact data key, that is, a key in the contact data. If you 
choose Contact data key, type the name of the key from 
the contact data that contains the value that will be used in 
the search.

For example, if you want to search for all entries in the database 
where the field “Calling From” matches the source of the current 
contact, you would type the database field name that 
corresponds to the display name “Calling From” in the 
Directory field name to search box, and then select the 
Source option. 

5. Click OK.

15.6  Configuring the data management options

You can configure the options related to the management of data in the 
contact center, including the data retention periods. 

NOTE:  To configure any of the data management options, you must 
have Full or Modify access for the associated Manager permission.
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15.6.1  Configuring the data maintenance 
time

The data maintenance time is a specified time during the day when the 
application performs automatic data maintenance procedures. During 
this time, the system performs various tasks, such as calculating daily, 
weekly, and monthly statistics, and deleting information that has been 
kept longer than the specified data retention periods.You cannot create 
reports while the data maintenance procedures are being performed. 

By default, the application is configured to export the existing 
administration data to a Microsoft Access database at data 
maintenance time. A new database, named according to the time the 
database was created, is exported at each data maintenance time and 
is saved in the AdministrationData folder in the ShareData folder. The 
last 30 databases are saved. These databases can be used by your 
service representative to troubleshoot problems with the system. The 
structure of these databases is identical to a design database. 

To minimize the impact on contact center operations, you should 
configure data maintenance to occur when the contact center is closed 
or during its least busy period. Be sure to consider the time zones of 
remote locations. For details, see Section 15.6.1.1, “Effect of different 
time zones on data maintenance”, on page 278. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the data maintenance time. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

NOTE:  When the system is configured for high availability (warm 
standby), the OpenScape Contact Center service on the server 
machine that is in standby mode automatically restarts every day, one 
hour before the configured data maintenance time. This ensures that 
the backup instance of the system gets updated with the replicated 
data changes that have been made on the active server machine. 

To configure the data maintenance time:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Data 
Management.

3. Under Data Maintenance, in the Maintenance time box, type or 
select the hour of the day when the system begins to perform data 
maintenance procedures. The minutes cannot be changed. 
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4. Ensure that the Export administration data option is selected. 

IMPORTANT:  The Export administration data option is enabled 
by default and should be disabled only under the direction of your 
service representative. 

5. Click OK.

15.6.1.1  Effect of different time zones on data 
maintenance

The OpenScape Contact Center system allows you to run reports 
against different time zones. Because of this, we recommend that you 
ensure that the full day is complete at all locations that are in different 
time zones before data maintenance occurs. If the full day (or full week 
or full month) is not complete at all locations when the reporting 
statistics are calculated, reports that are based on the time zone of the 
user's location will not show any data for that day (or week or month). 
However, the data will be available the next day. 
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For example, in the following diagram, the main server machine is 
located in Toronto. If you schedule data maintenance to occur at 12:00 
midnight (Monday- Tuesday) in Toronto, the day is not complete in 
Vancouver where it is only 9:00 P.M. Monday. In this case, the data for 
Monday will not be available in reports that are based on the time zone 
of a user whose location is Vancouver (specifically user, routing state 
reason, Wrap-up reason, and Post-processing reason historical 
reports). We recommend that you schedule data maintenance to occur 
after 3:00 A.M. Tuesday to ensure that the full day is complete in 
Vancouver. 
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Similarly, when the contact center has the networking feature, you 
should schedule data maintenance on the central reporting server 
machine to occur after the full day is complete at all remote networked 
sites. For example, in the diagram below, you should schedule data 
maintenance to occur in Toronto after 3:00 A.M. This will ensure that 
the data for Monday in Vancouver is available when you run reports 
from the central reporting server machine based on the time zone of 
the Vancouver site. In the case of networking, all historical reports that 
are based on the time zone of a remote site can be affected, not just 
user historical reports. 
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Finally, when the contact center has both networking and remote 
locations, you should take the time zones of the remote networked 
sites and their locations into consideration. For example, in the 
following diagram, you should schedule data maintenance to occur at 
the central reporting site in Halifax after 7:00 A.M. Tuesday, to ensure 
that the full day (Monday) in Honolulu is complete. 

15.6.2  Adding a data location

To ensure that the system has enough data storage capacity, you 
should check the total data usage, and use the values provided to help 
you determine if you need to add a new data location. 

NOTE:  The Data Locations and Total Database Usage group boxes 
appear only when you are connected to a production database. 
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In the Data Management options, on the General tab under Total 
Database Usage, the following values are displayed as a guideline:

• Maximum allowed space – This is the maximum disk space 
allowed for data storage. This value cannot be changed. 

• Allocated space – This is the total amount of disk space currently 
allocated by the system for data storage. 

• Estimated required space – This is the amount of disk space 
currently estimated to be required for data storage, based on the 
current system usage and the total of the configured retention 
periods. 

The new data location must be an internal hard disk drive that is 
intended exclusively for OpenScape Contact Center data storage. 
Before you begin, you must ensure that the disk drive you want to add 
is already installed. 

NOTE:  The System Monitor application displays a message when 
there is not enough disk space available to store the data that will be 
generated over the next two weeks or less. The estimation is based on 
the configured retention periods and the current system usage. You 
can also configure a notification to this effect. For details, see Section 
5.3.3, “Configuring a notification”. 

NOTE:  In a multitenant environment, only a system administrator can 
add a data location. For details, see Section 19.3, “Administrator roles 
in a multitenant environment”, on page 394. 

To add a data location: 

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Data 
Management.

3. On the General tab, under Data Locations, click Add.

4. In the Add Data Location dialog box, select the disk drive you 
want to use for additional data storage. 

5. Click OK.
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15.6.3  Deleting a data location

Before you can delete a specified OpenScape Contact Center data 
location, you must remove all data from the disk drive. 

NOTE:  The Data Locations and Total Database Usage group boxes 
appear only when you are connected to a production database. 

NOTE:  In a multitenant environment, only a system administrator can 
delete a data location. For details, see Section 19.3, “Administrator 
roles in a multitenant environment”, on page 394. 

To delete a data location:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Data 
Management.

3. On the General tab, under Data Locations, select the disk drive 
in the table that you want to delete.

4. Click Delete.

15.6.4  Configuring the retention periods for 
reporting data

You can configure how long to store various OpenScape Contact Center 
reporting statistics and the error log. 

The reporting statistics are described as follows: 

• Detailed statistics – Detailed statistics include detailed contact 
and user statistics, and contact data. The following reports use the 
detailed statistics: user and source activity reports, contact and 
source historical reports, queue by user historical reports, and user 
by queue historical reports. 

• 15-minute statistics – Historical reports with no interval, 15-
minute intervals, and hourly intervals, are generated using the 15-
minute statistics.

• Daily statistics – Historical reports with daily intervals are 
generated using the daily statistics.

• Weekly statistics – Historical reports with weekly intervals are 
generated using the weekly statistics. 
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• Monthly statistics – Historical reports with monthly intervals are 
generated using the monthly statistics.

Under Database Usage for Reporting, the following values are 
displayed as a guideline:

• Maximum allowed space – This is the maximum disk space 
allowed for reporting data storage. This value cannot be changed. 

• Allocated space – This is the total amount of disk space currently 
allocated by the system for reporting data storage. 

• Estimated required space – This is the amount of disk space 
currently estimated to be required for reporting data storage, based 
on the current system usage and the specified retention period. 

NOTE:  The Database Usage for Reporting group box appears only 
when you are connected to a production database. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the retention periods for reporting data. For details, see 
Section 19.3, “Administrator roles in a multitenant environment”, on 
page 394. 

To configure the retention periods for reporting data:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Data 
Management.

3. Click the Reporting tab.

4. Under Retention Periods, for each row in the table, click in the 
Value column and type a new value in the cell. You can also click 

 to specify the retention period using the Retention Period 
Converter dialog box. 

5. Under Database Usage for Reporting, the application updates 
the value of the Estimated required space based on your 
changes. 

6. Click OK. 
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15.6.5  Configuring the retention period for 
e-mail data

You can configure how long to store e-mail messages and contact 
information. 

Under Database Usage for E-mail, the following values are displayed as 
a guideline:

• Maximum allowed space – This is the maximum disk space 
allowed for the storage of e-mail data. This value cannot be 
changed. 

• Allocated space – This is the total amount of disk space currently 
allocated by the system for the storage of e-mail data. 

• Estimated required space – This is the amount of disk space 
currently estimated to be required for the storage of e-mail data, 
based on the specified retention period. 

NOTE:  The Database Usage for E-mail group box appears only when 
you are connected to a production database. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the retention period for e-mail data. For details, see Section 
19.3, “Administrator roles in a multitenant environment”, on page 394. 

To configure the retention period for e-mail data:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Data 
Management.

3. Click the E-mail tab.

4. Under Retention Period, click in the Value column in the table, 
and type a new value in the cell. You can also click  to specify 
the retention period using the Retention Period Converter dialog 
box. 

5. Under Database Usage for E-mail, the application updates the 
value of the Estimated required space based on your changes. 

6. Click OK. 
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15.6.6  Configuring the retention period for 
Web collaboration data

You can configure how long to store Web collaboration transcripts. You 
can use the transcript data for custom reporting. 

Under Database Usage for Web Collaboration, the following values are 
displayed as a guideline:

• Maximum allowed space – This is the maximum disk space 
allowed for the storage of Web collaboration data. This value cannot 
be changed. 

• Allocated space – This is the total amount of disk space currently 
allocated by the system for the storage of Web collaboration data. 

• Estimated required space – This is the amount of disk space 
currently estimated to be required for the storage of Web 
collaboration data, based on the specified retention period.

NOTE:  The Database Usage for Web Collaboration group box appears 
only when you are connected to a production database. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the retention period for Web collaboration data. For details, 
see Section 19.3, “Administrator roles in a multitenant environment”, 
on page 394. 

To configure the retention period for Web collaboration data: 

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Data 
Management.

3. Click the Web Collaboration tab.

4. Under Retention Period, click in the Value column in the table, 
and type a new value in the cell. You can also click  to specify 
the retention period using the Retention Period Converter dialog 
box. 

5. Under Database Usage for Web Collaboration, the application 
updates the value of the Estimated required space based on your 
changes.

6. Click OK.
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15.7  Configuring the statistics options

The options you specify for the statistics affect the user performance 
calculations in the Manager application. 

NOTE:  To configure any of the statistics options, you must have Full 
or Modify access for the associated Manager permission. 

15.7.1  Configuring the service level interval

The service level interval is a target set for the contact center to help 
monitor performance. The service level interval is the target amount of 
time within which a contact should be answered. This means that a 
contact should not wait in queue longer than the time specified to be 
considered answered successfully. You set the service level interval 
globally for each media type in the contact center; however, you can 
override this setting for a specific queue. 

The application uses the service level interval to calculate the service 
level for all queues that route OpenScape Contact Center contacts. The 
service level is defined as the number of successfully answered 
contacts divided by the total number of contacts. The application 
calculates the service level based on the chosen service level 
calculation formula. 

NOTE:  In a multitenant environment, only a business unit 
administrator can configure the service level intervals. For details, see 
Section 19.3, “Administrator roles in a multitenant environment”, on 
page 394. 

To specify the service level intervals:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Statistics.

3. Under Service Level Calculation, for each Media type in the 
table, double-click the time and then type the time interval in which 
a user should be able to answer a contact. Note that the time 
interval for calls is in hours, whereas the time interval for callbacks 
and e-mail messages is in days. 

4. Click OK. 
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15.7.1.1  Choosing the service level calculation 
formula

The application uses the service level interval to calculate the service 
level for all queues that route OpenScape Contact Center contacts. The 
application calculates the service level using one of four formulas, each 
of which defines “successfully answered contacts” and “total number of 
contacts” differently. 

NOTE:  In a multitenant environment, only a business unit 
administrator can configure the service level calculation formula. For 
details, see Section 19.3, “Administrator roles in a multitenant 
environment”, on page 394. 

To choose the service level calculation formula:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Statistics.

3. Click Formula.

4. In the Service Level Calculation Formula dialog box, under 
Redirected Contacts, select the Include in service level 
calculations check box if you want to include redirected contacts 
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in the formulas. Redirected contacts include calls redirected to an 
unmonitored device before being answered by a user, abandoned 
by the caller, or timed out. 

5. Under Details, select the service level calculation formula you want 
to use to calculate the service level. For a description of the 
formulas, see Section 15.7.1.2, “Service level calculation formulas”, 
on page 285.

6. Click OK.

15.7.1.2  Service level calculation formulas

In the service level calculation formula, the numerator defines which 
contacts are considered successfully answered within the service level 
interval. The numerator can include:

• The number of contacts answered within the service level interval.

• The number of contacts abandoned within the service level interval. 
(You can consider these contacts successfully answered because it 
is difficult to answer a contact that is abandoned quickly.)
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The denominator defines which contacts comprise the total number of 
contacts. This number is determined by the type of report the service 
level is displayed in. In a real-time report, the total number of contacts 
is the number of contacts received since the last shift start, up to a 
maximum of 24 contacts. In a cumulative or historical report, the total 
number of contacts depends on the time range specified in the report. 
The denominator can include:

• The number of contacts answered during the defined time.

• The number of contacts abandoned during the defined time.

• The number of contacts abandoned after the service level interval. 
(You can use this number instead of the total number of abandoned 
contacts, if contacts that are abandoned quickly are not included.)

• The number of redirected contacts, if the Include in service level 
calculations check box is selected under Redirected Contacts.

NOTE:  The meaning of the terms Abandoned, Answered, and 
Redirected differ by media. For details, see the Reporting Reference 
Guide.

Example

If the global service level interval for voice is set to 30 seconds, it 
means that calls in your contact center should be completed within 30 
seconds. Assume that 15 calls come into the contact center: 9 calls are 
answered within 30 seconds; 2 calls are abandoned by the caller before 
30 seconds; and 4 calls are answered after 30 seconds. This means:

• Answered in service level interval = 9

• Abandoned in service level interval = 2

• Answered = 13

• Abandoned = 2

Based on these numbers, in the Service Level Calculation Formula 
dialog box:

• The first formula calculates the service level as 11/15 = 
0.73333333

• The second formula calculates the service level as 9/13 = 0.692307

• The third formula calculates the service level as 9/15 = 0.6

• The fourth formula calculates the service level as 9/13 = 0.692307
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15.7.2  Configuring the wait time

By default, wait time starts when a contact is placed in a queue. You 
can specify whether to include the time before a call is enqueued (such 
as when the contact is in an IVR) or the time when a callback or e-mail 
message is suspended by the system. This is reflected in the wait time 
statistics used in reporting. 

The wait time includes the time a contact spends reserved for a specific 
user while enqueued. Reserved contacts that remain unanswered 
before proceeding to the queue steps could adversely affect the service 
level calculation. For more information, see Section 8.2.1, “Configuring 
the manual reserve time”, on page 142, and Section 15.7.1, 
“Configuring the service level interval”, on page 283. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the wait time. For details, see Section 19.3, “Administrator 
roles in a multitenant environment”, on page 394. 

To configure the wait time:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Statistics.

3. Under Wait Time, do the following:

• To have the wait time start when the call arrives at the first 
monitored resource, such as an IVR extension, select the 
Include time before enqueue check box. When this option is 
cleared, the wait time starts when the call is enqueued. This 
option only applies to calls. 

• To include the time when the contact is suspended by the 
system, select the Include system suspended contacts 
check box. The system suspends the routing of e-mail messages 
and callbacks when the current time is outside the configured 
routing schedule for the media type. This option only applies to 
e-mail messages and callbacks. 

4. Click OK. 
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15.7.3  Configuring the user calculation

Statistics are monitored for every OpenScape Contact Center user who 
handles contacts. These statistics include the time spent in each state 
and utilization.

Utilization is the percentage of logged on time that a user spends 
handling routed contacts or otherwise working (for example, attending 
meetings): 

Utilization = (Routed Handling time + Busy time) ÷ Logged on time 
* 100

You can choose to include the time a user spends in Idle state in the 
Utilization calculation. For more information on the definition of user 
statistics, see the Reporting Reference Guide. 

You can also specify the amount of time that must pass after a user 
contacts another person at the site, for the contact to be considered a 
consultation. 

NOTE:  In a multitenant environment, only a system administrator can 
configure the user calculation. For details, see Section 19.3, 
“Administrator roles in a multitenant environment”, on page 394. 

To configure the user calculation:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Statistics.

3. Under User Calculations, do the following:

• In the Consider consultation after box, type or select the 
number of seconds that must be exceeded after a user contacts 
another person at the site, for the contact to be considered a 
consultation. 

• To include the time that a user spends in Idle state in the 
Utilization calculation, select the Include idle time in 
utilization check box. 

4. Click OK.
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15.7.4  Configuring how contacts that are 
finished in Call Director or an IVR are 
considered

If the OpenScape Contact Center system has Call Director or an IVR as 
a front end, or if a contact is transferred to Call Director or an IVR from 
within a routing strategy workflow, the contact can be finished in Call 
Director or the IVR before it is enqueued. This can happen in two ways: 
by Call Director or the IVR disconnecting, or by the caller abandoning. 

You can specify whether contacts that are finished in this way are 
considered as Answered or Abandoned. For example, if a customer gets 
all the information the customer needs from the IVR and then hangs 
up, you would want this to be considered Answered rather than 
Abandoned. Contacts that are redirected out of scope are also 
considered Answered when this option is enabled. 

Contacts that finish in Call Director or an IVR while they are enqueued 
are considered Abandoned, regardless of this setting value. 

NOTE:  In a multitenant environment, only a system administrator can 
configure this option. For details, see Section 19.3, “Administrator roles 
in a multitenant environment”, on page 394. 

To configure how contacts that are finished in Call Director or 
an IVR are considered: 

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Statistics.

3. To consider the contacts that are finished in Call Director or an IVR 
as Answered, under Call Director or IVR, select the Consider 
finished in Call Director or IVR as Answered check box. If you 
do not select this option, these contacts will be considered as 
Abandoned. 

4. Click OK. 
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15.7.5  Configuring the shifts

The real-time statistics are calculated for contacts based on time 
periods in the contact center normally defined as shifts. At the start of 
a shift, the real-time statistics for your contact center are set to 0 to 
start calculating new real-time statistics. 

You can have a maximum of three shifts in a 24-hour period. You must 
specify the Shift 1 start time; the other two start times are optional. By 
default, the start time for Shift 1 is 00:01 (one minute past midnight). 
With only one shift configured, your site will have one 24-hour data set 
per day. The times are entered using the 24-hour clock. 

The reports and views in the Manager application show the real-time 
statistics for the current shift only.

NOTE:  In a multitenant environment, only a system administrator can 
configure the shifts. For details, see Section 19.3, “Administrator roles 
in a multitenant environment”, on page 394. 

To configure the shift start times:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click Statistics.

3. Click the Shifts tab.

4. Under Shifts, type or select the start time for Shift 1. By default, 
the Shift 1 check box is selected and cannot be cleared. 

5. To configure additional start times, select the check box next to the 
Shift label, and then type or select the required start time. 

6. Click OK.

NOTE:  To delete a shift start time, clear the check box next to the shift 
you want to delete. 

15.8  Configuring the CRM integration options

If the contact center is licensed for either SAP CIC or SAP ICI 
integration, you can configure the integration settings. For details, see 
the following topics:

• Section 20.8.1, “Configuring the SAP CIC settings”, on page 440
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• Section 20.8.2, “Configuring the SAP ICI settings”, on page 442

NOTE:  To configure any of the CRM integration options, you must 
have Full or Modify access for the associated Manager permission. 

15.8.1  Configuring the SAP CIC settings

If the contact center is licensed to integrate with an SAP Customer 
Interaction Center (CIC), you can configure the SAP CIC system and 
server settings. 

IMPORTANT:  When you are connected to the production database, 
any changes you make will take effect immediately and may impact the 
users that are currently connected to the system. 

NOTE:  In a multitenant environment, SAP CIC integration is not 
supported. For details on the multitenancy feature, see Chapter 19, 
“Working with the multitenancy feature”. 

NOTE:  Multiple contact handling is not supported for SAP CIC users. 
For details on multiple contact handling, see Section 8.3, “About 
multiple contact handling”, on page 167. 

To configure the SAP CIC settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click CRM Integration.

3. Click the SAP CIC tab.

4. Under SAP CIC Settings, do the following:

a) In the Host name box, type the IP address or host name of the 
SAP system. 

b) In the Client number box, type the Client number for the SAP 
system. 

c) In the User name box, type the user ID defined on the SAP 
system. 
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d) In the Password box, type the password required for the user 
ID on the SAP system. 

e) In the Confirm password box, retype the password to confirm 
that you typed it correctly. 

5. Under Server Settings, do the following: 

a) In the SAP program ID box, type the program ID for the SAP 
system. 

b) In the SAP RFC destination box, type the RFC destination 
defined in the SAP system. 

c) In the SAP gateway host box, type the IP address or host 
name of the gateway for the SAP system. 

d) In the SAP gateway service box, type the name of the 
gateway service on the SAP system. 

e) In the SAP system number box, type the number of the SAP 
system. 

f) In the SAP telephony server box, type the name of the 
telephony server on the SAP system. 

g) In the Voice logon label box, type the name of a voice queue 
defined in the SAP system. This provides the SAP logon 
mechanism with a configurable logon label. Refer to your SAP 
CIC documentation for more information.

h) In the E-mail logon label box, type the name of an e-mail 
queue defined in the SAP system. This provides the SAP logon 
mechanism with a configurable logon label. Refer to your SAP 
CIC documentation for more information.

6. Click OK.
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15.8.2  Configuring the SAP ICI settings

If the contact center is licensed to integrate with an SAP Integrated 
Communication Interface (ICI), you can configure the SAP ICI port 
number and script settings. 

NOTE:  In a multitenant environment, SAP ICI integration is not 
supported. For details on the multitenancy feature, see Chapter 19, 
“Working with the multitenancy feature”. 

NOTE:  Multiple contact handling is not supported for SAP ICI users. 
For details on multiple contact handling, see Section 8.3, “About 
multiple contact handling”, on page 167. 

The script settings are related to the ANI scripting feature which is used 
to modify the ANI passed from the communication platform before 
relaying it to the SAP CRM system so that it adheres to SAP standards. 
Depending on the format of the ANI provided, you might have to:

• In North America, add a country code and area code to the ANI 
provided for a local call, for example, change 5551430 to 
14165551430. 

• In Germany, strip out a leading zero and add 49 to the ANI provided 
for a national call, for example, change 08972289561 to 
498972289561. 

OpenScape Contact Center provides two sample script files: 
SapIciAniScript.vbs and SapIciAniScript.js. These sample script files 
are installed in the default folder on the server machine. You can open 
one of the sample scripts, modify the code to the specific needs of the 
contact center, and then save the file under a new name. 

IMPORTANT:  When you are connected to the production database, 
any changes you make to the SAP ICI settings will take effect 
immediately and might impact the users currently connected to the 
system. 

NOTE:  If you want to change the script that is currently in use, we 
recommend that you save the script as a new file, make the required 
changes to the new file, and then specify the new file name, as 
described in the following procedure. 
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To configure the SAP ICI settings:

1. On the Tools menu, click Options.

2. In the left pane, under System Settings, click CRM Integration.

3. Click the SAP ICI tab.

4. Under SAP ICI Settings, in the Port Number box, type the port 
number the SAP ICI system uses to communicate with OpenScape 
Contact Center. 

5. Under Script Settings, do the following: 

a) To enable ANI scripting, select the Enable script processing 
check box.

b) In the Script file name box, type the file name of the script you 
want to use, including the extension. 

c) In the Script language list, select the scripting language: 
VBScript or Jscript. 

d) In the Maximum file size box, type or select the maximum size 
of the script file. If the size of the script file exceeds this value, 
script processing will not be used and the ANI will be passed to 
the SAP ICI system in the original format. 

e) In the Maximum script duration box, type or select the 
maximum amount of time for which the script can run. If the 
script execution exceeds this value, the script will terminate and 
the ANI will be passed to the SAP ICI system in the original 
format. 

6. Click OK. 
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